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COMMUNICATIONS 

APPLETALK 
Oose The Chooser 
To improve Apple Talk network perfor­
mance, don't leave the Chooser open. 
Active Choosers create packet traffic on 
Apple Talk networks. On large networks, 
this chews up 5 to 10 percent of the avail-
able bandwidth. ' 

APPLES HARE 
Prevent Server VlrUS Infection 
To protect your server's Desktop file 
against WDEF infections, simply lock 
the top level against changes. This has 
the side effect of keeping users tidy. 

Keeping Users From Trashing 
Database Flles 
How can you keep users from trashing a 
database file on an AppleShare server, 
even though they need access to it? 

AppleShare controls user access by folder, 
so the first thing you have to do is to put 
the file in its own folder, to which you 
can assign specific privileges. 

If users need only Read Access to the 
file, you can simply select the folder, 
choose Privileges from the Finder's File 
menu, and select the See Folders and See 
Files check boxes for your group (or 
everyone). Don't check the Make 
Changes box, though. 

There's no easy way to keep people from 
trashing the file if they need write access. 
One kludgy solution is to use ResEdit or a 

similar file utility to make the database 
file invisible. This will keep the file's icon 
from being displayed in the Finder, which 
means the file can't simply be dragged 
to the trash. Note, however, that utility 
software still will be able to see and 
delete the file. 

Passwords Are Case-Sensitive 
If your AppleShare server doesn't accept 
your password but you know you are typ­
ing it correctly, check the Caps Lock key. 
AppleShare passwords are case-sensitive. 

Access Server Flles With 
Timbuktu 
Wanna grab some files fast from an 
AppleShare server? If you're running 
Farallon Computing Inc.'s Timbuktu on 
it, you can transfer files quickly from vir­
tually anywhere- including unmount­
ed volumes and the Server folder. 

Finding A "Lost" Printer 
Sometimes the reason for printing prob­
lems is software-based. For example, if you 
use a printer over Apple Talk, you might 
one day find that the printer doesn't show 
up in the Choose Printer dialog box. If 
this happens to you, first Quit the applica­
tion and make sure your disk contains all 
the files you need. If it does, try this: 

If the printer you need doesn't show up as 
a print option in the Choose Printer dia­
log box, disconnect Apple Talk and close 
the dialog box. Then reopen the dialog 
box and select Apple Talk Connected. 
Hopefully, the missing printer icon will 
mysteriously reappear so you can select it 
and try to print again. 

Another resort is to reinstall the printer 
drivers in your System Folder. 

J.: 
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APPLETALK PHASE 2 
Mixing Phase 1 And Phase 2 
When you install System 7 .x on a net­
work, Apple recommends that you 
upgrade all routers and workstations to 
Apple Talk Phase 2 if you haven't already 
done so. A network that mixes Apple Talk 
Phase 1 and Phase 2 can have communica­
tions problems under System 7 .x. For 
example, if you install System 7 .x on an 
Ethernet network, workstations that use 
Phase 2 won't be able to talk to those run­
ning Phase 1. If you decide to keep the 
entire network on Apple Talk Phase 1, you 
must reinstall Phase 1 EtherTalk drivers 
on the System 7 .x workstations. 
Upgrading to System 7 .x doesn't have any 
adverse effects on Local Talk or Token Talk 
networks that use AppleTalk Phase 2. 

COMPUSERVE 
Cutting Noise On CompuServe 
On CompuServe, as on any other network, 
line noise can ruin an upload or download. 
To cut out the noise, make the first charac­
ter in each "typing" command in your 
macro the control character that says to 
the network, "Ignore what I've typed so 
far." This cuts down on problems associat­
ed with your program's reading noise 
input as your typing. When you· re on 
CompuServe, type Control-D. This tells 
the service to ignore noise. 

E·MAIL 
It's All In The Tide 
Too busy to be bothered with opening 
your mail? Often, the substance of ames-
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sage can be expressed in the tide, leaving 
intricate details for the body of the mes­
sage. For example, instead of entitling a 
message "Meeting Reminder" and fur­
nishing the date and time in the body of 
the message, you can entitle it "Meeting 
10/22 1 P.M." The title then acts as an 
effective reminder. You get all the infor­
mation you need just by looking at the 
mail window. 

Discourage E-Mail Printing 
One of the benefits ofE-mail is that it can 
reduce the amount of paper in an office, 
but printing messages negates this 
advantage. Each time a message is print­
ed, it has to be transmitted over the net­
work twice if you use a network spooler. 

1 

An E-mail message sent to 20 people and 
printed by 10 should probably have beeJ 
photocopied. I 

There are usually two main reasons people 
print their E-mail. The first is that they 
want to keep a record of their correspon­
dence. But some E-mail packages, such as 
Quick Mail, let you create electronic fold­
ers in which you can store old messages. 
Another feature your E-mail program may 
have is the ability to store mail messages 
on a local hard disk, rather than on the 
mail server. Rereading a message stored 
on the server adds network traffic. 

Another reason for printing E-mail mes­
sages is that users are only in the office for 
a short time each day and want to be able 
to read them later. Remote access to the 
mail server might be a worthwhile alter­
native for such users. Perhaps they already 
have a computer and modem at home or 
can borrow the necessary equipment from

1 

their company. Using a remote computer j 

lets them respond electronically tomes- ' 
sages as they read them. 



GENERAL 
INFORMATION 
Getting Cheap Practice 
If you're new to telecommunications, or 
are just getting to know a new telecom­
munications program, you don't have to 
pay a lot of expensive connect charges 
while you learn how to upload and down­
load on networks. Contact your local 
Macintosh users' group or an experienced 
friend and get the phone number of a free 
local bulletin board. Practice uploading 
and downloading on the free network. 

Once you know your way around the local 
network, look for shareware and public 
domain libraries, where you might be able 
to download programs for far less than 
you'd be charged by a national network. 

When Call-Waiting Disconnects 
Transmissions 
If you have call-waiting and a modem, 
you can run into a lot of interrupted 
telecommunications sessions. A little­
known trick is to add "*70" on touch tone 
phones, or to dialll70 on pulse phones, 
just before the number to be dialed in 
your modem dial command. This disables 
call waiting. This tip may not work in all 
areas of the country. Ask your phone com­
pany for more details. 

Telephone Noise Can Interrupt 
Transmissions 
If you experience continued failures mid­
way through transmission while using a 
protocol transmission, your problem 
could be telephone noise. Try getting a 
cleaner connection by hanging up and 
redialing. 

Disabllng The Internal Modem 
Speaker 
The internal modem speaker of a Hayes­
compatible modem can be temporarily 
disabled. Just type ATMO from your ter­
minal program and press Return. The 
command will be acknowledged by an 
"OK." Turn the volume back on by typ­

ing ATMl and pressing Return. 

Getting Your Program To Wait 
Longer To Redial 
Many terminal programs allow users to 
change the amount of time that the 
modem waits for a carrier before redialing 
when in auto-redial mode. The command 
ATS7 =x sets the number of seconds the 
program waits, with X= the default num­
ber of seconds. Default value is usually 20 
seconds, but you can change it to almost 
any number less than 255 by changing 
the default value. 

Telexing With A Mac 
If you need to send a telex message, you 
can use your Mac to do the job. At least 
three services let you send telex messages 
from any Mac equipped with a modem: 
MCI Mail, AT&T Mail, and CompuServe. 

Using the Desktop Express software 
package from Dow Jones Software, which 
simplifies using MCI Mail, is the easiest 
way to send telex messages. Save fre­
quently- used telex addresses in your 
Address Book and you can send messages 
with a few double clicks. 

AT&T Mail and CompuServe are a little 
less user-friendly. Sending a telex with 
either of these systems involves addressing 
your communications with special codes. 
On CompuServe, for example, you enter 
the Easy Plex mail subsystem (type Go 

J.: 
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Easy at any prompt) and address your cor­
respondence: > TLX 12345 howdy, where 
12345 is the telex-machine number of 
the party you are sending to and howdy is 
the answer-back message. You can obtain 
complete on-line instructions on using 
CompuServe's telex feature by typing 
Find Telex at any prompt. 

IN BOX 
Setting The Time On The Message 
Serve 

'he Mac that runs your InBox mail sys­
em resets all of the Macs on the network 
:o its clock. So, if you are frequently reset­
ting your clock, check the server clock. 

INTERNET ROUTER 
Clear Out The Old Before 
Changing Zone Names 
When you're using Apple's Apple Talk 
Internet Router software, it's easy to 
change the name of a network zone as 
long as you remember one simple step: 
Delete the old zone name first. If you just 
type over the existing zone name, click 
Done and save your changes, the router 
doesn't change anything. 

INTER•POLL 
Upgrading Inter• Poll To 
System7 
Inter• Poll version 1.0 is mostly compati­
blewithSystem 7, but version 1.0.1 is 
fully compatible. The update to 
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Inter• Poll is free and you should upgrade· 
the Inter• Poll software after installing 
System 7. 

Inter• Poll will work with both System 7 
and System 6 systems over the network. 

MACTERMINAL 
How To Use Cursor Keys Instead 
OfTheMouse 
If you prefer using cursor keys to mice 
while connected to a remote computer, 
hold down Option to transform the cur­
sor into a four-way, VT100-type arrow 
cursor that can be moved where you 
want. Then click the mouse. The cursor 
key sequences will be transmitted to the! 
remote computer. I 

Command Key Combinations 
MacTerminal's key combinations always 
work when you're off-line; they're less 
reliable while you're connected. The com­
binations are: 

one space. 

Command-I moves the cursor co the 
right, stopping at the next tab marker. 

Command-} moves the cursor down 
one line. 

Commaod-K moves the cursor down 
two lines. 

start of the current line. 

Command-G cells the Mac to sound a 
cone. 



Use Hard Backspace When 
Correcting Mainframe Data 
When you're communicating with main­
frames, pressing Backspace will not cor­
rect data stored in the mainframe, even 
though it corrects your screen display. To 
remove the character you backspaced over 
on the mainframe as well, use Command­
Backspace. 

Create Replacement Mac-To-Mac 
Document 
The program supplies its own Mac-To­
Mac document with preconfigured ter­
minal settings. If you've accidentally 
trashed this document, you can make a 
replacement: 

Start by pulling down the Settings menu 
and change the dialog boxes in Terminal 
Compatibility and File Transfer, in that 
order. In the Terminal Settings, click New 
Line, Local Echo, On Line, Auto Repeat, 
and Auto Wraparound to On; in the 
Compatibility Settings dialog, choose 8 
bits per character, No parity, No hand­
shake, and the baud rate the host comput­
er will use; in the File Transfer Settings 
dialog, choose XModem, Retain Line 
Breaks, Word Wrap Outgoing Text, and 
Remote System equals MacTerminal. 
Leave all the other default settings, and 
save the document as "Mac-To-Mac." 

Avoiding System Hang 
Once in a while, MacTerminal will hang 
up after the host computer has answered 
the call. If you're using a Hayes-compati­
ble modem, solve the problem by insert­
ing a few commas after the phone num­
ber. Each comma causes the modem to 
wait two seconds, allowing MacTerminal 
to register the fact that a connection has 
been made. 

MCI 
Transfer OfFlles 
MCI Mail's electronic mail service 
doesn't accept Mac files other than text 
messages except from two sources: MCI's 
Desktop Express program and Solutions 
Inc.'s CommGate gateway for Microsoft 
Mail2.0. 

Desktop Express is pretty limited and 
may not fit into your setup. It doesn't use 
modem scripts so you can't use it 
through an office modem pool, it has 
trouble on busy networks with shared 
modems like Shiva Corp.'s NetModems, 
and MCI doesn't recommend running 
the program on the Mac Ilci and Ilfx, 
either. Desktop Express also has not been 
updated in five years, and has difficulty 
working with System 6.07 and on. 
Forewarned is forearmed. 

MODEM 
Quiet Dialing 
If you're using a Hayes-compatible 
modem and don't want to hear all those 
beeps and clicks during dialing, turn off 
the speaker using the ATMO command. 
To turn it back on, type in ATMl. 

Dedicated Phone Une? 
If you plan on having a fax machine and a 
modem you may want an extra phone 
line for each, but it is not necessary. 

A phone line is a phone line, as long as 
you have a dial tone. A second phone line 
is a necessity if you intend to keep things 
running 24 hours a day (if you're running 
a BBS or want to keep the fax machine on 
24-hour standby), unless you're absolute-

J.: 
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ly sure no one will want to engage you in 
analog telecom (nerdspeak for "talk to you 
on the phone"). 

You may consider adding a second line 
for purely anthropological reasons, how­
ever, particularly if you have roommates. 
The usual way that human beings check 
to see if another human is using the 
phone is to pick up an extension and 
shriek, "Hey, anyone on the phone?!?" 
This has the effect of cutting off whatever 
data is coming across the phone line at 
the time and making your modem very 
angry with you. 

Another problem with voice/data cohabi­
tation is Call Waiting. When you hear a 
beep on the phone, you know another call 
is coming in. Unfortunately, this beep is to 
modems what garlic is to vampires. One 
beep, and your modem runs screaming 
into the night, terminating its connection. 

You can temporarily switch off call wait­
ing in most parts of the country by dialing 
*70 before dialing the number you want 
to connect to. Call waiting will be reacti­
vated as soon as your modem hangs up. 

Another solution is to buy a bunch of 
"privacy switches," little boxes you plug 
into every phone jack in the house. Then, 
whenever your modem goes off-hook, all 
the other receivers go dead. Radio Shack 
sells its Teleprotector (stock #43-1 07 ) for 
just $7.95- if you put them onto two or 
three phones, it's a lot cheaper than a sec­
ond phone line. 

IfYou Can't Connect, Tell Your 
Modem to Wait Longer 
If you have trouble connecting to an on­
line service, adjust the length of time the 
modem waits for a carrier signal before it 
hangs up and redials. The command 
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ATS7 =x sets the number of seconds the 
modem waits for a carrier. The default 
value for x is 20 seconds, but you can sub­
stitute a new number of seconds for x. 

NAVIGATOR 3.0.4 
Finding Names And Addresses 1 

When creating a message in Navigator 
3.0.4, type the first few letters of the 
recipient's name into the MsgTo field and 
select Lookup. 

IfNavigator finds only one matching 
entry, it will paste the name into the field. 
If it finds multiple matching entries, it 
will open the address book and highligh~ 
the first one. I 

NETWORK 
MANAGEMENT 
The Hit-or-Miss Method 
Troubleshooting a network can be a 
methodical process, or just random 
attempts to get rid of the problem. Here 
are some random things to try for net­
work problem solving: 

If the problem appears to be somewhere I 

on the network, try cycling the power on 
network devices such as routers, star hubs, 
and network modems. Be sure no one is . 
using the device before you cycle the 
power. Turn the device off, leave it off fori 
30 seconds, and then turn it back on. If 1 

the problem goes away, it's possible that 1 

the device or its software got "hung"- the 
device received an instruction it couldn't 
process or ignore. Restarting the device · 
clears that instruction and starts the 
device from scratch. 



If it is an individual Mac having the net­
working problem, use the Chooser to 
turn Apple Talk off and then back on 
again or, more drastically, restart the 
computer. If you have more than one net­
work driver, try switching to a different 
one. For example, if you're connected 
simultaneously to Ethernet and 
Local Talk, you can momentarily choose 
the alternative network with the 
Network cdev and then switch back to 
your regular network choice. This forces 
your Mac to join the first network all 
over again and re-alert other devices of 
its presence. 

Turn off all your INITs. INIT conflicts 
are tricky and unpredictable, and few 
people understand why they cause prob­
lems. If the problem goes away after 
you've turned off the INITs and rebooted, 
then it probably is an INIT conflict of 
some kind. Turning the INITs back on 
one by one will help you discover which 
one is the culprit. 

Check for viruses on the file servers and 
on your Mac. Viruses don't usually cause 
network problems (although they can be 
transmitted over a network), but it's 
worth a try. 

Reload the software in network devices 
such as hubs, routers, gateways, and 
servers. Reenter the configuration infor­
mation, making sure it is exactly what 
you want and is compatible with the other 
devices in your internet. It's possible that 
a colleague changed the software or 
configuration tables without your knowl­
edge and misconfigured them, or perhaps 
you've misconfigured them yourself. 

Swap out the various devices, cables, 
connectors, and network cards on your 

machine and across the network. Do this 
one component at a time, and see if any­
thing changes. Usually if cables or con­
nectors are bad, they will be bad right 
out of the box, but sometimes they go 
bad while in service. Maybe a forklift ran 
over your network wires, lightning 
struck the building, or something wig­
gled loose. 

If you use Ethernet or Token Ring 
configuration, reinstall your network soft­
ware. If you have an older Mac, you may 
need to patch its ROM by running a newer 
version of Apple Talk or you may need to 
put the ADSP (Apple Talk Data Stream 
Protocol) patch file into your System 
Folder (ADSP is built into System 7). 

Remove your password from the server, 
or reconfigure your user information 
with the administrator software that 
comes with your server. Maybe you typed 
the password incorrectly. Also, pass­
words are usually case-sensitive, so be 
sure you're not typing in your password 
with the Caps Lock key down. 

Try adding more RAM to your machine 
(or the server) or using the Finder instead 
ofMultiFinder. Use CE Software's 
HeapFixer to increase the size of your 
system's heap space. Do the same for the 
server if necessary. If your central work­
station is running more than one net­
work service (such as file-server, mail­
server, and print-spooler software), try 
placing the services on different 
machines or disabling one of them 
temporarily. 

Try reading the manual, even if you've 
read it before. It's weird, but sometimes 
while you're having a problem, you open 
the manual and see an obscure passage 
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you've never noticed before or didn't 
understand. 

NETWORK PRINTING 
Printing Large Documents 
Off-hours 
A practice that strains network resources 
is printing huge documents during the 
day on shared printers. Sometimes this 
can't be helped, but when possible, try to 
do large printing jobs during off-hours. 

Sometimes investing in a large paper bin 
makes this more attractive, in that you 
don't have to contend with adding paper 
to the 200-page tray that comes with, for 
example, an Apple Laser Writer liNT. 
With a print spooler, you can specify 
when a job will get printed. The cheapest 
print spooler, Print Monitor, comes free as 
part of Mac system software, but it 
requires that you have enough memory to 
run MultiFinder. 

Using The Appleshare Print 
Spooler With A Router 
Those who use the ASPS (AppleShare 
Print Server), a network spooler, have 
probably figured out that although ASPS 
has a lot of benefits, one of the drawbacks 
is that all print traffic goes through the 
network twice- once to get from your 
Mac to the spooler and again to get from 
the spooler to the Laser Writer. 

You might try putting your printers onto a 
different network, which involves running 
ASPS concurrently with a software router 
such as Apple's Internet Router or 
Farallon's Liaison. 
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NSCATELNET 
Version 2.4 For Unix Host 
Communication 
The National Center for Super-comput­
ing Applications produces some excellent 
free Mac utilities. One of them, NCSA 
Telnet, has become popular with Mac 
users communicating with Unix hosts. 

Version 2.4 ofNCSA Telnet has a prob­
lem with System 7.0 that can mess up 
the display of Option-key characters in 
fonts. The fonts themselves aren't affect­
ed, but they don't look right on screen. 
The bad-font effects linger even after you 
quit the application. 

According to Apple's engineering net- I 
k 

. I 
wor services, you can get around the 
bug by typing Shift-Command-zero 
when you first start the program. 
Option-key characters should display 
correctly after that. 

QUICKMAIL 
Backing Up Carefully 
Your electronic-mail server deserves to be 
included as part of your normal backup 
procedure. CE Software Inc., however, 
warns that you should never backup a 
QuickMail server while the QM Server 
Startup document (INIT) is running. 

While the server INIT is operating, 
QuickMail is opening and closing mes­
sage and index files constantly. Any files 
that are open when the server is being 
backed up will be skipped. The company 
recommends shutting down the E-mail 
server before backing it up. j 

I 



An Easy Way To Force Names To 
The Top Of The List 
Tired of scrolling through a long directory 
every time you want to send a message to 
the person at the bottom of the list? An 
easy way to force names to the top of the 
list is to use QuickMail's Group com­
mand to create a group for the person (yes, 
a group can have just one member). 
Groups always appear at the top of the 
directory list. 

Checking To See IfYour Message 
Has Been Read 

Want to know if someone read your mes­
sage but don't want to be interrupted by a 
return receipt? Select Preferences from the 
QuickMail menu and click on Log 
Handling. You can then enable your Mail 
Log. A Log entry shows who has read each 
message and when. 

Un-Sending A Message 
Tired of sending the standard retraction 
"Ignore that last message- I forgot to ... "? 
You can un-send a message that hasn't yet 
been read by using the Mail Log (but only 
if you have it enabled). 

Speeding Things Up 
Is QuickMail more like Snail Mail for 
you? Here's how you can speed things up: 
In the Preferences dialog box, un-check 
"Fill folders when opening" and disable 
your Mail Log (yes, we know that the last 
two tips told you to use the Mail Log, but 
there we were talking about features, and 
here we're talking about speed). Select and 
file new messages before reading them; 
this moves them from the server to your 
own hard disk, speeding up access. 

Reading A Message Without 
logging In 

Want to read a message you've filed on your 
hard disk but don't want to log in to a Mail 
Center? Use QM Remote. It can open text 
files as well as QuickMailletters you've filed. 

Bug Crops Up With Ethernet And 
AnSEServer 
For sites with a lot of E-mail traffic, a mail 
server on Ethernet is often a good solu­
tion. But CE Software's popular 
QuickMail has a bug that makes it crash 
sporadically when handling large 
amounts of mail on a Mac SE or SE/30 on 
Ethernet. Moving the server to a Mac 11-
class machine solves the problem, accord­
ing to the company. 

Sending A Timed Message To 
Yourself 
Wish you could attach messages to 
Apple's Alarm Clock DA? Use QuickMail 
to address a message to yourself and press 
the Delay button to postpone sending it 
until a specified date and time. 

THE RESPONDER 
Bullt Into System 7 
The Responder functionality is built into 
System 7, and installing System 7 removes 
the Responder extension from a System 
6 system. 

SERVER VOWME 
Maximum Single-volume Size Is 
2Gbytes 
If you are setting up a server, you may be 
wondering how large a single volume can 
be on a Macintosh. 
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The Mac's file system defines a 32-bit 
space to represent the number of bytes in 
any volume. Only 31 bits are used, how­
ever. With that many bits you can speci­
fy 2,147,483,648 bytes- 2 Gbytes­
which is therefore the maximum size of a 
volume. 

SMARTCOM II 
Capture Routine Saves Only 
Selected Text 
If you capture data to disk after receiving 
a transmission, highlight the text you 
want to save. The Capture routine saves 
only selected text, so if you save a file with 
nothing selected, nothing is what you'll 
end up with. 

Saving Text From The Capture 
Buffer 
If you accidentally Close your document 
without having saved the contents of the 
capture buffer, don't panic-yet. Try 
reopening a communications document. If 
you dido 't use the Clear command from 
the Edit menu to purge the buffer before 
you closed the transmitted document, the 
text is still in the capture buffer, and it will 
appear in the document window. This 
won't work if you accidentally Quit 
Smartcom, though. 

Save And Save As .•• Don't Save 
What's In The Capture Buffer 
The Save and Save As ... commands only 
save the settings, not the data in the cap­
ture buffer. 

Put Your Work Files At Root Level 
On Disk 
Some earlier versions ofSmarccom (2.1a, 
for example) can't recognize documents 
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or applications that are in folders on an 
HFSsystem. 

Remember to puc your work files on the 
root level before scarring and you 
shouldn't have any problems. (Version 
2.2b corrects the folder problems.) 

Forcing Smartcom To Use Text 
Protocol 
Ins read of Sending a file, Paste it from the 
Clipboard. This makes Smartcom use a 
text protocol, even ifMacBinary or Hayes 
Verification protocol has been indicated. 

DATABASES 

4TH DIMENSION 
Shortcut To Call Up A Layout 
When you're programming procedures 
in 4th Dimension, it's sometimes useful 
to call up a layout you've referenced in a 
procedure. Here's a shortcut that bypasses 
going through menus. 

While you're in the procedure editor, drag 
co highlight the filename and the layout 
name mentioned in a procedure. Then 
press Command-L. 4D will automatically 
open the highlighted layout. 

Formatting Numbers 
4th Dimension offers no quick, docu­
mented way co control the format of 
times, dares, or numbers in the 
QuickReporc editor. You have to resort 
to formulas, which is more than many 
users are prepared to do. It is possible to 
format these items automatically, howev­
er. To format a rime or date, you need 
only type che number of the format you 



desire into the detail area of the column 
in question. The different formats and 
their numbers are described on page 332 
of the Language Reference and in the 
addendum to version 2.0.10. 

Formatting a number is even more 
straightforward: Type the desired format 
in the detail section just as you would in 
the Design environment. For example, if 
you want to format an integer as a dollar 
amount, type $#,###.00 into the correct 
column. 

4th Dimension also lets you type format­
ting numbers into the dialog box that 
pops up when you click on OK in the File 
menu's Page Setup box. 

Getting From Runtime To User 
Mode 
To immediately go from the Runtime 
opening screen to User modes, hold 
down the Option key and press F. This 
works even when no Quit menu item 
is installed. 

Getting To The Debugger 
Window 

Normally, to get into 4th Dimesion's 
Debugger window, you have to put the 
Trace command into a script or procedure, 
where it can be evaluated. Here's a shortcut: 
hold down the Option key and the mouse 
button while a procedure or script is run­
ning. Using this method, you don't have to 
put the Trace command into any code. 

Outlining An Object Or Group 
When you are using the Layout Editor, it's 
possible to create an outline around any 
object or group of objects. Select the 
object, and then hold down the Command 

key and press any number from 1 though 
9. Command-1 places the border one pixel 
out from the object; Command-9 places 
the border nine pixels out from the object. 

Using The Arrow Keys To Move 
Objects 
It's possible to move objects in a layout 
(when you're using the Layout Editor) by 
pressing the arrow keys. If you hold down 
the Command key while pressing the 
arrow keys, the upper left corner of the 
object will be anchored to the layout and 
the object will be resized according to the 
direction of the arrow key you're using. 
Holding down the Option key and then 
using the arrow causes the objects to 
move along the x or y axis defined on the 
grid (the default is ten pixels). 

Bringing Up The Coordinates 
Box 
Holding down the Control key and then 
double-clicking on an object while using 
the Layout Editor displays that object's 
Coordinates dialog box. 

Seeing Scripts 
A quick way to view scripts is to Option­
click on an object that has a script. This 
immediately opens the script. 

FILE MAKER 
Entering Multi-Word Phrases As 
Search Identifiers 
Use Option-Space instead of the space bar 
when you're entering multiple-word 
phrases to be used as search identifiers. 
That indexes both words as one, allowing 
searches by combinations or portions of 
all the words. 
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Entering Copies Of A Record 
To enter a lot of copies of a record using 
the Command-M key combination, it 
helps to execute a Find on the first record 
entered. Thereafter, the number under 
Found will increase by 1 each time you 
press Command-M. This allows you to 
keep track of how many records have 
been entered. 

Selecting Records Without A 
Common Field 
Have you ever wanted to select a group of 
records in FileMaker II that have no field 
in common (for example, the 23 people 
who lost last month's report)? Create a 
special "select" box on your layout- a 
field in a box to make it easy to find. 

To use the select box, issue the Find com­
mand to locate each individual record, 
and then enter X in the select box. Use the 
Find All command and then the Find 
command to locate the checked boxes. 
The whole group is selected, and you can 
mail-merge or sort the results. You can 
sort records into several groups by enter­
ing different characters into the select box 
and then using the Find command to 
select each subgroup. 

To deselect the records, highlight the 
select field, press Delete, and then press 
Command-= to clear all the boxes. 

FILEMAKER II 
Upgrading FlleMaker ll Flles To 
FlleMaker Pro 

Don't upgrade your FileMaker II files 
simply by opening them in FileMaker 
Pro. Apparently a bug in FileMaker II 
creates a structural problem in its files. 
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The bug was fixed in FileMaker Pro, but 
the problem might still be present in 
your old FileMaker data files and could 
cause serious problems if you convert 
them to FileMaker Pro by opening them 
directly from that program. 

The work-around is simple, but Claris 
didn't include it in the FileMaker Pro 
documentation. Save a compressed copy I 

of your FileMaker II files by using the 
Save a Copy command. Then open these 
compressed copies in FileMaker Pro. 

If converted files exhibit any strange 
behavior- trouble with sorting, for exam­
ple- use FileMaker Pro's Recover com­
mand to attempt to correct the problem. 

If problems still exist- which should 
rarely happen- return to your original 

1 

FileMaker II file and export all its records 
to a tab-delimited file. Save an empty 
copy of your FileMaker II database, using 
xhe Save a Copy command. Open the 
empty copy in FileMaker Pro, and then 
import the data from the tab-delimited 
file. When using this method, make sure 
that all fields are lined up correctly in 
FileMaker Pro's "Specify field order for 
import" dialog box. 

If you've already converted your FileMaker 
II files and haven't experienced any prob­
lems using them in FileMaker Pro, there's 
no need to go back and reconvert. You'll 
know immediately if you're going to have 
any problems caused by the old FileMaker 
II bug- they don't appear gradually. 

FILEMAKER PRO 
Missing Fields When Exporting 

1 

Sometimes when using FileMaker Pro's l 
Export menu, not all of the fields are avail 

! 



able to be exported. This problem is most 
likely to happen in data files that have 
been converted from FileMaker II to Pro. 

The work-around for this is simple: Hold 
down the Option key while clicking on 
the New button in the Export dialog box. 
The Choose Fields dialog box, which 
appears next, displays all the fields. Simply 
select the fields you want to export. 

Exporting To Spreadsheets 
Export tab-delimited files instead of 
SYLK files if you need to use your data in 
a spreadsheet. 

FileMaker Pro exports numeric and cal­
culation fields into SYLK files as text, not 
as numbers, making it impossible to per­
form mathematical calculations with this 
data after you've imported it into a 
spreadsheet. These fields are treated as 
numbers in tab-delimited files, though, 
and virtually all spreadsheet programs 
can import tab-delimited files accurately. 

Adding Predefined Usts 
You can use the following technique to 
add any sort of predefined list to your 
FileMaker Pro database. As an example, 
say you wanted to create a predefined list 
of state abbreviations associated with a 
State field: 

1. Choose Define Fields from the Select 
menu. Select the state field (or whatever 
field you want to add a predefined list to) 
in the dialog box, click on Options, and 
select "Use a predefined value list:" 

2. In the Display Values dialog box, type 
each field's name, followed by a Return, 
the two-letter abbreviation, and finally 
another Return. 

3. Switch to the Layout mode (on the 
Select menu), and select the State field. 

4. Choose Field Format from the Format 
menu. In the dialog box that follows, 
select the "Use field's value list to display 
fields as" check box and choose "pop-up 
list." Go to the Select menu, and switch to 
Browse mode. 

Now whenever you select the State field to 
input information, a pop-up list with all 
the states' names and abbreviations will 
open. Just starr typing the first few letters 
of the state name, and the pop-up box will 
automatically scroll to that state. Then 
use the mouse or down-arrow key to select 
the two-letter abbreviation following the 
state name, and press Return to insert it 
into the field. 

Printing Commas Between Fields 
If you use FileMaker Pro and PageMaker 
or another layout program together for 
database publishing, you may benefit 
from this tip. 

To line up a comma in a label layout after 
the city field so that it prints correctly 
after the fields slide together (to eliminate 
spaces between the city name and 
comma), create a calculated field: 
CITY comma = CITY & ", ". Then use the 
CITY comma field in the label layout 
instead of CITY. 

Concatenate Fields To Ensure 
Proper "Slide Left" and "Slide Up" 
Operation 
The easiest way to force horizontally 
arranged fields to slide in layouts is to use 
the Arrange menu's Slide Objects com­
mand, which is available in the Layout 
view only. This method sometimes proves 
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unreliable, so you may want to force your 
fields to slide by using concatenation. 

Concatenation requires creating a new 
field for each record in your database and 
instructing FileMaker Pro to add the 
information from several other fields to 
this new field. 

To create the name line on an address 
label, for example, create a new field called 
Nameline and define it by using the fol­
lowing formula: Salutation & " " & 

FirstName & " " & LastName (substitute 
your own field names for Salutation, 
FirstName, and LastName). Then place 
the NameLine field instead of the 
Salutation, FirstName, and LastName 
fields in your address-label layouts 

You can use this same trick to ensure that 
objects slide up: use a carriage return and 
the If statement to define multiple lines in 
a single field. 

Perform The Find Command In 
One Layout And View Data In 
Another 
Often you will want to view a subset of 
your records in a layout that doesn't 
include the fields that define the subset. 
You may, for example, want to print mail­
ing labels for all clients who have pur­
chased more than $5,000 in goods during 
the past year. Because the field containing 
your clients' year-to-date purchases is not 
on the mailing-label layout, you should 
execute the Find command in a generic 
layout and then switch to your mailing­
labellayout before you print. 

This procedure can't be automated with a 
single script-FileMaker Pro will fail to exe­
cute the Find command, because it requires 
a field not present in the final layout. 
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Therefore, you must create three scripts: 
one that selects the layout containing the 
necessary field and then performs the 
find, one that specifies your mailing­
label layout and the required printing 
options, and a third that runs the first 
script and then runs the second script b~ 
using the "Perform a chain of scripts" 1 

option. Do not include the first or seconCI 
scripts in the menu or assign keyboard 
shortcuts to them. 

Take Advantage Of The Replace 
Command 

Many people don't understand the Replace 
command and perform unnecessary data 
entry as a result. The Replace command 
lets you enter data into a single field in the 
current record and have that data copied j 

into all other currently selected records. 

Suppose, for example, that you're renew­
ing your state licenses for all the haz­
ardous chemicals that have been stored in 
your warehouse under expired permits. 
After identifying all such materials by 
using the Find command, printing the 
required reports, and completing the nec­
essary licensing forms, you can reset all 
license-expiration dates (assuming they're 
all the same) by entering the correct value 
into the license-expiration-date field of 
one record and using the Replace com­
mand to apply that date to the other cur­
rently selected records. Be certain that 
you've selected the correct subset of 
records before confirming the replacement 
-you can't undo the Replace command. 

Use Page Setup To Adjust The 
Layout Marker 
In the Layout view, FileMaker Pro displa~ 
striped lines that represent page borders.] 
These borders' calculations are based on 



the current settings in the Page Setup dia­
log box, so be sure to configure your pages 
horizontally or vertically and to specify any 
printing reductions or enlargements 
before finalizing your layout. 

Using reduction is a good way to gain some 
extra room to fit all required data onto a 
layout. If you use this technique, create a 
script that switches to the layout and uses 
the "Restore the Page Setup options" 
option so that your reduction is applied 
every time you use the layout. 

Hold Down The Option Key To 
Customize The Position Of Part 
Boundaries 
When you're defining layouts, the gray 
lines that define part borders (such as 
headers and footers) cannot normally be 
moved past any fields, text, or graphics. If 
you hold down the Option key while 
you're repositioning the part border, how­
ever, you can move the border freely. 

Give FlleMaker Pro Sufficient 
Memory 

When FileMaker Pro runs short of memo­
ry, the "Out of memory" error message 
usually appears. In some cases, there's not 
even enough memory left to display this 
dialog box, so you may notice that key­
board equivalents or menu commands 
suddenly seem to have no effect. 

To correct this problem, increase the 
amount of memory allocated to 
FileMaker Pro. The 1 ,024K of RAM that 
FileMaker Pro normally requests is insuf­
ficient in many cases, especially if you're 
working with large databases. To change 
the memory allocation, highlight the 
FileMaker application icon, open the Get 
Info dialog box (under File menu in the 
Finder) and change the "Application 

Memory Size" option. Provide 1 ,500K as 
a minimum- more if you have enough 
memory available and work with very 
large databases. 

Avoid Printing Duplicates 
To create a layout that includes only one 
occurrence of any duplicate record, define 
a layout using the "Subsummary when 
sorted by" option in the Define Parts dia­
log box. 

When scrolling through the field list to 
select the field that will determine 
duplication, be sure to select a field that 
will be unique for all non-duplicate 
records. Remove the body part in your 
layout, and position all required fields 
within the subsummary part. Sort the 
database by the field you've selected to 
determine duplication, and choose the 
"Preview" option from the Select menu. 
The resulting duplicate-free database is 
then displayed. Choose the Print com­
mand to print this data. 

Use A Subsummary Part To 
Create Running Page Totals 
To create a running page total for any 
report, define a "Subsummary when sort­
ed by" and place summary field types, 
that have the "Running total" option, 
into this part. To force this subsummary 
to appear at the bottom of every page, 
determine the number of records that will 
fit on one page by doing a preview of your 
report and then select the "Page break 
after every X occurrences" option and 
enter this value. 

This method works best if no "slide up" 
options are used in the report body. If 
records in your report are of variable 
length, you must choose the minimum 
number of records that naturally fit on 
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a single page and use that value in the 
"Page break after every X occurrences, 
option. 

Replace One Field With Another 
In Layouts Without Deleting 
If you accidentally place an incorrect field 
in your layout or just decide that your 
needs have changed, hold down the 
Option and Command keys and double­
click on the field you want to replace. This 
allows you to select another field to 
replace the one you selected previously. 

Fitting Templates For Any 
Monitor 
If you create FileMaker Pro templates on a 
Mac with a large monitor, it can be hard to 
know whether your layout will fit on a 
smaller monitor, such as the Classic's 9-
inch screen. You can create a page guide 
for small screens by choosing Help from 
the Apple menu. This brings up a win­
dow exactly the size of a small Mac screen. 
Simply size your layout window so that it's 
the same as the Help window, and your 
layout will fit fine on a small-screen Mac. 

Producing Columnar Reports 
With Repeating Fields 
Repeating fields do not slide up properly 
in columnar-report layouts. If you have an 
existing columnar-report layout contain­
ing repeating fields, copy all its elements 
and paste them into a new blank-format 
layout. 

Another way to improve the sliding of 
repeating fields is to choose Field Borders 
from the Format menu, check the 
Between Repeating Values box, and make 
sure all border options are set to None. 
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Putting A Better Font Forward In 
FlleMaker Pro 
The default font in Claris Corp.'s 
FileMaker Pro is Helvetica. Here are 
some steps to follow if you would like to 
start a database out in a different face: 

Create a new database. When the field- : 
definition dialog box appears, hit the I 
Done button. An empty database layout • 
appears; switch to Layout mode and 
choose a new font, size and style (and your 
preferred colors, if you like). Choose 
Define Fields from the Select menu and go 
on creating your database fields. When 
you're done, the fields shown will be dis-
played in your choice of type. . 

I 

Time Flles With FlleMaker On Big 
Networks I 

I 

Timeouts- when one Apple Talk node 
gives up trying to communicate with 
another- normally indicate bad connec­
tions. But sometimes big networks work 
slower than applications expect, and pre­
mature timeouts result. If you've got a 
large network, you may run into this 
problem when trying to use the internal 
database-sharing capabilities of Claris 
Corp.'s FileMaker Pro. 

To lengthen the amount of time before 
the network times out when communi­
cating with a FileMaker database, hold 
down the Option key when clicking the 
Network button in the Open dialog box' 
or when switching between zones in the 
resulting dialog box. This trick is useful i 

only on slow networks, so you should 
expect correspondingly sluggish response 
from the database. 



DOUBLEHEUX 
Running Two Collections 
Simultaneously 
When using Double Helix, you may want 
to look at two collections (the Double 
Helix word for databases) simultaneously. 
Double Helix can open only one collec­
tion at a time. 

Although Odesta has copy-protected the 
program so that copies with the same seri­
al number cannot run on a network at the 
same time, you can run duplicate copies of 
Double Helix on one computer under 
MultiFinder with no problems. 

Just copy the program by using the 
Duplicate command on the Findees File 
Menu to make as many copies of Double 
Helix as you need. You can then open the 
copies under MultiFinder. Of course, you 
need generous amounts of RAM to make 
this work. 

Advance Planning Helps 
To use one of Helix's abacus icons to per­
form complicated calculations, it's best to 
plan your function before building it in 
on the Mac. If possible, break the calcula­
tion into modules, then combine them in 
the final calculation. This also means you 
can use the modules in other calculations 
without having to start over from scratch. 

If you can't break a complex calculation 
into modules, plan it on paper first, then 
construct it on the Mac. A quick flowchart 
now can save hours of confusion later. 

Viewing Entire Complex 
Calculations 

Seeing the entirety of complex calcula­
tions can be difficult, since you have to 

view portions of it by scrolling the win­
dow. View the whole calculation by 
printing it out on the Image Writer by 
selecting Print Scaled Image from the 
File menu. This doesn't work on the 
Laser Writer. 

Avoiding Icon Confusion 
Complicated Relations clutter your work 
with a lot of icons. To keep from getting 
confused, name your most important and 
frequently-used icons in all uppercase let­
ters to make them stand out. Then, move 
lesser-used icons off to the side of the win­
dow and arrange your icons in logical 
groups for easier tracking. 

Save Time: Copy Old 
Calculations, Then Modify Them 
To create a calculation with an abacus icon 
that differs slightly from another one 
that's already created, duplicate the origi­
nal calculation's icon and then modify the 
copy to create the new calculation. 

Save Time Whlle Setting Up A 
New Relation 
When setting up a Relation for the first 
time, several fields will probably have for­
mats different from the default settings. 
Save time by creating one field with each of 
the formats you plan to use, then replicate 
them as often as you'll need (one for each 
format) and name them appropriately. 

Moving A Single Tlle 
To move only one tile, click and drag any­
where on the tile except in an arrow or a 
blank space. 

Moving Groups Of Segments Or 
Tlles 
To move a group of arrow segments and/or 
tiles, use Shift-Click to select the individu-
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al elements to be moved, or surround the 
group with the selection reaangle. 

PANORAMA 
Creating More Than 256 Fields 
There are two ways to create a database 
with more than 256 fields in Panorama. 

You can put cells onto a form by using 
Auto Cell Layout from the Arrange menu. 
That dialog box uses the Apple List 
Manager and is good for about 500 items. 
The scrolling window updates much faster 
than the pop-up menu, and you can select 
one or more of the cells you want. 

Or you can create an auxiliary database 
chat duplicates cells beyond the 256-field 
"limit." The first item in the auxiliary 
database is the first item beyond the main 
database's pop-up menu (in ocher words, 
item number 257). You can chen simply 
copy and paste these cells from the auxil­
iary database co the main database. 

Both of these methods will g ive you cells 
beyond the the 256-field limit before the 
pop-up menu with 256 items can even 
draw itself. 

REFLEX PLUS 
Sorting Concatenated Fields 
One of the more annoying things about 
using Reflex Plus is having to take several 
extra steps when sorting on a field that 
hasn't been expressly included in a report. 
For instance, to make a neater label, you 
might concatenate a last-name and a first­
name field [First_ Name &"" & Last _ 
Name]. As long as you're in the report, 
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however, you won't be able to sort by the 
last name. 

The simplest solution is to create a last­
name field and hide ic. You make room for 
it by making it a tiny size (such as 6-point 
Helvetica), shortening it as much as possi­
ble, and tucking it in some uncluttered 
corner of the report window (keeping it in 
its proper repeating collection if neces­
sary). Make the last name field invisible 
by adding a carriage return with the 
CHAR function to its formula 
[CHAR(13)&Last_Name] so che field 
will show a blank spot and yet still sort 
correctly. 

This method also works well if you want 
to search by zip code when you've lost it in 
a field formula such as: 

[City&""&State&""&""Zip]. 

DESKTOP PUBLISHING 

ADOBE TYPEALIGN 
Highlighting Text Strings 
When you're using TypeAlign, the text­
distortion DA from Adobe, you can high­
light an entire text string without drag­
ging from left to rig ht. J usc insert your I­
beam tool anywhere in the text, and 
press the Tab key. It's easier than drag­
selecting, which can be difficult with 
curved text, and it's not mentioned in 
the manual. 

Undocumented Type Manager 
Tip 
H ere's a tip about Adobe Type Manager 
(ATM) that's not mentioned in the prod­
uct manual: If you have little need for 



math and Greek characters, you might be 
tempted to save disk space by not 
installing the Symbol font. But when you 
try to print one of the 18 characters that 
are also included in the other three fonts, 
you'll find that they print with a bad case 
of the jaggies. 

It turns out these characters are represent­
ed in the Helvetica, Times, and Courier 
PostScript files only by references to their 
locations in the Symbol font. Without 
Symbol available, your Macintosh has no 
choice but to print the bit-maps instead. 
If you want decent output for any of these 
characters, you must install the Symbol 
font- both the outline fonts and the 
bitmapped font. 

ADOBE TYPE 
MANAGER2.0 
Installing ATM Under System 7.0 
A problem with ATM is that it fails to 
work if its files are placed in sub folders 
within the System folder. You must move 
ATM files directly into the top level of 
the open System folder. If the System 
folder is closed when you drag files into 
it, the Finder will automatically place 
files into subfolders, and ATM will not be 
able to find them. 

You do need some way to access the ATM 
control panel so the ATM file is an excep­
tion to the top-level rule; it needs to go in 
the Control Panels subfolder. A neater 
alternative is to leave it at the top level of 
the System folder and create an alias for it 
in the Control Panels subfolder. 

mimioate TrueType Fonts 
If you are using ATM, you may want to 

eliminate any True Type versions of your 
PostScript outline fonts- typically, 
Helvetica, Times, Courier and Symbol. 

To remove True Type fonts, double-click 
on the System file while running Finder 7 
and locate the icons that show three Ns­
these are True Type fonts. (Bitmapped 
fonts show only a single A in the icon and 
include a point size in their names.) If you 
have a PostScript outline font and at least 
one bitmapped font, you can drag the 
equivalent True Type icon out of the 
System file and throw it into the Trash. 

It is not a good idea to keep both 
TrueType and PostScript fonts for the 
same typeface, since the relationships 
among bitmapped, PostScript and 
True Type fonts are complicated (and con­
fusing) in this configuration. 

ATM gives non-PostScript printers such 
as the Image Writer and Laser Writer IISC 
the ability to print Adobe's PostScript 
fonts. The package includes the 
PostScript outline fonts for the four 
"basic, fonts as well as the corresponding 
bitmapped fonts: Helvetica, Times, 
Courier, and Symbol. 

Storing Fonts Outside The System 
Folder 
You don't have to store the outline fonts in 
the System Folder. 

A shareware DA called SetPaths 
(or other utilities which set a path) lets 
you access outline fonts (printer fonts) 
from a single drive on a network or anoth­
er folder on a local drive, and open the 
SetPaths DA to make the necessary path 
for ATM to work. 

Another alternative is using Suitcase II. 
You can place all your font suitcases and 
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complimentary PostScript outline ver­
sions in folders outside the System folder. 
All you need to do is have one suitcase 
among all the font outline documents 
open all the time, so that Suitcase can find 
the outline versions of the fonts. For 
example, you can have a folder of screen 
fonts and printer fonts, place the screen 
font suitcase of Symbol among the out­
line documents (in the printer fonts fold­
er) and always have Symbol open. 

The Font Cache 
If ATM seems to be slowing down opera­
tions such as popping into Word's page 
preview or zooming in a graphics pro­
gram, you probably need to give it more 
working space. When ATM creates 
screen fonts, it temporarily stores the 
characters in a reserved area of RAM 
called the Font Cache. When the cache 
overflows, the currently undisplayed 
characters are deleted and replaced by 
newly built ones. When you scroll to a 
part of your document that contains 
deleted cached fonts, ATM patiently 
rebuilds them. This purge/rebuild cycle 
always takes noticeable time, and you 
will blame ATM for slowing you down. 

To give your system back its old zip, use 
the Control Panel DA to access the ATM 

DESIGNSTUDIO 
Adjusting Type Using Style Sheets 
In DesignStudio you can tighten all the 
boldface type in a document simultane­
ously or make virtually any kind of 
adjustment to any kind of type style by 
using style sheets in conjunction with the 
program's search-and-replace function. 

For example, here's how to tighten all the 
boldface type in a document: 

1. Create a style sheet with tracking and 
other attributes set to whatever you want. 

2. Call up the Replace dialog box, and 
click on Use Format in the Find section.

1

, 

You then get another dialog box that lets 
you set boldface. 

3. In the Replace section, click on 
Stylesheet and scroll to the style sheet 
you've just created. 

4. Click on Document in the Limit 
Search To box, and then click on Start 
Search. All the boldface type in the doc­
ument instantly tightens to the degree 
that you've specified. If you want to fur­
ther adjust the boldface, simply make 
the change in the style sheet. 

cdev and then set the Font Cache to 256K Examining A Portion Of Text 
or more-sometimes far more. A large 
enough cache will pay off in zero waiting 
time whenever you scroll or zoom. You 
should pump up the cache appropriately 
whenever you use large sizes or many dif­
ferent sizes or if you routinely zoom to 
several levels. Keep in mind that the first 
time you zoom or use a new font/size/ 
style, ATM will need extra time to build 
the properly-sized screen font. 
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If you need to check a small portion of 
text in DesignStudio but it is too small to 
read on the screen, select the text (up to 
20 characters) with the 1-beam tool and : 
pull down the Text menu at the far right: 
of the menu bar. The Find Selection com­
mand displays your selected text on the 
menu so you can read it. You save time 1 

doing it this way rather than changing 
the page magnification, which redraws 
the entire page. 



Creating An Anchored Rule 

Those who use DesignStudio (and Ready, 
Set, Go) can get anchored rules by using 
this tip (PageMaker has a special com­
mand for this). Although this method 
works best with rules wider than 2 points, 
you should be able to obtain nearly any 
point size with a little experimentation. 

When you're ready to place a rule in your 
text block, select ZapfDingbats from the 
Font menu and type a lowercase n, the 
filled-box character. 

Highlight the character, set i_ts track 
value to .25 or .5 by using the 
Horizontal Spacing command on the 
DesignStudio Format menu, and set its 
point size to the rule width you need. 
Place the cursor after this dingbat, and 
type as many as you need. The rule will 
appear on-screen as a thick gray line. 

Producing a long rule in small point­
sizes can be tiresome, so after you've cre­
ated a portion of the rule, select it, copy 
it, place the cursor after the last dingbat, 
and paste until you've filled the column. 
You can delete the excess. The result now 
functions as an anchored rule that Bows 
with the text. This "rule" prints as a solid 
image at both 300 dpi and 2,540 dpi. 

One final point- you may need to exper­
iment to get the point size of this kind of 
rule to match a tool-drawn rule exactly. 
For example, to obtain a 1-point rule, 
you have to set the point size of the ding­
bats to 1.35. 

FAX MODEMS 
Don't Do Photos Without Gray­
Scale Ability 
Unless your fax modem has gray-scale 
capabilities, photographs and screened 
artwork are lost causes. Gray tones in the 
original image are converted to stark 
black-and-white blocks for transmission, 
often obscuring the contents. A conven­
tional fax machine with gray-scale and 
contrast controls does a much better job of 
handling such images. 

PostScript graphics usually look better 
if they are printed on a laser printer and 
then scanned into a fax machine. None 
of the Mac fax modems currently 
include a PostScript interpreter, which 
would bring the language's device- and 
resolution-independence to faxing. 
Because fax-modem software isn't able to 
interpret PostScript code, it sends a low­
resolution (PICT) screen image instead. 
(If an EPS file doesn't include an embed­
ded PICT, the image will be replaced by a 
rectangular placeholder.) 

Sending PostScript Wustrations 

If you have to send PostScript illustrations 
from a fax modem, create the mat roughly 
three times the desired finished size and 
then export and reduce them in a layout 
program before faxing. This process 
enhances the apparent resolution of the 
embedded PICT image, minimizing the 
jaggies you normally get when faxing the 
PICT portion of a PostScript object. 

Reverse Type To Emphasize 

For special emphasis, try reversing white 
type out of a black background. A sans serif 
typeface set in 18-point bold works well. 
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Graphic Mistakes 
If you're using a conventional fax 
machine, avoid layouts with long straight 
lines, small type sizes, and intricate art­

work. Misfeeds and phone-line noise cause 
unsightly broken lines, and the scanning 
process can thicken lines and darken type, 
causing text to become unreadable and 
turning artwork into a blotchy mess. 

No Letterhead 
Don't use your printed letterhead for fax 
documents. Many things that are effective 
in print- embossing, foil or other metal­
lic type, screened or pale type, very small 
type- can't be communicated effectively 
by fax. Instead, use a special fax letterhead 
with a related design. 

Truncated Type 
Keep type and images away from 
the margins so that they aren't truncated 
by the faxing process. Margins of three­
quarters of an inch all around seem safe. 

ATM Type For Fax Modems 
The best way to image type for a fax 
modem is through Adobe Type Manager. 
ATM uses the power of PostScript to cre­
ate crisp text on-screen at any size, and 
the fax modem transmits that scaled type 
directly. If you don't use ATM, the only 
way to avoid jagged-looking type is to 
install bitmapped screen fonts that are 
three times the size of those in your doc­
ument. The fax modem software uses the 
oversized fonts to scale the type correctly 
for transmission, but this option can be 
limiting. 

Choosing A Typeface 
Faxed text has a dot pattern that's visible 
to the naked eye. Typefaces and styles 
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that work well for laser-printed corre­
spondence may be too small and light 
for faxing -you may find that increasing 
the type size from 10 points to 12 or 13 
points helps readability. 

A couple of years ago, Adobe tested the 
faxability of several typefaces and found 
that Lucida Roman, Lucida Sans, and 1 

Stone Sans worked best. Some other faces 
that work well are Bitstream Charter, , 
Adobe Utopia, and sans serif faces such as 
Frutiger, Helvetica, and Universe. Thes~ 
typefaces (and probably others that work 
well) share three characteristics: ' 

*The letters have relatively unvarying, 
moderately heavy line weights. 

*Openings within the characters (in the 
e and a, for example) are large. I 

* The letters are relatively plain. In gen­
eral, sans serif typefaces work better than 
serif ones. 

Almost any PostScript font works well. 
Although conventional fax machines 
tend to thicken lines, obliterating small 
text, fax modems tend to lighten them, 
which means that you can often use , 
smaller font sizes and typefaces that 
have smaller letter openings. 

FONTS 
Screen Font Alignment 
Most Macintosh screen fonts supplied by 
Apple and all Laser Writer fonts have con­
stant-width digits. It's been a standard in 
typography since the binh of financial 
printing. So if you're having trouble lin­
ing up columns of numbers, try the fol­
lowing suggestions. 



In spreadsheet programs such as Excel, 
use a cell format that has a constant num­
ber of places after the decimal and left­
align them. Using the General format in 
Excel with numbers that vary in precision 
is a sure way to have your columns wan­
der. Similarly, in word processors, use a 
right-aligned tab and keep a constant 
number of places after the decimal or use 
the decimal tab that many word proces­
sors include specifically for this purpose 
-it aligns a tabbed column on the deci­
mal point (or on the right if no decimal 
point is present). Both Mac Write and 
Word include decimal tabbing. 
Remember- use the Tab key, not spaces, 
before each number in the column. 

The presence of non-digit characters such 
as commas, parentheses, and dollar signs, 
may alter the alignment of digits in 
columns, but they shouldn't be a problem 
if you use them consistently. 

GENERAL 
Avoid Spaces During Text 
Transfer 
When transferring text from one docu­
ment to another- for example, from a 
word processor to a page-layout program­
be aware that space-bar spaces are related 
to the size and style of each individual 
font. If you line things up beautifully and 
then change the font or export your text to 
another program, the spaces can change 
unexpectedly. To ensure exportability of 
text, use tabs rather than multiple spaces. 

Resolution, Dpi And Lpi 
Resolution is the maximum number of 
dots that a device, such as an imagesetter 
or laser printer, can cram into a linear 

inch, and it is the key determination of 
image sharpness. Resolution is measured 
in dpi (dots per inch), which could more 
descriptively be called dpli (dots per linear 
inch). A 300-dpi laser printer is capable of 
printing 90,000 (300x300) dots per 
square inch. 

Lpi refers to the resolution you specify for 
printing a particular job on an offset press. 
The Lpi (lines per inch) is also called the 
line frequency or line screen. If your job 
contains screens or halftones, ask the per­
sonnel at your printer ahead of time what 
line frequency to use and then specify that 
figure when outputting the document to 
an imagesetter or laser printer. (There's no 
need to specify a frequency for work that 
has only solid type and line art.) The print­
er's recommendation for frequency will 
reflect pragmatic factors- the quality of 
paper and ink, the size and sophistication 
of the printing press, and your budget for 
the job. 

Generating Special Characters 
Use the Option key to generate special 
characters such as the tilde (-, Option-N), 
registered trademark ( ®, Option-R), and 
delta (d, Option-D). Use Key Caps under 
the Apple menu to view other special 
characters. 

Getting The Command-Key 
Symbol 

Many users are suprised that the 
Command-key symbol (also called the 
Apple key) isn't included in the Dingbats 
font- especially since Apple thoughtfully 
provides its logo in the other Laser Writer 
fonts. In fact, the Command-key symbol 
is hiding in the Chicago font in another 
nearly untypeable location: ASCII 17. 
Only owners of keyboards with Control 
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keys- which excludes you if you own a 
Mac Plus -can type this symbol easily; 
you can access the command key symbol 
by pressing Control-Q. 

Chicago isn't a PostScript font, so if you 
need high-quality output, try Chicago 
Symbols, a shareware PostScript font. 
(Send $10 to Bradley Poulson, Northwind 
Enterprises, 4003 Martin Lane, Two 
Rivers, WI 54241.) If you own Altsys's 
Fontographer, you can use the accompany­
ing DemoFont, which also contains the 
Command-key symbol. 

GRIDS 
What Is A Page Grid? 
A page grid is an underlying structure of 
nonprinting guidelines that helps anchor 
elements such as text, pictures, sidebars, 
and folios. The grid provides a frame­
work for the page design, and like the 
smooth layout of a highway system, it 
defines the best transportation routes for 
reading a page. 

Using White Space Effectively 
White space gives the reader's eye a rest 
but can be a distraction if misused. A grid 
must place text, graphics, and utility func­
tions consistently. 

Construct A Grid For Both Right­
And Left-Hand Master Pages 
You'll need to construct grids for right­
and left-hand pages and perhaps for 
spreads (depending on your page-layout 
program) as well. In QuarkXPress 3.0, for 
example, you need create only right and 
left master grids to produce a spread that 
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can be printed to film, because 
QuarkXPress lets you write a PostScript 
file to disk for two pages side by side. 
(Using two single pages in QuarkXPress 
is preferable to using facing pages, 
because it avoids having a single right­
hand page at the top of the Document 
Manager.) In PageMaker, however, you 
must create a spread grid as well as left 
and right grids if you want to print a 
spread to film. 

A Fixed Zero Point Is An Absolute 
Reference Point 
Construct the grid from a fixed zero point 
so that you always have an absolute refer­
ence point for positioning elements on the 
page. This is important if you're sending 
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documents to a high-end prepress system 
such as a Crosfield or a Scitex, which posi-, 
tions all page elements based on a fixed 
zero point. 

QuarkXPress 3.0 offers this sort of preci­
sion grid building. You can select a text or 
picture box and use the Modify dialog box 
to enter its x (origin across) andy (origin 
down) coordinates from the zero point. 
This establishes where the left and top sides 
of the object begin. Entering the width 
(second x coordinate) and height (second y 
coordinate) establishes the object's right 
and bottom sides. This method is more 
accurate than positioning elements by eye. 

Re-Creating An Existing Grid 
When you're electronically re-creating a 
grid for an existing publication, it's best to 
first create a test grid, using hairline rules, 
and output it to positive film. Lay it over 
your existing grid sheet to check for mis­
alignment. 



Keeping Grid Lines Visible In 
QuarkXPress 
If you work in QuarkXPress, use the 
Preferences dialog box to default all text and 
graphic frames in your grid to No Fill and 
No Wraparound. This keeps the grid lines 
visible when you posicion text and graphics. 

Matching Page-Layout And 
Prepress System Measurements 
Prepress systems use the metric system for 
determining the trimmed page size, so 
you too should use metrics to measure 
page size and to create trim and bleed 
coordinates. Inside the page margins, 
however, you can safely use points and 
picas to measure text and image areas. 

A note of caution: Many prepress systems 
use a measuring system of72.27 points 
per inch, whereas most page-layout pro­
grams count 72 points per inch. If this 
level of accuracy is important to you, talk 
to the staff at your prepress bureau about 
dealing with this discrepancy. It may be 
possible to make adjustments at the pre­
press end- by adjusting the leading in an 
Atex system to match the Macintosh grid, 
for example. 

Optimum Viewing Precision 
View the page at 400 percent to achieve the 
best precision when you're placing elements. 

Securing Page Elements 
Group and lock all page elements to 
ensure that they aren't accidentally moved 
out of position. (PageMaker only lets you 
lock guides.) 

Varying Columns For Easy 
Reading 
Varying the number of columns makes its 
easier for a reader to select important 

information on a page; uneven column 
widths are ideal for small art, subheads, 
and quotes. 

LASERWRITER 
Printing With ligatures 
If you're using a Laser Writer to print, 
don't forget the two "ligatures" that all 
the LaserWriter fonts provide: "fi" and 
"fl.". These will make your text "extra 
tight" for best appearance. The "fi" is 
Option-Shift-5 and "fl" is Option-Shift-6. 
Don't forget the printer's quotes either: " 
Option-{ , "Option-Shift-{, ' Option-], ' 
Option-Shift-]. 

There are several desk accessories and 
!NITs available through on-line services 
and user groups that make using printer's 
quotes (also called smart quotes) easier. 
The ligatures are probably easiest if you 
type in "fi" and "fi" normally and use a 
search-and-replace in your word processor 
before printing. 

MORE 
Personalizing Your Startup 
Screen 
Consider what you want to do with your 
customizable startup screen before actu­
ally creating it, since once you've cus­
tomized it, you're stuck with it. 

Displaying More Than One Level 
Of Headline 
Sometimes you'll want to display more 
than one level of headline in a single bul­
let slide chart. To do it, Cut or Copy to the 
Clipboard each outline section that you'd 
like to see appear on one bullet slide chart. 
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Open a document window and Paste in 
the contents of the Clipboard. The inden­
tations remain intact. Edit the leader 
characters to your satisfaction, then go to 
the Bullet Subheads dialog box and turn 
off the Subheads, then leave on 
Documents. Your slides will show multi­
ple levels when you do bullet chart pre­
sentations. 

Centering Bullet Charts For 
Printing 
To center a bullet chart on a page when 
printing, make sure to turn on the As 
Shown When Printed in the Bullet 
Options dialog box. If you don't, the chart 
will print the way it looks on-screen. 

Indicating Where Sum Total 
Should Go 

The Calculate command normally posi­
tions the sum total at the start of a head­
line, although if there is already a number 
in the headline, the sum total will replace 
that number. To indicate exactly where 
the sum total should go, place a "$0.00" 
in the location you want to specify. 

Hiding Numbers From 
Calculation 
You can "hide" numbers from the 
Calculate command. MORE considers 
numbers containing a slash (!) to be dates, 
while it thinks of numbers containing a 
colon to be times. That means any figures 
that contain these characters will be 
ignored when the Calculate command is 
executed. 

Dollar Figure Takes Precedence 
Over Other Figures 

If a headline contains both a dollar figure 
and a non-dollar figure in the same head­
line, the dollar figure takes precedence for 
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calculations, while the other figure is 
ignored. For example, if you put both an · 
expense amount and the date of the 
expense in the same headline, put a dollar 
sign in front of the expense and, for calcu­
lations, the date will be ignored. 

Hide A Headline Whlle 
Reorganizing An Outline 
You can reorganize an outline by drag- ' 
ging a headline under another headline 
that has collapsed sub-headlines and 
"hiding" it there. This lets you clean up 
your outline and concentrate on organiz­
ing the main details. 

To move a headline under another one, 
select the headline you want to move. 
Then place the pointer to the right or le~ 
of the headline (or on the headline, if the ! 
Recognizes preference is set). Now click. 
The pointer changes to a right arrow. 
Hold down the mouse button and 
Option, and drag the pointer underneath 
and to the right of a headline with col­
lapsed subheads. Finally, release the 
mouse button. The chosen headline is 
now "hidden" at the end of the collapsed 
sub-headlines. 

Fast Access To Tree Size Dialog 
You can quickly access the Tree Size dia­
log box by double-clicking on any of the 
orientation icons (the first four icons at the 
top of the Tree Chart palette). This dialog 
box lets you alter the exact dimensions of 
the boxes in your tree. 

Quickly Opening Tree Options 
Dialog 
A quick way to open the Tree Options 
dialog is to double-click on any of the 
box-shape icons in the Tree Chart paletteJ 
This dialog box lets you adjust the pat- : 



terns of the lines and boxes in the Tree, 
and also allows adjustment of grid lines, 
rulers, and page lines. 

MORE 1.1 
Toggle Between Headlines And 
Document Window 
You can quickly toggle between a head­
line and its document window by press­
ing Option-Enter. 

Key Equivalents Work In Dialogs 
For all dialog boxes where there is no text 
input, you can use C for Cancel, 0 for OK, 
Y for Yes and N for No. If there are text 
entry boxes, use the Command key along 
with the key for choosing the button. 

Quickly CanceUng Dialogs 
You can cancel any dialog by pressing 
Command-period. 

Reversing Text Entry Point 
While the Tab key advances through text 
entry boxes of a dialog, Shift-Tab moves 
the text entry point in reverse order. 

Entering Tabs Into Headlines 

Enter tabs into a headline by typing 
Option-Tab. 

OMNIPAGE 
Edit With AppleScan To Help 
OmniPage Differentiate Pictures 
And Words 
OmniPage has some trouble recognizing 
text and pasting text blocks. The less 
"traditional" the page layout, the more 
difficult it is for OmniPage to differenti­
ate pictures and words. AppleScan's edit-

ing tools offer a good remedy: 

First, use AppleScan to get a picture of the 
page. The scanner settings should be 300 
dpi, Line Art. After scanning, move to the 
document window and use the eraser, 
lasso, and selection-rectangle tools to elim­
inate graphics that crowd into text, and to 
move text into groupings that are more 
easily handled by OmniPage. Then, Save 
the document as a TIFF file. 

Now, open OmniPage, choose Open from 
the File menu, and open the document 
you just saved. Choose Recognize from 
the Text menu. OmniPage runs through 
your newly-designed page flawlessly­
and in record time! 

OMNIPAGE 2.0 
Scanning Screened Or Colored 
Text 
Scanning text from magazines into files 
can be a real time-saver, but you'll fre­
quently come across text in sidebars or on 
the contents page that is boxed and 
screened with a color ramp or shading, 
which can play havoc with OCR. 

When faced with this problem, you can 
lessen your scan time while increasing 
the accuracy of the scan by selecting 
Lighten in the Text Settings dialog box. 
More often than not, this strips out 
background screens and lets OmniPage 
do its stuff. 

PAGE MAKER 
Repeating Items 
In FreeHand, if you want to repeat an item 
(such as grid lines that you want to be a 
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specific distance apart), you can clone the 
item, move it, and then duplicate the 
action. PageMaker offers the same capabil­
ity but requires a different set of steps: 

1. Draw the item (a line, for example) you 
want to repeat. 

2. Copy it, and paste it on top of itself by 
using the Option-Paste command 
(Command-Option-V). Move the dupli­
cated item to where you want it to be on 
the page. 

3. Use the Option-Paste command again. 
PageMaker will paste another line at the 
same distance as specified in the last 
move. You can keep using Option-Paste 
until you have all the lines you need. 

Improving Gray Shade Printing 
The quality and texture, or fineness, of 
PageMaker's gray shades leaves some­
thing to be desired. The default 53-lpi 
(lines per inch) screen is much too coarse 
for most 300-dpi printers. Since you 
cannot change this 5 3-lpi setting for 
graphics created within PageMaker, 
most users have simply settled for sec­
ond-rate output. 

You can create custom gray boxes in 
Aldus FreeHand by using the Special 
command to specify a higher lpi in the 
halftone screen. You can also accomplish a 
similar effect by using the ubiquitous 
MacPaint and special controls available in 
PageMaker: 

1. In MacPaint, create a black box the size 
you want. 

2. Place the box into a PageMaker docu­
ment, and while the box is still selected, 
use PageMaker's Image Control com­
mand to alter the lightness or contrast 
with the sliding scale. Change the 
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halftone screen from 53lpi to 66 or 75 
lpi. The result is a much tighter and finer 
dot pattern when you print the docu­
ment on a 300-dpi printer. 

Resetting The Page Numbering 
For Forms 
When using PageMaker to set up a dou-

1 

ble-sided form, you don't have to set the I 
starting page number to 1 and then flip 
between pages 1 and 2. Just set the start­
ing page number in the Page Setup dialog 
box to 2 and create two facing pages. 

This lets you work with both sides of the 
form on the screen at the same time (and 
the master pages correspond to the on­
screen form). Later, you can reset the 
Page Setup dialog box. Remember also J 
that most DTP programs offer automat•c 
page-numbering tricks, which become · 
useful when your documents start 
to grow. 

Setting Consistent Spacing 
Between Elements 
Getting the spacing consistent between 
several repetitive elements, such as photos 
and their captions, throughout a multi­
page publication can be a realchore- but 
not if you use this PageMaker trick: 

1. When setting the style for a caption or 
other repeating text element, go to the 
Rules dialog box, which you access by 
selecting Paragraph on the Type menu. 
Check Rule Above Paragraph, and set 
Line Style to None on the pull-down 
menu (this gives you an invisible rule 
above the text). 

2. Next go to Options, and type the 
desired number in the Top box for the 
amount of spacing you want between the! 
text and the invisible rule. For example, if 



you're working in 12-point type, an 18-
point space gives you 6 points between the 
text block and the rule which translates to 
the bottom of the graphic element. 

3. When you drag the text block to posi­
tion it, the invisible rule above the text 
will enlarge the text box (shown as a dot­
ted line), according to the amount of space 
you entered. Line up the top edge of the 
text box with the bottom edge of the 
graphic (see Figure 1). This will give you 
consistent spacing between all captions 
and related graphics. 

This trick also works if the invisible rule is 
set below the text block (which lets you 
place the text above the graphic) or if the 
text block is rotated (for example, for a 
photo credit on the side of a photo). 

Correcting Underscoring 
Problems 
When making a "fill-in" sheet, the under­
score characters you type at the end of each 
line will occasionally line up with the end 
of other lines. To correct this, after you've 
completed a page, draw a box over the 
edges of the ends of the lines which 
encompasses all of the associated lines. 
Give this box a white shade and "None" 
lines, so it can't be viewed. The objects 
behind it will be invisibly covered. 

Getting PageMaker To Remember 
Page Setup Alterations 
PageMaker will permanently remember 
page setup alterations if you choose Page 
Setup from the File menu with no docu­
ment open and only the gray desktop 
showing. Every new publication you cre­
ate will default to the altered settings. 

Getting The Most Accurate Size 
Display 
Although the 200% size has the most 
fractional markings on the rulers, it is not 
the most accurate size display. Since the 
printed version exactly matches the 
Actual Size display, always check it before 
doing your final printing. 

Toggling To A MacPaint-Style 
Hand Tool 
Hold down Option while clicking on 
your document in any other place but in a 
column guide. Use the hand to drag an 
image around the window and reposition 
your page. 

Disabllng "Snap To Guides" 
You have the option of turning off Snap To 
Guides in the Options menu if you don't 
use them often. When making a move that 
isn't affected by these guides, be careful 
where you place the pointer. Position the 
pointer away from the guides when you 
start the move so that the item you're mov­
ing won't be affected by the guides. 

Keeping The LaserWriter Up To 
Speed 
If you've been using your Laser Writer to 
print documents from other applications, 
cum it off and then back on again before 
printing PageMaker documents. This is 
because PageMaker initializes the 
Laser Writer with Aldus Prep, but it 
doesn't replace the old Laser Prep file. 
Since both Prep programs are memory 
hogs, when the Laser Writer stores both 
files it slows down in printing speed. For 
the same reason, reinitialize the printer 
after finishing your PageMaker printing. 
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You might try reinitializing the printer 
whenever your network-connected print­
er seems to be printing too slowly. 

Save Time When Switching 
Printer Drivers 
Switching from the Aldus printer driver 
to the Apple driver for background print­
ing under MultiFinder is a hassle if you 
rely on the usual, slow method of invok­
ing the Aldus Print dialog box and select­
ing Change. You can make the change 
much more quickly by holding down the 
Option key while selecting Print from the 
File menu; then click on OK in the two 
resulting dialog boxes. You'll find yourself 
at the familiar Laser Writer dialog box, 
where you can specify the number of 
copies and pages to print. You've automat­
ically switched printer drivers! 

Printing a Publication From Page 
One, With A Tide Page 
You may want your publication to have a 
title page and then start the document 
with Page 1, but PageMakerdoesn't let 
you treat the title page differently from 
your document (it also won't automatical­
ly number the pages starting with the sec­
ond document as Page 1). 

If you put the title page at the end of the 
document and cum off the Display Master 
option on the Page Menu for that page, 
you can use automatic page numbering 
for the document and still have a title 
page without a folio. 

Creating Evenly-Spaced Lines In 
Difficult Places 
There will be times when you want even­
ly-spaced lines in a place not easily divid­
ed by the ruler. You can create these lines 
easily: 
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First, draw and save your own simple ruler 
(with some division lines) in a PICT file 
(you can make these with MacPaint or 
MacDraw, for example). Enter PageMaker 
and use the Place command to put your 
ruler on the page. Select the ruler and 
resize it to fit the space you need to divide. 
You can now draw lines using the ruler~ 
a guide. When you're finished, remove ! 

the ruler. 

Solution For Imported Graphics 
"Clipping" 
When you open PICT files within 
PageMaker, you'll occasionally find a bug 
that clips off the top part of a graphic, 
especially if it consists of text placed above 
graphics. By placing a shape above the 1 

text and giving it no fill or pattern you cdn 
fool the program into including the full I 

imported PICT file. 

Toggling Between "Full Page" 
And "Fit To Window" Views 
You can toggle between the Full Page and 
Fit in Window views by holding down 
the Command key while clicking in the 
page window. 

PAGEMAKER 2.0 
Selecting Closely-Packed Objects 
Selecting closely-packed objects con­
fined to a small space is easiest if you 
Command-dick near the object you 
wish to choose. 

"Guide Lock" Aids In Object 
Selection 
It can be difficult to select items located 
on or underneath a guide without grab­
bing the guide by mistake. To lock the 
guides temporarily, use Guide Lock from! 
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the Options menu. This makes it impossi­
ble to select and move them accidentally. 
When you're done moving the objects, 
toggle the Guide Lock off by choosing it a 
second time. 

PAGEMAKER 3.0 
Printing Two Pages On A Single 
8.5 x 11 Sheet 
To print two pages on a single 8. 5 x 11-
inch sheet, just create two columns on a 
letter-sized page turned on its side by 
entering 11 x 8.5 in the Page Setup dialog 
box. Remember, you can't use 
PageMaker's automatic page-numbering 
feature, since auto-numbering considers 
this setup to be one page. 

Keyboard Command Shortcuts 
For Extended Keyboard Users 
If you have Apple's Extended Keyboard, 
you can choose tools from the PageMaker 
Toolbox window by using the following 
undocumented key combinations: 

Control-Shift-F1 selects the Pointer. 
Control-Shift-F2 selects the Line tool. 
Control-Shift-F3 selects the 
HorizontalNertical tool. 
Control-Shift-F4 selects the Text tool. 
Control-Shift-F5 selects the Square 
Rectangle tool. 
Control-Shift-F6 selects the Rounded 
Rectangle tool. 
Control-Shift-F7 selects the Ellipse 
tool. 
Control-Shift-FS selects the Cropping 
tool. 

Printing Through The Manual­
Feed Tray Of The Varityper-600 
PageMaker has difficulty printing 

through the manual-feed tray of the 
Varityper VT-600. The problem isn't 
with the VT-600 but with the VT-
600.apd (Aldus Printer Description) file 
that PageMaker uses to print. You can 
alter the APD with Word or another word 
processor so that the file will work with 
the manual-feed function. Open the VT-
600.apd in Word, find this line: 

@ManualFeed: "none" 
and replace it with these lines: 

@ManualFeed true: "statusdict begin I 
manualfeed true defend" 
@ManualFeed false: "statusdict begin I 
manualfeed false defend" 

Flowing Text Around Irregularly 
Shaped Objects 
PageMaker 3.0 lets you flow text around 
irregular graphics using an invisible out­
line that text won't cross. This feature also 
lets text flow into an irregular shape. 

Start by drawing or placing a graphic in 
a shape that you wish to replace with 
your text. 

Using the rectangle tool, create two side­
by-side rectangles to cover the graphic, 
with the two rectangles touching in the 
center of the graphic and extending 
across the width of the column and above 
and below the graphic. 

Select the center text-wrap feature, 
(found in Text Wrap under the Options 
menu) for each of these rectangles. The 
invisible wrap control lines will appear, 
overlapping in the center. 

Working first with the left rectangle, 
click along the right control line enough 
times to create the number of points nec­
essary to outline the left side of your 
graphic. Use these points to stretch the 
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control lines around the left side of your 
graphic. 

Repeat the process for the right rectangle, 
using the left side of the rectangle. Make 
sure the top and bottom control lines still 
overlap at the center. 

When you have the graphic outlined 
completely, delete it. Now, choose the 
two rectangles and specify None under 
the Lines menu. Flow your text into the 
column, and it will fill the area you creat­
ed. Set the text to be justified to flow it 
properly across the area. This tip works 
best when you're working with small font 
sizes, tight leading, no paragraph breaks, 
no tabs, and a column width no larger 
than the size of your graphic. 

Wrapping Text Around A 
Graphic, Then Captioning The 
Graphic 
If you want to wrap text automatically 
around a graphic and then put a caption 
below or next to the graphic, you must 
increase the stand-off value of the text 
wrap around the graphic on the side 
where you want the caption. If you're not 
careful, the text wrap area of the graphic 
will push the caption away, leaving it 
stranded right in the middle of the 
wrapped text again. Be sure that all the 
handles of the text block defining the 
caption are inside the text wrap area. 

Place the text or begin the text block by 
dragging the text cursor, rather than just 
clicking it. Clicking forms a text block 
the width of the column or page, which 
usually makes it larger than the text 
wrap area. The result is that PageMaker 
will push the caption away. When you 
drag instead, you can make sure that the 
text block of the caption begins and ends 

32 

inside the wrap area, so it will stay where 
you want it. 

Changing The Default Settings 
When Laser Printing 
The Default settings of the Aldus Printer 
Description (APD) files control the laser~ 
printer screen quality, producing outputi 
at 60 lines per inch and placing half-ton~ 
screens at a 45-degree angle. You can ! 

change these default settings using a text 
editor. 

With a text editor, open the APD file 
corresponding to the printer that you 
are going to use, and find the two lines: 

@ScreenFreq:" and @ScreenAngle:" 

Enter your desired screen frequency and i 
the desired screen angle between the I 
respective quotes. 

Save as a text-only file. The laser printer 
will now produce the new screen 
definition when you print. For best 
results, don't use a screen frequency 
higher than 13 5 lines per inch, and set 
your half-tone screen angle to a multiple 
of45 degrees. 

Saving Money When Going To 
PrintOrFDm 

Most service bureaus charge less for print­
ing one 11 x 17 -inch sheet of paper or film 
than they do for two 8.5 x 11-inch print­
outs. You can take advantage of the price 
break by using PageMaker's wide tabloid 
page setup to lay out two pages on a single 
page. This also lets you produce bleeds 
(graphics that extend across two pages). 

Here's an example of how to set up two 
three-column pages on one tabloid-sized 
page: I 

Set the left and right margins to be the I 



outside margin measurements (since nei­
ther one is an inside, or bound margin, they 
should be equal). Next, choose the distance 
between columns and the number of 
columns, but choose seven columns instead 
of the more common six. The columns will 
be evenly spread across the two-page 
spread. To rearrange them, you need to 
know the width of the column you want. 
For a three-column page, the formula is (8.5 
-(2 X the distance between columns}-(out­
side margin +inside margin)) divided by 3. 

Starting from the left margin, measure 
the width of your column and then drag 
the left side of the first column guide to 
that point. Zero the ruler to the right 
edge of the column guide, and repeat the 
procedure for the second and third 
columns. Then move to the right margin 
and repeat the measurements for 
columns six, five and four. The remain­
ing "seventh" column (the one left in the 
middle) and adjacent column divisions 
will be equal to the two inner margins. 

When printing proofs on a Laser Writer, 
make sure that you change the options at 
the bottom of the print dialog box so that 
the paper is set at Tall. At this setting, 
with the tile feature set at automatic and 
the overlap set at 0, the Laser Writer will 
print your proofs as neatly as if your layout 
were in an 8.5 x 11 format. 

Laying0ut2PagesOnAn8.5xll­
Inch Sheet Of Paper 
To print two pages on a single 8.5 x 11-inch 
sheet, just create two columns on a letter­
sized page turned on its side by entering 11 x 
8.5 in the Page Setup dialog box. Remember, 
you can't use PageMaker's automatic page­
numbering feature, since autonumbering 
considers this setup to be one page. 

Working With Word's Style Sheets 
When you first place a Word document 
into PageMaker 3.0 or 3.01, you place 
Word's style sheet into the PageMaker 
document's style sheet, even if you previ­
ously hadn't been using a style. In other 
words, the style is not actually created by 
PageMaker; rather, it's borrowed from 
Word. 

Once you've placed Word text into the 
program (and so, placed it in its style 
sheet), PageMaker will read whatever 
Normal text you place from Word, 
whether it's been formatted differently or 
not, as the same Normal style. 

If you have several stories with different 
formats to place in your document, make 
sure to delete the Normal entry from the 
PageMaker style sheet before adding addi­
tional text. You can either add the styles 
you want in Define Styles under the 
Format menu while still in Word, or else 
save your formatting until you've imported 
all your text into PageMaker. 

How To Save Revised Print 
Parameters 
PageMaker saves updates to your print 
parameters (like Paper Source, Driver, 
Scaling, etc.) only if it perceives that you 
have changed the file. Even though you 
may only be opening the file to print it, 
your changed parameters will be lost 
when you close the file. 

One solution is to do something and then 
promptly Undo it. For example draw a 
box and then delete it. Now PageMaker 
will perceive a saveable change, and your 
new print parameters will be saved within 
your file. 
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Using Pyro! To Force PageMaker 
To Update The Screen 
Automatically 
One annoying flaw in PageMaker 3.0 is 
its occasional failure to update the screen 
(as when the print dialog box disappears, 
leaving a gaping "hole" in the screen 
text). Most users just scroll off the page 
and then back again to recover the por­
tion that was blanked out. 

If you have Pyro! or another screen saver, 
there's a much faster way to force 
PageMaker to redraw the entire screen. 

Move the cursor to the sleep corner. When 
Pyro!'s startup screen shows, move the 
cursor back to the document. The fully 
updated page appears. It's a lot easier than 
dealing with the scroll bar. 

Use Easy Access To Nudge 
Graphics Or Text A Short 
Distance 
If you need to nudge an object just a tiny 
distance, you probably know that using the 
mouse to drag it is extremely inexact. Easy 
Access, an INIT that comes with the new 
System, can help. 

Just press Command-Shift-Clear to turn on 
the Mouse Keys. Press the 0 key to lock the 
mouse button down, then use the numeric 
keypad to move the pointer (press 8 to 
move up, 6 to move right, etc.). 

To move the pointer one pixel on the 
screen, tap the key once. For a longer 
movement, hold down the key a little 
longer. Press the decimal point to unlock 
the mouse button, and press the Clear key 
to turn off the Mouse Keys. 
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Hide The Guides And Rulers To 
GruDSomeS~nsp~eOnP~ 
And SE Screens 

You can gain some space on the small Mac 
Plus and SE screens by hiding the guides 
and rulers. To navigate through your docu­
ments, use: 

Command-Tab to move forward 
Command-Shift-Tab to move 
backward 
Command-G to go to a specific page 

Select the Hand tool and Option-Click 
with it to move around the page. 

Keeping Colors In Order For 
Strippers And Pressmen 
When printing a document with spot col­
ors, PageMaker doesn't print color name~ 
on each separate plate if the image area 
occupies the entire printed page. This can 
prove especially confusing if you're print­
ing multiple pages at a time. 

To keep your colors in order, insert a 
small text block in the top left comer of 
the document's master pages. Type in the 
name of a spot color you're using, and 
then make the text that color with the 
color palette. Repeat this for every color 
you use in the document. 

You can stack all the text blocks on top of 
each other, so when you print out, the 
names will only print out in the pages 
that have those colors on them. 

When you use this method, don't forget 
to tell the pressmen to cover the color des­
ignators when the page is exposed for 
printing. 



Switching Between Drivers 
Switching from the Aldus printer driver to 
the Apple driver for background printing 
under MultiFinder is a hassle if you rely on 
the usual, slow method of invoking the 
Aldus Print dialog box and selecting 
Change. You can make the change much 
more quickly by holding down the Option 
key while selecting Print from the File 
menu; then click on OK in the two result­
ing dialog boxes. You"ll find yourself at 
the familiar Laser Writer dialog box, where 
you can specify the number of copies and 
pages to print. You've automatically 
switched printer drivers! 

An Easy Way To Track Hours 
Spent Working 
If you need to track how many hours you 
spend on a particular PageMaker job, you 
can create a small chart on the Pasteboard, 
just off to the side of a page. Create 
columns for Date, Time Started, Time 
Ended, and Hours Worked in the chart , 
using tabs. Each time you open the docu­
ment, add a new row for the day and enter 
the pertinent information. When you 
close the document, fill in the Time Ended 
column. Now you'll always have accurate 
data handy for invoicing that project, and 
it's a lot cheaper than buying a time-track­
ing program. 

Opening More Than One 
Publication 
Ever wish you could open more than one 
publication in PageMaker? If you have at 
least 3 megabytes of memory, a hard 
disk, and MultiFinder, you can. 

Use the Finder to make duplicate copies 
ofPageMaker and rename each copy (ie, 
PMK.1, PMK.2, etc.). For safety's sake, 
place each copy in its own folder with 

accompanying files. Then launch each 
copy under MultiFinder. You can now 
copy and paste whole pages between pub­
lications easily. 

Vertically Justifying Columns 
PageMaker has no menu-based command 
for vertical justification, but you can verti­
cally justify columns in a primitive fash­
ion. Assuming the tops of all the columns 
are even, this procedure gets the columns 
to line up perfectly along the bottom of a 
page: 

1. Measure the distance between the bot­
toms of two columns and the bottom of 
the page, and divide that number by the 
number of paragraph endings in the 
shorter column (if the shorter column 
ends with a whole paragraph, subtract 
one from the total). 

2. Highlight all the paragraphs in the 
shorter column except for the last one, 
press Command-M, and type the number 
you found in step 1 in the Spacing After 
box. The shorter column will expand to 
fill the extra space. 

PAGEMAKER 3.02 

Getting The Proper Spacing 
When Dividing Horizontal Or 
Vertical Space 
A common operation in PageMaker is 
dividing an amount of space (horizontal or 
vertical) evenly among a number of incre­
ments. But when this amount of space is 
not a round whole number, the division and 
spacing can be problematic. Here's an easy 
way to get the proper space allocations: 

1. Draw a rectangle that is, for example, 
five inches in length, and divide it into 
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five increments. The rectangle should be 
divided into five l-inch segments. 

2. Copy this segmented rectangle to the 
Scrapbook and use the Place command on 
the File menu to place the most recent 
Scrapbook file as a grouped PICT graphic. 

3. To resize this rectangle to fit into a 
longer area, grab one of the handles of the 
rectangle and stretch it. Now you'll have 
five equally divided spaces without the 
tedium of trial-and-error measurement. 

Typing Numbers Using The 
Keypad 
Many people prefer to enter numbers 
from the numeric keypad, but with 
PageMaker the keypad numbers are used 
for moving around within a document 
(and the Num Lock key has been dis­
abled). You can use the numeric keypad 
by making sure the Caps Lock key is 
down. 

Another effective solution is to use a 
macro program such as MacroMaker or 
AutoMac III to program each key on the 
keypad to produce its corresponding 
number. 

PAGEMAKER 3.0 
AND4.0 

Tabbing With Dot Leaders 
When using tabs with dot leaders in 
PageMaker (3.0 and 4.0), the dot leaders 
take on the text format of the character to 
the left of the tab. Therefore, if you use a 
ZapfDingbats character just before the 
leader, the dots become little pencil icons. 

It isn't possible to select the dots and 
change their typeface format separately. 
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To avoid this problem, press Option­
spacebar just before the tab. Then select 
this special nonbreaking space character 
and format it so that the dots appear as 
desired. 

PAGEMAKER 4.0 

PageMaker 4.0 Tries To Forget Its 
Past 
If you've been using PageMaker for years 
and have upgraded to Version 4.0, you 
might not want to throw away your previ­
ous versions just yet. PageMaker 4.0 can 
open and use documents created with ver­
sion 3.0 or 4.0, but it can't open docu­
ments created with PageMaker 2.0 or ear­
lier. To get your older PageMaker docu- 1 

ments into Version 4.0, you need to opeti 
them in PageMaker 3.0 first and save 
them in that version's format. Then you 
can open the files in Version 4.0. Aldus 
recommends that you have free space on • 
disk equal to three times the size of the file 
being converted. 

You can upgrade all of your PageMaker 
documents each time a new version is 
released, but the safest solution is to keep 
all the old master disks so that you can 
reinstall older PageMaker versions when 
necessary. 

Saving Documents Created With 
Older Versions OfPageMaker 
PageMaker 4.0 has enhanced exporting : 
features for text, which can be a boon if · 
you need to compress and save documents 
created in older versions ofPageMaker. 
These documents are most likely large, 
and the formatted text sections are proba­
bly the most important part. If this is 
true, then translate the document createc;I 



with PageMaker 3.0 or 3.02 up to 
PageMaker 4.0. 

Now you can exJ)ort the documents (you 
can combine them by cutting and past­
ing) into a document that's formatted in 
your favorite word processor-style (or text 
only). This technique might save you 
1 OOK on small documents and as much as 
mega-bytes on large one. 

If you ever need your older document 
again, you'll find that reassembly is easy. 
Other exporting programs can perform 
this trick as well, but PageMaker docu­
ments save you the largest amount of 
space when you remove the formatting. 

PageMaker Graphic Dropouts 
Are you experiencing problems when 
importing graphics? There may be an 
explanation, depending on what's happen­
ing. Here are some common causes of the 
"Hey, the graphics didn't print!" problem. 

You may have placed a scanned image and 
then moved the image file to another disk 
or folder, where PageMaker couldn't find 
it. Fortunately, if the program can't find a 
file it needs, a dialog box will appear 
telling you, so you'll know what hap­
pened. PageMaker 4.0 automatically 
incorporates all EPS graphics into the 
data file itself, so the location of the origi­
nal EPS file doesn't matter. 

Another possibility is that you may have 
checked the Proof Print option in the Print 
Setup dialog box. This is a time-saving 
measure in which PageMaker prints 
dummy-style boxes in the place of any 
placed graphics. If you don't see a box con­
taining a jumbo X where you placed your 
graphics, you can rule this one out. 

If the dropouts are irregular (page ele-

ments of all types either print or won't 
print, without reason or mercy), you're 
probably looking at a bona fide computer 
problem. If you've installed a screen saver, 
try turning it off. Some screen savers can 
cause trouble if they kick in while a docu­
ment's being printed; the computer 
becomes engrossed in the challenge of 
drawing those fireworks, or fish, or 
exploding penguins, or whatever and 
quite literally "forgets" to send some data 
to the printer. 

It's also possible that the page was complex 
and your printer ran out of memory. 
Usually when that happens, your Mac is 
polite enough to report a "Not enough 
memory, boneheadr' -type error message. 
If you suspect this kind of trouble, you can 
clear any and all errors from your printer 
by switching it off and back on again. 

If you've already turned your printer off 
and then back on again and you still can't 
get the page to print, turn the printer off 
and then on one more time. Then manual­
ly download all the fonts used on the trou­
blesome page- all the fonts you used in 
PageMaker and all the fonts in your EPS 
graphic. Now print the troublesome page 
(but not the entire document). To down­
load stuff to your printer, you need a pro­
gram such as Font Downloader, which is 
included with Adobe fonts, or CE 
Software's Widgets or LaserStatus. 

Professional-Looking Fractions 
In order to set professional-looking frac­
tions in PageMaker 4.0, change the 
option for subscript position (on the Type 
menu) from 33.33 percent to 0 percent. 
To set a fraction, all you need do is type in 
the numbers and change the numerator to 
superscript and the denominator to sub-
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script. No more calculating and changing 
the size of your denominator- it will be 
perfect every time. 

Conversion OfMacWrite ll To 
PageMaker 4.0 
In converting documents from Mac Write 
II to PageMaker 4.0, the import and cre­
ation of en dashes is inconsistent. In the 
story editor ofPageMaker, you can't 
import en dashes, nor can you create them. 
The mode's global-change options doesn't 
recognize them. They import as hyphens. 

When you use the Place command on 
imported text in the page-layout view, the 
en dashes change to hyphens. You can cre­
ate en dashes in the page-layout view with 
the standard Option-hyphen keystroke 
combination, however. 

There is a way around this shortcoming: 
Cut and paste between applications. 
Copy the text you want to import from 
your word processing file, and then close 
the document. Open the PageMaker 4.0 
file, and paste the text. 

Although more steps are involved in this 
technique, if you have many en dashes in 
an existing document and want to copy 
directly to the PageMaker document, this 
is the only way the en dashes will survive 
the transition. 

PERSUASION 

Change The Master For Some But 
Not All Of Its Associated Slides 
You can't do this, but Persuasion's multi­
ple masters can produce the same result. 
Simply create a new slide master based 
on the old one by choosing Go to Master 
on the View menu and New from the 

38 

submenu. Then select any subset of 
slides by Shift-clicking in the Outline or 
Slide Sorter view, and apply the new 
master. Reformat the new master to suit 
your needs. 

Changing The Arrowheads 
If you find the arrowheads in Aldus 
Persuasion too large for your taste, you can 
change their size by changing the length 
of the line to which they're attached. On 
longer lines, Persuasion consistently 
makes the arrows the same size, but by 
adjusting shorter lines, you can obtain a 
variety of sizes. 

Draw the line in the position you want, 
and make it the length you want. Instead 
of choosing the arrow style from the Effeht 
menu and applying it to your line, draw~ 
shorter line off to one side, make it the 
arrow line, and then adjust the length 
until you get the arrowhead size you want. 
Copy and paste this arrowhead on top of 
the first line. You can also create a selec­
tion of arrowheads and copy them to the 
Scrapbook so you can use them later. Be 
sure to create them pointing in different 
directions. 

SwitchAutoTemplates To Give 
Your Slides A New Look 
Use the Auto Templates command to 
quickly change the formatting for an 
entire presentation. This is a convenient 
way to alternate between black-and­
white overheads and 3 Smm color slides~ 
Persuasion automatically replaces masters 
with the same names, reformats all slides, 
and replots charts to match the new 
design. The new Auto Template format 
also overrides any previously applied . 
color schemes and defined text and chart 
formats. 



Restore Master Formatting To An 
Individual Slide Element 
You·ve made several changes to the body 
text of a slide- italicized some words 
and moved and resized the text block­
but you don·t like the results and want to 
restore the master's formatting. 

The solution is, in Slide view, use the 
pointer tool to select and delete the 
entire text block. Leave Slide view, and 
then return to it. Voila- your body text 
has been reformatted and repositioned 
based on the master. 

This shortcut works for any text that's 
linked to the outline, including titles, 
subtitles, and body text, For an organiza­
tion chart, just select and delete the 
whole chart. (Note: A quick way to leave 
and return to Slide view is to click on the 
slide icon at the upper right corner of the 
window.) 

Restore Master Formatting To An 
Entire Slide 
The fastest way to remove all local over­
rides- such as format and position 
changes to the title, subtitle, or body 
text- is to select None for the master and 
then reassign the original master. 

Use Chart Placeholders 

You don•t have to use chart placeholders, 
because you can plot a chart directly to 
any slide regardless of which master 
you·re using, but you can easily use a chart 
placeholder by assigning a master con­
taining one to the slide before you plot. A 
chart placeholder offers two benefits: One, 
you can adjust the size, positioning, and 
formatting of charts on several slides at 

once simply by changing the master. Two, 
if you switch Auto Templates, all the 
charts will automatically be replotted, 
resized, and repositioned to reflect the 
new template design. 

Use "Selective" Select All To 
Choose All Objects Of A Given 
Type 
In Slide view, you can select all the objects 
created with a specific tool by choosing 
that tool and then using the Select All 
command (Command-A). If you choose 
the Rectangle tool and choose Select All, 
for example, all rectangles are selected. 
Choose Select All again, and all objects on 
the slide are selected. 

In Outline view, the Select All command 
has three levels of operation: Issuing the 
command once selects all the text in a sin­
gle heading, twice selects all the headings 
of the same level that share the same supe­
rior heading, and three times selects all 
the visible headings in the outline. 

Take Advantage Of The 
Temporary And Permanent 
DefawmForDrawingToo~ 

Permanent defaults are saved with your 
document. You can change them by 
selecting the pointer tool and choosing 
line styles, colors, or patterns from the 
Effect menu. (Make sure no objects are 
selected, or they will be affected by the 
changes.) 

You can set temporary defaults by click­
ing on a drawing tool and then making 
selections from the Effect menu. The 
temporary defaults affect all the objects 
you draw until you choose another tool. 
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Edit Text In Grouped Objects 
Such As Charts And Tables 
Without Ungrouping 
Choose the text tool, click on the text in 
any group or chart- no matter how 
deeply nested it is- and proceed with 
your editing. You can also change the type 
style and apply superscripts or subscripts. 
(Note: text changes you make to chart 
labels are automatically reflected in the 
data sheet.) 

Create One Or More Preview 
Slides Automatically 
A preview slide gives an overview of a set 
of slides by listing their titles (see Figure 2). 
You create preview slides in the Outline 
view by using the Set Heading As com­
mand from the Outline menu to tum sub­
ordinate headings into slide titles. The sub­
ordinate slide title then appears twice, once 
as body text in the preview slide and again 
as the title of its own slide. 

Let Persuasion Keep Text 
Blocks And Charts Centered 
On The Slide 
You might want to keep a text block cen­
tered on the slide even if the text within 
the block is aligned on the left. Use the 
Anchor Placeholder command to do this. 
Few of Persuasion's Auto Templates use 
center anchoring, so this feature is largely 
unknown. 

Go to the slide master, select the place­
holder for body text or organization chart, 
and choose Anchor Placeholder from the 
Master menu. Select both Center options 
and you've finished. Now all the text 
that's contained in the placeholder, 
regardless of its size and alignment, is ver­
tically and horizontally centered relative 
to the placeholder. 
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Create Slide Bullds (or Layers) 
Automatically 
A build reveals a slide's text and graphics 
one layer at a time, in a manner similar to 
using a flip chart with acetate overlays. 
You can create builds manually by select­
ing objects in Slide view and sending 
them to different layers (using the Layer I 
pop -up menu in the lower menu bar). But 
many users don't realize they can create 
builds for text and charts automatically 
for an entire presentation. 

The process is simple: Go to a slide master, 
select the appropriate place-holder, pick 
Build Layers from the Master menu, and 
choose a build option in the dialog box. 
All the slides based on that master are now 
layered. To see the builds, you can run th~ 
slide Show or output them by checking ' 
Builds in the Print or Export dialog box. 
(Note: builds print cumulatively -layer 1 
on the first page, layers 1 and 2 on the sec­
ond page, and so forth.) 

Use Auto Templates As More Than 
Just A Collection Of Coordinated 
Masters 
You can save any presentation as an 
Auto Template, and all the data, document 
attributes and defaults are saved along with 
it. Similarly, you can open the original of 
any Auto Template (instead of a copy), 
modify it to fit your needs, and resave it. 

Here are some possibilities for enhancing. 
Auto Templates. Setup level-specific text . 
styles for the Outline view (you can alwayS 
override the styles for individual characters 
and topics). Define drawing-tool defaults 
for patterns, colors and line styles. Create 
your own color schemes. Save a collection 
of drawing objects or clip art on an unuse~ 
slide, a notes page, a handout master, or tQe 
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gray area of any slide (in other words, any­
place they won't print). 

Creating An Entire Presentation 
Without The Outliner, But With 
AutoTemplate 
The key here is to choose New from the 
Slide pop-up menu. This gives you a 
brand new slide with a dummy title and 
body text based on the slide master. Use 
the Text tool to select the dummy text, 
and type in new text. You can use the 
Move Right and Move Left commands 
(on the Text menu) to alter the heading 
level of a paragraph, and the font and 
style automatically change to reflect the 
new level if it is different on the master. 

Assigning Different Type, Style 
And Color To Body Text Levels 
On A Master 
Use the text tool to select one or more 
paragraphs of body text, and then choose 
the desired styles and color from the 
Text menu. 

Changing Body Text On The 
Slide Master 
Make changes to body text, organization 
charts, and so forth on the slide master 
rather than on individual slides. All slides 
that use the master will be updated 
instantly. 

Mixing Tall And Wide Overheads 
In The Same Presentation 
Slide or overhead orientation is always 
based on the orientation of the master 
and is usually horizontal (wide). If you 
prefer an overhead with a vertical orien­
tation, make a new master, don't give it a 
background (select None from the 
Background pop-up menu), and choose 
Tall Orientation from the Master menu. 

Any slide using this master is now tall 
instead of wide. This technique always 
works for overheads, but it's less reliable 
for slides, because some film recorders 
can't handle a tall orientation. 

Replacing The Default 
AutoTemplate Without 
ReinstalHng The Program 
When you install Persuasion, you have 
the option of installing one Auto­
Template as the default presentation; 
this file is called Persuasion Prefs and 
resides in the Aldus Folder, (inside the 
System Folder). If you later want to 
make another Auto Template the 
default, you don't have to reinstall the 
program. Instead, just create a presenta­
tion and adjust the various settings to 
meet your needs. Save the file as a pre­
sentation called Persuasion Prefs and 
store it in the Aldus Folder, where it 
replaces theoriginal file. 

Reformat All Slides 
Simultaneously By Making 
Changes To The Slide Master 
Most people change the formatting for 
existing slides one at a time right on the 
slide, but one of Persuasion's unique fea­
tures is that you can reformat all your 
slides simultaneously by making 
changes to the slide master. All slides 
based on the master immediately reflect 
the changes. This works for any place­
holder change, including font, style, size, 
position, and fills. (Placeholders are 
markers that define the size, format, and 
location of objects on a master.) 

Persuasion Does Animation 
You can use Persuasion's layers to achieve 
animation effects. Say, for example, that 
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you want to have a ball bouncing across 
the screen. First, copy and paste the ball 
at different positions on successive layers 
of the slide. On each layer, hide the ball 
from the previous layer by using a solid 
rectangle whose fill is the same color as 
the background. Similarly, you can build 
text word by word (or letter by letter) by 
sending the appropriate characters of the 
text block to different layers. 

Note: when you paste or draw new 
objects they always go to the current 
drawing layer. You can change the draw­
ing layer by choosing it from the Layer 
pop-up menu when no objects are 
selected. 

Use "Warm" Unks To Quickly 
Replot Charts Linked To External 
Spreadsheets 
You can open a spreadsheet from another 
program (if it's saved in text or WKS for­
mat) and use it to plot selected informa­
tion. Persuasion maintains a link to this 
external tie enabling you to update a pre­
sentation quickly if data in the original 
spreadsheet changes. Simply use the Data 
Sheet command to open the external 
spreadsheet, select the data to be replot­
ted, and click on the Replot button on the 
menu bar. 

Spice Up Your Charts With Some 
Variety 

You can flip charts vertically or horizon­
tally and reposition legends and pie slices 
by double-clicking and dragging. You can 
add round corners to bars via the Round 
Corners command on the Draw menu as 
well as ungroup any chart and alter the 
individual elements. 
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Improve A Resized Chart Using 
The Redraw Chart Command 

When you stretch or resize a chart in a 
drawing program such as Persuasion, the 
screen image may become distorted. If 
you select Redraw Chart from the Chart 
menu, the chart will be recalculated base'il 
on its new size and replotted, giving you~ 
clean image. 

Highlight Key Data Points By 
Enhancing Individual Chart 
mements 
You can change patterns, colors, and line 
styles for a single data element as well as 
for an entire series. 

When you double-dick on a bar, all the . 
bars in the series are selected. If you doublj'­
click again, the individual bar is selected . 
and you can alter its appearance without · 
affecting other chart elements. Similarly, 
you can alter the tops and sides ofbars, pie 
slices and so on; make independent changes 
to major grids, minor grids and tick marks; 
and enhance text for individual category 
and legend labels. (Note: you can use one 
triple-dick instead of two double-clicks to 
select an individual chart element.) 

7 Keyboard Shortcuts 
1. Move between slides by holding down 
the command key and pressing either the 
up arrow key (to go backward) or the 
down arrow key (to go forward). 

2. Move between the Outline, Slide, and, 
Notes views by holding down the · 
Command key and choosing the right or 
left arrow key. 

3. You don't have to use the selection han~ 
dies to resize selected objects. Just hold 
down the Command key and drag the 
mouse anywhere on the slide. You can 



reduce the effect of mouse movement by 
beginning the drag outside the selection 
and magnify it by starting the drag inside it. 

4. Resize text blocks without leaving 
text editing mode. Just hold down the 
Command key and drag the left or right 
edge of the text block. This applies to all 
text blocks, including those in groups and 
charts. 

5. Select objects behind other objects by 
using the Option key. If you hold down 
the Option key and click, you can select 
an object behind the front-most object. 
You can use this keyboard shortcut 
to select several unreachable objects in 
succession. 

6. Change the default text style for one or 
more levels of the outline without using 
the Outline Styles dialog box. Hold down 
the Option key while you choose any font, 
size, style or color from the Text menu, 
and all the headings on the same level as 
the selected one change simultaneously. 
All the new headings have the new for­
matting, but local style overrides are 
preserved. 

7. In the Outline view, you can show only 
first-level subordinates of a heading and 
hide all deeper levels by holding down the 
Command key and double-clicking on 
the heading icon. Tore-expand the subor­
dinates of the heading, hold down the 
Option key and double-click on the head­
ing icon. 

Let Your Chart Data Go Through 
The Roof 

You can emphasize expanding sales 
figures by changing a chart's plot range so 
that the largest numbers literally go off 
the chart. Select the chart, and then 
choose Axes from the Chart menu and 

Value Axis Format from the submenu. 
When the dialog box appears, reduce the 
value for Plot Range Maximum. Now the 
longest bars (or highest points) will extend 
beyond the chart axes. 

POSTSCRIPT FILES 

Using ResEdit To Add A 
PostScript File Option To 
The Print Dialog 
Pressing Command-F after clicking on 
OK in the Laser Writer dialog box writes 
the PostScript output, minus the 
Laser Prep file, to a file. But some applica­
tions intercept this Command-F event, 
preventing the file from reaching the 
Laser Writer driver. Using ResEdit, you 
can place the PostScript File Option in 
the Print Dialog Box of the Laser Writer 
Driver. 

1. In ResEdit, open the copy of the 
LaserWriter driver, version 5.2 or 6.0, 
and select DITL from the list of resources. 

2. Using the Open as Template option 
(labeled Open As in earlier version of 
ResEdit), select DITI ID = -8191 to open 
it as a Dm resource. 

3. Find the Item for Disk File with a 
Display rect (display rectangle) ofO 0 0 0. 
Change the Display rect to 49 320 65 400. 
Save your changes, and exit from ResEdit. 

4. When the Laser Writer Print dialog box 
appears, you should see a new option 
called Disk File. Clicking on it results in 
the creation of a PostScript file of the out­
put called PostScriptO (or 1, 2, 3, and so 
on). This file will appear in your System 
Folder or in the Spool Folder within the 
System Folder. 
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5. To avoid confusion with other 
Laser Writer driver files on your hard disk, 
rename this altered driver. You'll have to 
select this driver from the Chooser to 
access it after you've changed its name. 

Postscript Flle From 
Laserwriter 7.0 
In Laser Writer 7 .0, the old trick of press­
ing Command-K or Command-Fat just 
the right instant to get a PostScript file no 
longer works. Instead, a new button in the 
print dialog offers "PostScript file" as an 
alternative destination to "Printer." 

Printing PostScript To Disk 
Under Multifinder 
Prior to System 7, one way of sending a 
PostScript file to disk is to hold down the 
Command and K keys immediately after 
clicking on the OK button in the Print 
dialog box. This approach works, unless 
you're using MultiFinder and have 
Background Printing enabled. If this is 
the case, your PostScript file will never 
be printed to disk. 

If you normally use both MultiFinder and 
Background Printing, don't despair- you 
can still print a PostScript file to disk. 
Here's what you need to do: 

1. Open the Chooser DA. 

2. Select your laser printer. 

3. Turn Background Printing off. 

4. Close the Chooser. 

Now, if you hold down the Command and 
K keys immediately after you click on OK 
in the Print dialog box, you'll see a box 
that says, "Now printing PostScript file." 
Don't forget to turn Background Printing 
back on when you've finished. 
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Sending A PostScript Flle To The 
Printer 

Once you have created a PostScript file on 
the Mac, you need an application or DA 
capable of sending the file to the printer. 
Adobe's Font Downloader can, in addi­
tion to manually downloading fonts, 
download PostScript files one at a time. 
CE Software's Widgets application or 
LaserStatus DA can download files one at 
a time or in batches. 

Font Downloader is included with Adobe 
fonts, and you can download it from the 
Adobe Forum on CompuServe. Widgets 
and laserStatus DA are bonus programs 
included with CE Software's excellent 
Finder-replacement DA, DiskTop. 

Printer Dialog Boxes-Selecting 
Specific Printers 

In some applications, such as 
QuarkXPress, PageMaker, FreeHand and 
Illustrator, the Print or Page Setup dialog 
boxes let you select a specific printer, such 
as aLaserWriter II, QMS PS-810 or 
Linotronic 300. Your printer choice 
affects the PostScript code that is sent to 
the printer and can occasionally limit the 
output quality. 

This is because when you choose a printer, 
the application uses a printer-description 
file to determine what information to send 
to the printer. Some descriptions are built 
into the application; others use separate 
printer-description files. These files are 
usually identified by a special filename 
extension, such as APD for Aldus applica­
tions, PDF for Quark programs and PPD 
for Adobe applications. The printer 
descriptions affect gray levels, page mar-l 
gins, and other factors- some permit , 
more versatility than others. 1 



It would be great if these descriptions were 
perfect, but thaes not always the case. If 
you suspect that the printer description is 
limiting the quality of your output, try 
telling your application that you are print­
ing to Linotronic 300, which is a high-end 
imagesetter. In many cases, this printer 
description gives the printer the ability to 
print the best-looking page instead of 
sending a restricted copy of the page's code. 

PRE PRESS 
Printing Spot-Color Components 
The advent of color electronic page make­
up has highlighted a problem that most 
software manufacturers have over looked. 
The problem occurs when you print a 
spot-color composite to a low-resolution 
(300 dpi) black-and-white printer for 
proofing. If you compose a document 
using spot-color components from a page 
layout program such as PageMaker or 
QuarkXPress and place color graphics 
from illustrator or FreeHand, the printer 
driver assigns a percentage of black to 
represent the differences between colors. 
This is fine for proofing a color break, but 
it makes copy on the page (and within 
graphics) very difficult to read. 
QuarkXPress offers the option of print­
ing colors as grays or in black-and-white, 
but this option has no effort on color EPS 
files placed on the page. 

Solution: Tell the printer to use a screen 
ruling too high for it to reproduce (150 
lines per inch, for example, for a 
Laser Writer or other 300-dpi device). 
When the page comes out of the printer, 
the tinted areas fill in to black. 

To achieve this effect in QuarkXPress, 

simply set the screen ruling in the Page 
Setup dialog box to the desired value. 

The process is more involved for 
PageMaker. You must open the APD 
(Adobe printer description) file for the 
appropriate printer and edit it with a 
word processor. Remember to save the 
APD file as a text file under a different 
name (LW II NTX composite.apd, for 
example) so the original remains 
unchanged. You need to locate the lines 
listed below and change the screen-fre­
quency values indicated in bold to the 
appropriate values: 

@ DefaultScreenFreq: "150" 
@ DefaultScreenAngle: "45" 
@DefaultScreenProc: "{dup mul 
exch dup mul add sqrt 1 exch sub}" 
@ ScreenFreq: "150" 
@ ScreenAngle: "'' 
@ScreenProc: '"' 
Remember, this procedure turns almost 
every percentage tint in a document to 
solid black, so it doesn't work in situa­
tions involving background tints, process 
color photos, or tint builds. 

QUARKXPRESS 
Booting With MacQuerty 

Version 3.0 ofQuarkXPress won't boot 
if you have your keyboard configured 
with MacQwerty, from Paragon 
Concepts, in the Dvorak layout. 

To get QuarkXPress 3.0 to work with 
MacQwerty's Dvorak keyboard, go to the 
Control Panel, choose keyboard, and 
select U.S. (this works only if you have 
installed MacQwerty). Close the Control 
Panel, and launch QuarkXPress. Go back 
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to the Control Panel, choose Keyboard, 
and select Dvorak. You can now type 
away in QuarkXPress without sacrificing 
the sanity provided by the Dvorak key­
board layout. 

Applying Two Style Sheets To 
A Paragraph 
QuarkXPress, like most other word pro­
cessing and page layout programs, doesn't 
let you mix two style sheets in the same 
paragraph. But let's take an example 
where your layout needs a hanging indent 
with New Century Schoolbook and num­
bers in Helvetica Bold. 

In this case, you might set up a format 
for the hanging indent in New Century 
Schoolbook and then painstakingly select 
and change the numbers to Helvetica 
Bold. 

A quicker way is to set up a style sheet for 
the hanging indent and a separate style 
sheet for the part number. Then instead of 
running the part number and the descrip­
tion together, as they will eventually 
appear, insert some unique combination 
of paragraph returns (and other characters 
if necessary) between the part number and 
the description so you can search for and 
replace it later. 

Select the entire text, and format it as a 
description (with hanging indents) by 
using your first style sheet. Now click on 
each of the part numbers and- with the 
function-key equivalents that 
QuarkXPress lets you assign to style 
sheets- format all the part numbers with 
their own style sheet. 

Now use QuarkXPress' Edit Find/Change 
menu option to replace your separator (in 
this case, two carriage returns) with spaces 
or whatever else you want to have between 
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the part number and the description. 

When you've finished, you'll see that the 
description and the part number each 
have their own style. QuarkXPress, 
unlike PageMaker and Word, doesn't 
store styles in the paragraph marker, so 
when you eliminate the paragraph marker 
between dissimilar styles, QuarkXPress 
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simply juxtaposes the styles rather than 
replacing one with the other. 

Because all formatting options in the style 
sheet remain with the text itself, you can 
have different fonts, styles, formats, and 
you-name-it, and QuarkXPress will pre­
serve them. 

QUARKXPRESS 2.0 
Improving The Printed Look Of , 
AppleScanned Art 

There's a problem with the way 
QuarkXPress handles line art saved as 
Pier files in AppleScan. An AppleScan 
Pier file placed into QuarkXPress looks 
fine on-screen, but prints out terribly with 
the Laser Writer. If you import the same file 
in the TIFF format, QuarkXPress auto­
matically assigns a halftone screen value to 
the line art, which ruins its clarity. 

A solution not documented in the manual 
is to save the line art in the TIFF format in 
AppleScan, then to hold down the 
Command key when selecting the file in 
QuarkXPress, using the Get Picture com­
mand. Doing this imports the file as non­
halftoned line art. Now you can take 
advantage of nearly all the options on the 
Style menu, such as Negative, Contrast, 
and others which are not available for any 
graphics imported as Pier files. [ 



Wrapping Text Around 
AppleScanned Images 
When irregularly shaped pictures are 
scanned with AppleScan and then import­
ed into Quark.XPress, it is usually impos­
sible to use the automatic text-wrap fea­
tures. When text is wrapped around the 
imported graphic, it wraps only around 
the shape of the graphic box. 

Here's a solution that allows you to wrap 
text around an irregularly shaped image 
imported from AppleScan: 

While in AppleScan, select the irregular­
ly shaped object using the Lasso tool. 
After the object is selected, AppleScan 
gives you the option to Save Selection As 
in the File menu. Save your image as a 
TIFF file so that it can be imported into 
QuarkXPress. 

After you've imported the TIFF file, you 
can go through the normal steps to create 
a wraparound. The text will wrap per­
fectly around the shape of your object, 
and if you put the object into a rectangle 
picture box you can set the Text Outset 
to anything you want. 

QUARKXPRESS 2.1 

Circumventing Quark's 500-Point 
Font-Size Limit 
Here is a quick and dirty way to circum­
vent QuarkXPress' 500-point font-size 
limit and create some beautiful text effects: 

1. Using QuarkXPress 2.1, with its new 
font-rendering extension, set the Render 
Limit command (on the Utilities menu) 
to a relatively low number, such as 48 
points. 

2. Select an unencrypted (Type 3) down­
loadable PostScript font or one of the 
Bitstream fonts that are distributed with 
QuarkXPress. 

3. Choose the largest point size that fits in 
your window. A 500-point character, 
which is the maximum size that 
QuarkXPress allows, usually fits on a 
13-inch Apple color monitor. 

4. Use the Fkey Command-Shift-3 to 
take a screen dump of this single letter 
(you may want to open the MacPaint file 
and erase everything except the letter). 
You can then use that file as a template 
for Illustrator 88 or FreeHand to 
auto-trace. 

You will find that you can create an 
outline object that is nearly indistin­
guishable from the original. You can 
then scale it beyond QuarkXPress' 500-
point limit, use Illustrator's blend tool, 
and manipulate it in ways that you 
cannot manipulate normal text. 

Recovering The Text From A 
Corrupted Document 
If you get a Bad File Format error when 
you're attempting to open a Quark.XPress 
3.0 document, the document is history. 
You can, however, recover most of the text 
in the file by using the Open Any File 
command in Microsoft Word 4.0. Access 
this command by holding down the Shift 
key as you pull down the File menu (you 
can also add this command to the menu 
by using the Commands item on the Edit 
menu). The text may be somewhat scram­
bled and there will be some garbage in the 
file; however, if you need the text, you are 
in luck. 
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QUARKXPRESS 3.0 

Importing Word's Fast Saved 
Documents 

Here,s a quick tip on importing Word 4.0 
documents with style sheets into 
QuarkXPress. When you import text by 
using the Include Style Sheets option and 
the Word document,s styles have the same 
names as those in the QuarkXPress docu­
ment (for example, Body Text), the 
QuarkXPress styles should override the 
Word styles. However, this won't work con­
sistently if you've saved your Word text 
with the default Fast Save option- only 
some formatting will take effect. To make 
sure the QuarkXPress styles do override all 
the Word styles, use the Save As command 
when saving your documents in Word. You 
can also use the Commands option from the 
Edit menu to add the Fast Save Enabled 
command to a menu. This lets you toggle 
Fast Save on or off as you need it. 

Creating Crop Marks For 
Consolidated. Jobs 
If you're outputting files at a service 
bureau that charges per page, you can 
consolidate space and reduce costs by 
combining several small jobs such as 
business cards onto a larger page. 
However, because you are putting several 
separate documents onto one page, you 
can,t use QuarkX.Press' automatic-crop­
marks feature. Here is the best way I've 
found to quickly create accurate crop 
marks for each document on a page: 

1. Draw a text box within a letter- or 
tabloid-sized page, and give it a white fill 
with no runaround. 
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2. Select the box, and make it the size of 
the document you want (for example, a 2~ 
x-3 business card), using the Modify com­
mand from the Item menu or the 
Measurements palette. 

3. Draw two lines with a 0.25-point line 
weight. One should be horizontal, 
butting the top of the box, and the other; 
should be vertical, butting the left side df 
the box. Both lines should extend about 
114 to 112 inch beyond the box at both 
ends. 

4. Duplicate each line, and drag it to the, 
opposite side. 

5. Now drag the zero ruler guide to the 
top left corner of the text box, and drag 

1 

the corner to resize the box so that it is 118 
inch larger than it was at the top and left~ 
Drag the ruler guide to the bottom right 
comer, and extend the box likewise to the 
right and bottom. With the box still 
selected, bring it to the front, using the 
Item menu. 

6. Create a descriptive title if necessary 
(for example, "My business card- shoot @ 

100%,), and place it appropriately. Select 
all items, and group them. If you want to 
save this as a template for future use, drag 
a copy of it to a library. 

7. Now drag the grouped item to an 
appropriate place on the page, and add 
any ruler guides as necessary. Continue 
adding other items to the page as desired. 

Accessing The Environment Box 
QuarkXPress 3.0 can provide you with 
useful information about your system 
configuration in its Environment dialog 
box. You access it by holding down the 

1

, 

Option key when you choose About 
QuarkXPress from the Apple menu. But 



if you use QuicKeys 2 or Suitcase II, you 
can run into problems, because those pro­
grams use the Option key to modify 
menus. Quark suggests that you change 
this menu-modifier key, but if you have an 
Apple Extended Keyboard, you don't 
have to. Hold down the Option and Help 
keys, and the QuarkXPress Environment 
dialog box is all yours. 

Creating Real Fractions 

QuarkXPress 3.0's in-line-graphics and 
paragraph-rule capabilities give you an 
easy way to create real fractions (placed 
top over bottom, not diagonally as in the 
QuarkFreebies extensions). In-line text 
boxes are simple to manipulate. 

First create your standard text, leaving 
markers where you want the fractions to 
be. Then create a new text box on the 
pasteboard, making sure that the text 
inset for this box is set to 0. Create a frac­
tion by typing the numerator, pressing 
Return, and then typing the denominator. 
The point size of the fraction should be 1 
to 3 points smaller than the body text. Set 
the alignment to center. 

Highlight the first line, and create a para­
graph rule (using the Style menu). A hair­
line rule based on the indents works well 
with numbers greater than 9, but you can 
use the text setting for fractions that con­
tain only a single digit top and bottom. 

Make sure the text box is as small as possi­
ble without losing any type, and then 
click on the text box with the item-selec­
tor tool and copy it. Using the editing 
tool, paste this box into the body text 
where you want the fraction to be. Use the 
Baseline Shift command in negative 
increments to bring the fraction down to 
the level you like. Use the kerning com-

mand on the Measurements palette to 
adjust the word spacing. 

For small body text, you may find that the 
in-line text box has too much white space 
to the right and that even kerning does 
not help. The only solution is to use the 
text box as a free-floating graphic. Just 
make sure that if you edit the body text, 
you also reposition the fractions, if neces­
sary. Once you've created a fraction this 
way, you can create others by copying and 
pasting the original fraction into new 
positions and changing the numbers. 

Creating A Large Letter With 
Nested Text 
If you've ever wanted to create a word 
with a large initial letter and the other let­
ters nested inside it, you can do it in 
QuarkXPress 3 .0. The following steps 
will help you create this effect: 

1. Type the first letter in a large 
font size. 

2. Type the rest of the word in a smaller 
point size. 

3. Select the smaller letters, and move the 
baseline up until it is in the middle of the 
opening of the letter (an example of this is 
the word Cats, where the C is the large let­
ter and ats are the letters nested in the C). 

4. Select the large and small letters, and 
modify the tracking until the small letters 
are nested inside the large letter. 

5. Select the small letters, and reset the 
tracking to 0. 

Although you can achieve the same effect 
by using two text boxes and placing one 
inside the other, this method is easier, 
because you don't have to worry about 
grouping text boxes or making boxes 
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transparent. It's also a lot easier to rear­
range and copy. 

READY, SET, GO! 3.0 

Wrapping Text Around Text 
It's possible to wrap text around other text. 
J usc choose Specifications from the Special 
menu and pick "run around." The result­
ing text can wrap around the text block 
just the way it works for a picture. 

Viewing A Page At The Text Block 
Insertion Point 
Using Command-1 to Command-5 to 
view a page can be annoying, since you 
always see the upper left comer of a page. 
To work around this, while the text tool is 
activated, click and hold the mouse button 
with the cursor in the text block you want 
to zoom to. Still holding down the button, 
hit the Command key to zoom to any fac­
tor. When you release the mouse button, 
the view will shift to show the insertion 
point in your text block. 

You Can Only Import 32K 
Documents Or Smaller 
If you're importing a complex PostScript 
document, check the size of the file first. It 
has to be 32K or less to import properly, 
since Ready, Set, Go! 3.0 is limited to 
32K text blocks. Importing longer docu­
ments may be courting trouble, so break 
large files down into smaller ones before 
entering Ready, Set, Go! 

Use The Program's Drawing 
Tools To Save Printing Time 
Although Ready, Set, Go! is usually excel­
lent at importing 300 DPI graphics, try 
to make do with the drawing tools includ­
ed in the program if your needs aren't too 
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complex. It saves considerable time when 
you print out the page. You'll find you can 
create some pretty elaborate logos with 
imaginative use of the fill patterns and 
shapes, and your page will print almost as 
fast as a text-only document. 

Bypassing The Get Picture 
Routine With The Clipboard 

Although most people copy graphics from 
files using the Get Picture routine, you 
can skip a step by passing the image 
through the Clipboard instead. If you 
work with a drawing or painting program 
and Ready, Set, Go! under Switcher, cut 
the image to the Clipboard, switch to 
RSG, use the cropping tool to prepare th~ 
target graphics block, and then Paste. 1 

You'll still have the same control over the 
image as if you had imported it in 1 

through Get Picture. 

Unk Text Blocks In Exact Order, 
Page By Page 

When linking text blocks together, make 
sure to link them in the exact order, page 
by page. The program won't assume that 
you want the blocks linked in numerical 
page order, but instead will take your 
commands literally. If you try to link up 
the blocks from front to back, the results 
will be a real mess. 

Using ResEdit To Recover A Lost 
Application Icon 
Sometimes Ready, Set, Go! 3.0 loses its 
application icon, which can result in a 
"Couldn't find the application" error 
when you try to open a Ready, Set, Go! 
document. If you have a copy ofResEdit, 
here's a fix to try: 

On a backup ofReady, Set, Go! 3.0, laun£h 
ResEdit and select the Ready, Set, Go! 3 .p 



application. Choose Get Info from the File 
menu and click on the bundle box to turn 
it on. Then close the window and save the 
changes. (Setting the bundle bit in an 
application specifies that the application 
"owns" documents and that it has its own 
individual icon.) 

Now, double-click on the Ready, Set, Go! 
3.0 application to open it and show its 
resources. Select NEW from the File 
menu and enter a new resource type of 
MRSN (all caps). A blank MRSN window 
opens immediately. Choose NEW again 
from the file menu and enter the follow­
ing at the insertion point: OB 56 65 72 73 
69 6F 6E 20 33 2E 30. 

Now close the window, and you'll notice 
how the only listing in the MRSN win­
dow is highlighted. Choose Get Info from 
the File menu and change the ID name to 
zero. Finally, quit ResEdit and save the 
changes made to the Ready, Set, Go! back­
up. Now, just reboot the backup, and 
you're ready to work again. 

READY, SET, GO! 4.0 
Stretching Text Easily 

There's a quick and easy way to stretch 
text as tall or as wide as you want. Start 
with a text block and type in the desired 
text. Then draw out a picture block to the 
size of the end product. If, for example, 
you want the text to come out half as wide 
and four times as tall, create the picture 
block in that size. 

Select the text block to be stretched by 
clicking on it, then Cut or Copy it. Now, 
ready the picture block as if it were to 
receive clip art, and then Paste the text 
into the block. Select the Picture block, 

choose Specifications (Command-M), and 
use the Scale Across and Scale Down func­
tions to stretch the text accordingly. The 
stretched text will now appear as you 
want it. 

Wrapping Text Within Two 
Graphics 
It's possible to wrap text within two 
graphics to create interesting paragraph 
shapes like circles, triangles, or just about 
any shape you can imagine. Here's how: 

Draw the shape that you want the text to 
conform to with a graphics program like 
MacDraw. The trick is to draw it in two 
halves (such as two half-moons that 
together would form a circle). Copy and 
Paste each half of the drawing separately 
into the Scrapbook. 

Now, boot RSG! 4.0 and create two 
graphic blocks large enough to accommo­
date your drawings. Make sure they butt 
up against each other. Then, paste your 
two graphics into these graphic frames­
the left half into the left block, and the 
right half into the right one. The two 
halves should now resemble the graphic 
shape you want. Invoke the Specifications 
box (Command-M) for each graphic block 
and click Don't Print and Runaround 
Graphic (instead of Runaround Frame). 

Then, create one text block as large as the 
two graphic blocks. Make sure the text 
block lies directly on top and covers these 
blocks. Put your insertion point in the 
text block and start typing or import a 
text file. The resulting text will take on 
the shape you created with the two 
graphics. Use justified text if you want 
the text to conform exact! y to the shape 
you've created. And set text repel dis­
tance to zero. 
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If you have problems getting the text to 
flow correctly into the shape, try drawing 
nonprinting lines above and below your 
graphic. 

READY, SET, GO! 4.5 
Using Ready, Set, Go! To Produce 
Gray-Scale Characters 
An undocumented feature of this pro­
gram is its ability to produce gray-scale 
characters. Just make text different colors 
and print without the Color Separation 
option checked to get gray-scale charac­
ters when you print on a PostScript­
compatible printer. 

Getting Rid Of Unwanted 
Characters In Imported Text Flles 
You may need to import a text file into 
RSG 4. 5 that displays unwanted or 
unknown characters on-screen. Files trans­
ferred from other computers or download­
ed from bulletin boards often contain such 
characters, as do files from non-Macintosh 
operating systems. These unwanted char­
acters often appear as little boxes. 

You can get rid of these characters by 
using the Replace command. Select the 
offending box or symbol by highlighting 
it. When you select Replace, the character 
is automatically pasted into the Find box 
in the dialog box. Move the cursor to the 
Change To box and press Option-D and 
then R (this specifies that you want the 
replacement character to be a carriage 
return; or you can replace the non printing 
characters with a space or with nothing at 
all). When you click OK, all your 
unwanted characters will be deleted. 
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Increasing And Decreasing Text 
Point Size From The Keyboard 
You can increase and decrease the point 
size of your text right from the keyboard. 
Select the text whose point size you want 
to alter. Press Command-> (greater than) 
to increase the text size one point at a 
time; press Command-< to decrease the 1 

size by one point. • 

Shortcut When Jumping Around 
View Levels 

This shortcut makes it much easier to 
jump to a specific spot on the page when 
you change view levels in Ready, Set, Go! 
4.5a. 

If you find yourself at the Size To Fit view 
and you need to zero in on a text or grap~ 
ic element at the Actual Size view, just 

1 

hold down the Command and Option 
keys while clicking on a text element with 
the I-beam or on a graphic element with 
the pointer arrow. You will automatically 
switch to the Actual Size view. 

Underlining Text Selected 
As Italic 
Underlining text that has been selected as 
italic from the Style menu can be tricky in 
Ready, Set, Go! 

If you are like most users, you double­
click on words to select them and then 
make style changes. However, as with 
most word processors, double-clicking 
on a word in Ready, Set, Go! selects both 
the word and the space after it. If this 
word is then underlined, for example, 
the space following the word will also be 
underlined. 

You can eliminate this problem by siml 
ply pressing the Command key when , 
double-clicking on the word. This 



ensures that the space after the selected 
word will not be selected too. 

SUDES 

What Printer Driver To Use? 

If you're creating files to be imaged by 
Autographix or Genigraphics centers, it's 
wise to use their proprietary printer 
drivers (Mac Chooser documents) when 
you create slides. These printer drivers are 
included in some presentation packages. 
PowerPoint includes a copy of the 
Genigraphics driver, for example, and 
Persuasion includes the Autographix 
driver. 

If your software doesn't include one of 
these drivers and you want to use an 
Autographix or Genigraphics center, you 
can probably get the correct driver from 
the imaging center for a fee that is usually 
deducted from the cost of your first slide 
order. These drivers work with all presen­
tation programs, so you're not locked into 
using one of the name-brand services if it 
would be more convenient to use another. 
Also note that the driver you use has no 
effect on the quality of your slides. 

Select The Printer Driver Before 
Creating Slldes 
If your software includes a special driver 
for writing slide files to disk, always go to 
the Chooser and select it before launching 
the program. Converting from another 
format is always more difficult than work­
ing in slide format from the outset. 

Avoid Side-to-Side Or Diagonal 
Blends 
Film recorders are raster devices, which 
write images in horizontal lines. 

Although your presentation software 
may make it easy for you to create ramps 
of graduated color that change in inten­
sity from left to right or even diagonally, 
the film recorder can take a long time to 
image such a slide. A ramp that changes 
from top to bottom, on the other hand, 
can run efficiently. (This doesn't mean you 
can't have a diagonal blend if you need it, 
just that it carries a price -literally, if your 
service bureau charges extra for slides that 
take more than a minute or two to image.) 

Test Your Files Before Running 
An Important Job 
Create a small file containing the types of 
slides you normally use- word slides, pie 
charts, diagrams, and so on- and send 
them to any imaging center you're think­
ing of using. This is also a good way to 
determine which format you prefer to 
work with. 

Keep It Simple When In A Rush 
When doing a rush job, use only Times or 
Helvetica. Film recorders are less likely to 
have problems with these basic fonts. 

SMARTFORM 
DESIGNER AND 
ASSISTANT 
Creating U.S. Government Forms 
SmartForm Designer is a full-featured 
forms-design manager, which includes 
SmartForm Assistant for filling out forms 
when the design is complete. The U.S. 
government allows programs such as 
MacinTax and Turbo Tax to use IRS tax 
forms, so if you are interested in creating 
the Standard Employment Forms, you can 
use Claris' SmartForm Assistant, and 
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Claris' customer support (408 727 -8227) 
can provide you with a copy of the U.S. 
Government Standard Employment Form 
171 to use with it. 

TRUETYPE 
Between Troe And Timbuktu 
Apple's True Type Startup document 
(INIT) doesn't get along with Farallon 
Computing Inc.'s Timbuktu INIT. To 
resolve the conflict, just rename 
Timbuktu so it loads after True Type. (You 
probably would have done that anyway.) 

A far more obscure incompatibility exists 
between ffiM's Model8209 token-ring 
to Ethernet bridge and AppleTalk itself. 
According to Apple, Macs on either side 
of this media-access control bridge can­
not communicate, because IBM's blind 
bit-pusher doesn't get the difference 
between Token Talk and EtherTalk and 
trashes AppleTalk packets in transit. 

TYPE 1 FONTS 
What's The Difference Between 
Type 1 And Type 3 PostScript 
Fonts? 
Type 3 fonts used to be Adobe Systems 
Inc.'s public font format; the specification 
was published and available to anyone. 
Type 1 fonts were proprietary; Adobe kept 
the format secret. These font files were 
encrypted also. The main difference 
between the two formats is that the algo­
rithm used to fill in the letter outlines in 
Type 3 fonts is inferior to the algorithm in 
Type 1 fonts. So Type 3 fonts tend to look 
darker than Type 1 fonts, especially at 
small point sizes on low-resolution print-
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ers. While seemingly trivial, this type of 
thing drives graphic artists bonkers. 

The situation changed when Apple and 
Microsoft Corp. announced True Type out­
line fonts. This formidable alliance 
prompted Adobe to make the Type 1 
specification public, so now everyone can 
create Type 1 fonts. Furthermore, Adobe 
Type Manager uses only Type 1 fonts so 

1 

that's the only format customers want 
these days. 

For those interested in such trivia, Type 4 
fonts are those built into the ROMs on 
PostScript printers, and there is no Type 2. 

ZAPF DINGBATS 
Creating A Simple Square With 
ZapfDingbats 
ZapfDingbats, a PostScript font, has 
some startling omissions. One is the sim­
ple square. There are shaded boxes and 
an all-black one, but no simple square 
exists. The solution is to use the black 
box in the Outline style. 

Breaking Away From Bullets 
To get rid of those boring Option-S bul­
lets, use ZapfDingbat characters such as a 
tiny triangle, V (press T), or a diamond, V 
(press U). To make these bullets subtler, 
raise their placement above the baseline 
by superscripting them. 

Left Out 

In Dingbats, virtually everything points 
to the right. If you would like to point to 
the left, you are stuck with the pedestrian 
arrows from the Symbol font. Here is a 
solution. 



Convert the ding bat of your choice, say 
the pointing hand, to a graphic and then 
flip it. Using a graphics program such as 
Canvas or Cricket Draw, you can do this 
quite easily. Since PostScript doesn't care 
which way a font character points, the 
graphic still prints at the maximum reso­
lution of the printer. 

Untypeables 
There are three font characters that can­
not be typed from the Macintosh key­
board. They correspond to ASCII num­
bers 252,253 and 254. In the Dingbats 
font the missing characters are three types 
of arrows. The font has more than enough 
arrows already, but if you're determined to 
access the three missing arrows, use 
Word's Character Code command, 
Command-Option-Q. You can then type 
in the ASCII number of the character you 
want. When you press Return, the desired 
character will appear. Using this tech­
nique, you can copy the untypeable 
arrows into the Scrapbook for later use in 
any application (and in any font). 

Missing In Action 
Eventually you will need a dingbat that is 
not in the Zapf collection. What to do 
then? You can buy Adobe Collector's 
Edition I, which contains 280 PostScript 
shapes: circles, squares, crosses, arrows, 
stars, and so on. They can be used as is or 
enhanced in FreeHand or Illustrator. You 
can get this $12 5 collection from Adobe 
Systems, Box 7900, Mountain View, CA 
94039; (800) 344-8335. 

Another possibility is a shareware 
PostScript font called Bill's Dingbats. It 
has 138 dingbats, including arrows that 
point in eight directions. This $8 font is 

available from U-Design, 201 Ann St., 
Hartford, CT 06103; (203) 278-3648. 

If that doesn't help, start looking 
through the numerous available picture 
fonts, such as Cairo and Mobile. Many 
are freeware of shareware and are avail­
able through most on-line services. 

Drawing A Dingbat Yourself 
If you really cannot find the appropriate 
ding bat, draw the ding bat yourself. A 
utility called Art Importer (a.k.a. 
Key Master) lets you create an installable 
PostScript font containing EPSF and 
PICT graphics. The resulting graphic 
characters can be typed like letters in any 
other font. This $99.95 program is avail­
able from Altsys, 720 Avenue F, Suite 
109, Plano, TX 75074; (214) 424-4888. 

Creating A Plain, Empty Box 
You can get a plain empty box- to indi­
cate the Macintosh's no-character symbol 
or for such uses as a check box- with a 
word processor or desktop publishing 
program such as Word, QuarkXPress, or 
PageMaker. The ZapfDingbat font has 
shadowed and filled boxes, but not 
empty ones. 

To create an empty box, type a lowercase 
n. Select the character and then choose 
ZapfDingbats from the Font menu and 
Outline from the Format menu. Voila! 
An empty box. If you want a box with a 
heavier border, make the character bold 
as well as outlined. 

You can make the box any point size, but 
if you want it to appear the same size as 
the text you're working with, make the 
box a point size or two smaller. For 
example, if your text is 11 points, the 
box should be 9 points; if you have 9-
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point text, you should make the box 8 
points. Otherwise, the box appears to be 
slightly larger than the surrounding text. 

ENTERTAINMENT 

DARK CASTLE 
Tracking How Many Times 
You've Won In A Session 
If you're expert enough, you can track 
how many times you've toppled the 
throne. While typing your name into the 
Hall of Fame, type Option with any other 
key. This creates a Dark Castle symbol. 
Use the number of castle symbols to rep­
resent how many times you've finished 
the mission. 

Keeping Your Shield Activated 
The shield usually lasts only about 3 sec­
onds. You can keep wearing it indefinitely, 
though. When you activate your shield, 
hold down the key for about 2 112 seconds. 
Then, at the last moment, release the key 
and press it again quickly. Experiment 
with this to pick up the rhythm. 

How To Walk On Air 
It's possible to make your on-screen hero 
literally walk on air. Press the duck key 
with either the up or down key as you go 
up or down a staircase or ladder. When 
you reach the top or bottom, your charac­
ter will seem to be walking on air. Once 
there, experiment with different com­
mands to get some entertaining results. 

Express Route To The Trouble 
Room 

The easiest way to get to the Trouble 
Room is to push Door# 3. You'll go to the 
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Black Knight's first chamber. If you wait, 
the platform will slip out from under­
neath you, dropping your character down 
to Trouble #3, saving you the trip 
through the first two rooms, and possibly 
saving a few game lives as well. 

MACGOLF 
Putt Like A Pro 

When you're on the putting green, make 
sure the wind is at zero. Then face away 
from the hold, and place the swing indica­
tor at zero. Click once on the Up arrow 
and putt, recording how far the putt goes. 
Now, do the same thing again, except this 
time, click twice in the swing indicator's; 
Up arrow. Keep doing this, adding one j 

click each time, until you reach a full- · 
strength putt. This helps you figure out 
how many clicks you need to do to get the 
ball to move different distances. 

SHADOW GATE 
Use The Note Pad To Keep Track 
Of Clues 
The Note Pad DA is useful for keeping 
notes handy. Just jot them on the Note 
Pad and you can refer to them whenever 
you need to. 

Don't Ignite Torches Without 
Examining Them 
There's a special torch you need to get 
through a certain section of the game. 
Examine all torches you find before light­
ing them, and save the one that looks dif­
ferent for a special situation. 



Surviving The Dragon's Lair 

You need several items located in the 
dragon's lair. To retrieve them with your 
hide intact, grab the shield first. You then 
have three more times to take more things 
(like weapons) before the shield melts 
under the dragon fire. 

Let Randomization Work In Your 
Favor 
The Sphinx asks you for a certain item, 
couched in the form of a riddle, when you 
enter the room it inhabits. However, the 
exact item it asks for is randomly-generat­
ed. To increase your chances of having the 
item the Sphinx wants in your possession 
(or at least, know where to find it), save 
the game just before entering the room. If 
the Sphinx asks for an item you haven't 
located, just Quit and start again for a 
chance at better luck. 

SHANGHAI 

Remove Tlles When You Can See 
All Four Of Them 
While you can't really cheat at Shanghai, 
you can vastly improve your chances for 
winning by trying not to remove any sets 
of tiles unless all four matches are showing. 
This guarantees that you aren't inadver­
tently trapping a tile under its only match. 

SIMCITY 

Bringing A Village To Metropolis 
Status 
Here's a slick way to bring a SimCity 
village to metropolis status within five 
years- a maneuver that should delight 
even the most jaded politico. 

Set the tax rate down to 0 percent, start­
ing with the January Budget Report that 
automatically flashes on the screen each 
year. Sims will flock to your apparently 
tax-free village. 

Leave the tax rate at this setting until 
December rolls around. When it does, 
select Budget from the Windows menu 
(or press Command-B) and set the tax rate 
to the highest allowable level, which is 
20 percent. 

When the January Budget Report 
appears, you'll see a sudden influx of cash 
for your coffers. Now set the tax rate to 0 
and wait until December- when you 
again set it back to 20 percent. 

If you keep your eyes on the calendar, you 
will generate enough tax revenues this 
way so that you'll never have to embezzle 
funds again! And the Sims, who never 
seem to catch on to the devious ways of 
the mayor, just keep on moving in. 

If you think taxes aren't enough, try 
SimCity's giant reptile! 

SIMCITY 1.0 

Collecting All The Taxes You're 
Owed 

SimCity has an annoying habit of reset­
ting the tax rate to zero when you load a 
saved city. If you save and quit from the 
loaded city mid-year, you'll find that 
when January rolls around, several 
months have gone by with no taxes being 
collected. This can devastate a city already 
on the brink of financial disaster! 

To avoid any loss of funds when you 
restart a game, immediately call up the 
Budget window and enter the tax rate. 
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Printing Cities With The 
Laser Writer 
The game manual and Print dialog box 
warn that Laser Writer printing isn't sup­
ported, but that's not entirely true. The 
Laser Writer can indeed produce (limited) 
printouts from the game. 

When you choose Print City from the File 
menu, you're offered two choices: print all 
on one page (this produces a reduced city 
map without fine detail) or print a tiled 
map (2-by-3 pages in size which displays 
buildings, roads and other fine details). 

If you print to a Laser Writer, the 1-page 
map prints out just fine. Choosing the 
tiled map produces the first section or 
page of the map, but the remaining 5 
pages must be printed with an 
Image Writer. 

STRATEGIC 
CONQUEST PLUS 
Attack On Each Move 

Don't limit fighters to two attacks per 
round. Use the Move Later command 
after each attack to attack on each move. 
This works for all water pieces as well. 

Regaining Full Naval Strength 

Carriers and battleships can safely regain 
their full strength if you put them into 
port for repairs and then use Move Later 
until they're fixed. 

Keeping Fighters Out Of Combat 
You can protect fighters from attack by 
leaving them in an empty enemy city. 
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When To Bulld Bombers 
Start building bombers on day 30 to get a 
blast radius of 1. For a blast radius of2, 
start on day 65. 

Stealth Bombers On The Cheap 
You can hide bombers by placing them on 
the same square as any other piece. 

TETRIS 
When It Gets Tight, Shift To The 
Right 
When pieces are falling rapidly and you 
can't find a spot for them, shift them over 
to the right. Most pieces fall slightly to 
the left (one tile towards the left), so 1 

shifting to the right will give you some l 
space when the next piece falls. · 

GRAPHICS AND DESIGN 

ADOBE ILWSTRATOR· 
Undoing A Move Even After 
Disabling "Undo Move" 
There's a helpful way to Undo an acciden­
tal move, even if you've already clicked 
the mouse button and so lost the opportU­
nity to Undo Move from the Edit menu. 
First, make sure that the same anchor 
points are still selected - if they're not, 
select the object. 

Now, hold down the Option key as you 
click the Pointer tool. The Move dialog 
box will appear, showing a positive value 
beside "Move distance." This value repre­
sents the distance in points of the LAST 1 

MOVE YOU MADE. All you have to do 
is make that value negative by inserting a 



minus sign in front of the positive num­
ber, and then click OK. Your anchor 
points will slink right back to where they 
were before you made the "wrong" move. 

Creating A Smooth Graduated Fill 
With The Blend Tool 
There are some tricks to getting nice, 
smooth graduated fills in Illustrator using 
the blend tool. If you are not careful, you 
can produce what looks like a banding 
effect in going from step to step in the 
graduation. You can specify more blend­
ing steps so the difference between one 
step and the other becomes more difficult 
to notice, but there are a couple of draw­
backs to this ploy. It makes for a huge file 
that takes insanely long to print and it 
may also cause your printer to freeze for 
lack of memory. Also, PostScript imposes 
a limit of256 steps on a fill, so at some 
point in a certain job, it may become clear 
that simply increasing the number of 
steps may not be the best solution. 

A better solution is to tweak the screen 
frequency (lines per inch) that the printer 
uses in printing the image. Lines per inch 
has a direct effect on the appearance of 
graduated fills. The higher the screen fre­
quency, the fewer shades of gray the print­
er can generate. Therefore, a high lpi can 
lead to savage banding no matter how 
many steps you've used in the fill! 
Lowering the screen frequency generally 
yields smoother-looking blends, but it can 
give the image a coarse appearance. 

Layering Graphics Higher-But 
Not At The Top 
You probably already know how to take 
an object low in the painting order and 
bring it to the front of everything else. 
However, there will probably be times 

when you wish you could bring the 
graphic forward, but not all the way to the 
top, as if removing a playing card from a 
deck and inserting it several cards away 
from the top. If you cut the object and 
paste it in front, then you'll have to select 
all the other objects that are supposed to 
be in front of it, and then move them in 
front to achieve the proper layering. 

Sounds complicated, and it is. However, 
there is a simpler way: 

Select the object that you want to bring 
forward, together with the forward object 
you want to move the first object directly 
behind. Group them while they're both 
selected by pressing Command-G. That's 
it! You don't have to cut and paste, and 
even if you Ungroup them, the layering 
change is preserved. The front-most 
objects can be left alone, with no editing 
at all. 

Moving Or Copying Objects In 
The Review Mode 
Althugh the Adobe Illustrator manual 
states that the current art file can't be deit­
ed in the Preview mode, there are some 
ways around that. You can move and copy 
objects in the Preview mode by using the 
Move dialog box. 

Select the object you want to move or copy, 
and enter the Preview mode. While there, 
hold down Option while clicking in the 
toolbox to call up the Move dialog box. 
Now, just enter the distance and/or angle 
data you want and click OK (or Copy). 
The object will move or duplicate imme­
diately and you'll be able to see exactly 
how this adjustment will affect your print­
ed copy. You'll find this very useful in 
making changes to aspects of the illustra­
tion that you can only see during Preview. 
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ADOBE ILLUSTRATOR 
88 

Quickly Canceling Preview 
Illustration Saves Time 
You can cancel Preview Illustration by 
typing Command-period. This is useful 
if you're using patterns or color and the 
pan you wanted to check has already 
been previewed, since it can take several 
minutes for the entire illustration to pre­
view fully. 

Working Around Text Elements 
Illustrator 88 has problems creating text 
elements such as tabs or leaders. You can 
type in a row of periods, but trying to cre­
ate leaders for a simple list of of products 
and prices, for instance, is time-consum­
ing. Stretching or shrinking the row to fit 
a specific width distorts it. One solution is 
to create a dashed line. 

1. Draw a line with the pen tool. 

2. Press Command-I to bring up the Paint 
dialog box. 

3. Choose None for the Fill, and Black 
100 percent for the Stroke. Enter a line 
weight (the default is 1 point), select the 
second choice for Caps, click on the 
Dashed button, and enter 0 in the first 
Dash Pattern box (contstraining your 
dashes to be perfect circles or dots) and a 
number to specify the space (in points) 
between your dots. 

4. To see your changes on screen, go to the 
Preview Illustration view. (Clicking on 
OK takes you back to the Artwork Only 
view, but you won't see the dashed line 
you just created.) 
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5. To modify the line, go back to the 
Artwork Only view. You can resize this 
line with the Scale tool so that it fits in any 
width without distortion. 

Extracting Wustrator 88 Graphics 
From PageMaker Files 
Extracting Illustrator 88 graphics from 
PageMaker files can be done as follows: 

1. Open the PageMaker document, choose 
Print from the File menu, hold down the 
Option key, and click on the OK button in 
the Print dialog box to bring up the 
PostScript Options dilog box. 

2. Turn off the Download bitmap fonts, 
Download PostScript fonts, and Include 
Aldus Prep options. Name the file to malfe 
finding the PostScript file easier; otherwife 
it will be called PostScriptO (1, 2, 3 and so 
on). Save the file either as EPSF or as 
Normal. Click on the Print button, and 
close PageMaker. 

3.0pen the resulting PostScript file with 
Illustrator 88. Illustrator recognizes only 
the PostScript code that corresponds to its 
file, and when the PostScript file is explitly 
saved from within Illustrator, only that 
code is saved. 

A voicing Cycling Through Layers 
When using Adobe illustrator 88, you can 
easily become frustrated with having to 
cycle repeatedly through layers of graphics 
objects to get to an object at the back of an 
illustration. This is especially true when 
you use the masking feature. You can 
avoid this frustration by creating 
identifiers, or "handles", for the objects in 
your multi-layered illustration. 

Start by creating a short, straight line : 
with the pen tool. Set its fill and stroke t<) 
None on the Style menu, and group it. ' 



This is one of your handles. Make several 
copies, and set them aside. As your work 
progresses, group the object(s) in a layer 
and move one of the handles you've creat­
ed toward the perimeter of the illustra­
tion. Group the handle to the object. 
Now, no matter where the object occurs in 
the layering of the illustration, you can 
select it quickly and easily. If you move an 
object away from the illustration, using 
its handle to make adjustments to any of 
its attributes (size, shape, fill, or stroke), 
you can return it to its position in the 
illustration, after regrouping, without los­
ing its layered position. 

For further clarity, you may wish to 
describe the attributes of an object in a 
layer, especially if objects in different lay­
ers are identical. When you create your 
first handle, create some dummy text and 
place it underneath the handle. Do not 
group the text to the handle at this point, 
but remember to set the fill and stroke of 
both handle and text to None. Select the 
handle and text, and make copies. When 
you're prepared to group a handle to an 
object, move a text/handle combination 
toward the illustration and change the 
dummy text to a description of the object. 
Then group the text to the handle and the 
handle to the object. 

These descriptive handles come in handy 
when you're trying to keep track of 
objects, especially when you need to make 
adjustments to a complex illustration you 
created weeks or months ago. 

Create Distortion-Free Leaders 
With A Dashed Line 
Using rows of periods to create leaders 
doesn't work well in Illustrator 88 
because stretching or shrinking rows dis-

torts the spacing between periods too 
much. You can work around this by cre­
ating a leader with a dashed line: 

First, draw a line with the pen tool. Then, 
press Command-1 to invoke the Paint 
dialog box. Choose None as a fill, and 
Black 100 percent for the Stroke. Enter a 
line weight (the default is 1 point), select 
the second choice for Caps, click on the 
Dashed button, and enter 0 in the first 
Dash Pattern box and a number to specify 
the space (in points) between the dots. 

You can see your changes on-screen by 
going to the Preview Illustration view. If 
you want to modify the line, go back to 
the Artwork Only view. You can resize the 
line with the Scale tool so it fits in any 
width without distortion. 

Extracting mustrator 88 
Graphics From PageMaker Flles 
There's a relatively painless way to access 
PageMaker files through Illustrator 88. 
First, open the PageMaker document, 
choose Print from the File menu, hold 
down the Option key, and click the OK 
button in the Print dialog box to bring up 
the PostScript Options dialog box. 

Then, turn off the Download bitmap 
fonts, Download PostScript fonts, and 
Include Aldus Prep options. Name the file 
to make finding the PostScript file easier; 
otherwise it will be called PostScriptO 
(1, 2, 3, etc.). Save the file either as EPSF 
or as Normal. Click on the Print button, 
and then close PageMaker. 

Finally, open the resulting PostScript file 
with Illustrator 88. Illustrator recognizes 
only the PostScript code that corresponds 
to its file, and when the PostScript file is 
explicitly saved from within Illustrator, 
only that code is saved. 
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Importing Wustrator 88 Flles 
Into QuarkXPress 
QuarkXPress lets you place and print pat­
terned artwork created in Illustrator 88 if 
you save the Illustrator document as an 
EPSF file. You'll face a bottleneck in 
Illustrator, though: saving a single art file 
in EPSF can take several minutes. If you 
do a lot of saving and revising, you'll 
waste valuable work time. 

Part of the delay in saving stems from 
Illustrator's tendency to create and show a 
Mac Preview image in its Print dialog 
box. You can stop this by unchecking the 
Preview and Print Patterns options in 
Illustrator's Preferences menu. 

Now, when you save in EPSF there will be 
no lengthy wait. The image will print out 
correctly through QuarkXPress, but it 
won't appear on-screen. 

Making All Your Lines Thicker 
Or Thinner 
You don't have to spend hours changing 
stroke attributes to, say, make all the lines 
in your document half as thick. There's an 
easy way to do it: 

Select the necessary paths and activate the 
scale tool. Click on one of the selected 
anchor points while holding down the 
Option key to open the Scale dialog box. 

To thin all selected paths uniformly, scale 
the object larger in the Scale dialog with 
Preserve Line Weights selected, and then 
immediately scale the selection back to 
its original size with Scale Line Weights 
selected. (Make sure to Option-click on 
the same anchor point when reducing the 
object back down, so the object keeps its 
original position on the page.) 
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The percentage you enter to scale the 
object back to its correct size must be 
fractionally inverse to the percentage to 
which you enlarged it (ie, a 200-percent 
enlargement is remedied by a 50-percent 
scaling factor; 500 is remedied by a 20-
percent factor, etc.). 

To make selected paths uniformly thick­
er, follow the same procedure, except 
choose Scale Line Weights while scaling 
up, and Preserve Line Weights while scal­
ingdown. 

Incorporating Bitmapped Images 
Incorporating a bitmapped image from a 
program such as MacPaint into an 
Illustrator 88 illustration is difficult 
because Illustrator cannot import a painf 
or PICT graphic into the Artwork mode 
by using either the Place command or the 
Clipboard. 

The work-around is simple and takes 
advantage of the fact that Illustrator can 
import or place an EPSF image into 
Artwork. Use Aldus FreeHand's Place 
command to import your paint graphic 
into a new FreeHand document. Then use 
FreeHand's Export command to save the 
placed graphic as an EPSF file. Now 
return to Illustrator and place the 
FreeHand EPSF graphic. Do not forget to 
select "Show placed images" in the 
Preferences dialog box of Illustrator's Edit 
menu to view the placed EPSF files in 
both the Artwork and the Preview modes. 

If you want to import this whole hodge- ' 
podge into a page-layout program, check 
the box in the Save dialog box to "Include 
copy of placed Encapsulated PostScript 
files for other applications." 



2. Type the text inside the box. It's best to 
ADOBE ILWSTRATOR 3.0 use a heavy type style, such as Helvetica 

Black or Stone Sans Bold. 
Accessing Some Elusive Symbol 
Characters 
Certain characters in the Adobe Symbol 
font, such as [1t} and raJ' are accessible 
within other Adobe fonts such as 
Helvetica but are not displayed on the 
keys (you can see what keys to use via the 
Key Caps DA). 

Although you can see these characters on­
screen in Illustrator 3.0, some of them 
don't print, even if you import text con­
taining these symbols. If you need these 
characters and can't- or don't want to­
switch to the Adobe Symbol font (within 
which they will print), here's a simple 
work-around: 

First make sure you have Adobe Type 
Manager 2.0 installed. Then with the new 
Create Outlines command on Illustrator 
3.0's Type menu, select the text and 
choose Create Outlines. By selecting 
Preview Selection from the View menu, 
you can see how the text will look when it 
is printed. The only drawback is that the 
characters may look slightly bolder when 
they're printed. 

Creating "Embossed" Text 
Creating the look of embossed text is a lit­
tle harder than creating effects such a out­
lines, shadows, and drop shadows, but 
when you do it correctly, it can add a 
touch of class to your layouts. Here's a way 
to create "embossed" text in Adobe 
Illustrator, but the basic technique should 
work in a variety of programs: 

1. Create a box containing a background 
shade. 

3. Copy the text to the Clipboard. Paint 
the text lighter chan the background (say, 
25-percent black). Using the arrow keys, 
move the block of text left and then up 
the same amount of space (in the example, 
I pressed the left arrow three times and 
the up arrow three times). 

4. Use the Paste to Front command 
(Command-F) to place the Clip-board 
text in the box. Paint this text a shade 
that's darker than the background shade 
(say, 75-percent black). Using the arrow 
keys, move chis text block down and to 
the right the same number of spaces as 
before. 

5. Use the Paste to Front command to 
place another copy of the Clipboard text 
in the box, and paint in the same color as 
the background. Preview the image 
(Command-Y), and you'll see the 
embossed effect. You may need to go back 
co the image and tweak the number of 
spaces you've moved each copy of the text 
to get the best effect. 

Using the same technique, you can make 
simple EPS clip arc look embossed. 

BRODERBUND 
TYPESTYLER 
Converting Fonts To 
SmoothFonts 
To use regular fonts that you've converted 
into TypeS tyler SmoochFonts, you must 
have the original corresponding screen 
fonts installed in your system for 
TypeStyler to recognize them. But if 
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you've created several SmoothFonts, it can 
be inconvenient to remember to install all 
the appropriate screen fonts. It's easier to 
install the necessary screen fonts right into 
the SmoothFont suitcase: 

After you've created your SmoothFont in 
the usual way, open the Font/DA Mover. 
Close both windows. While holding 
down the Option key, click on Open; then 
select your SmoothFont file. In the second 
window, open the original screen font's 
suitcase. Now copy the original's 18-point 
screen font(s) into the SmoothFont file, 
and then quit Font/DA Mover. As long as 
the SmoothFont is available, TypeStyler 
will make use of this embedded screen 
font without your having to install it in 
your system. 

CANVAS 

Creating Filled Text 
The way to produce filled or patterned 
text in Canvas is not readily obvious, 
because the fill tool fills the background 
instead of the actual letters. Here's an easy 
method for creating filled text: 

1. Type the text. Thick letters work best. 

2. Draw a rectangle (or other shape) so 
that it covers the text, and fill the rectan­
gle with a shade or pattern. 

3. Select the Ink Manager tool (indicated 
by the word Copy near the bottom of the 
toolbox) and drag over to Bic (black is 
clear). This eliminates the black in the 
text and fills it with the pattern or shade. 

Laser Writers can be finicky about printing 
documents that use the Ink Manager, but 
you should have no problems using non­
PostScript printers such as the Desk Writer. 
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Creating An Accurate Display Of 
Proportional Rectangle Resizing 
To accurately see the proportional resizing 
of rectangular objects, draw a diagonal ' 
line from one comer of the object to the 
other, and extend it, keeping it lined up 
against the two handles. 

Now, grab a corner handle at the end of· 
the diagonal line and resize the object 
while keeping the handle on that line. 

Finally, delete the line. As long as the han­
dle is on the diagonal line, the object is in 
proportion. 

CANVAS2.0 

Accessing An Undocumented 
Search-And-RepJace Feature 
You can perform an easy search-and­
replace: hold down Option while choos- · 
ing Select All from the Edit menu. Then 
make a selection from the Pen Pattern, 
Fill Pattern, Foreground Color, 
Background Color, Pen Shape, Line, or 
Transfer Modes pop-up menu. Canvas 
will select all the objects with that 
attribute. You can now choose any 
attribute (such as fill patterns) to globally 
replace the selected attribute. 

Displaying Small-Scale Fractions 
On-Screen 
When using Canvas 2.0 for architectural· 
or engineering drawings, choosing Show 
Dimensions in Fractions under Preferences 
will not give you fractions for small scales 
such as 1" = 1' or 112" = 1". You can't get 
fractions in your dimensions by typing in 
1 "= 1' in the Ruler Manager. 

If you want to display fractions on-scree~ 
for such scales, the right-hand side of the I 



scale in the Ruler Manager box must 
always remain at 1 ". Then divide the left­
hand side of the scale for whatever fraction 
of the inch you want. For example, if you 
need 1"=1', use 1112"=1", which you 
enter as .0833= 1". Fractions now appear 
in your auto-dimension lines. 

Getting Rid Of The Frame Around 
Each Bitmap 
Although Canvas' multiple layers and 
overlay modes let you superimpose 
bitmapped objects over other graphics, 
the rectangular frame around each bitmap 
whites out everything below it, ruining 
the effect. If you try to make the 
bitmapped object transparent by using 
the Not Or option in the Ink Manager, 
the background shows through the white 
border- but it also shows through any 
white inside your object! Here's a work­
around for the problem: 

First, duplicate the bitmapped object, and 
use the paint bucket to fill in the frame 
area of the duplicate with black. Make sure 
the outline of the picture is a continuous 
line so the paint won't overflow the image 
itsel£ If the background is solid black with 
no patterns, skip the next three steps. 

Second, use the Ink Manager controls near 
the bottom of the tool palette to change 
the object with the filled frame from Copy 
to the Not BIC overlay mode. The object 
will be invisible unless it is in front of 
another graphic, so don't lose track of its 
position. 

Now, select the original bitmap with the 
unfilled frame and change its overlay 
mode to Or with the Ink Manager. 

Then select Bring to Front from the 
Object menu to bring the object to the 
front of the display. 

Finally, select both objects, place them 
exactly together with the Align command 
from the Object menu, and group them 
before clicking the mouse anywhere else. 

When laid over another object, the frame 
is transparent, but now nothing shows 
through the interior of the picture. Note 
that PostScript doesn't work with many 
QuickDraw overlay modes, so test print­
outs are mandatory when using 
PostScript-compatible printers. 

More Realistic Tracing 
You can make your traces more realistic 
and closer to the original image by select­
ing the bitmapped object and choosing 
the Object command from the Object 
menu. Change the resolution in the dialog 
box from 72 to 300dpi. Click OK and 
close the box. Now auto-trace the object. 
This increased resolution creates more 
handles as well as drastically improving 
your traced image's appearance. 

Switching Windows Without 
Using The Windows Menu 
If you're working with Canvas on a large­
screen monitor and have several windows 
open, using the Windows menu to switch 
between all your windows is a bother. An 
alternative is to Option-dick anywhere in 
the title bar of a window (except the zoom 
or close boxes) to get a list of all open win­
dows. 

CANVAS 2.1 

Using Separator To Keep 
Graphics Straight 
Macintosh users know about the problems 
with quality that can occur when 
MacDraw or similar graphics are pasted 
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into other applications. Many things such 
as alignment and line weights go haywire 
when you print. If you own Canvas 
Separator, you may have a solution right 
under your nose: 

1. Open the original graphic in Canvas. 

2. Save the graphic in Canvas format. 

3. Use Canvas Separator's Convert com­
mand to convert the file into a suitable 
format, such as EPS, PICT or EPS 
Illustrator. 

4. Finally, import the file into your page­
layout or word-processing package. More 
often than not, the problems will vanish. 

Organizing And Storing Object­
Oriented Clip Art 

You may have learned the hard way that 
object-type artwork that is stored in a 
HyperCard clip-art file loses its high reso­
lution and becomes 72 dpi. So how can 
you store large amounts of object-oriented 
clip art in an organized manner? Canvas 
2.1 provides a simple but elegant solution: 

1. Create a new document, and give it a 
descriptive name, such as Business 
Images. Then begin Pasting in the graph­
ic objects, arranging them on the page. 

2. Use the scroll bars or magnification tool 
to center one of the objects on your screen. 

3. Choose the New View command from 
the Layout menu, and give the view of the 
centered graphic a descriptive name such 
as Bottle Message. Click on OK. Repeat 
this step for every graphic on the page. 

Now whenever you drag your cursor down 
to the Views command on the Layout 
menu, the hierarchical pop-up menu 
includes the names you have given to these 
views, allowing you to jump quickly to 
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any graphic on the page, modify it if 
desired, and copy it to the Clipboard. 

CLARIS CAD 2.0 

Little-Known And Free Upgrade 
Claris Corp. has a free update to Claris 
CAD 2.0 that's available to all owners of 
the package. Version 2.0v2 solves some 
screen-refresh problems with the dynamic 
guidelines and Graphics Guide, and 
makes the program run more reliably 
under System 6.0. 7. According to the 
company, users with Macs that require 
System 6.0.7 (the Classic, LC and Ilsi) 
should definitely switch to Version 2.0v2. 

Claris Customer Support can be reachedjat 
(408) 727-8227; just ask for the latest · 
version of of Claris CAD. 

CLIP ART 

Recycled Clip Art 

One of the best resources for locating clip 
art, Canned Art- Clip Art for the MacintoJh, 
by Erfert Fenton and Christine Morrissett 
(Peachpit Press, 1085 Keith Avenue, 
Berkeley, CA 94708; (800) 283-9444). 
It's a meticulously indexed and organized 
book with representations of artwork 
from dozens of clip-art manufacturers. It's 
huge and worth every penny ofits $29.95 
cover price. 

You can create your own recycling clip art 

after seeing the art in Canned Art, or there 
are BBSs and public-domain libraries full 
of pictographs and the like, drawn by 
thoughtful, caring Mac users and available 
for pennies. Also, check for recycling logos 
available on-line from Zmac or from yout 
local user group. 



If you can't find the symbol you need, 
though, just hop on down to your local 
art-supply store. It'll have books of pub­
lic-domain symbols (artwork you can 
reproduce with impunity) for just a few 
dollars apiece. Take the book down to 
your local DTP service bureau, and the 
staffll scan the pictograph into a TIFF file 
for about ten bucks or so. 

CRICKET DRAW 
Creating A Partly Dotted, Partly 
Solid Element 
If you want to draw an oval or circle 
that's partly solid and partly dotted 
lines, you can do a quick cheat to get it 
done. First, draw a number of evenly­
spaced lines over the portion you want 
to make dotted (Cricket Draw's Grate 
tool is excellent at this) and then just 
make those lines white. 

Use Align Objects To Control 
Object Placement Permanently 
Cricket Draw contains a little-known 
trick that allows users to gain total control 
of object placement by using the Align 
Objects command. The ordering of 
objects drawn doesn't depend on their cre­
ation order or positioning, but rather on 
their layering. That means selecting an 
object and choosing Bring To Front from 
the Arrange menu will later make that 
object the point of reference for future 
Align commands. 

For example, when you have an object 
you'd like to align with other objects, 
select the item and choose Bring To Front 
from the Arrange menu. Then, Shift-Click 
on the other objects you want aligned 

(press Shift while clicking on each one), 
and choose Align Objects from the 
Arrange menu. Regardless of the align­
ment done, the object on the top layer 
will remain in its original position. 

Printing Is Faster When You 
Ungroup Objects 

When printing documents that contain a 
large number of grouped objects, you'll 
save printing time on Laser Writers by 
ungrouping your objects just before you 
print your document. 

CRICKET DRAW 1.1 
A Bug 
This version has a bug that wasn't present 
in Cricket Draw 1.0. If you construct a 
two-sided open polygon and then add an 
arrowhead to the end, the arrowhead will 
appear correctly on-screen, but will print 
out at the intersection between the two 
lines instead. 

The work-around is this: add an extra 
clickpoint to the polygon. For some rea­
son, this results in a printout with the 
arrowhead positioned at the end of the 
polygon, where it should be. This will 
work every time. 

FREEHAND 
Placing Text Around The Outside 
Of A Circle 
Although FreeHand has a feature to 
allow users to create text on a curved 
path, you'll probably find it a real chal­
lenge to accurately place text around the 
outside of a circle. The text normally 
starts to wrap clockwise around the out-
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side of the circle beginning at the 9 o'clock Horizontal alignment. The result is a cir-
position. de with text around both top and bottom. 

To center a word or phrase around the 
top of the circle, first draw your circle. 
Then select the Text tool and click your 
insertion point above the circle. In the 
Text dialog box that appears, choose the 
typeface, font and style you want and 
type in the text. OK your selections. 
Now, select the text block and the circle 
and press Command-) to join your text 
to the circle. 

When you've done this, you'll notice that 
your text has moved to the center of the 
curved path at the 3 o'clock position. 
Move it to 12 o'clock by using the Rotate 
tool to rotate the joined circle and text 90 
degrees counterclockwise by dragging 
the bottom right-size box to the position 
of the top right-size box. 

Wrapping Text Inside A Circle 
Getting text to wrap counterclockwise 
along the inside of a circle is accom­
plished with a method very similar to the 
one described above. Center the text 
within a circle at the 6 o'clock position 
by following the instructions above, 
with a minor change: 

Press Command-) to join the text and cir­
cle, then use the Mirror Reflection tool to 
flip the circle vertically. Now the text will_ 
be wrapped along the inside of the circle -
at the bottom. 

Wrapping Text Above And Below 
A Circle 
You can combine both of the effects 
described above by selecting both effects 
and choosing Align Elements from the 
Elements menu. Then hit the Center 
radio button for both Vertical and 
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Opening Adobe Wustrator 88 
Flles With FreeHand 
While FreeHand can easily open Adobe 
Illustrator 1.1 files for editing, it usually 
can't open Adobe Illustrator 88 files. 
Here's how to bring your Adobe 
Illustrator 88 files into FreeHand: 

Open the Illustrator 88 file with 
Illustrator 88, and Save As an Illustrator 
1.1-compatible file to convert custom 
colors to process colors, and also to defeat 
masking and remove all patterns and 
placed or imported images. Don't worry, 
all your objects will be retained. 

Next, open the file using Illustrator 1.1 1 

and then save it. Now you'll be able to 
1 

open it with FreeHand. If you don't have 
Illustrator 1.1, you'll have to open the file 
using a text editor capable of saving text­
only files. 

Change the second line from: 
0/o0/oCreator: Adobe Illustrator 88 (TM) 
1.6 to: 0/o0/oCreator:Adobe Illustrator 
(TM) 1.1 . It's important to remember 
that you'll have to delete the space before 
"Adobe" Now, save as TEXT ONLY, and 
open the file with a resource editor and 
change the Creator from ARTZ to ARTY 
The resulting file can now be opened and 
edited with FreeHand. 

Adding Variety To Ilnes With 
ZapfDingbats 
Unless you can program in PostScript, 
you'll probably find the fill and line 
options dull after awhile. You can expand 
your options by combining two FreeHand 
techniques with some ready-made · 
PostScript images- ZapfDingbats. 



To convert any drawn line to a line made 
up of dingbats, use the "text on a path .. 
feature. First, draw the line. Then choose 
the Text tool and create a single line of 
text in a small point font (6 point works 
very well) that's longer than your drawn 
line. Select both your text block and the 
line you wish to convert, and use the Join 
Elements command from the Element 
menu. That's all there is to it. 

Using ZapfDingbats As A Fill 
Pattern 
You can also use dingbats as an unusual 
fill pattern in your objects by using the 
"clipping path .. feature. First, create the 
area you want to fill. Then select the 
Text tool and create a block of text large 
enough to cover your fill area. Now, 
select the text block and use the Cut 
command to send it to the Clipboard. 
Finally, select the area to be "filled .. and 
choose Paste Inside from the Edit menu. 

The same techniques work with other 
fonts, but if they aren't PostScript fonts 
you'll find them printed out as bitmapped 
characters. 

Cropping Imported Graphics 
To crop imported graphics in FreeHand, 
paste them inside a path. Pan by selecting 
the path as points by dragging a selec­
tion rectangle over the path and then 
moving the path. If you select the whole 
path, the image will move as you move 
the path. But if you select points in the 
path, you can move the path without 
moving the image. 

Simulating Filled, Outlined Text 
FreeHand doesn't allow outlined text to be 
filled with shading, but there is a way to 

simulate the same appeamnce without too 
much trouble. 

First, make sure you've created the shad­
ing color you want to use. Then select the 
Text tool and create a text block specify­
ing outlined format. Once you click OK, 
go immediately to the Edit menu and 
choose the Clone command. This creates a 
duplicate of the first text block, right on 
top of the first one. 

Now, double-dick to edit the cloned 
block, making sure the text is selected in 
the resulting dialog box. Change the text 
effect box to read "solid" and change the 
color box to be your color choice. Click 
OK, then immediately send that text 
block to the back. 

This trick works because outlined text in 
FreeHand is transparent and lets the 
shaded text block show through. 

FREEHAND 2.0 

Quickly Deselect All Items In An 
Wustration 
You can deselect all the items in an illus­
tration by pressing the Tab key. This is 
particularly useful when you're in a close­
up view and want to deselect an object 
without selecting a larger one behind it. 

Drag A Small Object Without 
Grabbing Its Resize Handle 
If you can't drag a small object without 
grabbing one of its resize handles, try 
drawing a large object next to it, select­
ing both, and then putting the pointer 
on the big obje~t to move them as a unit. 
When the small object is in the correct 
spot, deselect both objects and delete the 
larger one. 
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Express Route To The Edit Dialog 
You can get to the Edit dialog fast to alter 
a line, fill or color style. Just press Option 
and select the style from its menu. 

Archiving Lines, Fills and Color 
Styles 
To save a reusable library of lines, fills, 
and/or color styles for use in other 
FreeHand illustrations, define the styles 
in a blank illustration file. You can also 
select a target printer and print settings, 
and add objects (like logos) that you want 
in every new document. Then choose Save 
As, name the file, click on the Template 
option, and save. 

The next time you need these styles, use 
the template to create your illustration. 
You can even make these styles your 
FreeHand default setting by deleting the 
Aldus FreeHand Defaults file that came 
with the program and assigning that 
name to your template file. 

Getting More Control Over 
FreeHand Tracing 
Double-dick on the trace tool to display 
the Curve and Corner dialog box, which 
lets you get more control over the number 
and kind of points FreeHand applies 
while it traces. 

Getting The Most Out Of Tracing 
Gray-Scale TIFF Images 
When tracing a gray-scale TIFF image, 
you'll get the best results if you make it 
into a black-and-white image first. Select 
the image, choose Element Info, and 
click on the Black and White option. 
Adjust the contrast and lightness to 
obtain the highest contrast, and then 
trace the image. 
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Opening MacPaint Flles Without 
Loading FreeHand 
You can open any graphics file MacPaint 
can open just by double-clicking on it, the 
same way you would if you were using 
Mac Paint. 

Using a resource editor like ResEdit or 
FEdit, you can alter your FreeHand pro­
gram so that it opens files like MacPaint~ 
Within the resource editor, select the 
paint program you like to use (in this case, 
FreeHand). Check the field Creator and 
change what it says to MPNT. Then quit 
the resource editor and return to the 
Finder. You'll notice that your FreeHand 
icon now looks like the MacPaint icon. If 
the real MacPaint is on your disk, get rid 
of it, or this tip won't work. I 

As with any resource editing work, mak~ 
changes only on a backup of FreeHand. 

Faster Screen Redraws 
For faster screen redraws, work in Key line 
mode rather than Preview mode. In the 
Document Setup dialog box, select Faster 
for display quality. In complex illustra­
tions, use Layer Control to view only the 
layers you need to see while you work. 
Move TIFF images, transformed text, and 
elements with complex fills to layers that 
are kept invisible until you need to see 
them. 

If you have a color or gray-scale monitor, 
use the optimum settings (2 grays or 256 
colors); also use 2 grays (black and white)· 
when you're working on black-and-white 
illustrations. 

If you don't want to wait for the screen tq 
finish updating, press Command-period ito 

I 

stop the redraw. 
1 



Faster Printing Of PostScript Fills 

When printing PostScript fills to a 
Laser Writer, make the color parameter 
gray (either 0 or 1) instead of color to 
speed up printing. 

Faster Printing Of TIFF Flles 
Make TIFF files print faster by using 
black-and-white images whenever possi­
ble. If you've applied color to a TIFF 
image, the color processing slows down 
printing tremendously. 

Having Trouble Printing Custom 
PostScript Line And Fill Effects? 
You can avoid problems when printing 
custom PostScript Line and Fill effects by 
making sure your UserPrep file is in the 
correct folder and is properly named. If 
UserPrep isn't in the FreeHand folder or 
the System Folder, you'll get an 
"undefined" PostScript error. 

Compatibility Problems With 
Older Systems And LaserWriter 
Drivers 
If your printer won't print a FreeHand 
file unless there is text on the page, it's 
because you have old or incompatible 
System and Laser Writer-driver files. 
When you update your System file, make 
sure to update your printer files as well. 

IfYou Print A Lot Of Fonts With 
FreeHand 
Using more than two or three download­
able fonts usually overtaxes a printer's 
memory and generates a PostScript error. 
Avoid this by going into the Page Setup 
dialog box, clicking the Options button, 
and checking the box marked Unlimited 
Downloadable Fonts in a Document. 

If you routinely print a lot of different 
fonts, set the above option as your default. 

Make Sure All The Pieces Of Your 
Flle Fit On A Printed Area 

When you print a file, FreeHand adds up 
the size of the illustration, any bleed that 
was added, and the space required for any 
print options you selected (such as crop 
marks and separation names). If all these 
pieces won't fit on the specified paper 
size- for example, adding crop marks to a 
letter-sized page and then printing to let­
ter-sized paper with a Laser Writer- you'll 
receive an error message. 

When printing to a Laser Writer, turn off 
the options that print information beyond 
your illustration area, or select the Fit on 
Paper option in the Print dialog box. 

If you use a Linotronic imagesetter, 
change the paper size to LetterExtr, 
which accommodates the crop marks. 

Creating An Outlined Pattern 
Effect 
When using one of the Post&ript lines 
from FreeHand's UserPrep file, you can 
create an outline of the PostScript line 
instead of a solid line: 

First, choose PostScript from the Line 
menu, and type DOT (or any other file 
name) in the dialog box. Then tab to the 
PostScript entry box and enter "[DOn 
10 101 0 newrope" in the box. (The word 
in braces should be the name of the 
predefined pattern you want to use from 
UserPrep.) The four numbers refer (in 
points) to width; height; the spacing 
between dots; and the color (0 =black, 
1 =white). The last term, "newrope," is a 
routine from User Prep. 
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Now, choose Lines from the Line menu 
and select the line name, DOT, you just 
created. Then click on the Copy button. 
The PostScript dialog box will appear 
with the attributes of the first line. 
Change the name to something like 
DOT2 and change the numbers in the 
PostScript entry box to "[DOT] 9 9 2 1 
newrope". Then, draw a line with the 
line tool. Choose DOT from the Line 
menu and clone (Command-=) the line. 

Finally, return to the Line menu without 
moving the lines and select DOT2. When 
printed, the cloned line will print as white 
over the black dotted line underneath, 
giving the effect of an outlined pattern. 

Centering Text Along The 
Outside Of A Circle 
You can center text along the outside top 
and bottom of a circle by first making the 
two text blocks and setting the text to be 
center-aligned. 

Draw a circle and ungroup it. With the 
knife tool, split the circle at the side 
points and delete the bottom hal£ Clone 
the top half and use the reflecting tool to 
make the clone the new bottom half of the 
circle. Then join each text block with its 
respective half of the circle. 

To make the text run along the outside of 
the arcs, use the Element Info dialog box 
to align the text to the path, with the base­
line (top half) and the ascent (bottom half) 
options. 

Creating A Three-Dimensional 
Box 
To create a 3-D box, first skew a rectangle 
upward to create one side. Then, clone it 
and use the reflecting tool to click on a 
vertical edge and move the clone to the 
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opposite side of the original. Now, clone 
the second side of the box and ungroup 
the clone. Shift-select the lower left and 
lower right points of the cloned element. 
Release the Shift key, then click on one of 
these points and drag to create the top of 
the box. Finally, give each side an appro­
priately shaded fill or color. 

Fixing Improperly Printed 
Strokes 
When you specify a point size for the 
stroke of text in the Fill & Stroke dialog 
box, the stroke will be too large to print 
properly if the text isn't joined to a path. 
For painless printing, place a period 
before the point setting in the dialog box. 
For example, a stroke set at .20 points 
prints out as 20 points high. 

Getting The Smoothest 
Graduated And Radial Fills 
You get the smoothest graduated and 
radial fills by making sure that the print' 
quality is set to Better. Lower screen rul­
ings generally create smoother fills 
because they produce more shades of gray. 
However, screen rulings are closely related 
to printer resolution: a high-resolution 
image-setter gives you smoother grays, 
and sharper images, at higher screen rul­
ings. (For a table of recommended screen 
rulings based on printer resolution, see 
pages 9-12 of the manual.) 

For best results, print to the highest-reso­
lution printer available. Also, smaller 
filled areas stand a better chance of being 
smooth than do larger filled areas. 

When You See "PostScript Error: 
Undefined, Offending 
Command" 

The above error message means your 



file has too many grouped subgroups. 
Ungroup some of them to solve the 
problem. 

Starting With Your Own Defaults 

When you select New from the File 
menu in FreeHand, your new page 
appears with a sometimes-annoying set 
of its own defaults. They include Snap to 
Grid, many different shades of gray, line 
weights, and other items that most peo­
ple usually end up changing. 

If you want to avoid this problem, start by 
creating a template that has whatever line 
weights, fills, and colors you use regularly, 
turn on features you consistently use, and 
turn off those you do not. 

Once you have set everything to your lik­
ing, save the document as a template, and 
name it Aldus FreeHand Defaults in your 
FreeHand Folder. (You might want to 
rename the old defaults first, in case you 
want to use then again.) 

You cannot change some things, such as 
the default font and font size, but you can 
add guides, select your printer type, and 
set the measuring system to the standard 
you prefer, just as with a regular template. 

Cheap, Editable Outline Fonts 
Here's a simple and economical tip for 
creating editable font outlines with Aldus 
FreeHand 2.0. 

Choose the Text tool, and click anywhere. 
Set the text size to the largest size that you 
have bitmaps for (if you have Adobe Type 
Manager, then the sky's the limit), and 
type the character(s) that you want. 

Once the text is on-screen, simply choose 
the tracing tool and auto-trace the text. 
FreeHand's auto-trace tool treats the text 

as an ordinary bitmapped object. As with 
any tracing, you have to play with the 
auto-trace controls, but with large screen 
fonts, you can get very good outlines that 
require only minimal touch-up. 

FREEHAND 2.02 

A Quick Way To Create Repeating 
Elements 
The most common technique for repeat­
ing elements in a closed path is to dupli­
cate them as many times as required to 
fill the space, cut these elements to the 
Clipboard, and finally use the Paste 
Inside function to create the effect. 
However, the Tiled Fill option is faster 
and makes it easier to adjust the spacing 
of the masked elements. 

In the dialog box you get when you select 
Tiled from the Fill menu, you can modify 
only scaling, angle and offset properties. 
The problem is that you cannot control 
spacing between the repeated elements of a 
tile. Here is a way to bypass this limitation: 

1. Create your tile (text, path and so on). 
Make sure your elements are ungrouped. 

2. Draw a square or rectangle around your 
tile, and align all elements to the square 
horizontally and vertically centered (you 
may have to group your elements to do 
this easily). 

3. Select your square, and set the line to 
None on the Line menu. 

4. Ungroup everything, and cut to the 
Clipboard. 

5. Select the path to fill, choose Tiled on 
the File menu, and click on the Paste In 
button in the Tiled dialog box. As with 
the Edit menu's Paste inside function, you 
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will not be able to see your results unless 
you are in Preview mode. 

If the tiled graphic you have created does 
not tile correctly to form a pleasing pat­
tern, you can easily change the spacing 
now. To edit the distance between objects, 
select the path, choose the Tiled com­
mand, and click on Copy Out. Paste the 
ungrouped elements back onto the docu­
ment. You can now modify the height or 
width of your square to change the way 
the element or elements will be tiled into 
a pattern. Once you are satisfied, paste the 
elements back into your fill. 

MAC DRAFT 
Producing Laser-Printable 
Diagonal Dotted Unes 
To produce high-quality diagonal dotted 
lines, start by editing a pattern so that 
most of the pattern is black, with a one- or 
two-pixel column or row being white. 
Now confirm that you're drawing with a 
non-dotted line, and choose that special 
pattern you've drawn as the ink for the 
line by holding down Option while 
selecting the pattern. 

Try drawing a few diagonal or dotted 
lines. Later, you can choose the special 
pattern for better control. 

The Same Name Can Spell 
Trouble 
Take care when naming your files. If you 
save with the same name as a MacPaint 
document in the same folder, the new 
MacDraft document will not be accessible 
from the application. The only way to 
open it will be to use a file editing tool 
like Mac Tools or FEdit. Open the file and 
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change the creator to MDFr and type to 
DRWG. This will allow MacDraft to 
access the file again. 

Create Original Patterns Easily 

Want interesting, original patterns in 
MacPaint? Use MacDraft to create them. 

First, create a patterned object in 
MacPaint, then copy an area of the pat­
tern and paste it into MacDraft. With the 
object selected, experiment with choos­
ing different patterns from the Fill menu. 
The MacDraft pattern will overlap the 
MacPaint pattern, with almost limitless 
new patterns resulting. 

MAC DRAW 
Editing MacDraw's Cursors For 
Greater Precision 
To obtain greater precision with 
MacDraw's cursors, use ResEdit to open 
the CURS resource. Then select CUR­
SOR IDs = 256 and 259, and redesign the 
cursor tools. You can make them smaller 
and simpler. Be sure to do this to a backup 
copy ofMacDraw. 

Creating An Accurate Display Of 
Proportional Rectangle Resizing 
To accurately see the proportional resiz­
ing of rectangular objects, draw a diago­
nal line from one corner of the object to 
the other, and extend it, keeping it lined 
up against the two handles. 

Now, grab a corner handle at the end of 
the diagonal line and resize the object 
while keeping the handle on that line. 

Finally, delete the line. As long as the han­
dle is on the diagonal line, the object is in 
proportion. 



Creating Proportionally Spaced 
TextUnes 

You can make lines of text with propor­
tional spacing by creating each individual 
text object and then lining all objects up 
vertically. Now, select all the objects with 
the selection marquee and group them. 
By stretching the grouped text with the 
corner and upper/lower resizing handles, 
the vertical spacing between the lines 
changes proportionally. 

Using Smoothing To Create 
Complex Arcs 
MacDraw's arc tool is quite limited in the 
complexity and variety of arcs it can gen­
erate. But you can create complex arcs by 
using MacDraw's smoothing functions. 
Use the polygon tool to draw a two-vector 
shape, then select Smooth from the Edit 
menu. After experimenting with this 
technique for awhile, you'll be able to cre­
ate some highly complex arcs. 

Quickly Selecting The Last Tool 
You Used 
To automatically select the last tool you 
used, hold down Command while press­
ing the mouse button. 

Centering Items Perfectly In The 
Middle Of A Page 

There's an easy way to center an item 
exactly in the middle of your page. Once 
the page has been created, type in the text 
you want to center, approximately where 
you want it placed. Then choose Reduce 
To Fit to create a rectangle wide enough to 
cover the entire width of the page. Choose 
None from the Fill menu, so you can see 
the objects behind the rectangle. Then, 
select the rectangle and Shift-Click the 
text item you want to center. Now, choose 

Align Objects from the Arrange menu 
and click on L-R Center, then click OK. 
Your text is now centered on the midpoint 
of the box. 

Use this technique to center objects hori­
zontally by clicking Top-Bottom instead 
ofL-R. 

Grabbing Tiny Resizing Handles 
If you're working with very small objects, 
it can be hard to grab their resizing han­
dles, and you might end up moving the 
object when you didn't mean to. 

To avoid this, create a second, larger 
object, and then Shift-Click on both, 
group them and use the resizing handles 
on the larger element to shrink or stretch 
them both. When you've finished resiz­
ing, ungroup the two objects and delete 
the larger element. 

Proportional Enlarging And 
Reducing 

To reduce or enlarge an object proportion­
ally, draw a one-inch by one-inch square 
(with Show Size active). Shift-Select this 
square with the object to be reduced or 
enlarged. Place the arrow cursor on the 
comer of the square and drag it to the size 
desired, pressing Shift while you do so to 
guarantee proportional enlargement or 
reduction. 

Maintaining Fill Patterns When 
Exporting To Bitmap Programs 
When you're transferring an object 
graphic to a bitmapped program such as 
MacPaint or FullPaint, you can maintain 
the original fill patterns ratio. Select the 
area that the object graphic will be pasted 
into by using the selection marquee, and 
then paste the graphic into the document. 
It will scale itself to the size specified by 
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the marquee without distorting. If you 
resize the graphic after it's been deselect­
ed, though, you'll get a distorted stretch. 

Selecting Multiple Objects At 
Once 
Hold down Shift while selecting more 
than one object to have all chosen objects 
selected at once. 

Duplicating Objects Easily 
You can duplicate any single object or 
group of objects by selecting them and 
then choosing Duplicate from the Edit 
menu. If you move the first copy duplicat­
ed, and then duplicate that copy, your new 
duplicate will be placed in the same posi­
tion the first copy originally occupied in 
relation to the original. To make a row of 
objects, put the first copy right next to the 
original image, then duplicate copies 
until the row is completed. 

Toggling To The Grid Option 
When the Grid option is turned off, you 
can temporarily use it by holding down 
Shift while you move an object. Press Shift 
after you've pressed the mouse button to 
pick up the object you want to move. 

Redrawing The Most Recently 
Created Object 
If you want to redraw the same type of 
object that you most recently created, you 
don't have to reselect the action from the 
icon panel. Just hold down the Command 
key and click at the place you want the 
new object to be drawn. The previous 
action is automatically selected with the 
Command key, so your image appears 
instantly. 
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Automatically Selecting Objects 
All the objects drawn while the 
Command key is pressed are automati­
cally selected when you release the 
Command key and the mouse button. 

Creating New Font Sizes 
You can create a different sized font by 
typing your text into MacDraw and then 
copying it into Microsoft Word, where it 
can be stretched or shrunk to any size you 
want. The new font will print out perfect­
ly well on laser printers. 

Selecting All Text Within A Block 
You can select all the text within a block 
by triple-clicking on the Text tool in the 
text block. 1 

Always Use The Same System To 
Create, Display, And Print 
A MacDraw document created with one 
System and called up with another might 
not show up at all, or might show up dis­
torted. For example, if you create a 
MacDraw figure using a 14 point font and 
then open the document using a System 
that doesn't contain that font in 14 point 
size, the character spacing will be com­
puted incorrectly. The obvious solution is 
to make sure that any MacDraw System 
you use contains the same point sizes and 
fonts installed on any System you'll use to 
open or print the document. 

Avoiding Text Default To The 
Geneva Font 
If you want to use a specific text in 
Mac Draw, change the font before you 
select the writing tool. If you don't change 
it, the font will automatically default to 
Geneva, and you'll have to choose a new 1 

font every time you switch into text mod¢. 



Computerizing Your Autograph 
You can keep your own signature on file 
in MacDraw, ready to affix to any docu­
ment. First, write your name as large as 
you can, using the free-hand tool. 
Read that as Large. Use the Smooth, 
U nsmooth, and Reshape commands 
until you're satisfied with the results, 
and then Group all the letters and grab 
the lower right handle to reduce the 
signature to the desired size. Finally, 
paste it in the Scrapbook. You might 
never need a pen again! 

Previewing Horizontal Layouts 
Preview how your horizontal layouts will 
look when printed by selecting Wide 
from the Page Setup option in the Print 
menu. This will show you the horizontal 
orientation of your page. 

IfYou Can't Complete The Print 
Command. •• 

Sometimes when you print a multi-page 
document, you might get a message that 
says the print command cannot be com­
pleted. The easiest way to work around 
this is to print only a few pages at a time. 

Laser Printing Small White Type 
If you have trouble printing small white 
type with your laser printer, try typing 
the text in Outline style, then fill in the 
background and then stretch the object to 
double its size, both vertically and hori­
zontally. Now, specify 50% reduction in 
the Page Setup dialog box. Your white 
type will probably print out much better. 

Enlarging Or Reducing Can 
Clip Text 
When you laser print a document con­
taining text, you might experience 

clipped text printouts if you use more 
than a 150% enlargement or more than a 
75% reduction. 

See The Graphics, Not The 
Rectangle 
To see a graphic image instead of a rectan­
gle while moving images around your 
page, press Option. 

An Easy Way To Create Perfect 
HollowUnes 
If you need to produce hollow lines, use 
the following procedure to raise the quali­
ty of your work: 

First, draw your graphic, making all lines 
with the third line thickness on the menu. 
When you're finished, Group all lines, 
duplicate the group, and set the line 
thickness of the duplicate lines to the sec­
ond line thickness on the menu. Then, 
under the Pen menu, set the pattern of the 
duplicate lines to white. Now, select both 
groups and align both centers. The white 
group will "carve" out the centers of the 
thicker lines. 

MACDRAWII 
Creating A Pixel Ruler 
One of the oversights in Claris' MacDraw 
II is the lack of a standard ruler for mea­
suring in pixels. You can create your own 
just by setting the scale ratio to 1:72 
inches, setting Divisions/inch to 1, and 
unchecking the Show Unit Name check 
box. 

Trimming Flle Space 
The grouping information stored in 
MacDraw II files for complex grouped 
graphics can cause the files to increase in 
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size- sometimes dramatically. If you need 
to trim some fat off a file, ungroup the 
grouped objects and then save the file. 

This works for all the major object-orient­
ed graphics programs, including Cricket 
Draw, Illustrator 88, and FreeHand. 

MACPAINT 
Leave Enough Disk Room To 
Work 
Mac Paint requires a lot of free space - at 
least 1 OOK or so- on the disk in order to 
work properly. If you're not using a hard 
disk, and are creating several docu­
ments, save them to a different disk for 
the time being. You can copy them back 
to your Mac Paint disk for editing later, 
if you want. 

Hints For Saving Disk Space 
Another way to free up space is to remove 
the Image Writer driver from your 
MacPaint system file. MacPaint doesn't 
use the driver to print documents. 

You can also save several small MacPaint 
illustrations in a single file, instead of in 
individual files. Mac Paint files take a min­
imum of 2K on-disk, per file. 

Getting Where You Want In 
FatBits, Fast 
You can take the express route into 
FatBits, and work on the exact area you 
want to, by selecting the Marquee tool 
and using it to frame the part of your 
picture you want to work on in-depth. 
Then, just double-dick on the Pencil 
tool, and you'll immediately go to a 
close-up of the area highlighted by the 
marquee. 

78 

Another way to access FatBits quickly is 
to choose the Pencil tool, hold down the 
Command key, and then point to the 
spot you want to work on and click the 
mouse button. Just click once; double­
clicking will bring you right back into 
the "regular" bits mode. When you 
release the Command key, the Pencil 
tool will behave normally. 

Moving The Page Whlle In FatBits 
When the Pencil tool is selected in 
FatBits, you can change the Pencil into a 
Hand tool by pressing the Shift button. 
This allows you to move the page without 
going back to the regular mode. When 
Shift is released, the Hand changes back 
into a Pencil. · 

I 
The Easy Way To Make Straight I 

Unes 

To make sure that the straight lines you 
draw are completely straight, with no 
jagged lines, hold down the Shift key 
while positioning and using the straight 
line tool. This constrains the line's move ... 
ment to vertical/horizontal only. 

Restraining Works Throughout 
The Program 
The same restraint can be applied to the 
paint brush, pencil, spray can, or eraser tool. 
Just hold down Shift while using the tool., 

You can even restrain the active window 
or the graphics elements in the Show 
Page mode by holding down Shift 
while repositioning your page. You'll ' 
be able to drag up, down, or to a 45-
degree angle. 

Multiple Copies Of An Image 
Make multiple copies of a graphic by : 
highlighting the image with the Lasso Of 



Marquee tool and pressing Command­
Option as you click and drag the picture 
around the page. 

Creating Multiple Copies In A 
Straight Line 
Multiple copies of an image can be cre­
ated and placed in a straight line by 
pressing Shift-Command-Option while 
dragging the image being copied. 

Controlling Spachtg With 
Multiple Copies 
You can control the spacing between mul­
tiple copies by choosing a line width that 
corresponds to the amount of space you 
want between each copy. Choose a narrow 
line width for closely-spaced copies, and a 
wider one for more distance between each 
illustration. 

Avoiding Pattern Distortion In 
Multiple Copies 
Sometimes when you make multiple 
copies of your document, the patterns 
start to look distorted. This can be reme­
died by choosing the Grid option before 
making copies, since it creates an auto­
matic grid that's 8 pixels apart, "gluing" 
your pattern down before it's copied. 

Stretching Images 
To select an image, use the Marquee tool 
to select the entire picture, then press 
Command while dragging the edges of 
the highlighted image. Drag from the 
edges, and one dimension of the image 
will be stretched. Drag from the corners 
and both horizontal and vertical dimen­
sions of the image will be altered. 

Keeping Patterns Intact While 
Stretching 
You can keep patterns from distorting 

during stretching by holding the Shift 
key down while dragging the edges. 

Stretching And Shrinking 
Rectangles Proportionately 
When working with a rectangular graph­
ic, you can control proportional stretch­
ing or shrinking by pressing Shift­
Command while stretching from the 
edges. If you drag from the corner while 
holding down these keys, the proportions 
of the picture will remain intact. Drag 
from the sides, and the horizontal resiz­
ing is limited in proportion to the verti­
cal position of the cursor. 

Keeping Rectangle Patterns 
Intact When Resizing 
Keep the pattern of your rectangle intact 
by holding down Shift while stretching. 

Changing Fonts Without Creating 
A New Entry Point 
Changing fonts mid-text can be a prob­
lem, especially if you don't want to create 
a new text entry insertion point. But it 
can be done without changing the font 
already entered by pressing Enter and 
choosing the new font or style. Once this 
has been done, though, you can't 
backspace past the point where the Enter 
key was pressed. 

Changing The Font Size Of 
Entered Text 
You can change the font size of text that's 
already been entered by pressing 
Command and both arrow keys ( < and > ). 

Changing The Font Of Entered 
Text 
Change the font of text already typed in 
by pressing Command-Shift and the 
arrow keys. 
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Command-comma brings the text to 
the next smaller font size. 

Command-Shift-period changes the 
entire entered text block to the next font 
shown on the font menu. 

Command-Shift-comma changes 
entered text to the previous font shown on 
the Font menu. 

Creating Ultrabold Letters 

You can create extra-bold letters by enter­
ing your text in Bold and Outline from 
the Style menu. Then, use FatBits, or the 
paint bucket's Fill option, to fill in space 
inside each of the letters. The Fill selec­
tion gives letters a shaded look. 

Creating Special Effects With 
Fonts 
You can create interesting special effects 
with any font and MacPaint.Just type 
your letters on the screen the way you 
want them to appear. Then select all the 
text with the Marquee tool. Now, either 
trace the edges with a shadow (Command­
Shift-E) or trace the edges normally 
(Command-E). Then, do a Command­
Shift-E. Do it several times to create 
progressively wilder effects. You can fool 
around with other options, like inverting 
the image, to get the best results. 

Grid Option Assists Text Entry 
Use the Grid option while working on doc­
uments requiring a lot of text entry, since it 
makes it easier to align new text inserts. 

The Fast Way To Edit Brosh 
Shapes 
Take the express route to the Brush Shapes 
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window by double-clicking on the Paint 
Brush tool. 

Edit Brush Shapes With A Font Or 
Resource Editor 
Brush shapes can be edited with a font 
editor. Use one that has the ability to 
access fonts stored as resources with appli­
cations. The font stored in MacPaint is 
"12." It contains characters with ASCII 
values 120-151 that make up MacPaint's 
brush shapes. Just use the font editor's 
edit mode to alter these characters to the 
new brush shapes and save the changes 
you've made. 

Customizing Your Eraser 

The standard eraser in MacPaint is a 16 x 
16 pixel square. You can make it as thickj, 
thin, or round as you like by selecting the 
paintbrush tool and choosing white as 
your brush color. 

Erasing Large Portions Of The 
Screen 

To erase large parts of your graphic quick­
ly, select one of the shape boxes (choose 
the colored one, not the transparent 
version). Then pick white as your fill color 
and select the dotted-line (invisible) 
outline. Finally, draw the shape directly 
over the part of the screen you want to 
erase. You'll still probably have to clean 
up the edges with the eraser. 

Another way to eliminate large illustra- : 
tions is to choose Show Page from the 
Goodies menu. Move the page until your 

graphic has disappeared from the screen, 
then hit OK. When you reposition the 
page again, the section you moved off the 
screen will be gone for good. 



The Lasso is useful for eliminating oddly 
shaped illustrations. Outline the shape, 
then press backspace to erase it. 

For large, uniformly-shaped areas, use the 
Marquee to highlight, then use backspace 
to erase. 

Shadowing Images 
Shadows can be added to MacPaint 
images. Just select the drawing with the 
marquee. Now, hold down Shift and select 
Trace Edges from the Edit menu. 

lasso Tool Doesn't Have To Close 
Its Loop 
The lasso tool doesn't require you to com­
pletely encircle the object you're lassoing. 
When you release the button, the lasso 
automatically completes the loop in a 
straight line back to the point where it 
started. 

Merging Patterns In Shapes 
It's possible to place one patterned shape 
over another without obscuring the origi­
nal shape. Press Command while select­
ing the paint brush, spray can, paint 
bucket or shape drawing tools. When you 
select this mode, both shapes' patterns 
will merge at the points where they over­
lap each other. 

Adding New Patterns To Your 
Palette 
If you create or find a pattern that you'd 
like to add to the patterns palette, choose 
a pattern you think you can live without. 
Then choose Edit Pattern from the 
Goodies menu and click the mouse on the 
part of the screen that you want to copy 
the pattern from. The new pattern 
replaces the old one. 

Using The Flip Horizontal Option 
To Create Gantt Charts 
You can produce large drawings or Gantt 
charts easily by printing out large draw­
ings in 8.5 x 11-inch sections on a 
Laser Writer, using the Flip Horizontal 
option to create a mirror image. Then, 
trim the pages and assemble with trans­
parent tap on the back of the drawing. 
The resulting 300-dpi flipped-image 
montage can be used as a master in a 
blueprint machine. 

MACPAINT 2.0 

Using ResEdit To Change Default 
To Pixel Measurement 
You can change MacPaint's default mea­
surement from inches to pixels, which is 
particular! y useful to programmers and to 
desktop publishers. Make a copy of 
MacPaint, and use ResEdit for a little 
surgery on the copy. 

First, use ResEdit to open your copy of 
MacPaint. Open the PREF resource. 
Open PREF ID= 128. On the line: 

00000008 0008 017B 0009 0001 

... change "017B" to 007B". 

In this position, 00 is for pixels, 01 is for 
inches, and 02 is for centimeters. 

When you've made the change, Quit 
ResEdit and type Y to save the changes. 

PIXELPAINT 

"Animating" Drawings With 
Color Cycles 
Here's a way to make PixelPaint cycle 
through colors on the color palette to 
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"animate" drawings. It's a great way to 
bring a picture of a waterfall to life, or to 
make a daytime sky seem to pulse with 
clouds. 

First, select the colors you want to cycle 
between by clicking the mouse on the 
color box and then dragging the cursor to 
the color you want. Then choose the sec­
ondcolor. 

Mter selecting colors, pick the selection 
tool, turn Caps Lock on, press the shift 
key, and click the mouse button. To stop 
the cycling, click again. 

This is quite spectacular if you copy a 
color Mandelbrot picture to the 
Clipboard, go into PixelPaint, and paste 
in the picture while in the Special Effects 
mode. 

PHOTOS HOP 
Comparing Original And 
Adjusted Images 
When you are using one of the functions 
under the Image Adjust menu, you can 
toggle between the current adjusted 
image (while you are working on it) and 
the original by clicking on the title bar of 
the dialog box. By clicking on the title 
bar, you are temporarily turning off the 
Video LUT animation and the original 
image (without adjustment) is being dis­
played. This can make minor adjustments 
easier to assess on-screen. 

Fine-tuning Palette Tools 
To use the tools in the Adobe Photoshop 
palette with greater accuracy and preci­
sion, turn on the Caps Lock key. This 
converts the standard tools into cross­
hair tools. 
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Ghosting With The Alpha 
Channel 
Photoshop's alpha channels are 8-bit gray­
scale images, so you can use them to do 
complex 8-bit masking. 8-bit masking 
lets you create soft-edged (or feathered) 
selections that blend in with the rest of 
the image- vital if you're creating subtle 
photo-realistic effects. 

To obtain the "ghosting effect", paste a 
gray-scale image into an alpha channel, 
and then make it the active selection 
mask. By using the Levels control to 
change the contrast, you can make the let­
ters ghost through the image. 

Creating A Textured Mask Using 
The Alpha Channel . 
To create a textured mask, select a patterd 
or picture and choose the Define Pattern 
command from the Edit menu to make it 
a Photoshop pattern. Fill an alpha channel 
with this pattern (using the Fill command 
from the Edit menu), and make it a selec­
tion mask with the Alpha->Selection 
command. (Because of the complexity of 
the selection at this point, you may want 
to suppress its flickering edges with the 
Hide Edges command.) 

You now get a textured effect when you 
paint on the image, because the paint 
Bows only into the areas of the pattern 
that were white within the alpha channel. 

You can vary this effect by using the . 
Hue/Saturation controls to dramatically' 
colorize the image (the changes are 
applied only to the white areas of the 
alpha-channel pattern). Or you can take 
another image and, using the Paste Into , 
command (on the Edit menu), paste it 
into the selection. The image will flow 



only into the areas of the pattern that 
were white within the alpha channel. 

Creating A Montage With The 
Alpha Channel 
To create a montage with one image 
gradually blending into another, you 
must modify one of the images so that it 
behaves like a gradient fill- that is, the 
pixels are opaque at one side of the image 
and transparent at the other, with a tran­
sition area in the middle. 

To do this, create a linear-gradient fill in a 
new alpha channel and make this channel 
the active selection mask. The mask will 
be applied to the entire image, giving it 
the same properties as the gradient fill. 
This means that the image's pixels will 
now follow a gradient from opaque to 
transparent, matching that of the alpha 
channel. 

Copy the selection to the Clipboard, and 
then paste it on top of a second image. 
The pasted image will merge with the 
background artwork to create the effect 
of one image blending into the other. 
The background art will be hidden 
where the first image's pixels are opaque 
and will show through where its pixels 
are transparent. 

Creating A Vignette With The 
Alpha Channel 
The same principle lets you create a 
vignette (a picture that shades gradually 
into the background). Use the New 
Channel command to create an alpha 
channel, and create a radial blend going 
from black (in the middle) to white. 

Make the alpha channel the active selec­
tion mask, and apply the Gaussian Blur 
filter to the image. The selection mask 

controls the strength of the filter's effect­
the image is intensely blurred toward the 
edge (where the alpha selection is white) 
and unchanged in the center(where it is 
black), following the gradient created in 
the alpha channel. 

SMART ART 1.0.1 

Using Smart Art To Preview 
EPSFFlles 
It can be a real pain to browse EPSF files. 
You can use Smart Art to browse because 
of the program's ability to preview 
unopened documents. 

J usc open the folder of EPSF files from 
Smart Art's Open dialog box and select 
the file you want to view. The preview 
window lets you zip through numerous 
files that are still displayed in a reduced, 
but recognizable, size. 

Remember, though, you're only preview­
ing files. Don't try to open these files in 
Smart Art. 

Smart Art Can View Old LaserFX 
Flles Through Desktop 
Publlshing Program 
Smart Art can create screen images for the 
EPSF files produced by some of the earlier 
text special-effects programs such as 
LaserFX. These first-generation programs 
have some wonderful effects, but when 
you place them into a page-layout desktop 
publishing program, all you see on-screen 
is a gray box. Smart Art can fix that, pro­
vided that the creator program can save 
files in EPSF and that you're working 
with a 300-dpi PostScript printer. 

First, save the effect as an EPSF document 
and open the document with Smart Art. 
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Then, click on Smart Art's Reimage but­
ton. After a few moments, Smart Art cre­
ates a screen image of the text special effect. 

Save the file from within Smart Art. When 
you place the new file in a DTP program, 
you'll see what the graphic will look like 
when it prints out. 

ViewingAutoCAD (PC) Drawings 

Although it's possible to place AutoCAD 
drawings (from an IBM PC) into 
PageMaker documents on the Mac, there's 
no screen preview-only a cryptic gray 
bounding box. Here's a procedure, using 
SmartArt from Adobe, that provides on­
screen viewing of the CAD drawing in 
PageMaker. The process may seem rather 
involved, but it really only takes a few 
moments and the results are well worth 
the effort. 

1. After you complete the drawing in 
AutoCAD (version 1.0), go to your 
AutoCAD setup menu and change the 
plotter driver from whatever you normal­
ly use to PostScript Plotter Driver. Be sure 
to set the resolution to 2,500 dpi if you 
plan to output the final PageMaker docu­
ment to a Linotronic. 

2. Plot the drawing to disk (you have the 
choice in AutoCAD of plotting to a print­
er or to a disk). 

3. Using aMacintosh-to-PC file-transfer 
utility (like Maclink Plus by Data Viz), 
transfer the plot file to the Mac. 

4. Create a new Illustrator document. 
Place the AutoCAD plot file into the 
Illustrator document with the Place com­
mand from the File menu. An empty box 
with an X through it will appear onscreen. 
The box will be about the same size as the 
original AutoCAD drawing. At this point, 
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you can rotate the box if you need to. 

5. Save this illustrator document, using 
the Save As command. Click on the 
option for including, a preview for 
Macintosh, and be sure to click on the 
"Include copy of placed Encapsulated 
PostScript file" check box. 

6. Using the SmartArt DA, open the 
Illustrator file. A gray box will appear in 
the SmartArt window. Click on the 
Reimage button. SmartArt will send the 
Illustrator file to your PostScript-compat~ 
ible laser printer for translation and 
reimaging. When it has finished this pro­
cess, a good screen representation of the 
original AutoCAD drawing will then 
appear in the SmartArt window. j 

7. Save the document (SmartArt won't ask 
you to rename it unless you choose Save 
As). The document is now ready to place 
in a PageMaker document with 
PageMaker's Place command. The draw­
ing will be completely visible and ready 
to Output to your laser printer or a 
Linotronic. The drawing will be embed­
ded in the PageMaker document, which 
means you don't have to provide your 
Linotronic service bureau with associated 
graphics files along with your PageMaker 
document. 

SUPERPAINT 
Making Shadowed Text 
You can create interesting shadowed 
effects on your text by selecting the font 
and style while in the draw mode, and 
then typing your text. (Hint: bold text 
looks best with this effect.) Switch to the 
Paint layer and choose a brush pattern, 
such as a simple dithered gray. Then, 



choose Text Pattern from the Style menu, 
and on another part of the page, type the 
text exactly the same as the text in the 
Draw layer. Now, switch back to the 
Draw layer and move the original text to 
create a shadowed effect. When you get 
the effect you like, copy the shadowed 
text on to the Draw layer. 

Enlarging Any Selection 
You can enlarge any selection in 
Super Paint to page size, or to any size you 
want. First, use the Lasso or Marquee tool 
to select the picture you want enlarged. 
Then, use Command-C to copy the 
graphic and press Command-A to select 
the screen. Next, press Command-V to 
paste and, after a few seconds, the selec­
tion will fill the entire screen. 

If you want a smaller enlargement, instead 
of pressing Command-A to select the 
entire screen, use the Marquee to select 
the size, then press Command-V to copy 
the graphic. 

You'll find this helpful when you enlarge 
graphics, since you can choose the size 
right away, instead of having to enlarge it 
step by step. 

Moving Tiny Items Easlly 
If you seem to be going blind trying to 
move tiny objects around, try drawing a 
line near the object to be moved, then 
grouping the two objects together and 
using the line as a "handle" to move the 
tiny item to its new destination. 

This also helps keep the Pointer tool from 
blocking your view. This also works in 
other graphics programs that allow object 
grouping. 

Using The Lasso While The 
Marquee Is Selected 
While in the Paint layer, you can have the 
Marquee tool selected and still be able to 
use the Lasso tool. Just hold down the 
Option key to turn the cursor into a Lasso, 
making it easy to select odd-shaped bit­
maps on the screen. 

"Nudging" Selected Graphics By 
A Single Pixel 
While any item is selected with either the 
lasso or the marquee, you can "nudge" it 
in any direction by using the arrow keys. 
If your keyboard has no directional arrow 
keys, use Command-Y to nudge 
upwards; Command-J to nudge left; 
Command-K to nudge right; and 
Command-D to shift downwards. 

Closing All Open Windows At 
Once 
Hold down Option while selecting Close 
from the File menu and all windows that 
are currently open will close. 

Crosshairs Can Help You Paint 
From A Centered Point 

Instead of choosing Draw (Paint) From 
Center before drawing one of the 
QuickDraw primitives to paint the shape 
from a centered point, you can double-dick 
on the palette tool you select instead of just 
clicking. The icons in the palette will then 
show crosshairs to identify the difference. 

Reversing The Pattern 
When editing paint patterns or paint 
brush shapes, hold down Command while 
clicking the mouse anywhere in the pixel 
editing box to reverse the pattern, making 
black white, and white black. 
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Creating A Spattered Effect 
You can create an interesting "spattering" 
effect by choosing the paint brush pattern 
that you'd like to spatter and then paint­
ing with the spray can while holding down 
Option. The faster you move the mouse, 
the further apart the spatters will paint. 

Creating a "Screening" Effect 
A great "screening" effect can be created 
by using Paint On Black and the selection 
rectangle, especially in conjunction with 
the Laser Grey patterns. If you don't like 
the effect, try moving the marquee one 
pixel up or down to change most of the 
screen effects. 

Smoothing Bitmapped Images 
For Laser Printing 
If you have an extensive library ofbit­
mapped clip-art, there's a way to smooth 
images for printing on the Laser Writer. 
Open your image in Super Paint and Save 
it. Then Open the new document, hit the 
Place Laserbirs command, and cell it to use 
the file you just created. The result will be 
a 1116 original size document at 300 dpi, 
and it prints perfectly. Realize that the 
larger your original image, the longer it 
takes to print. 

Turn Smoothing Off To Speed Up 
Printing 
When printing a Laserbits document, 
turn the smoothing effect off to speed up 
printing. 

Lower Detail Level Speeds 
Smoothing 
When using FatBics, don't immediately 
jump to the finest detail level. Instead, use 
the left side of the screen, which displays 
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the actual appearance of the work, as your 
guide. If you can see all of the object you'll 
be working on, stay on that magnification 
level unless you really need a finer one. 
You'll save time smoothing work if you 
work in the lowest possible magnification. 

Adjusting Length On Imported 
MacDraw Graphics 
Super Paint's print area is approximately 7 
11116 inches by 9 5/8 inches, which is 
slightly wider, and shorter, than 
MacDraw. A quick fix is to set the Page 
Setup to enlarge at 104%. This results in 
1 0-inch lengths when you need them. 
J usc remember to watch the width of 
your job, since it expands sideways as 
well, and also set the print dialog box to 

print only the first page. This circum­
vents Super Paint's need to send a blank 
page through when enlargements are 
requested. 

HARDWARE 

AUDIO OUTPUT 

Connecting A Stereo To The Mac 
The proper cable to connect the Mac's 
audio output to a stereo system is often 
hard to find. Fortunately all it takes is a 
trip co your local Radio Shack. Look for 
Part Number 42-2153. It's a Y adapter 
with a mini mono phone plug at one end 
and a pair of RCA phono plugs at the 
ocher end. You may need more than 42-
215 3 's 9-inch length. To extend this 
cable, use Radio Shack's 42-2472. You 
can use several of these if necessary. 



CD-ROM 
Software For Apple CD SC Under 
System7 
Versions of the Apple CD-ROM system 
extension prior to 3.0 are incompatible 
with System 7. Version 3.0 is mostly 
compatible with System 7 (which means 
it will work OK), but version 3.1 is rec­
ommended. You should install the Apple 
CD-ROM software BEFORE installing 
System 7. The upgrade to version 3.1 is 
free and can be found on the System 7 
Group Upgrade Kit CD. 

DAISYWHEEL 
PRINTERS 
Connecting Daisywheel Printers 
To The Mac 
Would you like to hook up your old daisy­
wheel printer to a Mac to get the letter­
quality output? 

First thing to know is that only a printer 
with a serial interface can be connected 
to the Mac. If your printer is serial, then 
you need a Mac-to-Image Writer printer 
cable. If it's parallel, you'll have to find a 
way to convert the signal. There are a 
bunch of parallel-to-serial converters on 
the market, selling for anything from 
$50 to $15.0. Depending on how you set 
it up, the converter will either translate 
serial to parallel or (if you're using a dot 
matrix printer) it'll translate the 
Image Writer-type printer codes into 
your printer's codes. 

Another problem you may encounter is 
persuading the Mac that it's not hooked 
up to an Image Writer or LaserWriter. 

One of the Mac's high-scoring concepts 
is that each Mac program doesn't have to 
know how to deal with several different 
printers. As long as the program plays by 
the rules, it can print on any printer 
whatsoever, assuming there's a driver for 
that printer in the System Folder (the 
driver describes the printer, its features, 
and how it operates). That's the good 
news. The bad news is that the only 
drivers Apple gives away (or even offi­
cially supports) are the drivers for its own 
printers, which are Image Writers and 
Laser Writers. 

Fortunately, drivers for non-Apple print­
ers are available from lots of non-Apple 
companies, notably GDT Softworks. Its 
MacDaisy Link (about $80) is a set of 
drivers designed for use with more or less 
generic daisywheel printers. 

DISKS 
Magnets Are Lethal To Disks 
Never expose your disks to any magnetic 
force, since it can wipe your data clean off 
the disk. If possible, store disks away from 
metals such as file cabinets. 

Also, avoid placing hard disks and floppy 
drives to the left of a Macintosh, since the 
power source has magnetic qualities. 
(Most, but not all, Macs have the power 
source on the left.) 

XRaysandYourDisks 
You may be wondering whether it is safe 
for diskettes to be scanned by an airport 
X-ray machine. Experience has shown 
that you shouldn't trust your floppies to 
airport-security machines,.and the same 
caution should apply to hard-disk drives 
as well. 
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But fear not for the safety of your data 
whilst traipsing through airports. Simply 
put your hard-disk drive and your floppies 
into a separate bag, and allow 20 minutes 
for a hand search procedure. In general, 
you may be expected to fieldstrip your bag 
and prove that your drive works by plug­
ging it in and starting it up. 

While we're on the subject of data preda­
tors, the anti-theft systems in public 
libraries and bookstores are unlikely to 
blitz your data. But beware of the desensi­
tizing machines at checkout stands. These 
machines (decorated with festive "DO 
NOT PLACE CREDIT CARDS ON 
THIS MACHINE!" stickers) contain 
powerful electromagnets. 

ERROR TONES 
Diagnosing The Tones 
The Mac has a cryptic system of error ID 
codes, which is supplemented by a sys­
tem of cryptic error tones. If there's a 
hardware problem, on startup you'll hear 
the specific tone indicating the relative 
hardware problem. For example, one tone 
indicates that your RAM has a problem. 

To learn more about the Mac's error 
tones, there is a program called 
Diagnostic Sound Sampler, that plays all 
the tones and explains what they mean. 
You should be able to get a copy of this 
program from a user group or on-line 
service. 

FAX MODEMS 

ATM Type For Fax Modems 
The best way to image type for a fax 
modem is through Adobe Type 
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Manager. ATM uses the power of 
PostScript to create crisp text on-screen 
at any size, and the fax modem transmits 
that scaled type directly. If you don't use 
ATM, the only way to avoid jagged­
looking type is to install bitmapped 
screen fonts that are three times the size 
of those in your document. The fax 
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modem software uses the oversized fonts 
to scale the type correctly for transmis-, 
sion, but this option can be limiting. 

Only a few fax modem vendors supply the 
necessary triple-sized fonts, and those that 
do usually provide only a limited selection 
of sizes and faces (often just Times, 
Helvetica, and Courier). If you want to 
use 11- or 13-point type for legibility 
(easy to do with ATM), you'll first have t? 
find or make 33- or 39-point bit maps. ! 

With ATM, you avoid all these problems. 
(Keep in mind, however, that ATM works 
only with Type 1 PostScript fonts. 
Chicago, New York, and other bit­
mapped faces will still suffer from the jag­
gies if you don't have triple-sized fonts 
installed.) 

FLOPPY DISKS 

Noisy Disks Signal Trouble 
If your disk makes more noise than usual 
upon being inserted into the disk drive, it 
might not have been aligned properly by 
the Mac. Eject it and try to boot it again. 
If a certain disk consistently makes 
unusual noise, back it up as soon as possi­
ble and don't save new data to it- the data 
may be corrupted. 

Troubleshooting Problems 
Below are some techniques and questioqs 
to ask when troubleshooting a floppy di~k 
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drive problem. If your Mac is still under 
warranty, leave repairs to your dealer, 
don't attempt anything you aren't com­
fortable with, shut down before opening 
the case, and handle all components with 
the greatest care. 

1. Good BOOK floppy disks suddenly 
become unreadable, and you can't initial­
ize blank floppy disks. If you have a mod­
ular Mac (Mac II series), you can easily 
take the cover off and check to see that 
the ribbon cable connecting the floppy­
disk drive to the motherboard is firmly 
seated. There's also a chance that the 
drive has dirty heads. You can buy clean­
ing diskettes from your local computer 
store; they look like regular diskettes 
except that they have a felt disk instead of 
a plastic one. Insert the premoistened 
cleaning diskette into the drive, and wait 
the prescribed time. 

2. You have the problem described in 
No. 1, cleaning hasn't solved the prob­
lem, and other floppy disk drives con­
nected to the same computer work fine. 
You (or someone else) may have dam­
aged the heads by forcibly removing a 
stuck disk. You can't fix this yourself, 
but you can remove the drive to have it 
repaired. 

The floppy-disk drives on the II, IIx, and 
IIfx are fastened to a horizontal mounting 
plate by a single Phillips-head screw. 
Unplug the data cable, remove the screw, 
and take out the drive. On the Hex and 
IIci, this operation is not as straightfor­
ward: unscrew the Phillips-head screw on 
the corner of the floppy-disk/hard-drive 
assembly, remove the power supply and 
cables, and the two drives will pop out. 
Rebuilding an 800K drive (with new 
heads) costs about $100. 

HARD DRIVES 

Data Errors Caused By RFI 

Some external hard disk data errors are 
caused by the RFI (radio-frequency inter­
ference) of fluorescent lights. 

To eliminate RFI problems, use double­
shielded, twisted-pair SCSI cables. Make 
sure that all the cables have a separate 
drain line running the entire length of 
the cable and that the shielding connects 
directly to the metal shell of the connec­
tors at both ends of the cable. 

Does Defragmenting Improve 
Performance? 
A fragmented file is one whose data is scat­
tered across the disk, rather than being in a 
single, contiguous section. Fragmented 
files take longer to read and write to 
because the disk head has to move to dif­
ferent areas of the disk to find different 
parts of the file- and the Mac can't do any­
thing except wait while the disk head is in 
motion. 

According to Karl B. Young, unsung 
author of Apple's Disk First Aid, disk 
defragmenting is rarely necessary unless 
your disk is so full you must often resort to 
deleting files just to make room. 

If you do want to defragment your disk, 
there are several utilities out there, 
including Norton Utilities and MacTools 
Deluxe. 

Resetting SCSI ID Clears Up Mac 
Boot-up Knot 
If, when you turn on your Mac, it doesn't 
boot from the hard disk, it just displays the 
blinking question mark, but then upon 
restarting your Mac it boots fine, read on. 
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This is happening because the disk isn't 
ready by the time your Mac gets around to 
checking for boatable devices. It takes 
time for the disk to go from a dead stop to 
operating speed, and in some cases this 
time will increase as the disk ages. 

One fix is to stuff your Mac full of RAM­
say, 32 Mbytes. The Mac performs a 
memory test every time it's turned on, and 
the more memory you have, the longer 
this test takes. 

A more prosaic solution is to change your 
disk's SCSI ID to zero. The Mac handles 
this ID as a special case and will wait as 
long as need be for a device at ID 0 to 
become ready. 

Troubleshooting Hard Disk 
Problems 
Below are some techniques and questions 
to ask when troubleshooting a hard drive 
problem. If your Mac is still under war­
ranty, leave repairs to your dealer, don't 
attempt anything you aren't comfortable 
with, shut down before opening the case, 
and handle all components with the great­
est care. 

1. You can't get past the Welcome to 
Macintosh message when you start up. 
This symptom can indicate that you have 
a corrupted Finder. Start up from a 
floppy containing the same versions of 
the System and Finder that are on your 
hard drive, drag a fresh copy of the Finder 
from the floppy to the System Folder on 
the drive, and choose Restart from the 
Special menu. If the hard drive boots nor­
mally, the problem is fixed. (You can also 
try installing a new System, using the 
System-installer disks that came with 
your Mac.) You may need to completely 
trash the System and Finder file before 
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copying or reinstalling the new ones. 

2. You can't get past the blinking ques­
tion-mark icon, and you're sure that the 
hard drive is spinning. Check for any SCSI 
problems such as an ID conflict, a termina­
tion problem, or a loose cable. To check the 
SCSI ID number, look on the switch on 
the back of each device or use a utility such 
as SCSI Probe (a freeware utility available 
from Zmac and other on-line services and 
use groups). Each device should have a 
unique number from 0 to 6, inclusive. 

When checking termination, be aware 
that only the first and last SCSI devices on 
a chain should be terminated. Some prod­
ucts are shipped with internal termina­
tion, however, and if you have one of these 
devices in the middle of a chain, you'll 
have problems. Check with the manufac­
turer to find out if a device is internally ter­
minated. If it isn't, check to see if there is a 
50-pin flow-through terminator plug on 
the SCSI connector. Remove the plug if 
the device is in the middle of the chain; 
add a plug if it's the first or last device on 
the chain. 

3. You can't get past the blinking ques­
tion-mark icon, and you've ruled out SCSI 
problems. You may have corrupted boot 
blocks. First, try using a hard-disk-recov­
ery utility such as Norton Utilities for the 
Macintosh to examine the disk. 

If you still have problems, your next step 
is to try SCSI-formatting software, such 
as Silverlining from LaCie or Format/ 
Partition from NuvoLabs. Start up from 
a floppy disk containing the SCSI-for­
matting software. If it recognizes the 
drive, there's a good chance you can fix it. 
Look for a menu item that verifies blod<s 
and runs a drive test. If a dialog box at 



the end of the test reveals that bad 
blocks were found and successfully 
reassigned, try to mount the drive (your 
software may let you do this from within 
the program). If you're successful, you'll 
have solved the problem and saved most 
of your data. If you can't mount the 
drive, your formatting software gives 
you a couple of options: reinitializing 
(which overwrites the directory) or 
reformatting (which overwrites the 
entire drive and tests the blocks). You'll 
lose all your data if you do either of 
these operations, so make sure you back 
up your files regularly. 

4. You can't get past the blinking 
question-mark icon, and you can't hear 
the internal hard drive spinning. If this 
happens, the bearing lubricant may have 
thickened or the heads may have stuck 
to the medium. Either way, there's a 

good chance you can fix it. On the II, Ilx, 
and Ilfx, the hard drive is fastened to a 
metal mounting bracket by two Phillips­
head screws. (On the Ilcx and IIci, the 
hard drive isn't screwed in, so you can 
simply pop it out.) Unplug the data and 
power cables, remove the mounting 
screws if necessary, and briefly place the 
drive in direct sunlight. More often than 
not, a few hours of the sun's heat will 
thin the lubricant or free the heads, at 
which point the drive should work fine. 
A variant on this procedure is to carefully 
turn the computer upside down or on 
its side and leave it somewhere warm 
(about 70 degrees) overnight. 

5. You can't get past the blinking ques­
tion-mark icon; the drive makes strange 
scraping noises, the stepper motor ticks, 
or the drive isn't spinning, and you have 
reason to believe it's not a power-supply 

or motherboard problem. Send the whole 
drive module to be repaired. Some repair 
shops will retrieve all or some of your data. 
Prices vary with drive size, hours of time 
spent in recovery and overnight service. 

Interleave Factor And Hard Disk 
Performance 
The performance of your hard disk 
relates to its interleave factor. If you 
change machines or add an accelerator 
card, you may need to change the inter­
leave. As a rule, drives attached to a Mac 
Plus work best with a 3:1 interleave; 
those attached to an SE require 2: 1; and 
Mac lis, Ilx's, SE/30s, and all accelerated 
Pluses and SEs work best if the disk has 
a 1:1 interleave. 

To see what that interleave is and to 
change it, use the latest version of 
Apple's HD SC Setup (which is part 
of the System Tools 5.0 or 6.0 package). 
Hold down Command-! after you arrive 
at the application's window to access 
the interleave areas of the program. 
Remember to back up your entire 
disk before changing the interleave. 
Changing the interleave requires 
reformatting the disk - an operation 
that destroys all the data on the disk. 

Old Apple Serial Still Works 
Though we certainly wouldn't recom­
mend it to anyone as a primary storage 
device, Apple's old non-SCSI Hard Disk 
20 is compatible with some of the latest 
Mac models. According to Apple, the 
Mac 512KE, Plus, SE, Classic, Portable 
and Ilci all work fine with the turtle-slow 
serial drive. All other Macs (aside from the 
original and Fat Mac) do not work. 
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HIGH-DENSITY DRIVE 
Adding A SuperDrive (FDHD) To 
A Mac Plus 

If you have a Mac Plus or SE and would 
like to add Super Drive capability to it, 
the Apple external FDHD won't work. 

What you can use are a pair of peripher­
als, Rapport and Drive 2.4 (Kennect 
Technology). Rapport is a plug-in 
microprocessor and drive controller that 
lets your Mac read 3.5-inch, 720K MS­
DOS, OS/2 and ProDOS disks (low den­
sity), using the existing BOOK internal 
drive. Drive 2.4 is an external drive that, 
in addition to supporting all existing 
Apple and IBM 3 .5-inch disk formats, 
supports two high-density formats that 
provide 1.2 megabytes of storage on 
BOOK disks and 2.4 megabytes on high­
density disks. Rapport supports the Mac 
512KE, Plus and SE. The Drive 2.4 sup­
ports the 512KE, Plus, SE/30, II, Ilx, 
Ilcx, Ilci and Ilfx. 

Such wizardry is possible because the prod­
ucts are the brainchild ofWendel Sanders, 
a major contributor to the Apple III team 
and codesigner of the SWIM disk-con­
troller chip that controls the floppy drive in 
Macs that have FDHDs. (Interesting 
Macintosh trivia: SWIM stands for 
Sanders/Wozniak Integrated Machine, not 
Super Wozniak Integrated Machine or 
Steve Wozniak Integrated Machine.) 

HP DESKWRITER 
Fooling The Desk Writer When 
Printing On Letter-Size Paper 
You may notice when printing a docu-
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ment that extends from top to bottom on 
aU .S. letter-size page that the HP 
Desk Writer leaves the bottom inch of the 
paper blank and prints those last lines on a 
second sheet. To fool the Desk Writer into 
printing all the data onto the letter-size 
paper, use the Page Setup command to 
indicate that you are using U.S.legal-size 
paper even though you are not. 

IMAGEWRITER 
What You See Isn't Always What 
You Print 

When you print, the Image Writer (I & II) 
uses a font twice the selected size (if it's 
available in the System) and then scales it 
down to produce high quality output. 
Fonts usually don't change from one size 
to the next. But Geneva is the exception 
that proves the rule: its lower case "y" in 
12 point has a distinctly different descen­
der than the 9-point "y" and both have 
different forms than the 24-point charac­
ter. That means, when you print high 
quality in Geneva, you'll often get some 
characters that print quite differently than 
they display on-screen. 

How To Access The Self-Test 
Mode 
The Image Writer II can run self-test sam­
ples of all three printing modes. To do 
this, turn the printer off and hold down 
the Form Feed button while turning it 
back on. This starts the draft mode self­
test. While it's printing, deselect the 
printer by pushing the Line Feed button 
and then push the Print Quality button to 
select a new mode. Then reselect the 
printer by pushing Line Feed. When thel 
print head begins a new line, it will prin~ 



in standard quality. Repeat step two to 
enter high quality mode. 

Modifying The Default Paper 
Sizes 

There is a freeware utility called PREC 
Manager, created by Bill Steinberg, coau­
thor ofPyro!, which makes it easy to 
specify custom paper sizes on an 
Image Writer. (It should be available from 
the usual shareware outlets: CompuServe, 
user-group libraries, bulletin-board 
systems, and so on.) 

PREC (which stands for PrintRECord) 
Manager lets you modify any of the six 
Image Writer paper sizes quickly and 
effortlessly. 

IMAGEWRITER II 
Producing Near-Letter Quality 
Printouts From The Image Writer 
Without Editing Codes 

There's an easy way to coax near-letter­
quality printing from the Image Writer II. 

Rather than using ResEdit or MacTools 
(we're not all hackers!) and the Print 
Merge function ofWord 3.0, simply 
select draft mode when the print dialog 
box comes up on the screen. Then, using 
the selection switches on the printer, 
select the typeface that you'd like to use in 
near-letter-quality mode (check your 
Image Writer II manual for details on how 
to select the various choices). 

How To Obtain Best Print 
Quality Fast 

Here's a way to obtain the fastest and best 
print quality from your Image Writer II. 
You can access the Image Writer II's 
built-in proportional fonts from within 

Mac Write or Microsoft Word. Certain 
fonts when printed with the "draft" qual­
ity access the printer's internal propor­
tional fonts. These internal proportional 
fonts are: Boston II 10 and 12 point, 
Toronto 12 point, Chicago 12 point, 
Venice 14 point, London 18 point, 
Athens 18 point, and San Francisco 18 
point. Other fonts, such as Geneva, use a 
monospaced font in draft mode that 
produces awkward spacing. 

Using The Image Writer And The 
HP PaintJet Film To Produce A 
Transparency 
If you've ever needed an overhead trans­
parency in a hurry (and in color, no less), 
here's an inexpensive solution: 

By using HP PaintJet transparency film and 
an Image Writer II printer, you can easily 
make a color (or black-and-white) overhead. 

IMAGEWRITER LQ 
Extending The Ufe Of 
Image Writer LQ Ribbons 
Here is one way of extending the life of an 
LQribbon: 

On the left side of the LQ (where the con­
trols are), there is a small switch. When this 
switch is depressed, the printer knows that 
a one-color (black) ribbon is loaded. The 
black ribbons have a tab protruding that 
should depress this switch. Color ribbons do 
nothavethistab.Makesurethatthetabis 
depressing the switch. Then most of the 
ribbon surface will be used for printing. 

Seating The Image Writer LQ 
Ribbon Properly 
If the top edge of your ribbon is receiving 
the brunt of the printing load, you may 
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not have the ribbon seated properly. 

A well-worn LQ ribbon has four parallel 
wear lines spaced evenly up and down on 
its surface reflecting the up and down 
movement of the print head. An improp­
erly seated ribbon defeats this motion, 
and the result is the characteristic top­
edge fraying. In other words, you're 
using only one-fourth of your ribbon. 

If you set up the printer as the manual 
instructs, there's every chance that you 
won't seat the ribbon properly, because 
doing so requires a degree of force and 
thumb pressure that most people will 
not instinctively apply to a new $1,300 
printer. 

To seat your ribbon properly, you must 
apply very strong thumb or finger pres­
sure to the extreme end of each of the lit­
tle arms that extend out from each end of 
the cartridge. You will feel a very satisfy­
ing click when it is properly installed. 

A Quick Tuneup 
If your Image Writer printer is more than 
two years old, it will benefit from a quick 
tuneup. All you need do is turn off the 
power, remove the ribbon, and clean the 
pin mechanism. Here's how: 

1. After removing the ribbon, locate the 
white plastic retaining clip, which is to 
the right of the printing mechanism. 
Gently pull the clip to the right so that 
you can lift the assembly up and out of 
the carriage. 

2. Using a general-purpose cleaner on a 
cotton swab, carefully clean any ink 
residue from around the pins. On the 
underside of the unit is a small cutout 
that allows lubrication of the pins. You 
can add a small amount of lubricant 
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(such as WD-40) here. 

3. Gently replace the assembly and the 
ribbon. You're now ready for another two 
years of printing. 

KEYBOARD 
There Are Three Apple Keyboard 
Options 
Mac buyers actually have three keyboard 
choices from Apple. They are the 
Standard, Extended and IIGS keyboards. 
The IIGS keyboard has the same key 
arrangement as the Standard keyboard 
but is about 10 to 15 percent smaller. 
The feel of the keys is also slightly differ­
ent, and the individual keys are relatively 
unsculpted and easier to rearrange (if, fqr 
example, you want to change it to a I 

Dvorak layout). If your dealer doesn't 
know what you're talking about, refer to 
Apple part number 658-4081. 

Using The Key Caps DADuring 
Keyboard Failure 
If one or more of the keys on your key­
board ceases to function or in the middle 
of a letter or document and something 
similar happens to you, simply go to the 
Key Caps DA. Click the mouse on the 
inoperative key and that letter, number,;or 
symbol will be shown in the text area at 
the top of the DA. Simply copy it from 
there and paste it where needed. ' 

Another option, which works in any pro­
gram that has a global search and replace 
feature, is to use a symbol that you ordi­
narily don't use in place of whatever the 
keyboard won't produce throughout the 
document. When you're done, use the I 

Change command under the Search mebu 
to have the program substitute the correct 



letter (or whatever) for the symbol. Paste 
the correct letter from the Key Caps DA 
stmight to the Change To area of the 
Change dialog. 

Cheap Keyboard Protection 
If you want a really cheap and easy way to 
protect your keyboard from dust or coffee 
spills, try wrapping it in plastic cling 
wrap. It last two to three months, and as 
long as you donee wrap it too tightly, the 
keyboard "touch" is the same. 

Running A Mac With A Copllot 
Did you know that you can run Macs with 
a real live copilot at your side? Just have 
your nearest Mac expert bring a second 
keyboard (and mouse) to your desk and 
plug it into one of the Apple Desktop bus 
(ADB) pons on the back of your Mac. 

The extra keyboard and mouse turn your 
Macintosh into a state-of-the-art training 
system, complete with room for a copilot. 
Your resident expert can sit beside you 
and demonstrate various techniques. This 
gives you the chance to try out the tech­
niques yourself without having to share 
the keyboard or mouse. 

The Keyboard Remembers What 
You Type 
The Macintosh has a very effective key­
board memory buffer. So, when you 
launch an application, you only have to 
wait about four seconds before starting to 
type, even if the application isn't fully set 
up on the screen yet. 

Having Numeric Keypads With 
The Pre-Mac Plus Keyboards 
Here's a simple tip for those of us with 
pre-Plus keyboards, which don't have 

numeric keypads: Use a macro program to 
redefine the backslash (\) key to be a plus 
sign ( + ). This saves a whole lot of shifting 
in spreadsheets, calculators, and other 
frequently used programs and basically 
doesn't cost you anything, since you sel­
dom need to use the backslash key­
unless you're running MS-DOS. 

Curing Keys With WD-40 
There comes a time in the life of every 
Mac keyboard when one of the keys fails 
to work. How-to articles describe how to 
repair the keyboard by breaking out the 
trusty ol' soldering pencil, tearing the 
keyboard apart, and replacing the individ­
ual key with one purchased from the local 
Apple dealer. Although this method does 
an admirable job, you may be uncomfort­
able doing this kind of minor keyboard 
surgery. There is an easier method that 
requires no soldering, based on the 
assumption that the key is probably suf­
fering from a dirty contact and that the 
contact can be cleaned with a judicious 
application of a solvent. 

Disconnect the keyboard from the Mac 
and carefully pry the key cap off the 
offending key. Now take a can ofWD-40 
(available at most hardware stores), insert 
the small straw that comes with the lubri­
cant into the nozzle, and direct as short a 
spritz ofWD-40 as possible at the point 
where the white key plunger enters the 
black body of the key. 

Work the key plunger several times and 
then reconnect the keyboard to see if the 
key works. The first application ofWD-
40 may not do the trick, but the key 
should be resurrected by the second or 
third try. 
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LASER PRINTERS 
Printer Care and Feeding 
Three hazards face a sheet of paper (or 
labels, transparencies, etc.) as it meanders 
through the Laser Printer's intestines. 
First, the page makes aU-turn as it trav­
els from the paper bin into the printing 
mechanism. If the page is a sheet of 
labels, some stickers may peel off while 
making the turn and get stuck among 
the innards of the machine. The solution 
is to feed the page manually to avoid 
theU-tum. 

Another problem is page thickness. 
Approximately a 60-pound cardboard 
(business-card stock) is the thickest stuff 
that can make it through the printer 
unscathed. 

Finally, there's heat from the fusion rollers 
at the end of the paper path. It can turn a 
happy sheet of transparency material into 
a hard glob of plastic nastiness that's ter­
minally fused to the printing mechanism. 
Because the lowest temperature of the 
heat rollers is typically about 150 degrees, 
you can test a sheet of material by setting 
an iron to 140 degrees or so and passing it 
over the sheet a few times. If the iron 
becomes permanently fastened to the 
ironing board, well, you have the answer. · 

Most office-supply stores sell special 
labels and transparency film for use with 
plain-paper copiers, which are very simi­
lar to laser printers; Avery 53 51 labels 
and Scotch 503 transparency film are 
commonly used for this purpose. 

Feeding Label Sheets 
Anyone who has ever fed a sheet of labels 
into a laser printer has feared that some-
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how a label is going to wreak havoc by 
peeling off its backing and adhering to 
the innards of the printer. 

If you print and remove a single label, the 
remaining sheet starts to curl at that end, 
increasing the likelihood that the sheet 
will jam the next time it's fed into the 
printer. The solution is to print from the 
bottom of the sheet, not the leading edge. 
Most label-printing utilities allow you to 
specify which label to begin printing so 
that you can- theoretically- use an 
entire sheet, one label at a time, starting 
anywhere on the sheet. Don't use the 
default setting of the first label on the 
sheet, but rather switch to the last one at 
the trailing end of the sheet. That way, 
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even if the sheet starts to curl, the leading 
edge will remain straight and you'll have. 
fewer problems each time you feed it into 
the printer. 

Printing The Screen 
Most 300 dpi printers -laser and ink jet­
don't support Command-Shift-4, which 
sends the contents of the active window to 
an Image Writer printer. 

Never fear. Your Mac has a built-in print­
screen-to-disk command. If you have a 
black-and-white monitor or color under 
System 7, Command-Shift-3 will create 
an editable and printable paint documen,t 
of the current screen, not just the active 
window. The document appears on the 
Startup disk as Screen X, where X repre­
sents a number between 0 and 9, inclu­
sive. You can take up to ten screen shots 
(Screen 0 through Screen 9) before you 
have to renumber them. Once you've cre­
ated a document this way, simply open 
the file with MacPaint (or any program 
that reads MacPaint files) and print it. 



If you have a color Macintosh system with 
System 6.x or earlier, Command-Shift-3 
works only if your monitor is set to black­
and-white (use the Monitor's cdev in your 
Control Panel to do this). System 7.0 will 
let you create color screen images when 
you use Command-Shift-3. 

An alternative is to use special screen­
printing utilities for any non-Image­
Writer printer if you want to print the 
active window directly to the printer. 
The good news is that there are a lot of 
alternative screen-dump INITs and 
Fkeys out there. One example is Nobu 
Toge's shareware Flash-It INIT/cdev 
(available from user groups, Zmac or 
other shareware sources). 

Avoiding The Startup Page Using 
The Paper Tray 
One way to stop your Laser Writer from 
printing a page each time it's started on a 
temporary basis is to pull the paper tray 
out an inch or so (the distance isn't criti­
cal) when you start the Laser Writer. 
When the green light stops flashing, indi­
cating the printer is warmed up and ready 
to go, push the tray back in. 

Preprinted Paper And The 
Laser Writer 

Here are some suggestions about using 
preprinted paper in a Laser Writer, such as 
paper that is offset-printed or copied on a 
copying machine. 

You shouldn't use paper that has been 
printed with thermography (raised letter­
ing), because the heat generated by the 
printer can melt the ink, which can cause 
problems. Depending on the chemical 
makeup of the ink, when the paper runs 
through the printer's fusing process, it 
tends to melt and can damage the fusing 

unit. It is better to be safe than sorry: 
letterhead or other paper printed with 
thermography is not recommended with 
any laser printer. 

On the other hand, Apple says you can use 
most precopied or colored paper in a laser 
printer. If you're not sure whether you 
should use a certain paper, Apple recom­
mends that you consider the following 
characteristics: 

Don't use paper with a colored coating that 
was added after the paper was produced, 
because the pigments used on the paper 
might not be able to withstand the 392-
degree temperature of the printer's fusing 
process. (You should also keep in mind that 
colored paper should be the same quality as 
regular photocopy paper.) 

To avoid problems with offset-printed 
paper, make sure the inks used are heat­
resistant and will not melt, vaporize, or 
release hazardous emissions when subject­
ed to the printer's fusing process. Whoever 
did the original printing should be able to 
help you in finding out about this. 

Copiers use the same electrophotographic 
process as a laser printer does, so running 
copied paper through shouldn't be a prob­
lem. Remember, however, that depending 
on the makeup of the copier's toner and the 
Laser Writer's cleaning process (which 
scrapes the paper), you may get toner drop­
pings in the bottom of your printer. 

To be safe, Apple says, you should avoid 
using the following in your printer: glossy 
paper, heavily textured or embossed paper 
(laser printing doesn't adhere as well to 
this kind of paper), carbonless or chemi­
cally coated paper, and paper and ink that 
are not compatible with the heat and pres­
sure of the printer's fusing process. 
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Using Word 4.0 To Disable The 
LaserWriter Test Page 
While in Microsoft Word 4.0, you can cre­
ate a document containing the following 
PostScript code, which when downloaded 
to the printer will disable the test page: 

serverdict begin 0 exitserver status­
diet begin false setdostartpage 

The important step here is to set the 
style of the code to PostScript style. To 
do this, select the text and then type 
PostScript in the style box in the lower 
left corner of the ruler (you can either 
select it with your mouse or press 
Command-Shift-S). 

There are also some shareware and com­
mercial utilities that switch the test 
page on and off, most notably CE 
Software's Widgets program. You may 
want to check out Apple's Laser Writer 
Reference and Adobe's PostScript 
Language Reference Manual, which con­
tain other PostScript commands and 
conditions for manipulating 
Laser Writer features. 

No Toner Is Forever 
Keeping important documents around 
for years or decades can be a little tricky. 
You should always use pH-neutral 
paper stock for archival printing and 
always store the documents in a cool, 
dry place away from light. 

And one more thing: If the documents 
were printed on a Hewlett-Packard 
LaserJet, don't store them with vinyl 
binders or notebooks. Vinyl reacts with 
the styrene plastic in the toner and 
breaks it down over time. 
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A Manual Fix For Envelope 
Jamming 
Envelopes frequently jam when going 
through a Laser Writer because they are 
too stiff to bend around the mechanism of 
the paper path. 

The low-tech solution is extraordinarily 
simple and takes about two seconds. 
Before printing, break the spine of the 
envelope. Run the flap edge of the enve­
lope between your thumb and forefinger, 
bending it at about a 45-degree angle as it 
passes through. Do this twice, bending 
once in each direction so that the envelope 
ends up Bat. Avoid paper cuts entirely by 
folding the flap over backwards. 

For an even better pass through the print­
er, break the stiffness along both long 
edges. This makes the envelope more 
flexible and the likelihood of jamming is 
substantially reduced. 

Keeping a LaserWriter Running 
You do not necessarily need to turn on a 
Laser Writer while you are using your 
Mac until you need it. Then, depending 
on whether you expect to do more print­
ing, you can either turn it off or leave it 
on. Turning your printer on and off a few 
times a day cannot harm anything, and it 
might even save a bit of energy. 

If we're talking more than two or three 
times a day, you wouldn't want to switch 
any piece of equipment on and off much 
more than that. Cycling a power supply 
(nerdspeak for "switching the thing on") 
causes a certain amount of stress on any 
circuit, and if you really go overboard, 
you can shorten the life of the printer. 
Admittedly, we're only talking about 



taking six months (at the most) off your 
printer's eight-year life span, but it's 
something to think about. 

Paper Trays For Legal And Letter 
Size Paper 
If you regularly use two kinds of letter 
size paper in your Laser Writer (for 
example, letterhead and regular paper), 
ies a good idea to get a second paper tray 
to avoid taking paper out and putting 
the other paper in constantly. However, 
don't get a legal size tray, on the theory 
that it would be handy to have both tray 
sizes. You'll discover your pages print 
misaligned. That's because the 
Laser Writer doesn't check to see what 
kind of paper is in the tray, but, instead, 
checks to see which size tray is inserted! 

Jamming With Envelopes In The 
LaserWriter ll 
A simple solution to jamming envelopes 
in the Laser Writer II is to open the door 
at the end of the Laser Writer II so the 
paper path is straight. 

MAC CLASSIC, LC 
AND IISI 

Expanding The Single ADB Port 
Because the Mac Classic, LC and Ilsi have 
only one ADB port, you can't plug in 
more than one pointing device. 

To get around this, replace the coil cable 
on your keyboard with the cable that 
comes with Sophisticated Circuit's 
PowerKey. This cable is an L connector 
you can plug into the back of your 
Macintosh (where you would normally 
plug in the keyboard) that gives you an 
extra connector for a pointing device. 

Plug one end of the connector into the 
back of the Mac and another into the key­
board. Plug your mouse (or other point­
ing device) into the other ADB port on 
the keyboard, and plug your second 
pointing device into the second connector 
on the PowerKey cable. 

You don't need to buy PowerKey to get 
the cable: Sophisticated Circuits sells it 
separately for $10. You can reach the com­
pany at (800)-827 -4669. 

MAC PLUS 

The Vents On The Top Of A Mac 
Plus 

Don't block the vents on the top or the 
sides the Mac Plus, since it interferes with 
the circulation of cool air to the inside. 
Without adequate ventilation, the Mac 
Plus (and other models as well) may be 
permanently damaged. 

Esc For Old Keyboards 
If you need to use an Escape key on the 
Macintosh Plus keyboards you will have 
to use a work-around. 

An easy solution is to use QuicKeys II. 
You'll find it useful in almost every appli­
cation. With QuicKeys, you can create a 
key set with the alias for the Escape key on 
a Mac with a newer keyboard and then 
save the key set and install it on your Plus. 

Or, CE Software has created a QuicKeys 
key set called Control KEYS that contains 
aliases for keys not available on the Plus 
keyboard- the Escape key (along with 
Shift-Esc, Command-Esc, and so on) and 
Control-A through Control-Z. You'll find 
a copy in the Zmac library on-line. 
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Yet another solution is to look into buying 
a third-party extended keyboard, such as 
Datadesk'sMac-101. lt'saniBMPC/AT­
style keyboard complete with Control, 
Escape, function, and a slew of other keys, 
thus bypassing the need for clumsy key 
alternatives in most situations. 

A Faster Plus 
Adding RAM won't speed up your Mac 
Plus, but you can add an accelerator to 
speed up my Mac Plus, except for 
calculations. 

Mac User ("Chasing the Ilfx: Accelerators," 
page 84) August '90, recommended the 
Gemini Series by Total Systems ($1 ,895, 
without a floating-point coprocessor). 
Call Total Systems at (800) 874-2288. 

When The Calendar And Clock 
Aren't Working On A Mac Plus 
The alarm clock and calendar functions 
are regulated by the Mac's internal 
battery. In the Mac Plus, its compart­
ment is located in the upper right side 
on the back of the machine. After about 
two years, the battery will give out. 
Replace it with an Everready 523BP, 
Ray-0-Vac RPX21, Duracell PX21 
or Panasonic PX21, all of which are 
4. 5 volt batteries. You can find them 
at an electronics specialty store and 
through some Mac mail order houses. 
If the above symptoms are occurring 
on a Mac other than the Plus, the bat­
tery is a lithium battery, which lasts 
about 7 years and requires a Certified 
Apple Technician to replace it. 
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MAC PORTABLE 
Turning Off The Power 
Conservation Feature 
Mac Portable users who try to use the 
machine for automated, time-consumiq.g 
operations may find it performs far belo\v 
their expectations. Without user interac­
tion or peripheral communication, the 
system will slow to a crawl after 15 sec­
onds to conserve power. You can turn off 
this feature from the Portable Control 
Panel device (cdev): Hold down the 
Command and Option keys while click­
ing on the words "Minutes U neil 
Automatic Sleep" at the top of the cdev 
window. A dialog will appear with the 
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Don't Rest option, which will keep the 
Portable on full power until reset. 

Using A Screen-saver Program 
On The Mac Portable 
Although the portable has an LCD screen, 
they are subject to burn-in the way CRTs 
are. You should use a screen-saver if your 
Portable spends a lot of time with the 
same image on its screen. 

Avoid The Control Panel 

Every time you open the Control Panel, 
the Mac accesses the startup drive. If you 
must make changes to the Control Panel 
settings, do them all at once. 

Don't Shut Down 
The Portable consumes the same amount 
of power in the Shut Down and Sleep 
modes. The only reason to choose Shut 
Down is if you are going to install an 
expansion card or attach a device to one of 
the ports on the back of the computer. 



(Apple does recommend that you shut 
down at least once a month.) 

Otherwise, choose Sleep so that all of 
your applications and documents are 
instantly available when you issue the 
wake-up call by touching a key. Aside 
from this convenience factor, you save the 
power required to spin up the hard disk 
and reload files from disk. 

Open Flles In Batches 
The hard and floppy drives are the 
most power-hungry components of the 
Macintosh Portable. Both require roughly 
the same amount of power to spin for any 
given length of time. 

Whenever possible, open simultaneously 
any of the documents that you plan to use 
in a session. To do so, use the shift-dick 
method to select more than one document 
in a folder and choose Open from the File 
menu or press Command-O. This launch­
es the parent applications and opens the 
designated documents all in one step. 

Create A Startup RAM Disk 
Whether you configure memory as a 
RAM disk or leave it available for applica­
tions doesn't affect how much power the 
Portable uses, so if you have at least 2 
megabytes of memory, specify a RAM 
disk, using the Portable cdev. 

Make it large enough to hold the required 
System files plus any heavily used applica­
tions and documents. Click on the RAM­
disk icon on the Finder's desktop, and 
then choose Set Startup from the Special 
menu. Now instead of spinning the hard 
disk on startup, the Portable can quickly 
fetch these files from the very-low power 
RAM disk. 

Although the RAM disk retains its con­
tents even when you choose Shut Down 
from the Special menu, for peace of mind 
save any really important files to a 
diskette every once in a while. 

Use A RAM Cache 

The General cdev has an option for desig­
nating a portion of memory as a RAM 
cache. Frequently requested data resides 
in the cache, so if it is asked for again, it 
can be accessed much more quickly from 
RAM than if it has to be retrieved from a 
disk drive. Because the drive needn't be 
accessed, you won't waste power. 

Load Entire Applications Into 
Memory 
Some applications (such as Microsoft 
Word) let you specify whether the entire 
application should be loaded into memo­
ry when launched. Say yes. Forcing the 
whole program to load at once means 
that you avoid unnecessary disk access 
later on. 

Turn OffThe Speaker 
The higher you set the sound volume, the 
more power is necessary to drive the 
speaker. Use the General cdev to lower 
the volume of the internal speaker as far 
as it will go. With the speaker thus dis­
abled, the Mac Bashes the menu bar 
whenever a system beep occurs. 

Use Any Desktop Pattern You 
Want 

Some people suggest using the General 
cdev to change the desktop pattern to 
all white. The assumption is that black 
pixels are "on" and therefore require 
more power to display that white pixels. 
In actuality, the Portable uses an active­
matrix LCD (liquid-crystal display) 
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panel, with each pixel controlled by its 
own transistor. It requires power only to 
change the state of a pixel, and even 
then the amount of power involved is 
negligible. 

Quit Telecom Apps When Not 
In Use 

Open telecommunications applications 
require the Portable to supply power to 
the internal modem even if you aren't 
connected to an on-line service. But if 
you quit the application, the Portable 
saves power by turning off the modem. 

Force The Hard Drive To Sleep 
Normally, after you access the hard drive, 
you must wait until the amount of time 
has passed that you specified in the 
Minutes Until Automatic Sleep in the 
Portable cdev before it turns itself off. 
But clicking on Sleep at the bottom of 
the Battery DA immediately puts the 
system into sleep mode, thereby shutting 
off the hard drive. Just press any key 
(except Caps Lock), and the system wakes 
up exactly as you left it but the hard drive 
remains off. 

If you get Andrew Welch's shareware 
INIT called Portable Siesta- putting 
your Portable to sleep is even easier- just 
press a user-specified key combination 
(the default is the Escape key). Portable 
Siesta is available from Zmac; the share­
ware fee is $5. 

Don't Save As Often 
The Mac Portable is a robust piece ofhard­
ware, so you needn't worry too much about 
losing work in progress. If you have a macro 
utility that saves to disk automatically at 
periodic intervals, or if the applications you 
see have this as an option, disable it. 
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MACINTOSH II 
Using The Latest With The Oldest 
And Not So Greatest 
The original ROMs (Rev. A ROM) in 
original-issue 1987 Mac lis won't work 
with the current crop of Apple video 
cards. A free ROM upgrade is still avail­
able from your Apple dealer if you've 
somehow managed to go this long with­
out it. 

Vertical Or Horizontal? 
Whether or not you can safely turn a Mac 
II on its side, lies with the disk drive. If 
you're going to verticalize your Mac II, d9 
the following: 

I 

1. Perform a low-level format on the drive 
in the position you will use it in. 

2. Don't keep changing the orientation­
once vertical, always vertical; once hori­
zontal, always horizontal. 

3. Pay careful attention to air flow, espe­
cially with the Mac II, Ilx, and Ilfx, which 
aren't designed to sit on their sides. If you 
want to put one of these models on its 
side, you'd better get a special stand for it. 
The Ilcx and Ilci, on the other hand, were 
designed to go either way. 

The Upgrade Path To A nfx 
Thinking of upgrading your Mac II to a 
Ilfx at some point? Any monitor, key­
board, or color board that works in the I 

your Mac II will also work in the Ilfx. As 
for RAM, any memory that you have for 
your Mac II will be utterly useless in the 
Ilfx, because the latter machine uses dif­
ferent ( 64-pin SIMMS) SO-nanosecond 
RAM chips that won't fit, much less 
work, in your II. 



MONITOR 

1\vo Or More Monitors, 
Simultaneously 
One of the nicest features of the Mac II 
series is that you can have as many as six 
monitors hooked up at the same time 
(each one requires a separate NuB us card), 
and you can arrange them any way you 
like, using the Monitors cdev. 

To specify which monitor will show the 
Startup screen, choose Monitors from the 
Control Panel and hold down the Option 
key. When the Happy Mac icon appears, 
drag it to the monitor you want to specify 
as the main monitor and then reboot. 

Monitor Resolution 
Exactly how much information a monitor 
can display depends on its resolution, 
which is measured in pixel dimensions 
and dpi (dots per inch). Pixel dimensions 
are the height and width of the active 
screen as measured in pixels (picture ele­
ments, or dots); the dpi figure indicates 
how closely these pixels are packed 
together. 

Most of the monitors have screen resolu­
tions of72 dpi, the standard set by Apple 
for a one-to-one (WYSIWYG) match 
with what appears on paper. A higher dpi 
yields images that are smaller on-screen 
than they are on paper; a lower dpi 
magnifies the display. Higher resolutions 
can make the screen appear sharper, 
although text may be almost too small to 
read; a lower resolution lets you work far­
ther from the screen and is good for pre­
sentations. 

Monitor Annoyances 
There are several factors that can make 
your life in front of a monitor either pleas­
ant or hellish. One of these so-called nui­
sance factors is glare. A monitor with 
good glare protection lets you reduce 
brightness and preserve focus. 

Also, check a monitor for flicker, jitter 
(image instability), bandwidth problems, 
screen shrinkage, and noise. Refresh rates 
above 65 hertz are usually sufficient to 
eliminate flicker. 

MOUSE 

Solving Mouse Ball Sticking 
To keep your mouse on the ball, check 
the ball your mouse is on. If your mouse 
sticks and hesitates, even after a thorough 
cleaning, it may be the ball that needs 
replacing. Take it out and examine it 
closely. If you see any small bumps or 
irregularities, you've found the culprits. 
You can get a new ball from your Apple 
dealer (Apple part number 699-8001 for 
the Plus or 699-8038 for the ADB) for 
about$9. 

The Frozen Mouse Syndrome 
One of the most irritating software crashes 
occurs when your mouse becomes para­
lyzed. The keyboard continues to work, the 
screen is still functioning (clocks and screen 
savers work fine), and you can continue to 
direct the Mac with keyboard commands, 
but the blinking cursor or arrow controlled 
by the mouse doesn't move. 

There are several possible explanations 
for this, so let's start at the beginning. 
A lot depends on whether or not your 
Macintosh has ADB (Apple Desktop 
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Bus) connectors for the mouse and the 
keyboard. Mouse deaths occur far more 
frequently on ADB machines, because 
the mouse is just a single element in a 
somewhat fragile chain of devices. 

There are many ways for the mouse to 
get lost in the chain. You may have too 
many devices daisy-chained together; if 
you have more than three devices con­
nected at once, there might not be 
enough juice in the bus to keep track of 
all those mice, trackballs and key­
boards. Or perhaps your mouse was dis­
connected from the bus and reconnected 
with the Mac still turned on- once an 
ADB device has been removed from the 
chain, the Mac usually can't find it 
when it's plugged in again. Or perhaps 
one of the ADB connectors on the chain 
is dirty: You can clean it (carefully) with 
isopropyl alcohol. 

It's also possible that something has bro­
ken (most likely the mouse, the ADB 
connector, or the device it's plugged 
into). Another possibility is that the 
program you're running isn't compatible 
with an INIT or cdev that works with 
your mouse, such as the Mouse cdev or 
the cdevs that come with some third­
party pointing devices. If you have a third 
-party device, call the manufacturer and 
ask if there have been similar complaints. 

If you have a Mac that doesn't use ADB 
(the Mac Plus or earlier), then the list of 
potential problems is somewhat narrow­
er. Hardware-wise, it might be a dirty 
mouse connector or a loose connection in 
the mouse itself. In these cases, all you 
can really do (short of- shudder- taking 
the Mac to your dealer for a checkup) is 
clean the mouse connectors or borrow a 
pal's mouse and see if it works on your 
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Mac. Some software can clobber the mouse 
on the Plus, too. One such error is so com­
mon that Greg Dudek wrote a shareware 
Fkey for Mac Plus owners called Defrost 
that can (sometimes) bring your mouse 
back to life after it freezes on-screen. 

If mouse-freezing is so common on your 1 

Mac that it really cramps your style, take 
some preventive measures. Install the ' 
Easy Access INIT that's part of Apple sys­
tem software. Once it's installed, press 
Command-Shift-Clear at anytime and 
Easy Access turns your numeric keypad 
into a mouse (the 8 key is up, 2 is down, 
arid so on- the details are in your system 
software manual). Easy Access works well 
enough for you to calmly save all your 
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work if the mouse freezes, quit the cur­
rent application, and politely restart yorlr 
machine. 

One last tip- never plug in or unplug an 
ADB device without first shutting down 
your Mac. If you do, the mouse-freezes 
might occur as a result of a damaged ADB 
chip. If that's the case, a trip to an Apple 
dealer for repair is necessary. 

Making Your Mouse A Tracing 
Tool 
Here's a low-tech way to transform your 
bulky mouse into a halfway decent tracing 
tool. 

Let's say you want to draw something 
moderately difficult such as a map of 
Jamaica to include in a letter with direc­
tions to your estate in Spanish Town. 

1. Get a paper clip. (Mac tips don't come 
much simpler than this.) 

2. Bend the clip so that one end comes 
away from the rest at 90 degrees. Bend 
that point down 90 degrees. 



3. Tape it to the top of your mouse. 

4. Use the overhanging end of the paper 
clip to trace the map from an atlas or a 
map of a decent size. The mouse will 
"draw" along. The Batter the surface, the 
better. It takes a little practice, but it 
works and enables someone with no artis­
tic flair to do a fairly creditable job. 

NETWORK BRIDGES 
mM Token Ring To Ethernet 
Bridge And AppleTalk Packets 
An incompatibility exists between IBM's 
Model8209 token-ring to Ethernet 
bridge and Apple Talk itself. According to 
Apple, Macs on either side of this media­
access control bridge cannot communi­
cate, because IBM's blind bit-pusher 
doesn't get the difference between 
Token Talk and EtherTalk and trashes 
Apple Talk packets in transit. 

POWER SWITCH 
Troubleshooting Power-On 
Problems 
Below are some techniques and questions 
to ask when troubleshooting power switch 
problems. If your Mac is still under war­
ranty, leave repairs to your dealer, don't 
attempt anything you aren't comfortable 
with, shut down before opening the case, 
and handle all components with the great­
est care. 

If pressing the power-on switch intermit­
tently fails to start your Macintosh II, llx, 
or llfx, read further. The usual problem is a 
weak battery on the motherboard. On the 
II, IIx, and IIfx, there are two 112 AA lithi­
um cells located under the drive bay. (One 

battery powers the power-on key, and the 
other powers the clock and PRAM. The 
IIcx and Ilci's power-on keys are powered 
by a 5-volt "trickle" line on pin 10 of the 
power supply.) 

To test the cells, press the power-on key 
and read the batteries' voltage with a digi­
tal multimeter (available from Radio Shack 
or other electronics-supply stores for about 
$40). Good cells generally read from 3.2 to 
3.7 volts and weak cells read from 2.3 to 3.2 
volts. Any cells that fall to less than 2.15 
volts are considered dead. Newer 
Macintoshes have a battery box that lets you 
simply pop the batteries out to replace 
them. On older Macintoshes the original 
batteries are soldered in, but you may be 
able to find a dealer who can retrofit your 
board with a removable battery holder. 

RAM 
Whose RAM Should You Buy? 

Are you wondering whether to use gen­
uine Apple SIMMs or if there really is any 
difference between Apple and third-party 
SIMMs? 

Some feel that third-party SIMMs are 
better- they're less expensive, and most 
vendors have a better warranty than 
Apple's. Apple doesn't make its own­
they purchase SIMMs from the open mar­
ket and from a variety of sources. 

There is no technical reason why Apple's 
DRAM is any better than third-party 
DRAM. Apple published the specs for the 
SIMMs, and they're turning up all over 
the place. 

So save yourself a few bucks, and get your 
RAM from a reputable third-party 
supplier. 
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Memory-Upgrade Options 
When you want to add more RAM 
(Random Access Memory) to your Mac, 
you add SIMMs. A SIMM is a Single In­
Line Memory Module, which is a bunch of 
little chips attached to a small circuit 
board. 

When selecting SIMMs you should con­
sider two factors. The first is how the 
actual chip attaches to the board. The two 
methods are surface mount (low profile) 
and DIP (high profile). You want sur­
face-mounted SIMMs, no matter which 
Mac model you own, because there's no 
longer a difference in price between the 
two (DIP SIMMs used to be somewhat 
cheaper). DIPs generate more heat, and 
DIPs are taller, which may interfere with 
the future installation of an internal 
hard-disk drive or other peripheral. 

The second factor is speed. RAM speed is 
measured in nanoseconds (nsec), which are 
billionths of a second. The factory­
installed RAM in a stock Plus or SE runs 
at 150 nsec; the factory-installed RAM in 
a Mac II, Ilx, Ilcx, or SE/30 runs at 120 
nsec; the factory-installed RAM in a Ilci 
runs at 80 nsec; and the Macintosh 
Portable uses special low-power-con­
sumption SRAM (static RAM). The Mac 
Ilfx requires special G4-pin SIMMs, 
which run at 80 nsec but are not inter­
changeable with the SIMMs in the Ilci. 

SIMMS 
Troubleshooting SIMM Problems 
You may have a SIMM problem if you see 
a blinking question-mark icon or hear an 
error tone on startup. 
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Immediately after their power button is 
pressed on, all Macs run an internal diag­
nostic program. The more RAM you 
have, the longer it takes. If the Mac passes 
the test and there's a startup disk on-line, 
the computer boots to the desktop. 
Otherwise the blinking question-mark 1 

icon is displayed. If you hear an error torte 
when you start up a Mac II, it can mean · 
SIMM problems. 

Test the SIMMs by replacing them with 
another set. Your SIMMs may be defec­
tive, in which case you need to replace 
them, or they may be too thick or too 
thin for the socket. It is possible to tight­
en the contacts on the sockets, but this is 
a sensitive operation and you need to use 
extreme care. To tighten the contacts, us~ 
a small, delicate tool such as a jeweler's : 
screwdriver to move the contact wires 
closer together. 

SCSI 
SCSI Device Setup 

Small-computer-system-interface (SCSI; 
pronounced "scuzzi ")devices connect to 
the Macintosh by way of the SCSI port in 
the back of every Macintosh from the 
Mac Plus on up, but they also introduce 
complications in the way the Mac reads 
signals-even from an internal hard-disk 
drive. Some conflicts are serious enough 
to damage your data or Mac, but most 
are common and easy to fix. The two 
most common points of SCSI confusion 
are addressing and termination. 

SCSI devices are connected in a single 
daisy chain. A single daisy chain should 
not exceed 18 fee.t in length and each 
device must have a unique numeric 



address between 0 and 7; the Macintosh 
is a SCSI device with address 7, and in 
an SE or II, an Apple-installed internal 
hard disk in an SE or II has a default 
SCSI address of 0. 

Different devices have their addresses set 
in different ways- through software, 
through external DIP switches or simple 
push-buttons or dials. Addresses must be 
unique, and two devices with the same 
SCSI address can cause System crashes or 
devices not to appear. Choosing certain 
addresses for each device is also impor­
tant. When the Mac starts up, it checks 
to see if there is a disk with a System 
Folder in the floppy disk drives, then it 
checks for serially connected hard drives, 
and finally starts checking the SCSI 
chain. It looks at SCSI address 0 first and 
then jumps to address 6 and continues 
downward, booting off the first system it 
finds. The physical order in which you 
connect the SCSI devices doesn't matter 
- just their SCSI addresses. 

Termination is another SCSI principle. 
A terminator is a resistor that reduces 
signal echoing along a chain of SCSI 
devices. It is recommended that only 
the first and last SCSI device be termi­
nated, for a total of two terminators. 

The internal hard disk in an SE or II has 
an internal terminator, but if you have a 
Mac Plus or an SE without an internal 
hard disk, then you need a terminator at 
both ends of a SCSI chain. 

Many SCSI devices (hard disks, scanners) 
have internal termination, and the easi­
est way to find out - is to check the doc­
umentation or call the manufacturer, 
and avoid peripherals with unremovable 
terminators. 

If a device does not have internal termina­
tion, then an external terminator can be 
placed into one of the two SCSI ports of 
the peripheral device, or into the cable 
before placing the cable on the SCSI port. 

SCSI Devices Powered Off 
It is possible to have several SCSI devices 
connected while keeping some of them 
switched off some of the time, depend­
ing on how the device was manufac­
tured. Most SCSI devices shut down the 
entire SCSI chain unless power is sup­
plied to them. Some devices contain a 
diode that allows you to turn them off 
and still use other connected SCSI 
devices. Unfortunately, such devices are 
in the minority, and it's not a feature 
that many manufacturers place high on 
their priority lists. 

The only way to tell whether a device will 
shut down the SCSI chain when the 
power is off is to try it. If your device is 
like most, though, you'll need to keep it 
turned on when you're using any of your 
SCSI devices. 

STYLEWRITER 
Reducing Printing Time 
Here's how Style Writer owners can 
reduce printing time for large word pro­
cessing documents. The Style Writer is 
definitely no speed demon when used 
with any computer less powerful that a 
Mac LC. But if you don't mind if the 
print quality is slightly less than the best, 
try this: 

Use a bold True Type font for your text. 
When the Print dialog box appears, 
choose the Print Faster option. The docu­
ment will print in about one-third of the 
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time, and the output will be almost as 
good as that of the best printing quality. 

SURGE PROTECTORS 
What's The Best Kind Of Surge 
Protector For Your Mac? 
Surge protectors are designed to protect 
electrical equipment- such as your 
Macintosh- from sudden surges of elec­
tricity. You might find one very useful if 
you've been experiencing power problems. 

Surge protector prices range from less 
than $30 to more than $200. The best 
surge protectors use silicon diodes, which 
have a reaction time of 5 billionths of a 
second and a clamp level of 220 volts. 
This technology apparently is superior to 
that of the standard MOVs (metal-oxide 
veristors) in all other surge protectors, 
which react too slowly and clamp at about 
500volts. 

Surge suppressors get hyped a lot. To 
avoid getting burned, make sure that 
both the packaging and the product carry 
the UL (Underwriters Laboratories) 1449 
trademark (1449 refers to the UL surge 
suppressor test). Counterfeit UL trade­
marks on some surge suppressors usually 
lack the 1449 designation. 

Also, look on the packaging for the desig­
nation "UL Listed 1449 Suppression 
Voltage LN 400/L-G 400/N-G 400," 
which means that the suppressor clamps 
at 400 volts when power surges across the 
line, neutral, and ground wires of the cir­
cuit. This is appropriate for Macs and 
their peripherals. The best UL rating, 330 
volts, isn't mandatory. 
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The response time needs to stay at less than 
one millisecond, and most- if not all­
UL 1449 suppressors are this fast. Buying 
a faster suppressor is like putting premi­
um fuel into an automobile that's rated for 
regular. 

No surge suppressor works against direct!. 
lightning strikes- for that, you need a 
surge arrestor. Your local power company 
can probably install one on the line lead­
ing into your home or office for less 
than$300. 

THUNDERSCAN 
ThunderScan 2.0/4.0 Running 
Under MultiFinder 
Frustrated that neither version 2.0 nor 4.0 
of ThunderScan will operate in the back­
ground with MultiFinder? Simply launch 
ResEdit, locate your copy of the 
ThunderScan software that you want to 
use for a background scan, and double­
click on it to open. Locate the Size 
resource, double-dick on it, then locate 
the 0 listing in the Size resource. Open this 
by double-clicking, at which time you 
should see the words "Can background" 
with two radio buttons to the side. Click 
on the 1, and then close the file and save 
changes. You can now run ThunderScan in 
the background with MultiFinder. You 
can also make most programs MultiFinder 
compatible, if they aren't already, by click­
ing on the 'Juggler Aware" button in the 
Size resource just above the "Can 
Background" radio button. 

Solving Distortion With Acetate 
If you're getting a lot of unwanted distor­
tion from your ThunderScan, and the prq-
gram even crashes occasionally, try · 



putting a piece of clear acetate over the 
item to be scanned. 

Focus in the high 50s and great scanned 
images will reduce possible distortion. Be 
sure the acetate lines up with the left­
hand edge of your document to be 
scanned. Also clean the lens on your scan­
ner and ad just the height of your scanner 
cartridge (according to your printer man­
ual) for optimum focusing. 

Adjusting Lines In 
A ThunderScan Image 

If you sometimes have trouble with just 
a few lines of a ThunderScan image, it 
may be because the scanner is having 
trouble with the end of the timing tape 
installed on the left end of the 
Image Writer roller. 

The easiest way to see if this is your 
problem is to scan an image at least 3-
114 inches long that contains a series of 
vertical lines. Watch the Image window 
close! y as the end of the timing tape 
passes under the scanner. If you see part 
of the vertical lines displaced to the left, 
it is probably because the timing tape 
doesn't reflect light back to the scanner 
accurately and the scanner misses its 
timing for a line or two. The problem is 
more noticeable if you magnify the 
image being scanned. 

An easy way to fix the problem is to care­
fully apply some typewriter correction 
fluid even with the edge of the tape to fill 
the gap. If you accidentally get correc­
tion fluid on the rubber roller, it can be 
removed with isopropyl alcohol. 

VIDEO 
Care And Maintenance Of The 
Screen 
Turn the screen intensity down when 
you're not using the machine. This pre­
vents images from burning into the video 
tube. If you have a separate monitor, you 
can turn it off with disrupting your files. 
Using a program like Mter Dark or Pyro 
accomplishes the same thing. 

Cleaning The Screen 
Do not forget that your Mac screen is 
extremely susceptible to inadvertent 
damage. Never use glass cleaner on it or 
touch it with anything but a very soft 
cloth. Better still, use a commercial CRT 
cleaning product designed specifically 
for use on computer monitors. 

VIDEO CARDS 
8•24Gc Display Card And The 
12-inch Monitor 
According to Apple, the Mac Display 
Card 8•24GC and 12-inch RGB monitor 
work fine together-which is helpful info 
if, for some reason, you sprang for a 
$2,000 card and then got cheap on the 
display. 

Troubleshooting Video Card 
Problems 
You see colored blotches, static, or buzz 
lines on the monitor display. Find out if 
the monitor is in trouble. Connect it to 
another Mac, and see if the problem per­
sists. The monitor may just require 
Degaussing, which quite often is handled 
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with a button in the back of the monitor 
(check the monitor manual). 

If the monitor's OK, then the problem is 
in the video card. (With a IIci and other 
Mac II series with no external video card, 
the problem may be the video circuitry on 
the motherboard). To remove the card, 
turn the power off, wait at least 20 sec­
onds, and then pull straight up on the 
card. Component-level repair of a video 
card costs about $115. 

If you do not have a picture at all, but the 
monitor is plugged in and the power is 
on, try straightening the cord connecting 
the monitor to the video card or Mac (in 
the case of built-in video). Sometimes the 
cord needs to be untangled. 

HYPERMEDIA 

HYPERCARD 
Working With The Tools Menu 
On A 9-inch Classic-style Screen 
When you're authoring HyperCard stacks 
on an 9-inch screen, you don't always have 
a convenient spot to stash the tools menu. 
You can hit the Tab key to go from button 
or field mode to browse mode, but this has 
the sometimes undesirable side effect of 
selecting the first unlocked field. The con­
tents of fields can be lost this way. This can 
be avoided by adding these lines to the 
Home Stack script: 

ontabKey 

get the tool 
if it is "button tool" or it is ''field tool" 
then 
choose browse tool 
passtabkey 
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end if 
endtabKey 

If you have the extended keyboard, you 
can change tools by using the function 
keys. Put the group of lines below into 
the Home Stack script: 

on functionkey num 
put "browse, button, field, 

selecf' into fKeys 
if num > 4 and num < 8 then 
get "choose" && (item 

(num-4) of fKeys) && ''tool" 
do it 
else 
pass function key 
end if 

end function key 

Don't use F1 through F4, since these are 
reserved for Undo/Cut/ Copy/Paste. 

Outlining Hidden Buttons 
Pressing the Command and Option keys 
simultaneously will outline all buttons. 
However, hidden buttons are only out­
lined in Button mode- other buttons will 
be shown in Button and Browse modes. 

While in Field mode, you can outline all 
fields, whether hidden or not, by pressing 
the Command, Option, and Shift keys 
simultaneously. This is very useful when 
learning programming techniques from 
other stacks. Version 1.2 has a command 
to show all buttons. 

Using Font/DAJuggler To 
Minimize Disk Space. 
To use Font/DA)uggler to minimize the 
size of HyperCard stacks, first use the 
fKey/Sound mover, included with 
Font/DA Juggler, to create the Sound 
files. Hold down the Option key while 
opening files to open a HyperCard stack. 



Then create new £Key/Sound mover files, 
and copy the HyperCard sounds to.the 
new files. Font/DA Juggler can open 
these new Sound files at any time. Up to 
12 Sound files can be opened. The only 
limitation on the number of sounds is 
disk space. You can switch sets of sounds 
quickly and easily. 

One problem: HyperCard can play only 
Hype.tCard sound resources. The Mac II 
beep sounds that come with Font!DA 
Juggler cannot be played in HyperCard. 

Reports 

While using HyperCard-compatible 
Reports, you can encounter an unusual 
problem. In the HyperCard script editor, 
using the Tab key simply realigns the 
indentation in the script. However, when 
using Reports' script editor, pressing the 
Tab key actually inserts a character 
(probably a tab character) that shows up 
as white space. When the script is exe­
cuted, HyperCard cannot interpret the 
added character and this results in a 
"can't understand" error. To fix it, you 
must delete the added character. So don't 
use the Tab key in HyperCard Reports' 
script editor. 

Printing A Range Of Cards 
The HyperCard printing options allow 
only the printing of the current card or 
the entire stack. But if you create a but­
ton on any card of your stack with the 
following script, you'll be able to print a 
range of cards that you specify. 

on mouseUp 
ask "First Card to Print? 
put It into Start 
ask "Last Card to Print?" 
Put It into Finish 

open printing with dialog 
repeat with counter= start to 

finish 
print card counter 
end repeat 

close printing 
endmouseUp 

Opening A Card To The Current 
Date 
If you'd like an Appointment stack that' 11 
always show the current day's card when­
ever you open the stack, do this: make a 
copy of the Appointment stack contained 
in Stack Ideas, create three months' worth 
of cards, then open the the stack's script 
via the Stack Info dialog box and enter 
this script: 

then 

on openStack 
if field "date" is the long date 

exit open Stack 
else 
find the long date 
push card 
hide message box 

end openStack 

The next time you open the stack, the 
current day's card will be on top. If it's 
not, see if there's a card with today's date. 
If there isn't, open the Message box, type 
extend, and press Return. That should do 
it. To check this, open the Message box 
again and enter "find the long dace;· press 
Return, and the current day's card should 
appear. 

Adjusting The Find Command 
The Find command ofH yperCard search­
es only for the first occurrence of a string 
in a stack. The Find menu item continues 
its search for the next occurrence of the 
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string in the stack after the Return key is 
pressed. 

If you want to prompt the user of your 
stack with a personal message (not the 
standard Find of the Message box), and 
want to continue the search after the first 
match, use the "Ask., dialog box to enter 
the string to find. Then "type., it in the 
message box with the Type command. 
All this can be done with the message 
box hidden if the BlindTyping is set to 
true. Here is an example of a script of a 
"Find., button: 

on mouseUp 
go first card 
ask "Find what word or 

group of words?" 
type ''find" & quote & it & 

quote & return 
end mouseUp 

If you type "Macintosh" as the string to 
find, HyperCard will itself type the string 
"Find Macintosh" in the visible or invisi­
ble message box, and will itself depress 
the Return key to begin the search. The 
next time you press the Return key, the 
search will continue, as with the Find 
menu item. With the command Find It 
(it = "Macintosh"), only the first occur­
rence of the string "Macintosh" would 
have been found, and the Return key as a 
"continue the search" command would 
not have worked. 

Adding A Phone Hang-Up Script 
When dialing numbers from the Address 
stack that comes with HyperCard, there is 
no obvious way to hang up once a number 
is being dialed or has been dialed. You can 
solve this problem by adding a back­
ground button to the address stack that 
sends a hang-up message to the modem. 
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The script is: 

on mouseUp 
send "dial " & quote & quote 

& ''with modem " & - quote & "+++ 
ATHO" & quote to HyperCard 
endmouseUp 

This sends a hang-up message to the 
modem. If you have the phone off the 
hook, you will still be connected until you 
manually hang up. 

Dialing With A Prometheus 
Modem 
In HyperCard, using the dialing feature 
with a Prometheus modem can be a little 
difficult if the modem doesn't switch 
from data to voice transmission. 
Prometheus thinks this is a bug in 
HyperCard, but not so. 

In the Phone Stack that is supplied with 
HyperCard, open the Stack script. Find 
the code that reads: then send "dial" & 
quote&- dial Number & quote ... 
Change it to read: then send "dial" & 
quote&- dial Number &";H" & 
quote ... 

Now the modem will switch to voice 
transmission immediately after dialing a 
number. 

Expanding The Cursors In 
HyperCard 
If you want to expand the cursors of 
HyperCard, make the ones you need with 
ResEdit, and call them from HyperCard by 
indicating the ID Number. The browse 
tool and all other HyperCard icons and cur­
sors are in the Font resource ofHyperCard, 
shown as a strange "12 ID 31756." 

You may not be able to open a resource 
with the ID number set so high. You can; 



change the ID number, temporarily, to a 
lower number using Get Info from the 
menu bar. Now you can open the resource, 
make your changes, then reset the ID 
number to the the previous value. Be sure 
to save the changes. 

Printing A Card With Better 
Quality 
If you want to print a card from a stack 
with better quality, especially text, export 
the card data to a Paint program, and 
print in the best quality available. 

Getting The Name Of A Tool With 
HyperTalk 
If you need HyperCard to select a tool or 
pattern from the Tool menu or the 
Patterns menu but you're not sure what 
it's called, follow this procedure: 

1. Tear-off the menu that has the item in 
question. 

2. Select the tool or pattern that you plan 
to use. 

3. Type "get the tool" or "get the pattern" 
into the Message Box and press Return. 

4. Type "it" into the Message Box and 
press Return. 

The Message Box should contain the exact 
name (or, for patterns, a number) that 
HyperCard needs to identify that item. 

Uninterropted Keying While 
Refreshing Settings 

Showing the time in a stack is nice, but it 
becomes a pain in the mouse if the stack is 
used for keyboard input. At the end of 
each minute, HyperCard updates the 
time. If you happen to be typing when the 
clock strikes, HyperCard abandons the 
text field to update the Time field. One 

way to ensure uninterrupted keying is to 
have HyperCard only refresh the time 
when you are not keying. The following 
lines in your stack script will do just that 
(assuming a field named "Time" is in the 
background): 

on open Field 
set lock Text of field ''Time" to 

false 
end open Field 
on mouseleave 

set lock Text of field ''Time" to 
true 
end mouseleave 
on idle 

if lock Text of field ''Time" 
=true then put the time into field 
''Time" 
end idle 

Adding The Time In Any Stack 
It's easy to show the time in any stack. 
Start by creating a field in the background 
called Time. Then add this short script to 
the existing background script, if any: 

on idle 
put the time into field ''Time" 
pass idle 

end idle 

If you want to add this feature to a sin­
gle card rather than to all the cards of a 
background, simply create a card field 
named "Time." The script should now 
be added to the card script, changing 
the second line to put the time into card 
field "Time." 

Compacting HyperCard Stacks 
With Hypertalk 
HyperCard stacks can be real memory 
hogs, especially if you modify them 
occasionally. The HyperCard manual 
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suggests you look at the amount of free 
space in the stack by selecting Stack Info 
from the·Options menu. If there is a lot 
of free space, you can reclaim it by 
selecting Compact Stack from the File 
menu. If you forget to do this, your stack 
can grow to twice its normal size. 

Start by choosing the Authoring level 
from the home stack. Then go to the 
desired stack and choose Stack Info 
from the Options menu. Click on the 
Script button and add the following 
script: 

on closeStack 
if the freeSize of this stack>O 

then doMenu Compact Stack 
end closeStack 
Another alternative script is the following: 

on closeStack 
get the freeSize of this stack 

if it> 1024*10 then do-Menu 
Compact Stack 
end closeStack 
This script will automatically compact 
the stack if you exit it and it has more 
than 10K(1024 = lK)offreememory. If 
there is already a script for this stack just 
add the new part at the end, and if there is 
already an "on closeStack" script, just add 
the two lines before the "end closeS tack." 

Changing The Default Font In 
HyperCard 
HyperCard uses the default (application) 
font to label icons as well as in the mes­
sage window. It's also used as the default 
font for the Text tool and new fields. To 
make HyperCard use your favorite font as 
its default font, change your application 
font using any of the several excellent 
public domain and low-cost shareware 
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programs that will do this. For example, 
to set the icon font to Geneva 9 you,ll 
need to make the following changes using 
FEdit Plus or MacTools. 

Change: 6720 3F2D F31E 
To: 6720 3F3C 0003 

The final 0003 is what sets Geneva. I 
I 
I 

Using Alphanumeric Keys To Set 
Polygon Shapes 
When using the Polygon tool, it is not 
necessary to complete each polygon by 
clicking where you started drawing the 
polygon. If you are in the Fill mode, you 
can complete the polygon and fill it by 
typing any alphanumeric key. 

Outline mode acts differently. When you 
type an alphanumeric key in that mode, 
the polygon lines stop where you last i 

clicked the mouse. These methods work ' 
in MacPaint, also. 

Blind Typing Out Of AJam 
The message box is always there, even 
when it's not visible, so just blind-type 
your message, such as "open resedit" or 
"go home." Don,t worry about getting 
the capitals right, but be sure you put 
spaces where they belong. Using this 
technique can get you out of a jam, such 
as when you use Recent to go to a card 
which you then discover has no menu or 
working buttons. 

Attaching FONT Resources To 
Stacks 

If you write a stack that includes text 
fields that use particular fonts, you can 
ensure that they will appear in your 
chosen font no matter what fonts other 
end users have available in their Syste~. 
Using ResEdit, copy the Font ID 



number of the font you want to lock in 
from the System file. Then paste this 
ID number into the Font file in the 
stack you want that font used in. Even 
if there wasn't a Font file to begin with, 
pasting in the Font ID will create one. 

Now when others open your stack, the 
fonts included within that stack appear 
in the text menu in HyperCard, along 
with the System fonts. You no longer 
have to worry about your stack using 
the default fonts and not looking the 
way you had planned it. Remember that 
fonts (and snds) take up large amounts 
of space in a stack. 

Seeing All Hidden And 
Transparent Buttons 
It's easy to see where all the buttons are, 
including hidden and transparent buttons 
that have been painted over, on a 
HyperCard card. All you have to do is 
press the Command and Option keys at 
the same time. All buttons will be out­
lined with a dotted line. 

Returning To The Finder Instead 
Of HyperCard 
If you want to return to the Finder rather 
than to HyperCard when quitting 
applications or documents launched from 
HyperCard, hold down the Option key 
while quitting. 

Creating A Scrapbook Of Buttons 
Often when creating a new stack you'll 
want to use the same buttons on different 
cards, with different backgrounds. If you 
save these buttons in the &rapbook, you 
lose all identifying information, and can 
easily forget which button is which. The 
solution is to create a "ScrapCard" on 
which to save these buttons. 

First, add a new card at the end of the 
stack. Paste any button you intend to use 
again onto this card. Now all you need to 
do is press Command-4 to get to the 
ScrapCard (be sure to leave it as the last 
card in the stack), choose and copy the 
appropriate button, press Command- to 
return to the card you were working on, 
and paste the button in. 

Putting HyperCard Into 
MacroMaker Macros 

HyperTalk is a verbose language- and 
typing commands is often tedious. But 
thanks to Apple's MacroMaker, typing 
HyperTalk scripts can be a breeze if you 
turn the most commonly used words 
into macros: 

1. When MacroMaker's active, its 
Cassette icon appears on the menu bar. If 
it's not active, put MacroMaker into your 
System Folder and restart. 

2. Launch HyperCard. Record your macro 
from any stack, at any card (but not from 
the scripting window, which won't let you 
do anything other than enter and edit 
scripts). 

3. Select Start Recording from the 
MacroMaker menu (the Cassette icon 
starts flashing). 

4. Type in your most frequently used 
HyperTalk commands, bearing in mind 
that you won't see what you've typed. 

5. After entering each command, select 
Stop Recording from the MacroMaker 
menu (the icon stops flashing). 

6. Assign a keystroke to the macro you've 
created-Command-Shift-U for on 
mouse Up, for example-and store it. 
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Setting Control-Key 
Combinations To Set The User 
Level 
An easy way for Mac SE and II owners to 
switch between user levels is to create 
Control-key combinations by inserting 
the following lines into the Home stack: 

on control Key x 
if x=49 then set the user Level 

to 1 
else if x=50 then set the user 

Level to 2 
else if x=51 then set the user 

Levelto3 
else if x=52 then set the user 

Levelto4 
else if x=53 then set the user 

Level to5 
else pass control Key end 

control Key 
end if 

end control Key 

Now you can press Control and any num­
ber from 1 to 5 and be transferred to that 
user level. 

If you've ever wanted to make your 
HyperCard stacks like real Mac applica­
tions with an About ... command in the 
Apple menu, copy the following resources 
(with ResEdit) to your stack from 
HyperCard itself: 

DLOG "About" 10=2002 

OITL "About" 10=2002 

STR#"Abouf' 10=2002 

ICON "Bill" 10=2002 

CON "HyperCard" 10=1001 

Once you've loaded the resources in your 
stack by means of the scary magic of 
ResEdit, you can alter them to your 
heart's content without actually modify-
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ing the originals in HyperCard. To do 
so, make STR # read whatever you 
want; move, add, or delete any of the 
icons; or place your own text inside the 
DITL. You can even move the DLOG 
box elsewhere. 

Now, when you open your HyperCard , 
stack, the About ... command will real-i 
ly tell other users what your stack is all 
about. So if you're tired of the same old 
HyperCard programming team, add a 
little spice, delete Bill's lovely face- and 
put in whatever you want. 

Speeding Up The Performance Of 
HyperCard And SuperCard By 
Turning Off Color 
The speed of HyperCard varies depending 
on the color setting, but in general you . 
will gain significant speed if you are using 
a color monitor and the color is turned off 
completely when you are moving a lot of 
monochrome images. For HyperCard, as 
well as SuperCard, if you have 256 colors, 1 

you should use either no color or 256 col­
ors (2 colors or 256 colors). 

In the Control Panel, the Control Panel 
Device ( cdev) called Monitors lets you 
adjust the number of colors your monitor 
shows. If you have 256 colors, your 
monitor will typically be at 2, 4, 16 or 
256 colors. 

Loading Fonts Into HyperCard 
Stacks With The Font/DA Mover 
With the Font/DA Mover open to fonts, 
you can load fonts into HyperCard stacks 
if you hold down the Option key while 
clicking on the Open button for the sec­
ond window. This lets you access and open 
applications and stacks in the Font/DA 
Mover window. 



Simulating A Toggle Switch 

Here's a simple way to simulate a toggle 
switch in HyperTalk (actually the basic 
idea can be implemented in any program­
ming language). Each time the program 
executes the following line, it toggles the 
variable Switch between 0 and 1. If the 
value of Switch is 0 (off), it will change to 
1 (on) and vice versa. 

In HyperTalk the line looks like this: 

Put (-1 *Switch)+ 1 into Switch 

You'll find this useful because it makes 
your scripts easier to understand and lean­
er and it saves typing all the code below: 

If Switch is 0 then 
Put 1 into Switch 

Else 
Put 0 into Switch 

End If 

Moving To The End Of A 
ScroJHng Field 
Let's say you have been using a stack that 
requires switching from card to card and 
entering text- but always at the end of a 
scrolling field. The speed of text entry is 
hampered because when you open a card, 
you have to scroll to the end of the field 
and click after the last word before you 
can type the text. 

Here is a short background script that 
causes the cursor to appear automatically 
at the end of the scrolling field whenever 
you switch to another card. 

on opencard 
select char (the number of 

chars in bg fld x) + 1 of bg fld x 
type selection 

end opencard 

If you want to make sure that the cursor 
always appears below the last line, even if 

the last line does not end in a carriage return, 
make the script read as it appears below: 

on opencard 

then 
if last char of bg fld x <>return 

put return after bg fld x 
end if 
select char (the number of 

chars in bg fld x) + 1 of bg fld x 
type selection 

end opencard. 

Truly Hidden Buttons 

HyperCard lets you create hidden but­
tons, but anyone can "peek" at their loca­
tion by holding down the Command, 
Shift, and Option keys simultaneously. 
What if you want to create a hidden but­
ton that truly stays hidden? 

The answer is to create two hidden but­
tons. Create the button you want, and 
then copy it and paste the copy directly on 
top of the original button. Neither button 
will be visible when Shift, Option, and 
Command are pressed, although you'll 
still be able to see them when the button 
tool is selected. 

Easy Userlevel Settings 
If you are tired of typing "set userlevel to 6" 
and "set userlevel to 2" when developing 
applications in HyperTalk, add the follow­
ing into your Home-stack script: on u X 

set userlevel to param (1) end u, Now I 
just type u 6 or u 1 in the message box. 

HYPERCARD 1 AND 2 

HyperCard 1 And 2 Co-existing 
On Your Disk 

Some HyperCard 1 stacks can't success­
fully be converted to Version 2. If you've 
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got some of these, and you need to keep 
them around, here's an admittedly 
awkward trick for keeping both versions 
on your disk. 

Using a file-editing utility, change the 
creator of HyperCard 1 and any Version 1 
stacks to something other than WILD. 

Once you've done this, double-clicking on 
a Version 1 stack won't launch HyperCard 
2, as is usually the case. In fact, double­
clicking will result in an error message. 
But you can launch the HyperCard 1 
application and open your older stacks 
from inside it. Your new HyperCard 2 
stacks and any stacks you've converted 
will continue to open with Version 2. 

Compacting 1.2 Stacks With 
Hypeflalk 
Even before you have a chance to convert a 
1.2 stack to 2.0 (it's possible to run a 1.2 
stack under 2.0 without converting it), 
you may encounter the script error mes­
sage "Can't find menu item 'Compact 
Stack'." What's going on here? 

Some stack authors build in routines that 
compact a stack according to some time 
interval (say, once a week) or a calculation 
based on a stack's freeSize property (for 
example, if the size of the free space is 20 
percent larger than the stack size). 
Compacting a stack rearranges the current 
stack on the disk, removing any unused 
space so that it fits into the smallest possi­
ble space. 

Although compacting regularly is highly 
recommended, a stack that has not yet 
been converted to HyperCard 2.0 simply 
doesn't have the Compact Stack menu 
item on the File menu. In its place is the 
Convert Stack menu item. Because com­
pacting is dependent on the data structure 
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of a stack, HyperCard 2.0 cannot compact 
a 1.2-generation stack until the stack's 
data structure has been converted to the 
2.0 format. Mter you've converted the 
stack to 2.0, the Compact Stack menu 
item returns and the stack's compact rou­
tine should run fine. 

Vision Problems 
Depending on what kind of Mac you use, 
the speed of visual effects may differ 
under HyperCard 2 .0. You can set a 
stack's visual effects to slow, very slow, 
fast, or very fast. Except for the very fast 
speed (which works as fast as your Mac's 
CPU chip does), these speeds have been 
normalized across all Macs in HyperCard 
2.0, so that visual effects will have 
roughly the same impact when run on : 
a Mac Classic as on a IIci. Because these 
speeds have been standardized to the 
slowest common denominator, if you use 
anything faster than, say, a Macintosh 
SE, you'll probably notice slower visual · 
effects when the stack is convened to 
HyperCard 2.0 than you did under 
version 1. 2. 

You can speed up these effects so that 
they're closer to what you're used to. 
To do this, start by using the 
searchScript command from the Messag~ 
Box to let a helpful utility handler in the 
Home stack find the locations of the 
Visual Effect command. 

Show the Message Box by pressing 
Command-M. Then type searchScript 
"visual", and press Return. If any object's 
script contains this command, the script­
editor window will open to display the ' 
script. The script editor already knows 

1 

what text you searched for with 
searchScript, so you can simply press 



Command-G to issue the Find Next 
command within that script. 

The search will find a line that looks 
something like this: visual effect wipe left 
(or whatever is being applied to the visual 
effect). To the end of the line, add fast or 
very fast, as in "visual effect wipe left 
fast." Press Command-G in this script 
until you hear a beep, which means there 
are no more visual effects in the script. 
Press the Enter key to save the script 
change, and close the script window. 

Sound Problems 
As for sound, if you're running System 
6.0. 7 or later, you must use HyperCard 2.0 
to ensure trouble-free sounds when using 
the Play command. 

In addition, existing sound XCMDs 
(external commands), such as those pro­
vided in Farallon's HyperSound Toolkit, 
need to be upgraded to work successfully 
with HyperCard 2.0 (you need to get the 
upgrade from the company that created 
the sound). You may get some sound out 
of the old XCMDs but not consistently. 

A note on XCMDs: Most existing 
XCMDs work in HyperCard 2.0 just 
fine. The ones that cause the most prob­
lems are those that create their own win­
dows or are dependent on Hyper-Card 
1.2 stack data structures. The former 
need to be redesigned around the new 
XCMD structure and libraries (both 
available from Claris); the latter need 
major overhauls. 

Finding Missing Text 
Some users have fretted over the appar­
ent disappearance of text in fields after 
converting a stack to 2.0. To encourage 
users to keep entries in this field to a 

maximum of four characters, the script 
author might have carefully sized the 
field so that the rectangular border 
allowed just a few pixels of white space 
to the right of the last character. 

When a stack is converted to HyperCard 
2.0, however, it looks as though the last 
character of the field has been cut off. 
The full text is still there- it's just 
wrapped to the next line. If you widen 
the field a couple of pixels, all the charac­
ters will return to the first, visible line 
(for best results, widen these fields after 
converting the stack). Although some 
word-wrapping oddities of HyperCard 
1.x have been corrected in 2.0 (for exam­
ple, parentheses and quotes now stay 
with their associated words), a field still 
requires several pixels of white space 
between the last character and the right 
edge of the field rectangle for the charac­
ter to be visible on that line. 

HYPERCARD 2.X 

Crippled HyperCard 
Currently Macs come with a version of 
HyperCard 2 .x that appears to be partial­
ly disabled. It really isn't; the Home stack 
is locked at the second level (Typing). 

To access the higher user levels, here is 
what to do: 

1. Launch HyperCard, arid go to the last 
card (Command-4). 

2. Make the Message box visible 
(Command-M}. 

3. Type "Set the Userlevel to 5"; press 
Return. 

4. Type "Magic"; then press Return. 
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Your copy should now have all five user 
levels available. 

SUPERCARD 1.5 

Using Stand-Alone Flles Without 
The Application 
A lot of programs on the Mac market cre­
ate stand-alone applications or self­
extracting archives. Two good examples 
are SuperCard and Compactor. 

If you get a project-only version but do not 
own SuperCard, it is impossible for you to 
run it. The same goes for Compactor: lf 
you get a Compactor file but do not have 
the program, you cannot extract the file's 
contents. 

The obvious answer is just to go out and 
purchase SuperCard or Compactor, but 
that's not always a cost-effective or timely 
solution. 

A different approach is to convert the 
SuperCard project into a SuperCard stand­
alone application or to convert a Compactor 
file into a self-extracting archive. 

The following methods requires ResEdit. 
If you're converting a SuperCard project, 
it also requires a SuperCard stand-alone 
application. If you're converting a 
Compactor file, it also requires a self­
extracting archive. 

Follow the steps (SuperCard project/ 
Compactor file is referred to as the data 
file, and the SuperCard stand-alone 
application/Compactor self-extracting 
archive as the app file): 

1. Run ResEdit. 

2. Open the data file. 

3. Open the app file. 

4. Select and copy all the resources in the 
app file. 

5. Activate the data-file window. 

6. Paste the resources in. 

7. Close the app file. 

8. Save the data file. 

9. Issue a Get Info command (Command­
!) for the data file. 

10. Change its type to APPL. 

11. Quit to the Finder. 

Now run the SuperCard or the 
Compactor file, and it will work perfectly. 

MULTIMEDIA 

MACROMIND 
DIRECTOR 

Drawing Concentric Circles 
Some graphics programs, such as 
MacroMind Director, don't provide a 
command for drawing concentric 
circles. Here's a quick and simple 
approach that works with any graphics 
program that doesn't include a 
concentric-circles command. 

Open the Paint window. Draw a 45-
degree line, using the line tool (you can 
restrain the line tool to 0 degrees, 45 
degrees, or 90 degrees by holding down 
the Shift key). Choose the Sphere tool. 
Hold down the Shift key, and place the 
cross hairs on any point on the line. 
Draw the circle down or up at the same 
angle as the line. 
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Now choose another point further along on 
the same line, and draw out another circle 
in the same direction and angle as before. 
You now have perfect concentric circles. 

Aligning Onstage 

To align text or graphics onstage in 
MacroMind Director, create QuickDraw 
shapes as registration tools and then dis­
card them when the layout is done. Also, 
use your tool bar or cast window for 
quick vertical registration. 

Joining Endpoints 
To make joining the endpoints of an 
open path easier, Option-select any­
where along the path and then use the 
Join command. This way, you don't have 
to go through the trouble of selecting 
both endpoints of the path. 

· MUSIC 

CONCERTWARE 
Keep Instrument Files In The 
Same Folder As The Player 
Concert Ware was designed before the 
Mac used the HFS filing system, so it 
might tell you it can't find the Instru­
ments you're using if they're stored in a 
different folder than the Player file. 

DELUXE MUSIC 
CONSTRUCTION SET 
Hooking Older Mac Models Up To 
Your Stereo 
You can get really great sound from older 
(128K or 512K) Macs when working 

with DMCS or other music software. 
Hook the Mac up to your stereo with a 
cable that has a mini phone plug on one 
end and a pair of phono plugs on the 
other. Put the phono plugs into the equiv­
alent AUX jacks on your stereo, then fit 
the mini phone plug into the back of the 
Mac, near the modem port. 

When you do this, remember to turn the 
volume slider all the way down on the 
Control Panel or else the music will dis­
tort. You should also set the External 
Speaker option on. Then, set the stereo to 
Mono, turn it on, and make music to your 
heart's content. 

Hard Disks Incompatible With 
Earlier Versions 
Earlier versions ofDMCS don't work 
with hard disks. When you would nor­
mally see a prompt to insert your key 
disk, your hard disk will bomb instead. 
The only solution is to upgrade. 

Don't Modify The Program's 
System Fonts 
Deluxe Music Construction Set uses 
special musical notation fonts which 
won't work properly after they've been 
modified. 

Save Only When You Have 
Enough Room On Your Disk 
Make sure you have plenty of room on­
disk before saving a file. If the disk is short 
on memory, the program could destroy 
your file instead of prompting you to 
insert a new disk. 
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PROFESSIONAL 
COMPOSER 
Work-around For Ignored 
Rehearsal Marks 
Use the Print Parts option under the 
File menu to "consolidate" rests in parts. 
However, in all parts other than the first, 
rehearsal marks will be ignored if rests 
precede AND follow the rehearsal mark. 
You can fix the problem by inserting a 
thick barline from the palette at the left 
side of any measure in which a rehearsal 
mark is inserted. Any barline at 
rehearsal marks, other than the standard 
one, force Professional Composer to 
break consolidated rests around 
rehearsal marks in parts where rests pre­
cede and follow the mark. 

Place Ties And Articulations After 
Transposing Parts 
When working with transposing instru­
ments, make sure to place your articula­
tions and ties AFrER you Transpose 
Parts. This is because the program won't 
allow for the fact that note stems often 
change direction after transposition. Your 
articulations and ties will often end up on 
the wrong side of the notes, and redoing 
all of them can be tedious work. 

STUDIO SESSION 
Note Entry Shortcut 
There's a quick way to enter notes with 
Studio Session. After putting any note on 
the staff, hold the mouse button down. 
Dragging it left or right changes the 
duration, and dragging up and down 
changes accidental. After moving one way 
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back and forth, you'll have to click again 
to make a different kind of change. 

SPREADSHEETS 

EXCEL 
Working With Several Work 
Areas 
If you have several work areas on the same 
Excel worksheet (for example, one for 
expenses, one for income, and one for a 
summary), you can sometimes run into 
layout problems when you add columns 
or rows to one of the areas. To avoid this, 
stagger the various work areas along an 
invisible diagonal running through the 
worksheet. This ensures that adding rows 
or columns in one area will not affect any 
of the other areas. 

More Than A Megabyte's Wasted 
Early versions of Excel (until version 1.5) 
access only the first megabyte of memory. 
If you have more than that installed in 
your Mac and use the program under 
MultiFinder or System 7, make sure to 
install it in the first memory slot to give it 
the lowest possible memory allocation. 

Customizing Chart Formats 
If you use charts a lot and like to use cus­
tom chart formats built from those 
already available, this tip will make your 
charting chores more palatable. 

You can store libraries of custom chart 
formats, instead of re-creating a custom for­
mat every time you need it. Simply use the 
Clear command to empty the formulas of a 
chart with a format you find particularly 
useful, and use Save As to store it to disk. 



To use your custom chart format, copy 
the data from the worksheet that you 
want to see in the chart and use Paste 
Special to paste the formulas into the for­
matted chart window. You now have the 
data illustrated in your custom chart for­
mat, without spending an hour or so to 
re-create that custom format. 

If you encounter a situation where you 
can't copy the data directly (a discontin­
uous selection, for example), select the 
data you want charted and create a new 
chart file. Then open your customized 
chart file. Do a Select Chart on the cus­
tomized chart file, use the Copy com­
mand, and then switch to the new chart 
file. Use Paste Special to paste the format 
of your customized chart file onto the 
new chart file. 

You can quickly select commands within 
most dialog boxes by typing the first let­
ter of a radio button command. That often 
selects the command without your having 
to actually click the mouse on the button. 

Selecting The Entire Worksheet 
You can select an entire worksheet without 
using the mouse by typing Command-A. 
This is the equivalent of clicking in the 
upper left comer of the worksheet. 

Show Or Print All Worksheet 
Formulas 
To show or print all the formulas in a work­
sheet (rather than the data), open a new 
macro sheet, copy the required cells from 
the worksheet, and paste them into the 
macro sheet. If you don't include all related 
cells, the cell references within the macro 
sheet may be incorrect or misleading. 

Excel Quick-reverse 
Fill Right and Fill Down are two of the 
handiest commands in Microsoft Corp.'s 
Excel. If you want to duplicate you data 
in other directions, though, just hold 
down the Shift key when you select the 
commands from the Edit menu. 

Insert New Row/Column Without 
Using File Menu 
You can select Insert to insert a new row 
or column without going back to the file 
menu every time. Hold down Option 
while clicking on the row or column in 
which you want to add a new area. 

Automatic Dates In Column 
Heads 
There's a way to make Excel automatical­
ly fill in the dates at the heads of columns. 
For example, to fill in months, select the 
cells you want co fill in with the months 
(12 in chis case). Then, choose Number 
from the Format menu. Type "mmm" 
into the dialog box for abbreviated 
months, or "mmmm" co have the month 
names spelled out. Then, without dese­
lecting the cells, enter 1 in the first cell 
and press Enter. 

Now go co the data window and choose 
Series. Then, in the dialog box, select 
Series in Row, Type Dace, Month Dace 
Unit, and increment of 1 without a stop­
ping point. 

Finally, go back to the spreadsheet, type 
2 in the second cell, and press Enter. The 
dates should appear in the columns. You 
can experiment with chis method to see 
how it works for other time increments 
as well. 

You can also use the NOWO function to 
enter the current dace or time into a cell. 
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Define which part of the information 
should be displayed by selecting DAY(), 
HOUR(), MINUTE(), MONTH(), 
WEEKDAY(), or YEAR(). The formula 
for entering the current month in a cell 
would be =MONTH(NOW()). 

Displaying/Printing Columns 
Starting With Zero 

Some zip codes have leading zeros (for 
example, 05091 for Woodstock, 
Vermont). If you always want Excel to 
display and print these zeros, select the 
row/column in question and select 
Number ... from the Format menu. Type 
in five zeros at the bottom of the dialog, 
then dick OK. The selected area will now 
allow for zip codes with zeros as their 
first digits. 

Copying A Spreadsheet As 
A Graphic Image 
Excel has a feature that allows you to copy 
a portion of a spreadsheet as a PICT file, 
instead of having to copy only the num­
bers. Select the area of the spreadsheet you 
want and choose Copy Picture from the 
Edit menu. (To get this opti9n to appear, 
hold down Shift before clicking on the 
Edit menu.) The selection, along with 
row and column headings, will now be in 
your Clipboard, where you can transfer it 
to another program like MacDraw for 
resizing or "dressing up." 

Highlighting Multiple Cells 
Highlight a large number of cells by 
clicking on the top left cell of the range 
and choosing Go To ... from the Formula 
menu. Then specify the lower right cell of 
the desired range and press Shift while 
clicking OK or pressing Return. 
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Cursor Key Movement 
When a group of cells is highlighted, 
you can't move the cursor outside the 
selected area if you're using the key­
board to control it. However, you can 
use the cursor keys to move around 
within the selected cells. When the cur­
sor hits the bottom or the edges, it will 
wrap to the other side. 

Naming Cells In Columns Easlly 
If you find yourself entering a column of 
labels, only to have to manually name 
each cell in the column just to the right of 
the labels for use in formulas, here's an 
easier way: Select the first cell that you 
want to have the same name as the con­
tents of the label cell to its left. Then use 1 

Command-L (or choose Define Name 
from the Formula menu) and press 
Return. Excel will automatically assign 
the contents of the label cell to the left as 
the selected cell's name. 

Centering Tables With Borders 
To center a table with a border, increase 
or decrease the left margin. Check your 
centering by viewing the page with the 
Preview option in the Print dialog. The 
left and right margins will both appear 
if the table is centered. Only the left 
margin appears in the reduced view if 
it is not. 

Remove Formulas To Trim 
Document Space 
When entering a formula into a cell, press 
Enter or Return to confirm the formula. 
The results will appear in the cell, but the 
formula is saved with the sheet. Press 
Command-= instead and the results of tqe 
formula will be entered into the spread­
sheet, while the actual formula is lost. (If~ 



new value is entered into a variable cell in 
the formula, the results won't change.) 

Use this method to trim a few K from 
your saved document when disk space 
runs tight. 

Enter Some Text Strings As 
Formulas 

You might find that entering some text 
strings into a cell produces odd results. 
For example, pasting 1 OA into a cell 
results in Excel displaying 10:00 A.M. 
Work around this by entering the text as a 
formula. Instead of lOA, type= "lOA," 
and the cell will show 1 OA. 

Copying Cell Groups For Page 
Layout Applications 
When copying a group of cells to be used 
in a page layout application, highlight the 
cells and then press Command-Shift-3 to 
copy cells, divider lines, and any other 
information in the spreadsheet. It will be 
converted into QuickDmw, so when you 
paste it into a word processor or desktop 
publisher, it can be easily resized while 
retaining its full resolution. 

Reopen Macro Sheet To 
Recompute Macro Functions 
You can only use macros from open macro 
sheets when building your spreadsheet. If 
you close a macro sheet containing a 
macro that a cell in your open spreadsheet 
refers to, the value of the affected cell will 
change to "#REF!" The way to recom­
pute your functions is to reopen the 
macro sheet. 

UsingX-modem To Import Lotus 
1-2-3 From MS-DOS Machines 
If you import Lotus 1-2-3 worksheets 
from a PC by modem, use X Modem. If 

the terminal program on your Mac has 
selectable MacBinary, turn it off. If you 
use X Modem, only 7 of the 8 data bits 
per byte come through, so the transfer is 
useless. IfMacBinary is used, the first 128 
bytes of data will be lost. 

Command Key Combinations To 
Select Page Setup Options 
Excel provides command key combina­
tions for almost all the choices in page 
setup and print dialogs. In both, 
Command-Cor Command-period 
select Cancel, and Command-O or 
Return/Enter selects OK. 

For The Image Writer Page Setup 
Dialog ... 

Command-U activates "US Letter." 

Command-A activates "A4 Letter." 

Command-N activates "No Gaps 
Between Pages." 

Command-P activates "Print Row and 
Column Headings." 

For The Image Writer Print Dialog 

Command- B activates "Best." 

Command-F activates "Faster." 

Command-D activates "Draft." 
Command-A activates "All". 

Command-H activates "Hand Feed." 

Command-P marks "Preview." 
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For The LaserWriter Page Setup 
Dialog 

Command-U activates "US Letter.'' 

Command-A activates "A4 Letter." 

Command-F marks "Font 
Substitution." 

Command-S marks "Smoothing." 

Command-P marks "Print Row and 
Column Headings." 

For The LaserWriter Print Dialog 
Command-A activates "All." 

Command-F activates "From ... To." 

Command-M activates "Manual Feed." 

Command-P activates "Paper 
Cassette." 

Command-N activates "No" (for No 
Cover Page). 

Command-L activates "Last Page" (for 
cover page). 

Command-H activates "Help." 

Formatting Commands In 
Headers And Footers 
To embed formatting commands or other 
instructions in the header or footer of an 
Excel document, insert the commands in 
the Page Setup dialog box. The keyboard 
equivalents are: 

&L: Align the characters that follow at 
the left margin 

&C: Center the characters that follow 

&R: Align the characters that follow at 
the right margin 

&P: Print the page number 

&D: Print the current date 
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&T: Print the current time 

&F: Print the document name 

&B: Print the left, center or right side of 
the header or footer in boldface 

&1: Print the left, center or right side of 
the header or footer in italics 

&&: Print a single ampersand 

Extra-Long Text In Headers Or 
Footers 
You can enter header or footer text that's 
longer than the box can display. If you 
need to edit this text later, view it by 
placing the cursor in the visible text near 
the rightmost end of the entry box and 
then dragging off the end. The text will 
scroll to the left and the extra text, 
already highlighted, will appear. 

"Can't Save" Message 
When the Mac boots, the System sets the 
maximum number of saved files a docu­
ment may have open at once. The number 
is generally 32, although it varies slightly 
from System to System. The error message 
means that the System won't let Excel 
open any more saved files or save any pre­
viously unsaved files. You can still create 
additional new documents in Excel, but 
you can't save them until you close some 
of the currently open saved files. 

Error Message "Extract Range is 
not valid" 
When using Excel's database, selecting a 
range of cells containing field names and 
choosing Extract from the Data menu 
may generate an error message "Extract 
Range is not valid." 

The names selected as the extract fields 
must exactly match the field names in the 
database. The names are case-sensitive and 



can't have any leading or trailing spaces, 
and the extract range can't have any blank 
cells in it. 

The best way to make sure the titles in 
your extract range match exactly the 
titles from your database is to copy the 
titles from your database directly to your 
extract range. Any number or date field 
names in the database can't be used in 
the extract range. If you're still encoun­
tering problems after making sure the 
names match, try extracting each field 
independently to see which one is caus­
ing the alert. 

Loading A Work Space By Default 
To load a work space by default when 
opening Excel, save your worksheet, 
chart, macro sheet, or work space into a 
file, label it Excel Startup, and place it in 
your system Folder. Excel then automati­
cally opens that file whenever the 
application is started. 

Inserting Cells Without The 
Dialog Box 
To insert cells without bringing up a 
dialog box that asks whether you want to 
shift cells up or to the right , do the 
following: 

Hold down the Option key, and select the 
range you want to insert. Excel will insert 
the range according to the default setting 
in the dialog box. 

Une Up Numbers With Mixed 
Formats 

You can line up the numbers exactly when 
using both the regular-number format 
and the dollar format in the same column. 
Select the cells with the regular-number 
format and choosing Number on the 
Format menu. Then select the dollar for-

mat, and delete the dollar signs in the 
Format Number dialog box. 

Using The SUM Function To Add 
UpTime 
How can you use the SUM function to 
add up individual times of less than 24 
hours when the sum of the times exceeds 
Excel's clock limit of24 hours? This is a 
frequently encountered problem for many 
Excel users, and the solution is a simple 
formula. 

Say you want to add three triathlon times, 
14:10:00, 16:15:00, and 13:23:00 and 
get an answer in hours and minutes. 
(14: 10:00 is 14 hours, 10 minutes and 0 
seconds.) Type the times into cells A 1 :A3. 

Enter the following formula in cell A4 in 
General format to sum the times in 
hh.mm.ss format: 

=INT(SUM{HOUR{A 1 :A3)) 

+SUM{MINUTE{A 1 :A3))60) 

+{MOD{SUM{HOUR{A 1 :A3)) 

=SUM(MINUTE(A 1 :A3))/ 

60,1 )* .6)+MOD(SUM(MINUTE 

{A 1 :A3)),60)/1 00 

In this case, the range is AI :A3 (the cells 
in which you entered the times)but you 
could substitute a different range for your 
own spreadsheet. 

To enter the formula as an array, press 
Command-Enter after typing in the for­
mula. The formula should give you a total 
of43:48 (43 hours, 48 minutes). 

Inserting lines Into A Chart Label 
To insert more than one line of text into a 
chart label, go to the formula bar, press 
Command-Return. This creates a larger 
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space in which you can type multiple lines 
of text. 

Rearranging linked Data 
When you link worksheets in Excel, you 
can rearrange the data on the supporting 
worksheet without affecting the link. 

Let's say you have a total in cell C5 of 
Worksheetl (Wl) that is linked to cell D7 
in Worksheet2 (W2), using the formula 
=Worksheet!! $C$ 5. If you insert a row 
into W 1, which pushes your total down 
to C6, the value in D7 of your second 
worksheet changes, because it's still linked 
to cell C5. You can adjust for rearrange­
ments by using a name instead of a cell ref­
erence. For this example, select C5 in Wl. 
Choose Define Name from the Formula 
menu, type in a name such as Total, and 
click on OK. 

On W2, change your link to read: 
= Worksheetl !Total. 

Now if you cut and paste the value in C5 
to some other area ofWl or insert rows 
that push C5 down, the name will follow 
the original value in C5 wherever it goes 
and the link will be properly maintained. 
Note: This won't work if you sort the rows 
into a new order. 

Bringing A Color Excel Chart Into 
Word 
Select Print Using Color in the Excel 
Print dialog box (you have to Click on 
OK and then press Command-period to 
stop the print job). Then when you copy 
the color chart (by clicking on the outer 
edge of the chart window and choosing 
Copy) and Paste Link it into Word, the 
chart appears in color in Word and is 
updated in color. 
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Copy Picture in the Shift-Edit menu in 
Excel also lets you bring a color chart into 
Word, but it lets you update the chart 
only in black-and-white. 

Displaying Formulas 
You can display, in a cell, the formula that 
produced a value. Command-tilde ( ..... )lets 
you toggle between showing a formula · 
and displaying a value in a cell. 

Deleting Formulas Whlle 
Maintaining Values 

To delete formulas in selected cells on a 
spreadsheet while maintaining the values, 
select and copy the cells. With the same 
cells selected, choose Paste Special from 
the Edit menu and select Values from the 
resulting dialog box. 

Creating An x-y Chart? 

You can plot an x-y chart for one or more 
series of y data by using the Scatter format 
from the Gallery menu. If your data is in 
columns, enter the y data into the 
columns directly to the right of the x data 
on your worksheet. If your data is in rows, 
enter they data into the rows directly 
below the x data on your worksheet. 

Next, select the data you want to plot, 
including column headings if you want 
to plot them as well. Copy the data to the 
Clipboard. Open a new chart: choose 
New from the File menu, and select 
Chart. Click on OK, and a blank chart 
will appear on your screen. 

Choose Paste Special from the Edit menu. 
If your data is in columns (or rows), choose 
Values in Columns (or Rows) and 
Categories in First Column (or Row). If you 
have also copied column (or row) headings· 
for inclusion in the chart, click on Series 
Names in First Column (or Row). 



Click on OK, and the data will be plotted 
in a bar chart. Select Scatter from the 
Gallery menu, and the data will be plot­
ted as an x-y chart. 

I.iokiog Data With Word 4.0 For 
Auto-Update 
Do you want to link Excel data and charts 
into a Word 4.0 document so that the 
Word document can be automatically 
updated when you change your data or 
charts in Excel? 

Select and copy the Excel information that 
you want in your Word document. Quit 
Excel, and then open your Word docu­
ment. Position the cursor where you want 
to paste the information, and choose Paste 
Link from the Edit menu. 

To update this information in Word after 
you've changed it in Excel, select the data 
in Word along with the identifier para­
graph preceding the data. You can update 
everything you earlier copied from Excel 
or select specific rows or columns. Choose 
Update Link from the Edit menu. Word 
starts up Excel (if necessary), opens your 
spreadsheet, copies the updated informa­
tion, and then transfers it to your Word 
document. IfWord can't find the Excel 
program or file it's supposed to be linked 
to, it displays a dialog box and asks you to 
locate the program. 

Avoiding Update Prompts 
When opening an Excel file, it can be 
annoying to get an alert dialog box that 
tells you to update references to unopened 
documents. This is especially annoying 
when hidden macro sheets are associated 
with the "workspace." 

Here's how to avoid this unwanted 
prompt. Files are opened in alphabetical 

order as specified in the saved workspace. 
To make your macro sheets open before 
the worksheets that reference them (thus 
avoiding the prompt), simply add a zero 
at the beginning of each macro-sheet 
name. This technique also works for com­
binations of worksheets and charts that 
are opened by a single document. 

Hiding Sensitive Data From View 
Using the Cell Protection command only 
hides formulas from being viewed. To 
really protect sensitive information, elim­
inate the column containing the data from 
view. Select all of the columns you want to 
hide, choose Column Width from the 
Format menu, and set the width to zero. 
Although hidden, the values will still be 
used in computations. 

Now, protect the document with a pass­
word. No one will be able to view the hid­
den data without knowing your password 
and unprotecting your document. 

Protecting Sensitive Information 
While Working On It 
To protect documents from prying eyes 
while you're working, open a new docu­
ment before opening the confidential one. 
Then use the new document's size box to 
make it as small as possible, and move it 
to the bottom of the page, so low that only 
its title bar shows. Finally, open the 
confidential document. 

If you're intruded upon while working, 
double-dick the new document's title bar 
and it will instantly cover your private IIIII 
information. 

Manipulating The Insertion Bar 
WithAtTow Keys 
Editing the Excel Formula Bar with the 
mouse can be a test of dexterity. It might 
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actually be impossible for a physically 
impaired user. 

The Microsoft manual does not mention 
that the insertion bar can be manipulated 
with arrow keys. The trick is to activate 
the Formula Bar first with Command-U 
instead of with the mouse. Once activated 
from the keyboard, the left and right 
arrows will then move the insertion point 
one character. With the Command prefix, 
the left/right arrows move one field per 
stroke. This field can be a word, a space, a 
symbol, or a cell reference, for example. 
With the Shift prefix, the region through 
which the bar moves is extended and 
highlighted in the usual way. 

EXCEL1.5 
Quickly Returning To Where You 
Left Off 
When you're using several worksheets, 
charts and macros simultaneously, quit­
ting the application and later returning to 
where you left off can be painful- you 
have to open every worksheet, macro, and 
chart separately. 

However, Excel lets you return to where 
you left off with the Resume Excel icon, 
which is created after quitting Excel. It 
works only if you haven't tried to use 
Excel with another worksheet. 

If you want to save a configuration, drag 
the Resume Excel icon out of your System 
folder and rename it. Resume Excel 
remembers all the windows last opened, 
their positions, and the locations of all files. 

This also works in earlier versions of 
Excel, where the Resume Excel icon 
appears in the folder that was open when 
you launched the application. 
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EXCEL2.2 
The Thick Border Trick 
Have you ever wondered how Microsoft 
does it in its ads- gets those nice thick 
rules in a spreadsheet? There's nothing in 
the manual about how to do this. You 
can't specify border thickness anywhere in 
the program. Here's the trick: 

1. Select just the cells around which you 
want thick rules. Don't select an entire 
row. Use the Border command on the 
Format menu to add top and bottom 
borders in those cells. 

2. Now select the entire rows that contain 
the bordered cells by Shift-clicking on the 
row numbers or dragging through the 
numbers of the desired rows. 

3. Select Row Height from the Format 
menu, and specify 1. 

You can also make gray lines by not bor­
dering the cells first. The result will look 
like gray bands on the screen but will not 
print out unless you decide to print all the 
worksheet's grid lines. 

Using Excel To Simplify Word's 
Mall-Merge 
If you are left intimidated by Word 4.0's 
mail-merge features, Excel can simplify 
the mail-merge process for you and pro­
vide a simple flat-file database as well. 

Here's how to set things up: 

1. Create an Excel address database. You 
can sort, print, edit, or search it. Make 
sure you save a version in the CSV 
(Comma Separated Values) text format 
so Word will be able to access it. 



2. Setup a Word "main document" (see 
the Word 4.0 manual)- not a difficult 
process. The first line contains the DATA 
statement followed by the name of the 
"data document," or address database. 
Text prints as usual. Field names are 
enclosed in double angle brackets 
(Option-\ Shift-Option-\). 

3. Now here's the good part. See all those 
field names? They're common to both 
the Excel address database and the Word 
main document (the form letter). Just 
make sure the name you use in the Word 
from letter is the same as the name 
you've given the Excel file saved in the 
CSV text format. 

To print form letters, open your main doc­
ument in Word, select Print Merge, and 
choose which records (the row numbers in 
your Excel address database that contain 
the names and addresses you want) to 
print. Click on the Print button, and 
you're finished. 

EXCEL3.0 

Allgoing Number Formats 
It's possible to modify noncurrency num­
ber formats in Excel3.0 so that they align 
properly with currency formats by using 
the Format Number command. 

In previous versions of Excel, the num­
bers in noncurrency cells didn't line up 
properly with cash or currency numbers 
in columns. This was because positive 
numbers formatted as currency included 
a space the width of a right parenthesis 
so that they aligned with negative cur­
rency amounts, which are always 
enclosed in parentheses. 

In order to avoid this problem in Excel 
3.0, select the noncurrency number cells, 
and choose Number from the Format 
menu. After the number format, which 
appears in the Format box, type an under­
line character and a right parenthesis:_). 

When you press Return, the noncurrency 
and currency numbers should align prop­
erly. Note: This tip does not work with 
the General number format. 

Microsoft Excel Has A Special 
Look That Says System 7 
To make System 7 users feel extra special, 
Microsoft gave Excel 3.0's Toolbar and 
outlines a 3-D, Excel-for-Windows-style 
appearance when run under System 7. But 
System 6 users don't have to miss out on 
the fun. Just hold down Shift-3-D when 
you start up Excel3.0 and you, too, can 
have puffy buttons in your spreadsheet. 

FULL IMPACT 2.0 

Under System 7.0, Full Impact 
Just Won't Quit 
Early adopters of System 7.0 would be 
~ise to pay heed to Apple's Compatibi­
lity Checker stack before booting up their 
favorite applications. 

When Ashton-Tate Corp.'s Full Impact 
2.0 is run under System 7 .0, the Quit 
command disappears from the File 
menu and the Command-Q keyboard 
equivalent doesn't work. To exit with­
out shutting down the Mac entirely, 
you need to create a macro that includes 
the instruction to quit. 

Late (but not final) versions of the 
Compatibility Checker also contained 
an incorrect phone number for the 
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company. Ashton-Tate's upgrade hotline 
is (800) 227-4866. 

MULTIPLAN 
Quick Column Additions 
Quickly add a new column to a spread­
sheet by holding down Shift while click­
ing in the head of the column directly to 
the right of the position you want to 
insert the row at. 

Copying Rows and Columns Into 
A Word Processor 
It's easy to copy the rows and columns of 
your spreadsheet into a word processor. 
Just select all the cells in the spreadsheet 
and Copy them to the Clipboard. Then, 
launch your word processor, making sure 
its tab settings correspond to the spread­
sheet's column widths. Then, Paste in the 
data from the Clipboard. 

Sorting A Series Of Rows 
To sort a series of rows, select all the 
filled-in cells in the column containing 
the "field" you want to sort on. Then 
choose the Sort ... command. In the dialog 
box, click your sorting choice in ascend­
ing or descending order. The information 
in columns other than the one you sorted 
on will be rearranged to reflect the sorted 
column. 

Extra-Long Header Or Footer 
Text 
You can create a header or footer that's 
longer than the box can display. To edit or 
view this text, place the cursor in the 
visible text near the right-most corner of 
the entry box and drag off its end. The text 
will scroll to the left and the "hidden" text 
appears, highlighted and ready for editing. 
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Recalculating New Values Or 
Formula Entries 
If you're having a problem because new 
value or formula entries aren't recalculat­
ed into the rest of your cells until the doc­
ument is saved, you must have turned off 
the Automatic Calculation feature. You 
can either just use Calculate Now from 
the Calculate menu (also accessed with 
Command-=) or you can reactivate 
Automatic Calculation from the 
Calculate menu. 

Rounding Off Half-Pennies 
If your spreadsheet contains dollar figures 
with decimal places less than a penny, 
Multiplan executes the calculations exact­
ly, using those values. You can choose th~ 
Round function to round the figures off to 
two decimal places before calculation, if 
you don't need such exacting figures. 

Fixed Numbers Act Like Text 
If you display a number with the Fixed 
function, it will act like text and can be 
treated as such for concatenation. 

Use Forced Page Breaks When 
Printing Large Sheets 
When you're printing large sheets of 
Multiplan documents, it's easier to use 
forced page breaks. These break up the 
spreadsheet into printable units. Then 
select pages from the Print dialog box. 

This may sound cumbersome, but it's a 
lot easier than constantly selecting areas to 
print from a large spreadsheet. 

~~gMoreDamOnA~e 

You can squeeze a little more data on a 
page by choosing a page size in the Page 
Setup menu that's larger than the actual 
size of the paper you're using. 



Another way of getting more data on the 
page is to select the Page Setup option and 
set all page margins to 0. 

Tall Adjusted Print Option Looks 
Good, Takes Longer 
The Tall Adjusted printout is much dark­
er and more legible than the printout you 
get using just the Tall setting. However, 
Tall Adjusted pages take almost twice as 
long to print. 

Simulating Freeze Tides Option 
On Printout 
You can simulate the Freeze Tides screen 
option on your printouts if you want to. 
Copy and paste an extra titles column at 
the leftmost side of each page, then 
obscure the column from view by drag­
ging from its right, over the dotted lines. 
You won't see it on-screen, but the printer 
will produce the tides column in its prop­
er position. 

You Can Print More Columns 
Than You Think 
Multiplan can print columns up to 128 
characters wide with the orientation 
printing option, even though you can't 
enter numbers over 99 in the Column 
Width dialog box. 

First, open the spreadsheet and Show 
Values. Then, use Column Widths to set 
the column width to exactly half of the 
width you want for the printout. Finally, 
select Show Formulas, and the column 
width will double to what you want. 

If you choose Column Width again, 
you'll get an "Invalid Column Width" 
message, but this won't affect any print­
ing or operations. 

Highlighting Sections With 
A Graphics Program 
It's not possible to highlight particular 
sections of a Multiplan sheet. However, 
pasting the documents into a graphics 
program like MacDraw lets you add 
tints to highlight headings and important 
totals. 

Showing Cells That Need 
Alteration 
Use the Protect Document and Remove 
Cell Protection options together to set up 
a model in which cells that might require 
alteration show up as highlighted and 
unprotected. Then, to make changes, you 
can move instantly between these unpro-. 
tected cells by using the Enter key. A plus 
is that row and column lines are sup­
pressed on a protected sheet, making 
them cleaner looking and easier to read. 

An Easy Way To Unprotect 
Protected Spreadsheets 
To recover protected spreadsheets, all you 
have to do is open the protected document 
and Save As. Pick a new file name, Save, 
Close, and then open the Saved copy and 
get to work. Protection doesn't transfer to 
new copies of old documents. 

Putting Tides At The Top Of Lists 
After Sorting 
If you compile lists and want the title 
at the top after the sorting, type a space 
before the title. This space has a lower 
ASCII code than any other single 
character. 
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WINGZ 
Using HyperScript To Add Hide 
And Show Commands 

You can use HyperScript to easily add Hide 
and Show commands to the Sheet menu. 

First, select New Script from the Script 
menu, and then type the following script 

select menu "sheet" 
add menu separator 
add menuitem "Hide" command 
"repaint off 
hide sheet hide tool box hide entry 
bar 
select report border no line border 
repaint on 
repaint window" 
add menuitem "Show'' command 
"repaint off 
show sheet show tool box show 
entry bar 
select report border single line 
border 

repaint on 
repaint window" 
The Repaint Off command in this script 
stops Wingz from redrawing the screen 
after hiding each element, which would 
slow down the script. The No Line 
Border command hides the border that 
Wingz normally draws around every 
printed sheet. 

Improved Date Formats 
Wingz's five date formats all use hyphens, 
but you may prefer Excel's compact 
m/dlyy format. This script replaces the 
fourth date format (mm-dd-yy) with 
m/dlyy. The fourth format was chosen for 
modification because Wingz uses it by 
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default for entering a date into a cell, but 
you can change the script to substitute 
this new format for any of the five 
Wingz formats: 

select menubar "main" 
select menu ''format number" 
select menu item "MM-DD-YY" 
rename menuitem to "M/DNY" 
date 4 "m/d/yy'' 
The new date format is not stored with 
spreadsheets- to use it, the script must 
be executed each time you start the 
Wingz program, making it a good candi­
date for placement in your Startup script. 

Restoring Row Height And 
Column Width 
Wingz lets you adjust the height of rows~ 
but this ability is a mixed blessing. Rows 
are narrow, and it's easy to accidentally 
change the height of a row when all you 
actually meant to do was select it. Once 
it's been changed, there is no simple way 
to restore a row to its original height. This 
script does exactly that- all selected rows 
are reset to their default height: row 
height 240. 

The 240 measurement is in TWIPs, 
Wingz's standard unit of measure. One 
TWIP is 1/20 point, so 240 is 12 points, 
the standard row height. A similar script 
restores default column widths: column 
width 1480. 

Setting Row Height And Column 
Width 
This script allows you to set the height of 
all selected rows by simply entering the 
desired height, in points, into a dialog box: 

row height value(dg:dgask ("Enter· 
height in points," round (rowheight 
()I 20, 0), 5)) * 20 



The dialog box initially displays the 
height of the first row in the selection. 
The dg:dgask function, which ships with 
Wingz, displays a dialog box with ames­
sage and a text field in which the user can 
enter a response. 

It takes three arguments: the message 
string, the initial value to display in the 
response field, and that field's desired size 
in characters. The multiplication and 
division by 20 handle the conversion of 
values between points and TWIPs. 

A similar script lets you set the width of 
all selected columns: 

column width value ( dg:dgask 
("Enter width in points," round 
(columnwidth ()I 20, 0), 5))* 20 

Time Made Simple 
Wingz is not smart when it comes to 
accepting time values. For instance, if you 
enter 10:35 or 12:30 pm into a cell, 
Wingz does not understand that you are 
entering a time- it interprets the entry as 
ordinary text. 

This script converts the text in the active 
cell to a genuine time value and then 
formats the cell to use the HR:MN AM 
format: 

put timevalue (cell () into 
range ( makecell (col (), row ())) 
format time 2 

A Goodies Menu 

Wingz features a HyperScript program­
ming language, which lets you easily 
create custom features and menus. You 
don't have to be a programmer to use the 
following scripts. To enter a script into 
Wingz, select New Script from the Script 
menu; type the text of the script; and then 

Save it, using whatever name you like. To 
run the script, select Run Script from the 
Script menu and open the file containing 
your script. If you create a script named 
Startup and put it into the same folder as 
Wingz, it will be executed automatically 
each time Wingz is launched. 

This script combines several previously 
mentioned scripts and includes an addi­
tional script for selecting the last cell in a 
spreadsheet. Directly out of the box, 
Wingz won't let you select the last cell­
this script defines the last cell. The 
Startup script provides the new date for­
mat and then creates a Goodies menu that 
has an entry for every one of the remaining 
commands. Be especially careful to type 
the script exactly as it is shown here: quo­
tation marks in the scripts appear doubled 
when they are embedded as menu com­
mands in the Startup script. Name this 
script Startup and put it into the same 
folder as Wingz; that way, you'll get the 
Goodies menu automatically each time 
you launch Wingz. 

{set 4th date format (the default date 
format) to m/d/yy} 
select 
menubar "main" 
select menu ''format number'' 
select menu item "MM-DD-YY" 
rename menuitem to "M/D/YY" 
date 4 "m/d/yy'' 

{create Goodies Menu} 

add menu "Goodies" with 6 items 
{restore selected rows to default 
height} 
add menuitem "Fix Row Height" com­
mand "row height 240" 
{set row height in points} 
add menuitem "Set Row Height. .. " 
command "row height value (dg:dgask 
(""Enter height in points"", round 
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(rowheight ()I 20, 0)) * 20" 
{restore selected columns to default 
width} 
add menuitem "Fix Column Width" 
command "column width 1480" 
{set column width in points} 
add menu item "Set Column Width ... " 
command "column width value 
( dg:dgask (""Enter width in points"", 
round (columnwidth ()I 20, 0)) * 20" 
{convert current cell's text represent­
ing time to time value} 

add menuitem "Fix Time" command 
"put timevalue (cell () into rnage 
(makecell (col (), row())) format time 2" 
{select last cell in spreadsheet} 
add menuitem "Select Last Cell" 
command 
"define sel, lastrow, lastcol 
repaint off 
select Active Cells 
sel = selection(1) 
lastrow = rowof(sel) + rows(sel)- 1 
lastcol = colof(sel) +cols(sel) - 1 
select range range (makecell(lastcol, 
lastrow)) 
repaint on 
repaint window" 

WORKS 

Taking Advantage Of The Draw 
Module 
The Draw module is a hidden treasure 
that you can use only in conjunction with 
the word-processing or spreadsheet pro­
gram of Microsoft Works. You can use it 
to dress up documents or as a graphics 
program. Objects and text created in the 
Draw module exist in a separate layer 
from the word-processing or spreadsheet 
information- similar to an acetate overlay 
-so you can read underlying text through 
a graphic if you choose. 
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The module lacks a vertical ruler and pre­
cise sizing tools -serious omissions, but 
you can precisely position objects in two 
ways: A snap-to-grid system lets you 
specify grid increments down to 1136 inch 
or 1114 centimeter, and the keyboard 
arrow keys and the directional arrows in 
the tool palette let you move objects one 
pixel at a time. 

Spreading Text With The Draw 
Module 
Works' Draw module has some exotic fea­
tures. It can make text follow and spread 
evenly along an arc or diagonal line. You 
can also use this technique to adjust letter 
spacing. 

Cut or copy your chosen text to the 
Clipboard, and draw an arc or line in the 
Draw module. Make it invisible by select­
ing White or No Line on the Line Pattern 
menu, and then select the Spread Text 
command on the Format menu. Each let­
ter becomes a separate Draw object that 
you can move or size independently. If you 
group the letters, using the Group Picture 
command on the Format menu, you can 
stretch or distort them. 

Desktop Publlshing 
Yes, you can create multiple-column 
newsletter pages and fliers with Works. To 
create columns, select the Text tool from 
the palette and hold down the Option key 
while you draw text frames, just as you 
would in a desktop publishing application. 
To link columns, hold down the Option 
key and, with the pointer, click on the 
columns in the order you want. Headings 
above each column indicate the name or 
number of the current column and the col­
umn it is linked to. You can edit these 
headings manually with the Text tool. 



Once you've created the columns, typed 
or pasted text flows from column to col­
umn. This doesn't work as smoothly as it 
does in conventional DTP applications -
you must deselect a column before text 
reflow occurs- but for occasional use, 
Works is a competent desktop publishing 
application. 

Better-Looking Charts 
Works is at its best when you use two or 
more modules together. You can't edit a 
Works chart in its own window, but if you 
paste it into a spreadsheet, you can edit it 
by using standard draw techniques. 

To improve a chart's appearance, use the 
Ungroup Picture command on the 
Format menu. This breaks the chart into 
individual Draw objects. You can then 
pull a wedge out of a pie chart, change the 
fill or line patterns, add additional text 
labels, circle important information, or' 
draw lines with arrowheads. 

Make Works Desktop 
The Make Works Desktop commands on 
the File menu creates a file (its icon looks 
like a desk) that remembers groups of 
Works documents: open the file, and you 
automatically open the whole group. You 
can use this feature to file any kind of 
linked documents, such as letters or mail­
ing labels. 

Creating a Works Desktop file is simple: 
Choose the Make Works Desktop com­
mand on the File menu while the files you 
want to include are open, and then name 
the new file. 

How can you put this feature to practical 
use? Try creating a check-writing module 
with the Make Works Desktop command. 
You'll need three Works files: 

A database that contains all the informa­
tion that will appear on the check, another 
database containing a list of companies to 
whom you write checks regularly (includ­
ing the check amount, in some cases), and 
a word-processor document that prints 
the checks by merging the data from the 
check-register file. Name this Works 
Desktop file Banking; double-clicking on 
it gives you instant access to the three files 
you need to write checks. 

Moving A Selected Range Of Cells 
In The Spreadsheet 
While in the spreadsheet, you can quickly 
move a selected range of cells by holding 
down Command-Option while clicking 
in an empty cell. The cell that you click in 
will become the upper left cell of the 
moved range. 

Date and Time Shortcuts 
Works provides a shortcut- Command-D 
-for entering the current day's date into a 
date field in a database. For time fields, 
Command-T has an analogous effect. 

Alternatively, you can enter a date in the 
current year by typing month/date 
(12/22, for example), and Works auto­
matically adds the year. This shortcut 
works even if you want to display the date 
in medium or long format; Works will 
display the date in your chosen format. 

Presentation Spreadsheets 
Like a high-end spreadsheet program, 
Works lets you insert charts within a 
spreadsheet. Starting with a chart window 
on-screen, select the Copy command, 
switch to the spreadsheet window, and 
paste in your chart. 

Works lets you ungroup your charts after 
you've drawn them. Select Ungroup 
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Picture on the Format menu, and you can 
adjust the placement of bars, legends, 
titles, and so on. 

Spreadsheet Cell Notes 
Cell notes are like Post-it notes that you 
can attach to individual cells. Use them 
for comments about the calculation for 
the cell or instructions about what to 
enter. This information, although useful, 
is unnecessary in the main display. 

To create a cell note, select the cell you 
want, select the Open Cell Note com­
mand in the Edit menu, and type your 
message in the cell-note window. The 
notes are saved with the document, and a 
mark appears in the upper right corner of 
any cell that has an associated note. 

Telecommunications Sessions 
Many communications applications for­
get text that has scrolled beyond the top 
edge of the window. To review a session 
later, you must save the screen text to a 
disk file. This approach has two disadvan­
tages: The file can't be read while the 
communications session is in progress, 
and you need a separate word processor or 
text editor to read the file. But what if you 
just want to reread information from three 
screens back? 

During a session, Works can remember up 
to 100 previous screens (the more screens 
you select, the more memory you need). 

Works also permits up to 14 windows to 
be open simultaneously and supports 
background communications, uploading, 
and downloading. You can save text from 
the screen into a new document, and you 
can also paste text you want to transmit 
into the communications window. 
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Using A Word Processor To 
Change Fonts 
Although the spreadsheet has no font 
changing capabilities, you can move a 
block of cells from a spreadsheet to a 
word processing document via the 
Clipboard, and then change the font, 
sizes or styles in the new word processing 
document. The only problem with this is 
that you lose the display grid, if you had 
one. Works' drawing functions allow you 
to easily reintroduce one. 

Sorting Columns 
The program's spreadsheet can sort rows, 
but there is no direct way to sort 
columns. A column sort can be per­
formed by selecting and copying the 
range of columns you want to sort. 
Then paste this selection into a new 
spreadsheet using Paste With Options 
instead of the standard Paste. Choose 
both Formulas And Values and 
Transpose, and click OK. Then reselect 
the range (it's now in a row) and use the 
Sort command from the Edit menu. 
Once the sort is completed, cut the data 
and then paste it back into the original 
range, using the Paste With Options 
command and both Formulas And 
Values and Transpose options selected. 

Microscrolling 
When horizontally scrolling, your view 
usually shifts a fixed length. Scrolling in 
the word processor happens one inch at a 
time, while scrolling in the data base or 
spreadsheet moves you one column. 

Hold down Shift while scrolling to micro­
scroll, allowing you to position all or parts 
of a window more exactly. 



Hanging Up Fast In 
Telecommunications Mode 
While in the communications mode, you 
can quickly hang up the phone or modem 
by typing Command- =. 

Pasting In Data Without Field 
Names 
If you have cut or copied information 
from the database, hold down Option 
while pasting it into a word processor to 
avoid pasting in the field name~ along 
with the data. 

Saving Files With Return At End 
OfEachLine 
Hold down Option while saving a word 
processor file as text (Export File) to save 
the file with Return characters at the end 
of each line. This will come in handy 
when transmitting text files. 

Bringing The Bottom-most 
Window To The Front 
When working with multiple documents, 
type Command-comma to bring the 
bottom-most window to the front. Use 
this to quickly switch between different 
documents you're currently working on. 

Entering Page Breaks From The 
Keyboard 
Enter a page break without having to go 

WORKS2.0A 
Going From Works 1.1 To 2.0a 
If you would like to transfer all information 
from Microsoft Works version 1.1 to 
version 2.0a, it's simple. First launch ver­
sion 2.0a. Now use the Open command on 
the File menu to open any file you created 
with version 1.1. Once the file is open, 
select Save from the File menu. That's it. 
The file is now in Works 2.0a format. 

Rounding Off Numbers 
The Microsoft Works database and spread­
sheet modules don't round off numbers 
consistently. 

Here's a formula used initially to round off 
test grades: 

=Round(((B7 + C7)/200),2) 

When this formula averages the test scores 
of87 and 84, it rounds up the result, 85.5, 
to 86. But with scores of91 and 100, the 
average, 95.5, is instead rounded down to 
95. By adding a very small number 
(.0000001) to the formula, as in 

=Round(((B7 + C7)/200) + 
.0000001),2) 

you can force Works to consistently round 
up to the next-higher whole number. 

to the Format menu by hitting Shift- Navigation Commands When 
Enter while you're typing. The page break Without The Extended Keyboard 
will be entered at that point. 

Quickly Accessing Graph 
Specifications Dialog 
Double-click in a chart window to quick­
ly bring up the graph specifications dia­
log box, which allows you to change the 
graph. 

Here are some undocumented navigation 
tips for anyone who is using Microsoft 
Works 2.0 without an extended keyboard: 

To go to the top of a document, press 
Command-A. 

To go to the end of a document, press 
Command-D. 
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To move up approximately one page at a 
time, press Command-K. 

To move down one screen at a time, press 
Control-L. 

SYSTEM SOFTWARE 

ALARM CLOCK DA 
Why Your Menu Bar Or Apple Is 
Flashing 
If your menu bar (or the Apple icon at the 
top left of the screen) is flashing and you 
don't know why, chances are it's because 
someone set your alarm clock. Choose 
Alarm Clock from under the Apple menu 
and click on the tiny flag at the far right 
side of the window. From there, choose the 
alarm clock icon (in the far right corner). 
Look into the middle section of the win­
dow- see that small switch image on the 
left? Set it to the up position by clicking 
on it, and your alarm should stop flashing. 

APPLE DESKTOP BUS 
(ADB) 
Power Down First 

Never connect or disconnect anything 
without first shutting down your Mac and 
all the peripherals. You may get away 
with it some of the time, but there's 
always a chance of damaging an internal 
component when you connect a peripheral 
without first powering everything down. 

Don't worry about turning your 
Macintosh on and off a few extra times. 
Also, don't forget to use the Shut Down 
command before you tum off the power. 
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APPLE FILE 
EXCHANGE 
Recovering Flles From A 
Damaged Disk 
Occasionally the Desktop file on a floppy I 
disk will become damaged so that it can'~ 
be rebuilt in the usual way. You can tell 
that the file is damaged when there is a 
long pause after you insert the disk into 
the drive, followed by an alert dialog box 
that says the disk needs minor repairs and 
asks if you want to repair it. 

If you click on OK to repair the disk, how­
ever, often the head shuftles around a bit 
and the disk is ejected without being readl 

Although you may lose the disk, you can I 
retrieve all the files not with an expensive 
recovery application but with an applica­
tion-APE (Apple File exchange}-that 
comes free with the System software. 

Launch AFE, and the entire file list 
appears. Now transfer all the files safety 
off the damaged disk to another floppy or 
hard disk. Other programs could proba­
bly do the same, but AFE is fast and effi­
cient- and the price is right! 

Fooling The Super Drive 
Here's a tip aimed at people who do a lot 
ofMS-DOS-to-Macintosh conversion, 
using the Apple File Exchange. IBM 
PS/2s and compatibles that use a 3.5-
inch 1.44-megabyte drive can read, 
write, and format a high-density disk at 
the lower 720K density. Unfortunately, 
when trying to read these disks on a 
SuperDrive-equipped Macintosh, Apple; 
File Exchange assumes that it formatted ; 
at the 1 ,440K density. AFE is looking at, 



the extra notch on the disk before it 
attempts to read the actual format. 

You can fool the SuperDrive hardware 
into thinking it has a standard DS/DD 
(double-sided/double-density) disk by 
using a piece of tape to cover the extra 
notch (or to further confuse the issue, 
you can use a write-protect sticker, as 
used on those archaic 5.25-inch floppies). 

Also, AFE displays hidden files, such as 
the desktop, and seemingly transfers 
them to an MS-DOS disk. However, the 
only thing that gets transferred is an 
empty file that is hidden on the MS-DOS 
side (i.e., the file's contents are not trans­
ferred, but a hidden file is created). If you 
make a habit of hiding your data files 
under a security program, you'd best un­
hide them before trying to transfer them 
to an MS-DOS disk. 

APPLE INSTALLER 
Reducing Disk Swapping 
When using Apple's Installer under 
MultiFinder to create startup disks, you 
normally have to put up with a lot of 
disk swapping- especially if you're 
working from a hard disk and your sys­
tem has only one floppy drive. You can 
reduce the number of disk swaps by 
increasing the amount of memory allo­
cated to the Installer program, so that 
each of the four System disks needs to be 
inserted only once to obtain the neces­
sary information. Here's what to do: 

Select the Installer icon, and choose Get 
Info from the File menu (or press 
Command-I). Increase the amount of 
memory allocated to the Installer in the 
Application Memory Size box. Give the 

Installer at least 1 megabyte of RAM to 
work with. 

Using the same method, you can increase 
the amount of memory allocated to 
Font/DA Mover. This will reduce the 
number of system crashes when you're 
copying or deleting large Font or DA files. 

CLIPBOARD 
Creating A Macro To Edit 
Clipboard Items 
One shortcoming of the Mac's Clipboard 
is that you can't add to it or edit it. But 
you can create a set of macros that allevi­
ate the problem by turning an ordinary 
untitled window into a quasi-Clipboard. 

First, create a macro (using any macro 
program) to open a new document that 
will be "under" the document you're 
working on: Press Command-N, and go 
back to your original document by choos­
ing it from the Window menu in the 
application you're using. Because both 
this and the macro that follows depend 
on mouse position, make sure your unti­
tled document is below the original one 
on the Window menu. (Unless the 
filename begins with a letter that comes 
afterT, just leaving the Untitled name is 
OK.) This untitled hidden window is 
your new Clipboard. 

Next, create a macro that copies text from 
the original document: Press Command 
C, select Untitled from the Window 
menu, then press Command-V, and 
finally select the document you are work­
ing on from the Window menu. You can 
create a separate macro that cuts from the 
original, by substituting Command-X 
for Command-C in the sequence. 
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The Copy macro, which you can call 
Library Paste, is especially handy for 
selecting items from a long general list 
(such as a large bibliography) for inclu­
sion on a specialized list. The Cut macro, 
which you can call Gather, is useful for 
collecting and moving material in a doc­
ument. As a companion to the Gather 
macro, you might want to create a fourth 
macro, Spill, that places the newly assem­
bled information in your document at the 
desired insertion point and empties the 
fake Clipboard. Before beginning to 
record the macro, dick on the insertion 
point and select Untitled from the 
Window menu, press the command that 
selects all in the application, press 
Command-X, select your original docu­
ment, and press Command-V. 

COLOR 
Color Windows On A Mac 
Kolar, a free cdev written by Russ 
Wetmore, allows you to change the 
default colors associated with buttons, 
scroll bars, windows, menus, and high­
lighting . Kolor isn't available directly 
from Russ, but it should be easy to find 
on your favorite on-line service or from a 
user group. 

If you're into spending money, you can 
buy Preferred Publishers' Personality. In 
addition to colorizing the desktop, it 
gives buttons and scroll bars 3-D shad­
ing, rainbowizes the pointer, and other 
stuff. Many of Personality's features 
duplicate shareware INITs that are avail­
able, but it's still convenient to have 
them all in one package. 
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Cycling 24-Bit Color On And Off 
A good rule for using 24-bit-color in 
your system is: Don't use it all the time. 
For example, when you have 24-bit 
color active, whatever program you're 
using may develop the annoying habit 
of flashing as you scroll or as the screen , 
redraws. Turn off 24-bit color off while , 
working with programs that aren't 
dependent on color, such as word pro­
cessors or spreadsheets. As a side 
benefit, you get faster scrolling and 
graphics drawing. 

How do you turn 24-bit color off? If 
you think the only way is to pull down 
the Apple menu, choose the Control 
Panel, and go to the Monitors cdev, 
you're wrong. Fortunately, there's a 
much easier method. The second rule 
for using a 24-bit color-system (indeed, 
any color system) is: get a copy of 
Switch-A-Roo. Similar utilities are 
available-Screen Flipper, for example. 

Switch-A-Roo is simple, and it's free 
(you can get it from Zmac and other 
freeware sources). Switch-A-Roo is an 
fKey that lets you configure Command­
Shift as 9 and toggle between two video 
parameters, and set the toggle between 
24-bit and 8-bit color. Switching to the 
lower color resolution results in faster 
screen updates (and gets rid of those 
annoying screen flashes). Then when 
you're manipulating color or touching 
up color transitions in a graphic with 
Adobe Photoshop, for example, I turn 
on 24-bit color. 



CONTROL PANEL 
Controlling The Happy Mac At 
Startup 

If you use a Mac with more than one mon­
itor, here is a way to select which monitor 
you want to use as the main one for the 
Welcome to Macintosh dialog box or a 
Startup screen. Choose Monitors from the 
Control Panel, and hold down the Option 
key. When the Happy Mac appears, drag 
it to your main monitor and reboot. 

DAHANDLER 

Disabllng TheDA Handler Under 
System6 
It can take a long time to access DAs 
under MultiFinder and System 6, because 
you have to wait for the DA Handler to 
start up. You can disable the DA 
Handler by holding down the Option 
key when you select the DA (if you use 
Suitcase II, pull down the Apple menu 
before you press the Option key, or you 
won't see your DAs listed). TheDA 
opens faster because it opens in the cur­
rent application's allotted memory space, 
just as it would under the Finder, rather 
than in the DA memory block that 
MultiFinder assigns. This is particularly 
useful for the Control Panel and the 
Chooser DAs, which are slow to start 
anyway. 

You should use this technique only if you 
intend to close the DA immediately after 
using it; otherwise, it may cause memory 
problems for the active application. If 
you like to keep the Scrapbook open 

while you work on other things, for 
example, you should probably select it 
without the Option key so that it has its 
own memory space under MultiFinder. 

DESKTOP MANAGER 

Substituting The Desktop 
Manager For The Finder Under 
System6 
The Finder uses the Mac's Resource 
Manager, which was designed to work 
with 400Kbyte floppies, to maintain 
the Desktop file. So it is not efficient 
when you begin to build up 1000 files 
or more; it is especially noticeable 
when copying and moving files takes a 
long time. The Desktop Manager is a 
Finder enhancement which speeds up 
the Desktop maintenance over a net­
work. It is included with the 
AppleShare server disk, and used auto­
matically if present in System 6.0 and 
later. To reduce the amount of time the 
Finder spends maintaining the 
Desktop, put the Desktop Manager file 
in the System Folder and reboot. Your 
single Desktop file will be replaced 
with two invisible files, Desktop DB 
and Desktop DF. 

DIALOG BOX 
SHORTCUTS 
Switching Drives In The Dialog 
Boxes In System 6 
When presented with a Save or Open dia­
log box in System 6, pressing the Tab key 
is a short cut to clicking on the Drive but­
ton. It selects the next available disk drive. 
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DIRECTORY DIALOG 
BOX 
Three Ways To Search The 
Directory Dialog Box 
You have just selected Open from the File 
menu to find yourself staring at a folder 
with multitudes of files. How can you 
speed up your search for a file that's in the 
middle or toward the bottom of the list? 

1. Scrolling or using the arrow keys lets 
you see every file in a folder, but these are 
also the slowest ways to search the directo­
ry dialog box. 

2. No matter how you have your view set 
in the Finder windows, the directory dia­
log box always lists files in alphabeticaU 
numerical order. Typing the beginning 
letter (or number) of the filename takes 
you right to the file or to a range close to it. 
If the file is near the bottom, try typing Z. 

3. Typing the tilde( ..... ) key takes you to 
the very bottom of the list. 

These techniques also work on windows 
in ResEdit, Symantec Tools, DiskTop, and 
Disk Tools II, but they don't work with all 
file editors. You might find other 
instances in which these work. 

Press On The Drive Name 
If you want to go upwards in the hierarchy 
of a drive while in a dialog box, click on 
the name of the drive. 

DOS EMULATION 
R~DOSPro~OnA 
The Old MaeSE 
To run DOS programs on an old Mac SE, 
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you can use a program called SoftPC, from 
Insignia Solutions. You have to upgrade 
to at least 2.5 megabytes ofRAM to run 
it, but going to 4 megabytes is recom­
mended for the best results. That solves 
only half of your problem, though, 
because the old SE doesn't have the DOS­
reading SuperDrive that's standard equipi 
menton all newer Macs. The old Mac SE 1 

lacks the SWIM chip that would enable it 
to use Apple's cheap external SuperDrive. 
However, you can get a 3.5-inch and/or 
5.25-inch SCSI floppy drive called the 
DaynaFile from Dayna Communications 
that will work just fine. 

SoltPC Or Mac286, 386? 
Since it uses a real80286 or 80386 pro­
cessor, Anaheim, Calif.-based Orange 
Micro Inc.'s Mac286 NuB us card is faster

1 

than Sunnyvale, Calif.-based Insignia 
Solutions Inc.'s SoftPC, which is a soft­
ware emulation of a processor. Typically, 
the Mac286 will be four to five times as 
fast in raw CPU throughput. Depending 
on the case, Soft PC can deliver close to the 
same performance as the Mac286, and it's 
a lot cheaper. 

EASY ACCESS 
Using Easy Access 
Easy Access is a startup utility which 
comes with recent versions of System 
software for those who can't use a mouse. 
Easy Access turns the numeric keypad 
into a substitute mouse. Put Easy Access 
into your System Folder and restart your 
Mac.Command-Shift-Clearinvokesthe 
Easy Access-mode mouse keys. The 5 key 
performs the mouse-button functions 
(clicks and double-clicks), and the other 



numeral keys from 1 through 9 move the 
mouse. The 0 key locks the mouse but­
ton down, and the period key unlocks it. 
This is documented in the New Features 
Update bundled with System 6 or later. 

Sticky Fingers Feature Of Easy 
Access 

Sticky Keys is a feature of Easy Access that 
allows single-finger operation of the key­
board. 

To turn the Sticky Keys feature on, press 
the Shift key five times in a row. Be careful 
not to move the mouse at all while press­
ing Shift, or you'll have to start all over. 

A Frozen Screen May Really Be 
Easy Access 
Here is a simple tip for those who often 
use cursor keys in Easy Access. If your 
screen freezes and it appears that your Mac 
has bombed, always try pressing the peri­
od key on the numeric keypad. You may 
have accidentally hit the keypad 0 key, 
causing the mouse to stay clicked and cre­
ating the illusion of a System error. 

With Sticky Keys turned on, the 
"modifier" keys (such as Shift) can be 
pressed before the key they modify, 
rather than at the same time. Pressing 
the modifier key once modifies the next 
keystroke only; pressing it twice locks it 
on until it is turned off by being pressed 
again. Multiple-modifier key sequences 
(like Shift-Option) can be executed using 
Sticky Keys. An indicator in the menu 
bar shows you which modifier key is active. 

With Sticky Keys turned on, you type as 
usual until you want to type a multiple­
character keystroke. Instead of pressing 
the keys together, you can now press one 
of the modifier keys, and the icon in the 

menu changes to a down arrow indicating 
that the last key you typed is still pressed. 

The other half of Easy Access, Mouse Keys, 
uses the numerical keypad for mouse 
movements by pressing the keystroke 
combination Command-Shift-Clear. 

Using Easy Access For Fine 
Tuning Graphics 
Easy Access was meant primarily to aid 
physically impaired Mac users who have 
trouble using the keyboard and the 
mouse. But any user can profitably use the 
utility from time to time. For example, 
using the Mouse Keys function of Easy 
Access, you can easily implement a 
"nudge" command, which moves a 
selected object one pixel at a time in any 
direction. Such a command exists in 
SuperPaint and Cricket Draw but is sadly 
lacking in many other draw programs­
like FreeHand. Here are the steps: 

1. Make sure Easy Access is in the System 
folder when you start (or restart) your 
computer. You have to be using System 
4.1 or later. 

2. Open your draw program and position 
the pointer over the item you want to 
nudge. Click the item to select it. 

3. Press Command-Shift-Clear to tum 

Mouse Keys on. With Mouse Keys on, the 
numeric keypad operates as a mouse sub­
stitute. 

4. Press the keypad's 0 key to lock the 
mouse button down. (This is an electronic 
locking, not a physical one.) 

5. Tap any of the keys surrounding the 5 
key to move the selected item exactly one 
pixel in the direction specified by the 
position of the key. For example, the 2 key 
moves the item straight down, the 8 key 
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moves it up, and the 6 key moves it to the 
right. 

6. When you've nudged the object into 
place, press the keypad period key to 
unlock the mouse button. 

You can leave Mouse Keys on as long as 
you don't need to use the keypad for regu­
lar input (the Enter key is unaffected by 
Mouse Keys, however). To turn Mouse 
Keys off, press Clear on the keypad. 

Mouse Keys can be incredibly useful for 
very fine mouse movement- and it's lots 
of fun once you get used to it. 

FIND FEATURE 
Take Your Time When Using 
System 7's Find; Extra RAM Won't 
Hurt 

Everybody's happy about System Ts 
built-in Find feature, but the "all at once" 
check box is a memory hog. If you have 
applications using up most of your avail­
able memory, the all-at-once option may 
not be able to display all the found items. 
In such cases, the Finder alerts you to the 
fact and suggests you choose the Find 
Again command to see more. 

But Find Again doesn't let you perform 
multiple, narrowing searches, which is 
one of the Find feature's neater tricks. 
Normally after choosing the all-at-once 
option, you can perform subsequent 
searches on the selected items. If Find 
can't select all items at once, you can't do 
an accurate follow-up search. The solution 
is to quit some applications and free up 
more memory for Find. Be warned: If your 
search nets more than a couple hundred 
items, the results can take a minute or 
more to display. 
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FINDER 
Easy Editing ofFllenames 
There's a quick and easy method for 
adding prefixes or suffixes to a filename 
without carefully placing the insertion 
point. Select the file/folder you want to 
modify by clicking on it once. Press the 
left arrow key, and when the blinking 
insertion point precedes the filename, 
type your prefix. Press the right arrow key 
to deposit the blinking insertion point at 
the end of the filename, and then type in 
your suffix. 

If you press the arrow keys and no inser­
tion point is deposited, the file is locked. 
If that's the case, make sure the file is 
selected and choose Get Info from the File 
menu (or press Command-!), click on the 
Locked check box, and close the Get Info 
window. The tip will now work. 

An Inherent Organization Tool 
This tip provides a quick and easy To-Do 
List function for the Finder. There are 
other list generators, outliners, and orga­
nizers- both applications and DAs -but 
in most cases you have to open the pro­
gram or the DA to look at your list. 
Although a program such as Smart 
Alarms solves that problem for a certain 
price- in money, INIT conflicts, and 
memory- here's a free and easy way to 
keep organized lists on your desktop. 

Press Command-N to get a new folder. 
Then, in 31 characters or fewer, enter a 
brief description of your memo. Do this 
for each item on your list. Drag these 
folders onto the desktop, where they're 
constantly under your nose as a reminder 
of some important activity or event. 



Or you can neatly arrange these folders 
inside other folders appropriately entitled 
To Do Today, Letters, Appointments, 
and so on. You can easily create, trash, 
rearrange, and modify these folders as 
needed. They're also useful as repositories 
of further information on a particular 
project. 

Ejecting Disks 
There are keyboard shortcuts to eject 
disks from disk drives using the 
Command-Shift keys. 

Command-Shift-1 ejects a disk from 
the first drive; 

Command-Shift-2 ejects a disk from 
the second drive; 

Command-Shift-0 ejects a disk from a 
third drive. 

To just eject a selected drive, press 
Command-E. 

Ejecting Floppy Disks Without 
Ghosting 
When you eject a selected floppy disk 
using the keyboard shortcut Command-E, 
a ghosted image of the floppy remains on 
the desktop and your Mac can demand 
that you insert the floppy when you 
least want to. To keep that from happen­
ing under System 6.0x, press Option­
Command-E or hold down the Option 
key when you select Eject from the File 
menu when you want to eject a disk. 
Under System 7 press Command-Y 

You can use the Option key for the same 
purpose when you click on the Eject but­
ton in the standard Open dialog box; 
Option-click on that button to ensure 
that the Mac doesn't pester you again for 
that floppy during your work session. 

Printing From The Finder 
To print a document directly from the 
Finder without opening it, select the doc­
ument and use the Print command on the 
Finder's File menu. The Finder will run 
whatever application created the file and 
print it out. This is really useful if you 
have a whole folder full of documents you 
want to print. If you select them all and 
print from the Finder, many applications, 
such as Word, will show you only one 
Print dialog box and then print the docu­
ments in succession. 

The requirement is that you must have a 
copy of the correct application on a 
mounted disk, of course, or you get the 
dreaded "the application is busy or miss­
ing ... " error message. You can't select two 
files from different applications- this 
works with only one application at a time. 
Many applications, such a Word, won't let 
you print from the Finder if the applica­
tion is already open. 

Use Special Characters To 
Arrange Flles 
Add special characters to the beginning of 
filenames to force grouping in the Apple 
menu (or in list views). For example, plac­
ing an exclamation point(!) in front of 
application names groups them at the top 
of the Apple menu, and adding the grave 
accent(') character to folder names moves 
them to the bottom. You can also start a 
filename with a space. 

Rebuilding The Desktop Of 
A Disk 
Holding down the Option and Command 
keys when the Finder launches rebuilds a 
disk's desktop. Rebuilding the desktop 
speeds up the process of launching appli­
cations. Be aware that you will loose any 
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comments in the Get Info box of all docu­
ments and applications when you rebuild 
the desktop. 

Keep Folders Small 
The more items there are in a folder, the 
longer it takes to open it, so you want to 
keep folders small. On the other hand, 
when folders contain fewer items, folder 
nesting becomes deeper. You'll want to 
find a balance between too many items 
in a folder and too many levels of nested 
folders. Some programs locate files by 
using their full pathname. This includes 
the name of the volume the file is in and 
every folder name, in order, on the path 
to the file, with each name separated 
from the next by a colon(:). For example, 
the full pathname to WriteNow 2.0 in 
the hierarchical organization might 
be like this- Hard Disk: Applications: 
Word Processing: WriteNow: WriteNow 
2. 0. As you can see, the deeper folders are 
nested, the longer the pathnames get. 
Most programs can't handle full path­
names longer than 25 5 characters. This 
255 character limit is also a reason not to 
make file or folder names too long. 

Why Isn't My Memory Freed 
When I Quit? 

Sometimes, when you quit a program, it 
seems as if the memory it was using isn't 
freed- at least according to the About 
the Finder window. Why? 

Actually, the memory's really there. If you 
look at About the Finder under the Apple 
menu you will see that the second number 
isn't Total Memory Available; it's Largest 
Unused Block. 

When you run a program under 
MultiFinder (or System 7's Finder), the 
program is run as high up in memory as 
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it can. When you run another program, it 
loads under the first program. When you 
quit the first program, its memory is 
available, but the size of the largest 
unused block of memory might not 
change, since the second program is 
sitting there with free memory both 
above and below it. MultiFinder can't ! 

move running programs, so your memor.y 
remains fragmented until you quit the 
second program or reboot. 

In this situation, the amount of memory 
available could be as much as twice the 
memory shown as the Largest Unused 
Block. But no more than the amount indi­
cated could be used by any one program. If 
a program crashes under MultiFinder, it 
may leave parts of memory allocated even 
though it's not running any more, which 
results in even more fragmentation. 

RAM Caching 

When you activate RAM caching in the 
General section of the Control Panel DA 
(or in the memory control Panel in System 
7), remember to reboot the machine. Only 
then will the RAM cache activate. The 
same applies to turning the RAM cache off. 

Changing Close In The Flle Menu 
In the Finder, holding down the Option 
key while pulling down the File menu 
changes the Close menu item to Close All. 

Clicking And Dragging Flles And 
Folders 
When a folder is shown by name, date, or 
kind, many users feel compelled to dou­
ble-click or drag a file by the itsy-bitsy 
icon on the far left. Even though this 
works just fine, it's unnecessarily precise 
and can slow you up. You can, in fact, 
click or drag a file anywhere in the row 



(including the white space after the 
name). If you,re double-clicking, howev­
er, avoid the name column because two 
clicks there makes the name editable and 
puts an insertion point where you clicked. 

Organizing Applications 
If you regularly use many applications and 
want to keep them all handy, the usual 
solution is to group all of them in a single 
folder on your hard disk. Unfortunately, 
many applications require that you keep 
several utilities and sample files in the 
same folder as the application, which 
makes spotting the application itself 
difficult. You can remedy this problem by 
hiding these utilities outside the visible 
window or by burying them in folders 
within the application folder, but there is 
a better way: 

Create an empty document in each of the 
applications you use regularly and keep it 
in a folder separate from the application. 
When using one of these blank docu­
ments to create a new file, choose Save As 
to save the new file and to preserve your 
template. Lock the empty document 
(using Get Info); this will prevent you 
from making any changes to it. 

These blank pages take up little memory 
and can be customized to your particular 
needs and serve as style sheets. 

Organizing Icons Alphabetically 
Here,s a quick way to alphabetize a 
column of icons: 

Select them, drag them to a new folder, set 
that folder to View by Name, then reselect 
all the files and drag them back to the 
original folder. And don,t forget that you 
can make a column look tidy by dragging 

a selection rectangle around it and then 
choosing Clean Up Selection from the 
Special menu. 

Neatness Counts 
It's worth the effort to arrange your 
desktop neatly- and to keep it that way. 
You can size and place windows so that 
as you open nested folders, the display is 
compact and all the windows are visible. 
You can also drag a folder to the desktop 
and keep it there over the span of your 
project, making it easily accessible. 
Later, you can select the folder and use 
the Put Away command in the File 
menu to return it to its home location. 

Tab Stop Assignments In The 
Finder 
You can save a considerable amount of 
horizontal space by resetting the gener­
ous tab stops Apple assigns in the Finder. 

To do so, run ResEdit and open the 
Finder on the disk you want to change 
(do this on a copy of the Finder other 
than the one you are currently run­
ning), open LAYO, open LAYO=ID 
128, scroll down to the Tab-stop labels, 
and substitute the following values: 

Tab stop 120 
Tab stop 2114 
Tab stop 3 154 
Tab stop 4 208 
Tab stop 5 304 
Tab stop 6 352 
Tab stop 7 384 

You can change these values to suit your 
preferences. These values save the most 
space without obscuring too much of the 
column,s contents. 
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Opening Applications Easlly 
The mouse button on the Mac is 

"buffered, so when you need to open an 
application directly on one of your hard 
disks, just make sure that all the images 
of the folders and the application's icon 
are aligned. Lees say that you have a 
folder on your desktop called "Word 
Programs;· inside of which are several 
folders containing various word proces­
sors and associated files. Odds are that 
there is one application you'll use more 
than the others, such as Word 3.01, that 
is in a folder by the same name. Click 
open the Word Programs folder, and 
align the newly opened window so that 
the Word 3.01 folder is directly over the 
outline of the Word Programs folder 
(this might take a few tries). Once they 
are aligned, open up the folder called 
Word 3.01 and align the application 
Word 3.01 in that window with the pre­
vious windows. 

Now when you want to open your most 
used word-processing application, all 
you have to do is place the arrow cursor 
in the middle of the Word Programs 
folder and click six times to open the 
two folders and launch the application. 
No more moving the mouse each time a 
folder window is opened to get the next 
folder to open. And this trick still allows 
you to keep a neat desktop with every­
thing in its correct folder. 

Moving Windows Without 
Activating Them 
When you hold down the Command key 
and click in the title bar of an inactive 
window, you can move that window on 
the desktop without activating it and 
bringing it to the front. 
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Oeaning Up Windows In The 
Finder 
Want to neaten the appearance of the 
application and document icons inhabit­
ing windows in the Finder? Open the win­
dow you want to tidy up. Go to the View 
menu and set it so that the window is 
showing your applications and documents 
by Name and not Icon or Small Icon. Use 
the Select All command under the Edit 
menu. Drag everything out onto the 
Desktop and wait a second or two while 
the Finder catches up with you. Go back to 
the View menu and reselect By Icon or By 
Small Icon- whichever you prefer. Then 
go to the File menu and select Put Away. 
Your applications and documents will 
begin quickly arranging themselves in the 
window in alphabetical order. 

Drag-selecting In Ust View 
When viewing a folderful of files by icon, 
you can click and drag to create a selection 
rectangle that scoops up a bunch of icons 
all at once. When using any of the text-list 
views (name, date, size, kind or color), it 
appears that you can't use this shortcut -
butyoucan. 

Expand the window to fill a standard 9-inch 
screen or larger (you can click on the win­
dow's zoom box). Next, click in the space to 
the left of the vertical scroll bar. You can 
then drag a rectangle over to the left edge of 
the window and select as many files as you 
can see. It sure beats shift-clicking. 

Speed Up Folder Copying 
If you Mac takes too long to copy a folder 
full of small files from a floppy disk to 
your hard disk, open the folder first, use 
the Select All command, and drag all the : 
files to the hard disk. This technique cuts 
the copying time by up to 85 percent. 



Preventing Pirating Of 
Applications From Your Hard 
Disk or Network 
Here's a way to stop people from pirat­
ing applications from a hard disk or a 
network: 

First, create a blank document with the 
application you want to protect and give 
it a name similar to that of the applica­
tion (such as "Word 4" for Microsoft 
Word4.0). 

Next, use ResEdit to make the program 
invisible (highlight the application 
name, choose Get Info from ResEdit's 
File menu, and click on the Invisible 
box). Quit ResEdit and restart. 

Copying Disks From The Finder 
When using the Finder to copy a disk, 
you can avoid typing the new disk name. 
Simply click on the icon of the original 
disk and select Copy from the Edit menu 
(Command-C), then click on the icon of 
the disk. 

Virus Protection 
Here's a very simple and effective way to 
protect programs on your hard disk from 
virus infection. 

While in the Finder, do a Get Info on each 
of the programs on your disk and click in 
the Locked box at the upper-right corner 
of the window. This usually protects the 
selected file from accidental deletion, but 
it also guards it against virus contamina­
tion, since it prevents new resources from 
being written to the application. Don't 
forget to protect mini-applications like 
Font/DA Handler. 

Quick Disk Erase 

The quickest and easiest way to erase a 

disk is to copy a blank disk over it. To do 
this, just insert a blank, formatted disk in 
a drive and drag its icon onto that of the 
disk you want to erase. You'll usually save 
a minute or so over using the Special 
menu's Erase Disk command. 

Preventing Switch-Launching 
Pressing the Option key while launching 
an application from a floppy disk 
equipped with its own System Folder 
prevents switch-launching- that is, you 
can continue operating under the 
current System (as opposed to the 
floppy's System). 

Note that System 5. 0 (and later version) 
won't let you switch-launch from a hard­
disk drive unless you hold down the 
Option key. 

Activating A New System Folder 
To bless or select a new active System 
Folder, hold down the Option and Com­
mand keys while double-clicking on the 
Finder icon in the desired System Folder. 

Closing All Open Windows With 
The Close Box 
In the Finder, holding down the Option 
key while clicking on a window's close 
box closes all open windows. 

Closing All Windows After 
Quitting An Application 
After you quit an application, holding 
down the Option key closes all windows 
that were left open on the desktop before 
returning to the Finder. 

Problems Trashing Flles 
If a file won't budge, like when you try to 
move it or to send it to the Great Trash 
Icon in the Corner, and the following alert 
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comes up: "Cannot be duplicated or 
moved," you may have a locked or pro­
tected file. 

In this instance, the file's attribute File 
Protected or File Busy flag has been 
checked. (File Protected means that the 
file cannot be copied or deleted; File Busy 
means it's currently being used by some 
application, such as MultiFinder or 
AppleShare.) To change a file's attributes, 
you need a program such as SUM, 
DiskTop, or ResEdit 2.0. 

If the File Protected or the File Busy flag 
is set, try turning it off (after you've made 
a note of which attributes were turned on 
before you started making changes). A 
document generally has just its Inited flag 
set; an application usually has its Inited 
and its Bundle bits set. Use a little caution 
at first- maybe another application really 
is using that file, and trashing it could 
ruin your whole day. For safety's sake, turn 
offMultiFinder and remove the Mac from 
any file-sharing networks. 

Ideally, file attributes should be modified 
only by the System, the Finder, and other 
programs that know what they're doing. 

Still can't trash the file? Maybe there's 
an INIT that's struggling to keep the file 
open, such as Suitcase II or a networking 
INIT. Disable all your INITs, and try 
again. 

Changing The Application 
Memory Size 
When in the Finder, if you highlight a file 
and choose Get Info from the File menu, a 
window about the file appears. 

On the bottom of the window are the 
Suggested Memory Size and the 
Application Memory Size. 
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How much memory- minimum- does a 
program need to run under MultiFinder? 
The answer is more complicated than it 
might appear. What you see in Suggested 
Memory Size is what the publisher offi­
cially says is the minimum memory 
required to run the application under 
MultiFinder. You can always assign a pro~ 
gram a greater slice of the RAM pie, but ~ 
you should not try to run it with less 
memory than is listed here. 

Application Memory Size, a user­
modifiable field, lets you change the 
amount of memory assigned to a program 
while it is running under MultiFinder. 
When you launch a program under 
MultiFinder, it claims a certain amount of 
RAM real estate as its own. 

There is no correct answer to the question 
of how much memory an application 
needs. It depends on how much RAM you 
have to divvy up, what other applications 
you will be using at the same time, and 
what demands you will be placing on the 
application while you are using it. The 
best strategy is trial and error: start out 
with the recommended amount (which 
should be the default setting anyway). If 
you find you are running out of memory 
at critical moments, start increasing the 
amount of memory by small increments 
until your problems cease or you run out 
of memory and have to buy more, 
whichever comes first. 

Many people forget that the Finder itself is 
an application and that it can be assigned 
an amount of memory to be used under 
MultiFinder. The default is 160K, but in 
some situation- when you are using a 
large hard disk or a CD-ROM disc, for 
example- you might find yourself run­
ning out ofFinder memory. Increasing the 



Finder memory to 256K not only solves 
that problem but also improves file-copy­
ing performance in general. 

Keeping Get Info Comments 
Using ResEdit 
It is a good idea to rebuild the desktop 
occasionally by holding down the 
Command and Option keys when turn­
ing on your Mac. The only drawback is 
that rebuilding your desktop deletes the 
Get Info comments permanently. (To see 
the Get Info window, select a file and 
choose Get Info from the File menu 
while in the Finder.) 

Disk Top (CE Software) has a feature 
called CD Comments that lets you 
rebuild your desktop without losing the 
Get Info comments. 

Here is a way around the problem for any­
one who is comfortable with ResEdit or 
some other resource editor: 

1. Start Apple File Exchange or any other 
program that lets you see and copy invisi­
ble files. 

2. Make a copy of the file called Desktop, 
giving it a different name if the applica­
tion you are using allows you to. If it does 
not, save the copy to a different folder so 
that you will not overwrite the original 
Desktop file. With Apple File Exchange, 
choose Rename Destination Files from the 
File menu to change the name. 

3. Rebuild the desktop by holding down 
the Option and Command keys while 
your Mac is starting. Just before your hard 
disk is mounted, you will get a confirma­
tion dialog box asking whether you want 
to rebuild the desktop. Click on OK. 

4. Once the desktop has been rebuilt, 
open ResEdit and open the copy of the 

Desktop file that you made in Step 2. Find 
the FCMT resource in the list of resources. 
This resource contains the Get Info infor­
mation that was erased when the desktop 
was rebuilt. Select and copy it. 

5. While still in ResEdit, open the rebuilt 
Desktop file and paste the FCMT resource 
into it. Now select the copy you made of 
the Desktop file and choose Clear from the 
Edit menu. 

6. Quit ResEdit, and answer Yes to "Save 
'Desktop' before closing?" Your Get Info 
boxes will now have their comments 
restored. 

RNDER6 
Vivid Color Icons 
If you have a color Mac, you can change 
the way colors are used with icons and 
change the colors displayed on the Color 
menu using an application called Layout. 
Layout is a free but copyrighted resource­
editing tool by Michael O'Connor that is 
available on CompuServe and other on­
line services. 

Open Layout and select Color Style from 
the Options menu. This will bring up 
two radio buttons labeled Normal Color 
Style and Alternate Color Style. Click on 
the latter for more vivid icons. You'll also 
see eight color bars like the bars on the 
Finder's Color menu. Click on any color 
and use the Color Picker to change its 
value. Quit, saving your changes (you 
can reestablish the old colors later by 
choosing the default). 

A Pre-Trash Folder 
For those who worry about throwing files 
in the trash and then later regretting the 
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decision, just create a new folder on your 
startup disk called "Pre-Trash", "Today's 
Garbage", or the like and place it above or 
next to the true trash on the desktop. You 
could even place it so that it mostly covers 
the icon. Then, instead of throwing files 
directly into the trash, put them first into 
the pre-folder. At the end of every session, 
you can calmly sort through the files 
placed in this folder and render judgment 
on them- no more accidental trashing of 
vital documents. 

Locldng A Flle 
When in the Finder, if you highlight a file 
and choose Get Info from the File menu, a 
window about the file appears. 

The Locked box in the top right comer is, 
by default, unchecked. If you click on it, 
an x appears and the file is locked. If you 
click on it again, the x disappears and the 
file is unlocked. Folders cannot be locked. 

If a file is locked, you cannot delete the 
file (or any folders containing it) by the 
usual method of dragging it to the Trash 
(unless you manually override by holding 
down the Option key). 

Most applications let you change the 
locked file in memory, but you won't be 
able to save the changes to disk unless you 
create a new file with a new name. This 
feature is handy for protecting template 
files from accidental changes. 

Some applications- notably HyperCard­
will not let you make any changes at all to 
a locked file. The file becomes "read only." 

The security provided by locking a file is 
very low-level- basically it only protects 
you from your own mistakes. 
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Rebullding The Desktop Without 
Rebooting 
Holding down the Command and 
Option keys when you quit an applica­
tion produces the same dialog box and 
desktop-rebuilding procedure as holding 
down these keys when you restart your 
computer. The net effect- rebuilding the 
desktop- is exactly the same. 

By the way, this technique works under 
the Finder only. If you're using MultiFinder, 
holding down the Command and Option 
keys when you quit an application does 
nothing. In this case, you have to rebuild 
your desktop by restarting your Mac. 

HidingFlles 
There are several programs for the Mac 
that can "hide" the existence of a file so 
that it doesn't appear in the directory 
window but also can't be overwritten. 
Any program that allows you to edit a 
file's attributes (such as CE Software's 
DiskTop, Apple Computer's ResEdit 
or Symantec's SUM II) can do this. All 
you have to do is turn on the Locked and 
Invisible attributes. To use the file, 
just reverse the process- use the same 
program to turn the Locked and Invisibl~ 
attributes off. 

System Heap 
When you access About the Finder under 
the Apple Menu while in the Finder, you 
will see a System gray bar indicating the 
amount of memory allocated to the 
System heap being used. The System heap 
is where all your fonts, DAs, INITs, cdevs, 
and Chooser devices reside. Under System 
6.0x and before, if you don't have enough 
memory allocated to the System heap, ' 
your Mac will slow down or even crash. 
You won't do any damage by making your 



System heap too large, although applica­
tions can't use the memory you assign to 
the heap. 

If you don't add a lot of fonts, DAs, cdevs, 
or !NITs to your system, the System 
heap's default setting is fine. However, if 
you've added lots of these goodies, you'll 
probably need to increase the System 
heap. How do you know whether or not 
you need to do this? A good rule of thumb 
is that if the System bar in the About the 
Finder bar graph is more than 7 5 percent 
dark gray, your System heap probably 
needs expanding. 

Apple doesn't provide a tool for expand­
ing the heap, nor does it adequately 
explain how to expand it anywhere in the 
Mac's manuals. Luckily for us, however, 
there are a lot of tools that let you expand 
your System heap. Among the low-cost 
options are Boatman (freeware), Heap Tool 
(shareware) and HeapFixer, which CE 
Software includes with some of its 
products. Bootman includes excellent 
on-line help that explains all the sub­
tleties of the System heap. As far as com­
mercial products go, INIT Manager 
(Baseline Publishing) and Startup 
Manager (included in Now Software's 
Now Utilities) handle heap expansion 
elegantly and also provide sophisticated 
mechanisms for managing !NITs. 

Canceling The Ghosted Icon 
Response 
People in multiuser environments some­
times eject floppy disks with Command-E 
or through a dialog box but forget to drag 
the ghosted icons of those disks into the 
Trash when they have finished. New users 
come along and eventually get asked for a 
disk they do not have. 

When the Mac demands a disk you do not 
have, one way to continue working is to 
press Command-period (a reserved key 
combination that stops operations before 
they complete). Most of the time, this will 
eliminate the computer's "Please insert 
the disk" message, letting you continue 
working in peace. 

FINDER 7 

Adding Keyboard Commands 
With ResEdit 

Several of the commands in System Ts 
Finder lack keyboard command equiva­
lents. Some obvious ones spring to mind­
Command-M for Make Alias and 
Command-P for Page Setup. You can 
easily add these keyboard shortcuts to 
the Finder's Edit menu with ResEdit. 
(ResEdit can be obtained from on-line 
services and local user groups.) 

1. Make a copy of the Finder, and work 
only with the copy- editing an active file 
with ResEdit is always a bad idea. Open 
the copy of the Finder in ResEdit. 

2. Locate the fmnu resources (resources are 
listed alphabetically). Double-dick on the 
icon, and then double-dick on ID 1252. 
This brings up a window filled with 
arcane text and numbers. 

3. The far-right column contains some 
familiar strings of text, such as New 
Folder, Close Window, and other Finder 
menu commands. The keyboard com­
mand equivalents for these (and other 
Finder menu items) are stored in the 
third character before the name of each 
item- the N before New Folder and the 
W before Close Window, for example, are 
what determine the keyboard command 
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equivalents for these options. A menu 
item without a keyboard command 
equivalent has only a box in this place. 

4. To change or add a keyboard-com­
mand equivalent, select the appropriate 
character in the far-right column and 
type in uppercase the character you 
want instead. It's important that you 
select only the character you want to 
replace. If you delete the character and 
then replace it, the Finder may reorder 
your menus or behave in other unpre­
dictable ways. 

5. Save the changes, and quit ResEdit. 
To restart with the newly customized 
Finder, move the current Finder out of 
the System Folder, rename the Finder 
copy so it's called Finder, and restart 
your Mac. 

The new keyboard command equivalents 
should appear on the menus once the 
new Finder has loaded. 

Editing Icons On Folders 
There is a way to edit or colorize icons in 
System 7 with nothing more complicated 
that a paint program. Here's how: 

1. Select an icon, and choose Get Info 
from the File menu (Command-I). 

2. In the Get Info window, click on the 
icon once to select it, and copy it. 

3. Open a new document in a paint 
program, and paste the icon into the 
document. 

4. Modify the icon in any way you want, 
and then select it, and copy it. 

5. Return to the icon's Get Info window, 
and paste in the new icon. 
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Desktop Manager Is APart Of 
Finder7 
In Finder 7, Apple finally fixed the nasty 
problems- including delays, freezes, 
crashes and error messages- that had long 
plagued people using many applications 
(or other files with resources) on a single 
disk volume. The new Finder uses the 
same approach as Desktop Manager, soft­
ware Apple developed years ago to elimi­
nate the problem on AppleShare servers. 
The software, which many users with 
large disks had installed on their personal 
systems, bypasses the Resource Manager, 
which was at the heart of the problem. 

Using Desktop Manager on your System 
6 disks avoids the hassle of rebuilding the 
desktop every time you switch between 
the old and new systems, since they can 1 

share the same invisible Desktop DB and 
Desktop DF files. Finder 7 needs to make 
some one-time modifications to the old 
Desktop Manager's files, but thereafter 
you can switch freely between the two sys­
tems, as long as Desktop Manager is 
installed on the System 6 disk. 

If either MultiFinder or Finder 7 rebuilds 
the desktop, any comments entered into 
Info windows are lost, despite Apple's ear­
lier promises to solve this problem in the 
new system. And, whenever you rebuild 
the desktop under System 6, even with 
Desktop Manager installed, it must be 
processed once again the first time you 
restart with Finder 7. 

The Invisible Desktop Flle Is Not 
Needed Under Finder 7 
If you're running both System 6 and 7, 
the invisible file named Desktop (from 
System 6) is not needed with either 



Desktop Manager or Finder 7, so delete it 
if it is not in use. 

Rebuilding The Desktop 
To rebuild the desktop manually in 
System 7, hold down the Command and 
Option keys during the last part of the 
start-up process, just as you do with 
Finder 6. (The option of rebuilding the 
desktop by holding these same keys 
down when quitting an application is 
no longer available). 

Under System 7 there is another, quicker 
way to rebuild the desktop, but it is not 
recommended. System Ts abort key com­
bination- Command-Option-Escape­
will quit from the Finder, letting you hold 
down Command-Option to rebuild the 
desktop immediately as Finder 7 starts 
back up again. 

Using Put Away To Eject Disks 
The File menu's Put Away command 
(Command-Y) ejects and/or dismounts 
disks, removable media, or file-sharing 
volumes. 

Saving Desktop Patterns Under 
Finder7 
If you like to create custom patterns for 
your desktop instead of using the default 
patterns in the General cdev, you now can 
save them by double-clicking on the 
cdev's miniature desktop. No longer will 
your handiwork disappear forever as soon 
as you choose another pattern. 

Color Screen Shots 
Pressing Command-Shift-3 takes a color 
PICT snapshot of your screen, complete 
with a camera- shutter sound effect. (In 
previous Systems, this command produced 
only a black-and-white MacPaint file.) 

Emptying The Trash 
If you don't want a warning message 
every time you empty the Trash, turn off 
the appropriate button in the Get Info 
dialog box. To do this, highlight the 
Trash and choose Get Info from the File 
menu or type Command-I. 

Renaming Flles Faster Under 
Finder7 
Some people are feeling a little disori­
ented since Apple changed the way 
users rename files, folders and whatnot 
in the Finder. Under System 6, you 
simply select an item and type the new 
name, but under System 7, typing 
selects files instead of renaming them. 

If you select an item and wait, howev­
er, System 7 eventually will present 
you with a text-editing box around the 
item's name. The length of the delay is 
determined by the double-dick speed 
set in the Mouse control panel. For the 
really impatient, selecting the item 
and hitting the Return key or moving 
the mouse slightly makse that box 
appear immediately. 

Keyboard Short-Cuts In Finder 
Windows Under System 7 
Under Finder 7, you can navigate within a 
window by using the arrow keys. 
Command- down arrow opens a 
selected file or folder (additionally hold­
ing down the Option key closes the cur­
rent folder); Command-up arrow 
opens the parent folder or volume window 
(adding the Option key closes the current 
folder). The Tab key moves you through 
files alphabetically. Type the first 
characters of a filename to jump to a par­
ticular file. Command-W closes the 
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active window. In list views, press 
Command-Option-right arrow 
to expand the entire outline and 
Command-Option-left arrow 
to collapse it. (More shortcuts are now 
listed on the Finder's Help menu.) 

Sorting Icons In Finder 7 
In System 7, holding down the Option 
key while selecting the Clean Up com­
mand lets you sort file icons. To choose the 
type of sort, select a list view (such as View 
by Date) immediately before selecting 
View by Icon or View by Small Icon. 
Using the View control panel's new 
Staggered Grid and Snap To Grid options 
helps Finder windows stay tidy even 
before cleanup. Holding down the 
Command key as you drag icons toggles 
the Snap To Grid option on and off tem­
porarily. In list views, clicking on a col­
umn title sorts files by that field. 

Background Copying 
In Finder 7, you can copy files in the back­
ground while continuing to work in an 
open application. You can't launch a new 
application while copying is in progress, 
however. 

Opening Documents In Finder 7 
In System 7, you can open a document by 
dragging its icon onto the icon of an 
application, provided that the program 
supports the document's format. This lets 
you open a file in programs other than the 
one that created it (for example, open a 
Mac Write file in Word). 

Locating The Original Flle For An 
Alias In Finder 7 
Need to find the real McCoy? Go to the 
Get Info dialog box for the alias, and click 
on Find Original. The Finder window 
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containing the original file opens and the 
icon is highlighted. · 

Closing/Hiding Windows In 
Finder7 
The Option key brings new flexibility to 
window management in the Finder. 
Holding down the Option key when you 
launch an application closes the window 
containing the application icon. Using it 
as you bring a background application to 
the foreground hides the current applica­
tion. Pressing the Option key and click­
ing on the desktop hides all the open 
application windows. 

FKEYS 

Testing Fkeys With ResEdit 
If you are looking around in a file with 
ResEdit and you see an Fkey resource, or 
you just want to try an Fkey before 
putting it in your System file, you can try 
the Fkey while in ResEdit. The system 
looks through the chain of open files, not 
just the System file, to find Fkeys. Since 
ResEdit has opened the file, when you 
press Command-Shift-N, where N is the 
ID of the Fkey, the Fkey is invoked. The 
most recently opened file is searched first, 
so even if the Fkey you want to try has the 
same ID as an Fkey in your System file, 
the Fkey you want to try is invoked 
instead of the one in the System file. 

GENERAL 
Opening An Older Document 
With The Current AppHcation 
Version 
Open the application first, and then try 



to open your old document with the 
Open command (usually Command-O), 
selecting the document in the standard­
file dialog box. More often than not, the 
application can convert the old format 
and open an untitled copy of the older 
file. Then save it with a new name. 
When you return to the Finder, you will 
find a double-clickable copy of the 
renamed file in the new format. If you 
want to avoid duplicate files, save the 
copy under the old name so that it over­
writes the original file. 

Switching Drives In The Dialog 
Boxes 
When presented with a Save or Open 
dialog box, pressing the Tab key is a 
shortcut to clicking on the Drive button. 
It selects the next available disk drive. 

HDBACKUP 

No Longer Supported Under 
System7 
HD Backup is also no longer being sup­
ported by Apple and is incompatible with 
System 7.x. 

I NITS 

The Scoop On INITs 
An INIT is an initialization resource- a 
System resource that is loaded into the 
part of the Mac's RAM called the System 
heap and runs as part of the normal start­
up procedure. You can buy !NITs com­
mercially or download public-domain 
INITs from a bulletin-board service 
(BBS). !NITs are generally neither menu 
or Command key-driven; they are 
designed to function automatically. 

When !NIT-based utilities first 
appeared, there was no way for the 
average user to install them into the 
System file. Developers invented their 
own installation methods, and some 
neglected to provide a way to remove 
!NITs when they were no longer wanted. 
What users needed was an !NIT equiva­
lent to Apple's Font/DA Mover. 

Responding to this need, Apple released 
INIT 31. It worked at startup, searching 
the System folder for any files of type 
INIT and loading the enabled ones it 
found. So now you can simply drag an 
INIT into the System folder and INIT 31 
would do the rest. 

Because INIT 31 executes only at startup, 
the Mac must be rebooted before a new 
INIT becomes active. To disable an INIT, 
simply remove the file from the System 
folder and reboot. The !NITs that are 
active in your System file will usually dis­
play a small square icon at the bottom of 
the screen during startup. 

With System 7, INITs are "system exten­
sion," and are placed in a folder in the 
System folder, called Extensions. 

Too Many INIT Icons 
At startup, most of the INIT icons appear 
in one long row, but some get lost. To see 
all the INITs you are loading, get a free­
ware INIT called Icon Wrap, written by 
Ken McLeod. Just drop it into your 
System Folder, and reboot. Voila- the 
icons automatically go into two rows. You 
can get Icon Wrap on Zmac and from your 
local user group. 

Trashing Active INITs 
If you attempt to trash an INIT and get a 
message saying the application is locked 
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or busy, it is because the INIT was in the 
System Folder at startup time, and so it is 
activated. Many INITs cannot be removed 
while they're active. 

There are several ways to deactivate them 
and then trash them. 

The easiest is to boot from a floppy disk 
with a System Folder on it and then drag 
the INIT from the System Folder on your 
hard disk to the trash. Another way is to 
use an INIT manager, such as !nitPicker 
or Aask. Turn the INIT off, reboot, and 
then drag it into the trash. Finally, you 
can move the INIT out of your System 
Folder and onto the desktop (or into 
another folder) and restart your 
Macintosh. Because an INIT won't acti­
vate unless it's in your System Folder at 
boot time, you can then trash it without 
any problem. 

Loading INITs At Startup Time 
INITs (or Startup documents) placed in 
your System Folder will normally be 
loaded and active in the System upon 
starting up your Macintosh. When 
starting up your Mac, you can choose 
not to load certain INITs by holding 
down the Shift key until the menu bar 
appears. This is an option that not all 
developers take advantage of, so some 
INITs will work 
and others will not respond to this key 
press. Suitcase and On Cue are two 
INITs which do respond to this action. 

INTERRUPT SWITCH 
A Crash Recovery Trick 
There are two "switches" on all Macs, the 
reset and interrupt switches. One serves 
as a restart switch and the other is pro-
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grammers switch. When you press the 
interrupt key, the machine enters a very 
simple debugger. In it, you can type G 
for Go, SM for Set Memory, and a few 
other commands. 

Programmers who need a real debugger 
for the Mac can use MacsBug, which is 
available from Apple Programmer and 
Developer Association (APDA can be 
reached at 1-800-282-2732; 408-562-
3910 International). MacsBug is a 
complete, full-feature debugger with 
breakpoints, tracing, and so on. 

Here is a trick for using the interrupt 
switch: If you've crashed or the cursor is 
frozen, press the interrupt switch and 
then type G FINDER at the >prompt. 
Leave a space after the G, and type a car­
riage return after the R. If the crash 
wasn't too severe, you'll be returned to 
the Finder, where you can use the Restart 
or Shut Down commands to close things 
up tidily. You'll probably see a message 
telling you that the application you were 
working in has "unexpectedly quit." 
That's OK. Even though you'll probably 
lose any work you've done since your last 
Save, chances are your file won't be dam-
aged. (See also System Errors.) I 

INTERRUPT AND 
RESET SWITCH 
Where Are The Macintosh llsi's 
Switches? 
On most Macintosh computers, the reset 
and interrupt switches are activated by a 
small plastic button found on the front or 
side of the computer. The Macintosh Ilsi 
has a keyboard-based set of switches. To 
activate the reset switch, press Command~ 



Control-Power On; to activate the inter­
rupt switch, press Command-Power On. 

KEYBOARD 
Keyboard Secrets! 
Option key: Hold down the Option 
key while dragging a file from one loca­
tion to another within a single volume, 
and the file is copied to the new location, 
not moved. 

Option-Command: Hold down 
these keys and double-click on a Finder 
file to switch to a different Finder without 
restarting your Mac. 

Option- Command: Hold down 
these keys when you mount a hard disk to 
rebuild the Desktop file. 

Option: Holding down the Option key 
while dragging a file into the Trash over­
rides any file lock or query from the 
System about whether you really want to 
throw away an application. 

Option: Holding down the Option key 
when opening folders that contain folders 
will close the previous folder- a great 
way to keep your desktop uncluttered 
with open folders. 

Option: When running DOS software 
on the Mac, the Option key doubles as an 
Altkey. 

Option: Press the Option and the semi­
colon key, and you'll discover this is where 
Apple hid the ellipsis ( ... ). 

FSC Key: Cancel an action (in some 
applications) (same as Command-period). 

Tab Key: Move through fields in a dia­
log box 

Shift-Tab: Move through fields back­
wards in dialog box. 

LARGE FILES 
Transportation OfFlles Larger 
Than SOOK or 1440K (High 
Density Disk) 
If you have to split up a file too large to fit 
on an BOOK or 1440 K (High Density) 
floppy so that you can take it to a service 
bureau there is a solution. If you have a 
program for backing up your hard disk, 
bring a copy of it with you the next time 
you visit the bureau. If a file becomes too 
large to save to a floppy-disk, use the 
backup program to back up the file (the 
program will break the file up- you can 
restore the fragmented file on your hard 
disk when you get home). 

LASERWRITER 
DRIVER 
Using Different Versions Of The 
LaserWrlter Printer Driver On A 
Network 
When using Apple Talk on a network, 
make sure all Macs have the same version 
of the laser Writer driver in their System 
Folder, assuming you are using a version of 
the Laser Writer driver which is less than 
version 5.2. The Laser Writer driver series 
6.0x can be mixed across a network, for 
example6.01 and6.02. 

If you're upgrading some computers to 
System 7. x, System 7 includes a new 
version of the Laser Writer driver. In this 
case, all the computers accessing the same 
printer should have the 7. x printer driver, 
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whether or not they are upgraded to 
System 7. 

Using ResEdit To Place The 
PostScript Flle Option In The 
Print Dialog Box 

Pressing Command-F after clicking on 
OK in the Laser Writer dialog box writes 
the PostScript output, minus the 
Laser Prep file, to a file. But some applica­
tions intercept this Command-F event, 
preventing the file from reaching the 
Laser Writer driver. To fix this: 

1. In ResEdit, open the copy of the 
Laser Writer driver, version 5.2 or 6.0, and 
select DITL from the list of resources. 

2. Using the Open as Template option 
(labeled Open As in earlier version of 
ResEdit), select DITL ID = -8191 to open 
it as a DITL resource. 

3. Find the Item for Disk File with a 
Display rect (display rectangle) ofO 0 0 0. 
Change the Display rect to 49 320 65 
400. Save your changes, and exit from 
ResEdit. 

4. When the Laser Writer Print dialog 
box appears, you should see a new option 
called Disk File. Clicking on it results in 
the creation of a PostScript file of the out­
put called PostScriptO (or 1, 2, 3, and so 
on). This file will appear in your System 
Folder or in the Spool Folder within the 
System Folder. 

5. To avoid confusion with other 
Laser Writer driver files on your hard disk, 
rename this altered driver. You'll have to 
select this driver from the Chooser to 
access it after you've changed its name. 
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LASERWRITER 
DRIVER6.01 

Changing LaserWriter Defaults 
The Laser Writer driver (version 6.01) can 
be modified to change the default settings 
of the radio buttons in the Print dialog 
box default print mode to be Black & 
White instead of Color/Grayscale. 

First, make a backup copy of the 
Laser Writer driver. That way, if you some­
how mess up with ResEdit and set fire to 
the file, your tuchas is covered. Launch a 
resource editor like ResEdit, and open the 
Laser Writer driver. 

Lunge straight for the PDEF resource with 
ID = 4. Set out on a search for the series of 
bytes 377C001700047801 and replace 
that series with 377C001800047801. 
Save your changes, and you're done- from 
now on, the default setting will be Black 
&White. 

By the way, the latest version ofResEdit is 
2.0x. It features an icon-based interface 
and much less intimidating editors for 
most resources. You should be able to find 
a copy in most of the usual places­
CompuServe, GEnie, America Online or 
your local user group. 

MACROMAKER 

No Longer Supported By Apple 
Under System 7 
MacroMaker will no longer be supported 
by Apple (Apple states that it is is incom­
patible with System 7 and no update is 



planned). However it does work with 
System 7 when placed in the root System 
folder, not the Extensions folder. 

Fixing Transposed Letters With A 
Keystroke 
If you catch yourself making typos such as 
typing "teh" for "the," you're not alone­
transposing letters is one of the most com­
mon typing mistakes. Here's a macro that 
fixes transposed letters with one keystroke. 
It can be used with Macro-Maker and 
Word, or you can use the same general 
procedure with AutoMac III, Mind-Write 
or other combinations of word processors 
(that support the arrow keys) and macro 
programs. 

1. If you don't already have MacroMaker 
installed, put a copy of the MacroMaker 
file, which comes on the Macintosh 
Utilities Disk 2 in System 6 and later, into 
your System folder. For MacroMaker to 
take effect, you have to restart your Mac. 

2. Place the cursor immediately after any 
two transposed letters in your word process­
ing document (if you've just typed them, 
this is where the cursor will be anyway). 

3. From the MacroMaker menu, select 
Start Recording. 

4. Press Shift-left arrow to highlight 
the second of the two letters to be 
swapped (don't use the mouse to 
highlight the letter, or the macro will 
operate only on this position of the screen). 

5. Cut this letter (with Command-X). 

6. Press the left arrow to move the cursor 
to the left of the first letter (again, do not 
use the mouse). 

7. Paste (Command-V) the second letter 
on the left side of the first letter. 

8. Press the right arrow to return the cur­
sor to its original position following both 
letters. 

9. Immediately select Stop Recording 
from the MacroMaker menu. 

10. Give the macro a name, such as Swap 
Letters or Transpose, and assign it a 
keystroke. 

11. Store the macro. 

To use the macro, make sure the cursor is 
positioned immediate! y after the trans­
posed letters and use the keystroke you 
assigned in step 10. 

Launching Applications 
When launching applications with 
Apple's MacroMaker, you may run across 
some instances in which it's difficult or 
impossible to make a macro for a simple 
launch. These applications may not allow 
access to the menu bar, or they may 
require you to perform some action prior 
to accessing the menu bar. 

This restriction makes it impossible for 
you to stop recording as soon as the appli­
cation has been launched. An example of 
this annoying problem in an application is 
the HD Backup program, which is pro­
vided with Apple hard-disk drives. 

To overcome this limitation, temporarily 
place an empty dummy folder over the 
precise location of the application for 
which you want to create a launch macro. 
Then record the steps you need to go 
through in order to launch the application. 

After the dummy folder has opened, stop 
the recording and save the macro. Exit 
from MacroMaker, and then remove the 
folder so that you can once again see the 
application on the desktop. From now on, 
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the application will launch nicely. This 
technique works because MacroMaker 
records the location of the mouse clicks -
not the items the mouse clicked on. 

MAPCDEV 

Magnifying The Map Control 
Panel Device ( CDEV) 
The Apple documentation on the Control 
Panel Map utility mentions that if you 
want a magnified map image, you should 
press the Option key while clicking the 
Map icon. This results in an image that's 
so magnified as to be virtually unusable. 
What the manual doesn't mention is that 
you can get a slightly magnified version of 
the map by pressing Shift while clicking 
the Map icon. 

Changing The Map Figure 
The world map image in Apple's CDEV 
Map can be copied to the Clipboard sim­
ply by choosing Copy from the Edit 
menu when Map is on-screen. Make sure 
the city name box is not highlighted (or 
you will copy the name instead of the 
map). So what's so great about that? 
Several things. 

First, if you have a color system, you can 
copy and paste the map image into a pro­
gram like PixelPaint, color it, and then 
copy and paste the colored version back 
into the cdev's window. Oceans could be 
blue, continents in contrasting colors, 
and soon. 

If you live in a black-and-white world, 
you can still modify the map in MacPaint, 
using patterns instead of colors. 

And in any case, you have a fairly decent 
world map that you can store separately 
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with your clip art for use in other docu­
ments. 

And, by the way, you don't have to 
worry about cutting or clearing the map 
image accidently- only Copy and Paste 
work from the Edit menu while you 
have the CDEV open. 

If you have System 7, you'll notice a 
more detailed color map in the scrap­
book file. You can uses this in the map 
control panel simply by copying in 
from the scrapbook and pasting it into 
the open control panel 

MULTIFINDER 
(SYSTEM 6) 

Starting MultiFinder Temporarily 
When In The Finder 
While running the Finder, you can start 
the MultiFinder without restarting your 
Macintosh by double-clicking the 
MultiFinder icon (in your System Folder) 
while holding down the Option and 
Command keys. The next time you do 
Restart, you will be back in the Finder. 

Loading Desk Accessories Into 
The Finder's Application Heap 
Under MultiFinder, holding down the 
Option key and then selecting aDA (desk 
accessory) loads the DA into the Finder's 
application heap instead ofloading it into 
the DA Handler. 

Reinserting Disks To Find Disk 
Icons 
It's often necessary to return to the . 
Finder from an open application for file 
information. But when you are working 
under MultiFinder, open documents 



obscure the desktop, hiding the disk 
icons you need. One way to open a disk's 
window from beneath the clutter is to 
eject it, using Command-Shift-1 or 
Command-Shift-2 (depending on what 
drive the disk is in) and then reinsert it. 
Reinsertion automatically causes the 
disk's icon to be selected (even if you 
can't see it). Then you will be able to 
open it with Command-O, and its win­
dow will pop to the forefront. 

Getting Info When Busy 

Have you ever received the message "the 
file is busy" when trying to get informa­
tion (Command-!) about an open file? 
This can be annoying, but there is a way 
to access the file without having to close 
the file or reboot (in case you're prying 
into some !NITs). 

For example, suppose that while using an 
application, you have problems you sus­
pect may be memory-related. You go to 
the Finder to check the memory size (with 
Command-I) and learn that this informa­
tion is "n/a" (not available) because the 
application is open. Your only recourse is 
to save your work and quit the application 
in order to check it. Or suppose you want 
to check the version number of an applica­
tion or an INIT/cdev such as MacroMaker 
that's always "busy." Quitting the applica­
tion or relocating the !NIT and then 
rebooting take some time. 

There is an easier way of obtaining the 
information you want with minimal dis­
ruption- at least if you're running under 
MultiFinder. Simply duplicate the file 
(Command-D) you're interested in and 
then use Command-I to get the data you 
need from the copy. When you're 
finished, you can trash the duplicate file. 

Hidden Humor 
Ever wondered what kind of people pro­
grammed your Mac? If you're running 
MultiFinder 1.0, hold down Control­
Option-Command and select About 
MultiFinder from the Apple menu. Alas, 
in more recent versions, this humorous 
box seems to have been removed. But 
don't despair, the Mac spirit lives on. For 
an example, use ResEdit to examine 
STR# ID = -127 inMultiFinder6.0.x. 

PARAMETER RAM 
Resetting The PRAM In The Mac 
The parameter RAM (PRAM) is where 
the Mac stores basic information like the 
time and default font (and other things) 
that it must know when you start it up. 
It's powered by the battery. And occasion­
ally it gets fouled up and must be reset. 

On Macs and Mac Pluses resetting the 
PRAM is simple. Just shut the machine 
off and remove the battery for 5 or 10 min­
utes. It's impossible to do that on the SE or 
the II, however. But Apple has provided 
another way to reset the PRAM. You must 
be using Control Panel3.1 (or higher). 
Version 3.1 is included with System 4.1 
and Finder 5.5. Here's what to do: 

As you select the Control Panel hold 
down the Shift, Option, and Command 
keys. You'll get a dialog box asking if you 
want to zap (reset) the parameter RAM. 
Select Yes, and then Restart your Mac. 
This will set most of the PRAM to zero, 
and will change all your Control Panel 
settings to default settings, but will not 
reset the clock. Reset all your other 
options as they were or as you wish. 
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PRAM And System 7 

Under System 7, the secret trick for 
rebuilding parameter RAM is even more 
unfriendly and obscure than in System 6. 
(PRAM is a special chunk of battery­
backed memory that retains data such as 
your control panel settings even when the 
computer is shut off.) 

In System 6, you could reset almost all of 
this special memory by selecting the 
Control Panel DA while holding down 
Command-Option-Shift. In System 7, 
you must hold down Command-Option­
P-R while restarting the computer. When 
the system sees this key combination, it 
resets PRAM and restarts the computer. 

PRINT MONITOR 

Making Print Monitor 7 A Little 
Less Pushy 
System 6 users who have turned on 
Background Printing and who also print 
manual-feed pages may complain. After 
they switch to System 7's Laser Writer 
drivers, they receive annoying alerts that 
"the Laser Writer is waiting for a sheet of 
paper." As they say, this is a feature, 
nota bug. 

To turn off these prompts, choose the 
Preferences command in the Print 
Monitor application (you can do this 
while printing) and click the "Give no 
notification" radio button. 

PUBLISH/SUBSCRIBE 

Publisher/Subscriber Options In 
System7 
You can see what material in a document 
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has been published or subscribed to by 
selecting the Show Borders command. 
This places a gray border around all the 
sections that are published or subscribed 
to. Double-clicking on this border brings 
up either the Publisher or Subscriber 
Options dialog box-depending whether 
the text has been published or subscribed 
to - which includes options for updating 
or canceling editions. 

QUICKDRAW 

Color Icons For Some 
The 32-bit QuickDraw icon appears in 
color when 32-bit QuickDraw is installed 
-except on the machines that have it in 
ROM (examples are the Mac Ilci and 
Ilfx). On these Macs the icon is just black 
and white like all the other icons, even if a 
newer version of32-bit QuickDraw is 
installed. 

STARTUP SCREENS 

Creating Custom Startup Screens 
Instead of a "Welcome to Macintosh" 
message, you can replace it with what is 
known as a Startup Screen. 

Obtain the image you want to make a 
Startup Screen in MacPaint format. You · 
can create the file from scratch in any 
paint program- MacPaint 2.0, 
Super Paint, UltraPaint, or PixelPaint, for 
instance- that supports the Startup 
Screen format. You can also scan in an 
image and save it in MacPaint format. 

If you have a color-compatible Mac, you 
can even have a color Startup Screen. All 
you have to do is use a color paint program 
that supports the Startup Screen format. 



SYSTEM 

Slimming The System Folder 
What doesn't belong in the System 
Folder? Many applications, DAs, fonts, 
sound files, and sometimes dictionaries, 
filters, and help files. A rule of thumb 
here is to take out items such as prefs 
files or dictionaries if the application 
doesn't require their presence in the 
System Folder. 

Sometimes the System Folder sprouts new 
files on its own. Word, for example, puts 
Word Temp files into the System Folder. 
These are temporary files that Word fails 
to clean up . Just make sure you quit the 
application first before deleting its temp 
files; otherwise, your Mac may crash. 

What does belong in the System folder? 
System files, Control Panel devices 
(cdevs), startup documents, and Chooser 
documents (PRERs and RDEV s) all 
belong there. Also include any utility 
whose documentation specifies such 
placement or that won't work unless you 
place it there (these will mostly be !NITs). 

Consign everything else to a utilities fold­
er (outside the System Folder), along with 
any of the above file types for which you 
have no present need. If you are not sure of 
a file's status, click on a questionable file's 
icon and type Command-I (Get Info) to 
bring up the file's Info box, or view the 
System Folder window as text (under the 
VIEW menu) to see if the file fits into any 
of these categories. 

Opening An Application From 
A Floppy Disk Without Switch­
Launching 
Pressing the Option key while launching 

an application from a floppy disk 
equipped with its own System Folder pre­
vents switch-launching- that is, you can 
continue operating under the current 
System (as opposed to the floppy's System) 
-note that System 5.0 (and later versions) 
will not let you switch-launch from a 
hard-disk drive unless you hold down the 
Option key. 

Selecting A New Active System 
Folder 
To bless or select a new active System 
Folder, hold down the Option and com­
mand keys while double-clicking on the 
Finder icon in the desired System Folder. 

Turn Off The Color To Speed 
Application Performance 
If your work doesn't depend on color, you 
should turn off the color display. Color can 
really cost you time in ordinary operations 
such as scrolling. The two main time con­
sumersare: 

The cost in time required to put the color 
in, including the time needed to make 
appropriate color choices and 

The cost incurred in using the color file, 
which will take up more disk space and 
time than a monochromatic document. 

In the Control Panel, the Control Panel 
Device (CDEV) called Monitors lets you 
adjust the number of colors your monitor 
shows. If you have 256 colors, your 
monitor will typically be at 2, 4, 16 or 
256 colors. 

Virus Checker Says "Encountered 
FCB Expansion" 
FCB stands for file control block, a data 
structure the Mac uses to reference an open 
file; there must be one FCB for each open 
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file. Under System 6, the number ofFCBs 
was fixed at start-up. Sometimes after open­
ing lots of files, you can run out ofFCBs, in 
which case you can't open any more files; 
applications often report this as a -42 error. 

Some utilities, such as Bill Steinberg's 
BoorMan, can alter the number ofFCBs 
created at start-up. System 7, however, 
automatically creates more FCBs as 
they're needed. This is what your virus 
checker is reporting, and it is harmless. 

Creating A Finder-less Startup 
Disk 
When you need to create a disk with a 
System folder and an application, and want 
the System on the disk to be as small as 
possible you may be able to get along with­
out a lot of the common files listed above. 

One way to trim the disk is to manage 
without the Finder. You can get rid of the 
Finder completely on a startup disk: 
eliminate all folders by placing every­
thing on the desktop and make an appli­
cation on the disk the startup file. You 
can do this by selecting the application's 
icon (or launching it if you're in 
MultiFinder) and selecting the Set 
Startup option under the Special menu. 
When you use this Finder-less disk, 
you'll see at least one Finder-related error 
message that you can ignore. 

Ten Basic, Good-Natured Tips 
Here are ten tips for using your System (or 
your system) wisely. They're so funda­
mental that you're probably already hon­
oring some of them now and can check 
them off immediately. 

1. Save your work often enough, so often 
that it becomes a reflex. If you press 
Command-S whenever you get up to refill 
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your coffee cup, if you press Command-S 
before answering when asked a question, 
if you press Command-S whenever you 
pause to gather your thoughts or wool, 
yours is the world and everything in it, 
and that's not bad. 

2. Back up all your work adequately. 
There are a lot of strategies for backing up 
files. Adequately refers to the number of 
backup copies you keep. Two is the mini­
mum for any files you really care about, 
but if you think you need five, make them. 

3. Organize your files somehow. Pay 
attention when the Save As dialog box 
comes up the first time you try to save a 
newly created file. That way, you can save 
the file into the folder in which it belongs 
rather than into whatever folder you hap­
pen to have opened most recently, which 
is exactly what will happen unless you 
specify otherwise. 

4. Use spelling checkers often. 

5. Rebuild your desktop annually. That's 
how often Apple recommends. Rebuilding 
the desktop improves your system 
performance. 

6. Don't use commercial software or 
shareware without paying for it. 
Commercial software and shareware 
authors deserve compensation and some­
times even respect for their efforts. It's a 
matter of payment for value received. If 
you use it, pay for it. 

7. Send in your registration cards promptly. 
Sending in your registration cards is just 
good sense; it makes it possible for the 
company to reach you in the event of a 
product upgrade or recall. 

8. Keep your computer reasonably clean. 
What this means is that you shouldn't 



crush potato chips into the keyboard or 
pour liquids on the motherboard. 

9. Experiment. Try new things. 

10. Look out of the window now and then. 

SYSTEM 7 

Getting Desk Accessories To 
Open In The Application Heap 
Under System 7 
Under System 6 with MultiFinder, hold­
ing down the Option key while choosing 
aDA causes the DA to open in the appli­
cation's memory partition instead of the 
system heap. This trick is useful with DAs 
that depended, for example, on the cur­
rent program's color environment. 

DAs installed via the Apple Menu Items 
folder under System 7 are unaffected by 
the Option key. But if the DA is in a file 
opened with Fifth Generation Systems 
Inc.'s Suitcase II, the old trick still 
works. You also can use Font/DA Mover 
4.1(available from CompuServe and local 
user groups) to install the DA in a 
specific application. 

Hidden Viewing Options In 
Finder7 
The Clean Up command in the Finder's 
Special menu has always had some more­
or-less secret options. Under System 6, 
holding down the Option key while 
selecting this command force-fits all the 
icons in a window into an orderly pattern. 
Under System 7, Clean Up options let 
you sort icon or small icon views by any 
other available viewing criteria (date, 
size, label, etc.). 

First, you select one of the non-icon views 
from the View menu. Then you switch to 

one of the icon views- poofl The icons 
lose their sorted order. 

But if you then hold down the Option key 
while selecting the Clean Up command, 
the icon view will be sorted by whatever 
criteria you had chosen for your earlier 
list view. 

Crash Recovery Under System 7 

If you crash in any application under 
System 7 x, you can usually recover to the 
Finder by pressing Command-Option­
Shift-Escape and clicking on OK in the 
resulting Force Quit? dialog box. To be 
safe, you should then immediately close 
all applications and reboot the machine. 

With Virtual Memory, Is There 
Any Reason To Buy More Real 
RAM? 

Virtual memory (disk space used to simu­
late RAM) is obviously cheaper than real 
memory. It's also a lot slower. SIMMs (sin­
gle in-line memory modules) with 1 
Mbyte of RAM are cheap enough these 
days to make real memory readily avail­
able, at least up to 8 Mbytes. 

Using virtual memory in a low-RAM 
configuration can make sense if you use 
one or two programs that benefit from the 
extra memory or if you use several pro­
grams under MultiFinder but switch 
between them infrequently. In these cases, 
virtual memory might make more sense 
than paying for rarely used RAM, and the 
performance penalties will be minimal. 

In other cases, virtual memory doesn't 
work well. Using a graphics program to 
edit a large 24-bit-color image will be 
slow if most of the image was stored in 
virtual memory, resulting in continual 
thrashing of the disk as parts of the 
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image were swapped into and out of 
RAM. Try out System 7 .x's virtual mem­
ory to see how it works for you; after all, 
it's free. 

Disabling Extensions 
Holding down the Shift key while the 
Mac starts will prevents the launch of all 
INITs in the Extensions, Control Panels, 
and System folders. You must restart the 
machine to turn them back on. 

No Need To Initialize Your Hard 
Disk For System 7! 
There is no need tore-initialize any hard 
disk on which you plan to run System 
7 .x, unless the disk has been damaged in 
some way, or it is a third party drive that 
requires initialization. Check with your 
third party hard drive vendor for more 
information on that specific drive. 

If you plan to run Virtual Memory, the 
SCSI driver will need to be updated 
using HD SC Setup v 7 .x. This requires 
that you boot from the Disk Tools floppy, 
choose the target drive, and click on 
"Update,'' This process takes a second or 
two to complete, and does NOT require 
any reformatting, or reinitializing of 
your hard drive. 

Software No Longer Needed 
Under System 7 
The following software is no longer needed 
under System 7 because Apple has incorpo­
rated its functionality into System 7: 

BOOK Eject INIT 
Font/DA Mover 
Memory Manager INIT 
TrueType INIT 
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Invisible Applications Under 
System7 
In System 7, an application that is 
marked invisible will not be found when 
you try to open one of its documents, and 
the result is an error message. 

Under System 6, documents are always 
connected with applications, even if the 
application is invisible. 

Each approach has its advantages. Under 
System 6 you could set up your Macs so 
naive users couldn't delete, rename or 
move applications, but could still run 
them by double-clicking on a document. 

Under System 7, the applications are 
more completely hidden, and you can 
open them only with the help of a utility 
such as the Disk Top desk accessory from 
CE Software Inc. (DiskTop is convenient 
both for launching applications and for 
setting the Invisible attribute.) 

Stay At Phase 1? 

Though everyone will tell you that System 
7 requires an upgrade to Apple Talk Phase 
2, you can stick with Phase 1 for your 
Ethernet cards if you like. According to 
sources at Apple (don't blame us if this 
doesn't work), if you install System 7 and 
then reinstall the older drivers, the cards 
should operate like they did before. 

Aliases Multiply Flle-sharing 
Options 
If you need to share the same application 
programs or files with several groups of 
people, you may want each group to have 
its own set of file-sharing privileges. 
System 7 lets you define different privi­
leges for a group of owners and one other 



group. The way to accommodate more 
than two workgroups is through System 
Ts aliases. 

First you make aliases of the files you want 
to share and put them in a folder. Then you 
share that folder, and give it a set of access 
privileges. For a second group of users, 
make another set of aliases, put them in a 
different folder and give that folder its own 
privileges. You can repeat this process as 
many times as you like within the system's 
limit of 10 shared items. 

Clicking On Installer Scripts 
Don't double-dick on a script to open the 
Installer application. Unlike most appli­
cations, the Installer doesn't pay attention 
to how it was launched and opens only the 
documents it wants to. If you've copied 
the program to your hard disk, the script 
that it reads might not be the one you 
double-clicked on. 

SYSTEM ERRORS 

How To Avoid Restarting The 
Macintosh During A System 
Error 
To avoid restarting your Macs if a serious 
system error occurs, you can press the 
interrupt switch (also known as the pro­
grammer's switch) when your Mac bombs 
and type "G40F6D8 <return>." This 
works fine on a Mac Plus, but not on a 
Mac SE or a Mac II. To accomplish this on 
a Mac SE, use the procedure above, replac­
ing "G40F6D8 <return>" with 
"G409B24<return>." If you are using a 
Mac II, substitute "G4080D5CE 
<return>" for "G40F6D8 <return>." 
This method has been used many times to 
copy files from a RAM disk after a system 

error occurred. If you use this method, 
however, you should keep in mind that a 
serious system error really does mean seri­
ous. Your safest bet after copying the files 
is to restart your computer. 

Two more character sets that might work 
is "SM 0 A9F4 <return> G 0" or "G 
FINDER <return>:· If this works, you'll 
be returned to the Finder, where you can 
select Restart from the Special menu, giv­
ing your Mac a chance to shut the file sys­
tem down properly and minimizing the 
risk of damage to disks or files. (See also 
Interrupt Switch.) 

SYSTEM 7 UTIUTIES 

System Utilities Upgraded For 
System7 
This software is incompatible with System 
7, but compatible versions are included 
with the System 7 Personal Upgrade Kit: 

Apple File Exchange (prior to 7 .0) 
Disk First Aid (prior to 1.5) 
Laser Writer Font Utility (prior to 6.0) 
Teach Text (prior to 7 .0) 

This software is incompatible with 
System 7, but compatible versions are 
supplied with the System 7 Group 
Upgrade Kit: 

QuickMount 
Apple CD-ROM 
TheNamer 

VIRUSES 

(prior to 1.0. 7) 
(prior to 3.0) 
(prior to 2.1) 

Recurring WDEF Infection 
WDEF is a computer virus that infects 
the invisible "Desktop" file used by the 
Finder, but does not infect applications, 
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documents, or other system files. WDEF 
is spread through the sharing and distri­
bution of disks (floppy disks, hard drives, 
etc.), and it spreads quickly. Also, both 
hard disks and floppy disks are completely 
immune to the Desktop file viruses 
WDEF and CDEF under System 7. These 
viruses never activate, spread or cause any 
damage of any kind under System 7. 

There are actually two strains, WDEF A 
and WDEF B. The B strain beeps when it 
infects a Desktop file, but the A is silent. 
Other symptoms include system crashing 
and problems with the display of font 
styles, especially the "outline" font style. 

Frequent scanning with anti-viral tools 
such as Disinfectant, SAM or Virex won't 
prevent you from getting reinfected; you 
really need to install the INITs that come 
with these programs to completely 
eradicate the virus. 

Another way you can rid your Mac of the 
WDEF virus is by rebuilding the 
Desktop (hold down the Command and 
Option keys while starting the Mac). If 
you have more than one hard disk or 
multiple partitions, keep holding the 
Command and Option keys down until 
you've seen the dialog box for each drive. 

The difference between Disinfectant 
(shareware) and some commercial INITs 
is in the auto-scanning. Disinfectant's 
INIT automatically scans the System file 
at startup, but it doesn't automatically 
scan individual files, because it's 
designed to sense the activity (not the 
presence) of known viruses and block 
them from actually following through 
with their unholy machinations. 
Compared with commercial scanning 
!NITs, Disinfectant's INIT is faster, less 
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obtrusive, and just as effective in pre­
venting infection. 

VtrUS Protection Across 
A Network 
If someone on your network has mounted 
your hard disk as a remote volume, it's 
possible that your disk could become 
infected by a virus on that person's hard 
disk, transmitted through the network. 
For this reason, any attempt at virus pro­
tection has to be applied to all the Macs on 
the network in order to be effective. Of 
course, if you install virus protection on 
every networked Mac, you'll eliminate the 
problem entirely. 

I 

UTILITIES 

ADD/STRIP 

A Powerful Flle Fllter And 
Converter 
Jon Wind's Add/Strip shareware applica­
tion is a file filter that combines powerful 
conversion options, such as converting 
spaces to tabs, up to nine strings of charac­
ters to replacement strings, cleans up 
spaces, blank lines, double hyphens to em 
dashes and much more. 

Add/Strip also has built-in tables for 
conversion between DOS and Macintosh 
text formats and a encryption/ decryption 
system. Add/Strip is available on Zmac 
or your local user group. 

AFTER DARK 2.0 

Editing The MultiModule 
Even After Dark 2.0's extensive collec-



tion of modules can fail to stimulate 
after a while. But the screen saver's 
MultiModule allows an amazing amount 
of customization without you having any 
programming knowledge whatsoever. 
One of my favorites is Stormy Skyline. 
To turn Stormy Skyline into one hell of 
an electrical storm, simply follow these 
instructions: 

1. Duplicate the Zot! module twice 
while you're at the desktop, renaming 
the copies Zot!2 and Zot!3. 

2. Open the MultiModule to Stormy 
Skyline (a predefined combination of 
Starry Skyline and Zot!), and click on the 
Edit button. Add Zot!2 and Zot!3 to this 
MultiModule, making them transparent 
instead of opaque. You should now have 
all three of the Zot! modules and the 
Starry Skyline module combined. 

3. Resize and reposition the Zot!s- it 
looks better to have them different sizes. 

4. Close the edited MultiModule, but first 
rename it something like Really Stormy 
Skyline. 

5. Open the individual Zot! modules, 
and edit the forkiness, kinkiness and 
delay of each. 

ALTWDEF 
Shrinking Finder Windows 
If you have window clutter- as in too 
many open or overlapping windows in the 
Finder, get a copy of AltWDEF, a share­
ware cdev that "iconizes" a window, 
shrinking it out of the way when you're 
not using it. AltWDEF is available on 
Zmac or from your local user group. 

CAPTURE 
Capture Your Thumbnails 
Whenever you need a thumbnail of some 
pages, don't bother using your page-layout 
program's Thumbnail print option, 
because it takes too long to print (especial­
ly if the pages consist of halftones and fonts 
that have to be downloaded and scaled). 

Instead, use a screen-capture utility such 
as Capture to take a picture of the pages 
one at a time. Paste them into the 
Scrapbook or directly into another docu­
ment, reducing the "thumbnails" so that 
several can fit on a page. 

Although the quality of thumbnails creat­
ed in this way won't be as good as that of 
those generated from within page-layout 
programs, it will be good enough for exam­
ining the general look of a page or docu­
ment. This method has several advantages: 

1. You can choose the exact thumbnail 
size you want- something you can't do 
with the Thumbnail print option in your 
layout program. 

2. You can add descriptive copy. 

3. Printing is much faster because you're 
only dealing with a single bitmap per page. 

DISKFIT 2.0 
Managing MultiFinder Memory 
For DiskFit 2.0 
SuperMac Technologies DiskFit 2.0 was 
designed to backup typical hard disks on 
typical Macs. If you try to back up more 
files than usual, however, DiskFit 2.0 can 
run out of memory under MultiFinder. 
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Here's the suggested MultiFinder memo­
ry settings for large numbers of files: 

No. files Memory Partition 
1,000 >625 Kbytes 
1,500 825 Kbytes 
2,000 925 Kbytes 
3,000 1,225 Kbytes 
5,000 1,877 Kbytes 

JUST CLICK 

Just Click Under System 7 To 
Switch Between Applications 
If you want to have the old MultiFinder­
style application switching (clicking in 
the upper right corner of the screen) in 
System 7, then Just Click (freeware) is a 
system extension for you. If you're tired 
of pulling down System 7 's Application 
menu and long for the good old days, Just 
Click will bring them back. You can find 
Just Click on Zmac and from local user 
groups. 

KIWIENVELOPES! 3 

Bar Coding With Dot Matrix 
Printers 

KiwiEnvelopes! 3, an envelope-address­
ing DA, doesn't currently support bar 
coding on non-laser printers. The feature 
is disabled. 

If you own SuperGlue, though, you can 
print the bar coding on your dot-matrix 
printer. Open the Chooser DA, and select 
Super Glue's SuperlmageSaver II instead 
of your dot-matrix printer. Print your 
envelope from KiwiEnvelopes 3, and save 
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the file in SuperGlue format. Reselect the 
printer from the Chooser DA. Open the 
SuperGlue file and print. 

Kiwi Software has stated that tests admin­
istered in close cooperation with the U.S. 
Postal Service indicate that dot-matrix 
printers cannot position a print job pre­
cisely enough to produce valid bar codes. 
Kiwi disabled the bar-code feature for 
dot-matrix printers deliberately, and this 
is documented in their manual. A bad bar 
code may move your mail more slowly 
through the postal system than no bar 
code at all. 

LAUNCHINIT 2.0 

Logging Mac Activity 
There is a program that automatically 
logs your activities on the Mac -
Launchinit 2.0. Launchinit will prompt 
users for a name each time a Mac is boot­
ed and then keep track of the programs 
or folders that are opened (logging the 
date, time, length of use and user name). 

To run it, launch the INIT by double­
clicking on it while holding down the 
Command and Option keys. When the 
Configuration dialog box appears, make 
sure to check the Enter at Startup option 
under User Name and then save. 
Because this is an INIT, you need to 
drop Launchinit into your System 
Folder and restart your Mac to activate it. 

If for some reason, it still doesn't work, 
consider Softview's commercial product 
MacinUse. It does everything mentioned 
above and sells for about $99. 



LAYOUT 
Lengthening The Document 
Name 
Layout (a freeware program by Michael C. 
O'Connor) is a convenient tool for chang­
ing the way the Finder displays its various 
views (bringing a System 7 feature to 
System 6 users). You can use it to stagger 
icons in the Finder's icon view, preventing 
the names from overlapping the icons. 
Unfortunately, Layout uses the rather 
short name "Document" for the samples 
that you drag on the screen to set the 
grid spacing and offset. The Finder 
allows names of up to 31 characters, so 
some trial and error is necessary to 
achieve the best spacing for the name 
lengths you typically use. 

The name Layout uses in adjusting spac­
ing is stored in the STR resource "DocT" 
(ID = 328). To eliminate the trial-and­
error approach, employ ResEdit to modi­
fy this resource, which originally con­
tains the string "Document". Replacing 
this string with "Document name with 
max 31 chars" lets you space the icons to 
accommodate the longest names Finder 
lets you use. 

Of course, you can enter any other string 
here to represent the maximum length of 
names you normally use. As always when 
modifying applications with ResEdit, be 
careful to make your changes on a copy of 
Layout, not on the original. 

Layout is available in the Download 
Library Forum on Zmac. 

Doesn't Work With System 7 
Mike O'Connor's freeware application, 
Layout, lets people control how Finder 6 

handles the desktop, including how icons 
are staggered, how many windows can be 
open at once, how text is displayed and 
much more. 

In Finder 7 .0, Layout no longer works 
because the new Finder lacks the LAYO 
resource O'Connor's software modified. 
System 7.0 offers a Views control panel 
instead, with a few of the same functions, 
but far less flexibility. 

LIFEGUARD 
Eye and Body Saver 

You may have seen many screen savers, 
but have you heard of an eye and body 
saver? The National Academy of Sciences 
reports that more than half of all video­
display and microcomputer users polled 
complained of eyestrain, headaches, and 
muscle pain, and Business Week reports 
that RSI (repetitive-strain injury) is the 
fastest-growing occupational disease of 
the 1990s. 

The best way to protect yourself is to take 
a break every so often and do something 
else. You can do this with a software prod­
uct called LifeGuard. 

LifeGuard is an INIT and DA from 
Visionary Software that interrupts your 
work at customizable intervals- with an 
audible or visual notification- and 
reminds you to do something else. It also 
keeps track of the number of keystrokes 
you've made in the past hour (according 
to the manual, experts recommend you 
keep your keystrokes to fewer than 
12,000 per hour). TheDA includes illus­
trated exercises for the eyes, neck, shoul­
ders, back, arms, wrists, hands, and legs, 
plus ergonomic reference diagrams to 
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help you create a workstation that won't 
cause you pain. 

MAPPING UTILITIES 

What's My Contour line? 
Looking for a program that can create 
topographical maps? If you have a spread­
sheet program with decent graphing 
capabilities, such as Wingz or Full 
Impact, you might not need a special pro­
gram. If you have all the elevation data for 
the area, all you need to do is plug the data 
into a spreadsheet as a 2-D table and have 
the program create a 3-D surface graph 
from the data. You'll be able to make all 
kinds of modifications -zoom in or out, 
rotate around the area, change the view­
ing angle- from the spreadsheet. 

If you haven't shelled out for a spreadsheet 
program that can handle 3-D graphs, 
there is a more sophisticated solution. 
Rock Ware, Inc., ofWheat Ridge, 
Colorado, has a $400 gridding, contour­
ing, and basemap-plotting program 
called MacGRIDZO that might be exact­
ly what you're looking for. Call Rock Ware 
at (303) 423-5645 for more information. 

PARTITIONING 
SORWARE 

Organizing Your Hard Disk 
Partitioning software (including 
AI..Soft's MultiDisk, FWB Software's 
Hard Disk Tool Kit, and the HD 
Partition program in Symantec Utilities 
for Macintosh) divides your disk into 
multiple volumes, each of which is its 
own "virtual" disk. You can use parti-
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tions to help organize your files. They're 
a great aid with most backup programs, 
which work volume-by-volume. If you 
create a small partition for your recent 
documents, you can back up that volume 
daily and the backups will go quickly. 
Keep older documents in a separate par­
tition. For security, partitions can be 
password-protected, and if you share 
your hard disk, partitions can give all 
users their own private work areas. 

You can keep older versions of software in a 
separate partition for when it's necessary to 
use an old version of a program. You don't 
want both the old and new version on the 
same volume, because when you double­
click on a document, you don't know 
which version of the application will open. 

The Finder also slows down when a disk 
has too many files and the System 
Desktop file gets too big- so partitioning 
your disk limits each volume to a size the 
Finder can manage. 

NORTON UTILITIES 

Using The Fast Find DA 
When you're using The Norton Utilities 
for the Mac's Fast Find DA, Command-T 
gives you access to a dialog box that 
allows you to search by type or creator- a 
useful feature for power users that's not 
mentioned in the manual. 

Fast Find Faster 
Although Norton Utilities' Fast Find 
command is extremely speedy, you can 
make it work even faster if you hold down 
the space bar while it's searching- this 
stops the animated sprinting-man icon. 



ON LOCATION 
Calling On Source-Code 
Collections 
Using On Location is a dandy way to keep 
track of what's on your hard disk, and it's 
even dandier for programmers. For exam­
ple, if you have megabytes of sample 
source code scattered throughout thou­
sands of files, you can use On Location to 
fully index these files. 

When you need an example of how to use 
any function, just call up On Location and 
search for all the references to the function 
from the source-code collection. This also 
lets you view the text in each sample 
source-code file and cut and paste the 
sample into your own program. It's fast 
and a great way to make your program­
ming more efficient. 

POWERMENUS 
Using PowerMenus And Coach 
Pro Together 
Coach Pro and PowerMenus can't be used at 
the same time when they're set to defaults. 
IfPowerMenus (an INIT) is loaded and you 
launch Coach Pro, the menu bar flickers. 

You can circumvent this by going to the 
Control Panel and telling PowerMenus 
not to put PowerGadgets into the menu 
bar. When you want to use PowerGadgets, 
pop them up by using the alternative acti­
vation event that you've selected in the 
Control Panel (for example, Command­
click and triple-dick). 

PUBLIC FOLDER 
Moving Files From One Mac To 
Another With Public Folder 
There's a solution for transferring files 
between workstations on a network, aptly 
named Public Folder. This handy network 
file-transfer utility is available from most 
on-line services and user groups. 

Public Folder is a Chooser document that 
allows you to designate a folder on your 
hard disk as public. You can't send a file 
anywhere, but any file you put into your 
public folder can be retrieved by anyone 
else on your network who is using Public 
Folder. 

When people are moving a file from your 
Mac to theirs, you will feel a performance 
hit: your mouse may become twitchy and 
reaction time may be slower than usual. 
However, Public Folder moves files rapid­
ly from one Mac to the other, the speed 
depending on network traffic. 

It is not a replacement for AppleShare or 
TOPS, but for occasional transfer of files 
Public Folder provides an elegant answer. 
There is no need for Public Folder under 
System 7, since it has File Sharing, which 
is built-in AppleShare for all users on the 
network. 

QUICKEYS 
Using QuicKeys To Print 
If you program QuicKeys to scan the 
menus looking for "Print ... " and find 
that it doesn't work in some applications. 
remember that some applications do the 
ellipsis after Print with three periods 
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and some do it with Option-semicolon. 
They may appear the same on the screen, 
but to QuicKeys they're quite different. 
Solution: Define an application-specific 
QuicKeys file for each of these 
applications. 

QUICKEYS 2 
Recovering After A Program 
Upgrade 

QuicKeys 2 lets you create program­
specific macros that are stored according 
to the name of the individual application. 
After you upgrade a program to a newer 
version, you may discover that all your 
QuicKeys macros for that program have 
disappeared. You can retrieve them by 
opening the QuicKeys resource and 
changing the program names and /or ver­
sion number to the new ones. Here's how: 

Open the Preferences folder in your 
System Folder. Inside the QuicKeys folder 
is a QuicKeys Preferences folder, which 
contains a KeySets folder where all your 
macro sets are arranged by program name. 
Simply change the version number on the 
filename, and you're set. 

READ MACWRITE 
Reading Mac Write Flles Without 
The Application 
Many software developers continue to use 
Mac Write format as their standard for on­
disk program documentation. This can be 
inconvenient if you don't have Mac Write. 
You have to open up Microsoft Word or 
some other word processor and import the 
file, even if all you want to do is take a 
peek at the documentation. 
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You can modify Word's Creator to 
MSWD using ResEdit. However, if 
you're not comfortable with ResEdit or if 
text files are what you're after, there's a 
nice shareware utility, Read Mac Write, 
that opens Mac Write files and scrolls 
through them on the screen while saving I 
the contents as a plain text file. Now if , 
you need to take a look at some documen­
tation on the fly, you can just open the file 
with aDA such as miniWRITER (which 
is also shareware). 

You can pause the scrolling, but Read 
Mac Write lacks a text buffer and elevator 
boxes for scrolling back over what you've 
reacl. Once the text has scrolled by, it's 
gone until you reopen the file and start at 
the beginning. 

Read Mac Write's quick production of text 
files from Mac Write-formatted docu­
ments would also come in handy if you 
had several Mac Write files that you need­
ed to get into plain-text format in a hurry. 

Read Mac Write is available in the 
Download Library Forum on Zmac. 

RES EDIT 
INITs Across Your Startup Screen 
If you dislike those INIT startup icons 
goosestepping across your startup screen 
and the programmers didn't see fit to give 
you the option of disabling the icons, 
there is a simple solution: You can change 
the icon ID number, using an icon editor 
such as Icon Designer or a resource editor 
such as ResEdit, thereby eliminating the 
startup icon without affecting the INIT 
itsel£ 

Use a consistent pattern when you change 
the numbers so that you can restore them 



later if you need to. For example, change 
ID number 128 to 12800 or change ID 
number-4023 to +4023. 

The patterns you use don't matter- just 
be consistent. After you've changed the 
ID numbers, your startup screen will be 
untrodden. 

Changing The Shutdown Screen 
If you want to change the Shut Down 
screen that says "You may now switch off 
your Macintosh safely", use a copy of 
ResEdit and follow the steps below: 

1. Make a copy of the System file, using 
the File menu's Duplicate command. 

2. Launch ResEdit, open the duplicate 
copy of the System file, and locate the 
DSAT resource. 

3. Double-dick on this resource, and then 
double-dick on the ID 2 file. 

4. Scroll down until you see the "You 
may now ... " message in the narrow right 
column. 

5. Starting with the letter Y, highlight 
the message through the last character, a 
period. 

6. Carefully type in your message, using 
exactly 45 characters, including spaces. 
Save your changes. 

7. Quit ResEdit, shut the Mac down, and 
restart from a floppy disk. 

8. Save a copy of your original System file 
on a floppy disk. Replace the hard disk's 
System file with the duplicate copy, and 
change the copy's name to System. 

9. Restart your Mac from the hard drive, 
and choose Shut Down from the Special 
menu. 

10. Your message should appear the way 
you typed it. If you did something wrong, 
the Shut Down screen will flash, but that 
shouldn't cause any major problems. 
Simply trace these steps, and make sure 
that you typed exactly 45 characters. 

Deleting Sound Resources To 
Save Space 
Digitized-sound resources are fun but 
are also often very large and expendable. 
If you're running short of disk space or 
if you're looking for ways to reduce 
telecommunications time, you might 
want to use ResEdit to locate the snd 
resources on a copy of the application or 
stack. Delete the resource, save the 
program, and make sure the program 
still works. The About box or startup 
screen might be less entertaining, but 
the program will be lots leaner. 

Reassigning The Shift-period Key 
Combo 
If you've ever tried to type P.O. Box 
quickly on a typical Mac keyboard, 
you've probably wished that the Mac key-
board functioned more like a traditional 
typewriter, with Shift-period producing a 
period (instead of>) and Shift-comma 
producing a comma(instead of<). Here's 
a way to reassign these keys, using 
ResEdit 2.1 or later: 

1. Make a copy of the System file in the 
System Folder by using the Duplicate 
command (Command-D) on the File 
menu. Remove the copy to a nonboot disk 
or partition (having two System files on 
your boot disk can cause problems). 

2. Open the copy with ResEdic, and f:;)l, fil 
open the KCHR resource, which controls UJ 
the mapping of ASCII characters to key-
board keys. 
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3. The keyboard display in the bottom 
third of the window changes as you press 
the modifier keys, in the same way as it 
does with the Key Caps DA. Hold down 
the Shift key to display the shifted key­
boardmap. 

4. Using the mouse, drag the desired char­
acter (in this case, the period) from the 
palette in the top two-thirds of the window 
onto the key you want to represent it. Do 
the same with the comma. (Because this 
operation replaces the > and < symbols 
with the period and comma, you might 
want to assign the < and > symbols to the 
Option-Shift positions on their respective 
keys so they're still accessible.) 

5. Close the KCHR resource, and save 
the changes to the System file. Restart 
the Mac from a floppy disk, store the old 
System file in some place other than the 
boot disk, and place the edited version of 
the System file in the System Folder. 
Restart the Mac. This will eject the 
floppy disk, and your Mac will reboot 
with the new System file in place. 

This change affects the keyboard map­
ping, not the font information, so it 
should be font-independent. 

Reducing The Amount Of Space 
Between Files 
When you have many documents in a 
folder, you can use the By Name option in 
the View menu to see more of my docu­
ments at one time, though they still have 
large spaces between them. To reduce the 
amount of space and make more files visi­
ble, modify the Finder using ResEdit. 

To do this, run ResEdit and open the 
Finder on the disk you want to change. 
Double-dick on the LAYO resource. 
Double-dick on LAYO = 128. Click 
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once on the gray part of the scroll bar. 
Change the number in Line Spacing 
from 16 to 11. Save the Finder and quit 
ResEdit. Now your documents will be 
listed in a tighter format. 

RESEDIT 2.0BX 

Turning An EPS Image Into A 
Startup Screen 
If you want to turn your favorite EPS 
image into a startup screen, for example, 
or want to otherwise process it on a pixel 
level, try ResEdit. Open the EPS file with 
ResEdit and you'll find a resource of type 
PICT. Open it and click on the image and 
copy it to the clipboard (with Command­
C). Open MacPaint (or any graphics pro­
gram that can save files as startup screens), 
and Paste (Command-V) the image into 
the Mac Paint window. You can do this 
even if the original PICT image was in 
color- although it will be converted to 
black-and-white. 

SCROLL LIMIT 

Controlling Scrolling 
If your scroll bars are working at warp 
speed, there's a little cdev called Scroll 
Limit that can help. Scroll Limit is a free­
ware program, available from Zmac and 
other shareware sources. 

SOUND CONVERTER 

Editing Sounds 
When you want to turn sounds into 
sound resource files, the sounds are often 
at the wrong sampling rate. A utility 
called Sound Converter converts 



SoundEdit, SoundWave, or Sound Cap 
files into sound resources and lets you 
choose the sampling rate when you con­
vert sounds (although it doesn't let you 
change the sampling rate of an existing 
sound resource). 

Sound Manager is a sound-manipulating 
shareware utility that can do any type of 
conversion, play sounds, and let you do 
some light editing. But you'll also need 
SoundEdit (one of the applications that is 
included with Farallon's MacRecorder 
sound digitizer) if you want to change the 
sampling rate of the resource. Sound 
Manager can convert sounds to SoundEdit 
format; SoundEdit can save the sounds 
with a different sampling rate (although 
it can convert only from faster rates to 
slower rates). 

STEPPING OUT II 
Disabling Stepping Out IT Upon 
Launching An Application 
Stepping Out II is a useful addition to the 
Mac, giving the effect of a larger screen. 
Many people keep it on all the time. But 
some programs, particularly games and 
telecommunications software, are better 
off without it. To save yourself a trip to the 
Control Panel DA, launch your program 
while holding down the Option key, and 
Stepping Out II will automatically shut 
off. You should use the Control Panel to 
turn it back on when you Quit, though. 
This is an undocumented and handy rever­
sal of Stepping Out's QuickStart feature. 

Stepping Out As A Screen 
Shrinker 
TheDA Stepping Out II is a screen exten­
der that allows the creation oflarge virtual 

screens on the Mac. Although most peo­
ple can readily see the benefit of this (par­
ticularly for the 9-inch screen of the Plus 
and SE), there is another benefit for those 
who would rather use a larger monitor 
while developing applications for the 
smaller, standard screens. 

Stepping Out II also functions quite effec­
tively as a screen shrinker. Creating a 
small screen size is simple. First, call up 
Stepping Out II from your Control Panel. 
Click New and enter the pixel count for 
the screen size you want (512 pixels wide 
by 342 high for the Mac SE). Then, enter 
a name for your screen definition (such as 
"Mac SE Screen") and click Save. Finally, 
highlight the name of your new screen 
setup and click Set. If you have enough 
memory reserved for the new screen (and 
assuming that Stepping Out II is active), 
the change takes place immediately, oth­
erwise, you will first need to reboot. 

Once all this is accomplished, you can eas­
ily switch from one screen size to the other 
by simply turning Stepping Out II on or 
off from the Control Panel. 

STUFFIT 
Automatically Unstuffing All 
Archived Files 
Stufflt, which has become the industry­
standard utility for archiving and com­
pressing Macintosh files, has a hidden 
(and very handy) feature. After selecting 
the archive you wish to open (or after 
clicking in the About box if you opened 
an archive and not the program itself), 
hold down the Shift key and Stufflt will 
automatically select all the files, decom­
press them, and save them to disk. 
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Halting Stufflt Operations 
Simply pressing Command-period- the 
usual method for halting operations on the 
Macintosh- doesn't stop the stuffing/ 
unstuffing operation in Scuffle 1. 5 .1. 
Instead, you need to hold down Command­
period continuously until the operation 
has stopped. 

Archiving Several Flles 
If you need to send more than 20 files via 
modem, you will need to send data in at 
least two sessions. Save yourself some 
time by enclosing all the files in one 
folder. Scuffle can archive entire folders of 
vanous stzes. 

STUFFIT 1.5.1 

Unstuffing Deluxe Flles Using 
Res Edit 
Users of the shareware file-compression 
utility Scuffle 1.5.1 by Raymond Lau 
may start coming across .SIT files that 
have been stuffed with Scuffle Deluxe, the 
new commercial version of this useful 
program. And they will quickly find that 
they can't use the shareware version to 
unstuff the files. Well, actually, in many 
cases they can, but they'll have to get 
their hands dirty with ResEdit. 

Launch ResEdit, and select the .SIT file 
created with Scuffle Deluxe. Press 
Command-I (Get Info), and change the 
file type from SITD (the Scuffle Deluxe 
format) to SIT! (the type format for the 
shareware version). 

Save the change, quit ResEdit, and 
unstuff the compressed file. 
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SUITCASE 

Getting Just The Applications 
Under The Menu While In 
MultiFinder 
If you use Suitcase and you don't want to 
scroll to the bottom of the Apple menu 
to see what applications have been 
launched, hold down the Option key 
while selecting the menu. The DAs are 
not listed, and you have easy access to 
the applications list. 

SUITCASE II 

Distinguishing Between 
Bitmapped And Postscript Fonts 
If you can no longer remember which of 
your fonts are bitmapped and which are 
PostScript, you can use Suitcase II to 
find out. 

Select Suitcase II from the Apple menu, 
and click on the Fonts radio button or 
type Command-F. Select any font name 
and click on Show, or double-dick on a 
fontname. 

Above the sample text, Suitcase will list 
the printer font filename if the font is 
PostScript. If the font chosen is a 
bitmapped font, the message "This is a 
bitmapped font" will appear. 

Suitcase ll Grows In Patches 
Suitcase II, like other popular utilities on 
the Mac, experiences growing pains. 
Version 1.2.6 had some problems with 
popular applications, such as 
QuarkXPress 3.0, and needed updating. 
Unfortunately, the road through subse­
quent updates has been rocky. As of this 



writing, the latest release is Version 
1.2.10, which fixes many known bugs and 
promises compatibility with System 7 .0. 
If you are having problems with an older 
version, you should check it out- care­
fully. The Suitcase II Updater application 
can be found in on-line services; it's avail­
able in Fifth Generation's support forum 
on CompuServe (GO CIS:APVENA). 

Suitcase Harmony In Finder 7 
Finder 7 normally opens font and desk 
accessory suitcases when you double-dick 
on them, giving you access to the individ­
ual items, but it stumbles on some files. 
Files created by the Suitcase II utilities, 
Font and Sound Valet and Font Harmony, 
may be reported as "damaged" by the 
System 7 Finder. 

The simplest solution to these problems is 
Font/DA Mover 4.1. This System 7 ver­
sion of the utility program is not included 
on the standard System 7.0 floppies, but it 
is available on-line from CompuServe. 

Open the suitcase with Font/DA Mover 
4.1 (using Option-Open to locate the file 
if necessary). Create a new file, select all 
the fonts or DAs from the old suitcase, 
copy them to a new one, and save it. This 
new file should work both with Suitcase II 
1.2.10 and with Finder 7. 

SWITCH-A·ROO 1.6 

Switching Among More Than 
Two Screen Depths 
Switch-a-Roo 1.6 is one of the most useful 
FKeys available for the Mac II. If you need 
to switch between more than two screen 
depths, however (because you have a 24-
bit monitor, for instance), the FKey will 
come up short. If you need to switch 

among 2, 16, 256, and 16 million colors 
often, you can modifY Switch-a-Roo to 
allow two copies of the program to run at 
the same time. Here's how: 

1. Make a copy of Switch-a-Roo 1.6. 

2. Using ResEdit, select the copy of the 
FKey. First, use the Get Info command to 
change the ID to a number other than 9 
that your system isn't using currently. 

3. Next, open the file and scroll down to 
byte 2417. In the ASCII translation of the 
hex code, you will see Roo File. Change 
this filename to something that uses the 
same number of letters (for example, 
Row File). 

4. Save the file, and install it into your 
system, using ResEdit, or load it with 
Suitcase II. 

This modification will make the two 
copies of a Switch-a-Roo run concurrent­
ly, with each assigned to a different 
keystroke. You may want to make one 
copy switch between 2 and 256 colors 
and have the other switch between 16 
and 16 millions colors. Even if you have 
to switch among only three screen 
depths, it's still easier to have two copies 
running concurrently than to go to the 
Monitors cdev or to call up the full 
screen to reconfigure Switch-a-Roo. In 
addi cion, you can assign these FKeys to 
the functions keys on the extended key­
board, so any screen depth is no more 
than one or two keystrokes away. 

SYSTEM ERROR 
TABLEDA 

Printing The Error Table 
Pyro! co-author Bill Steinberg produces a 

183 



concise list of system error and bomb-code 
definitions on the Macintosh in the form 
of aDA, called System Errors DA. 

You can't order it directly, but you can 
download it from Zmac or from 
CompuServe's MAUG forum (where 
Bill's a sysop). 

You can view any error opening the DA, 
but you have to have a working Mac 
before you can use it! A good idea is to 
keep a printed list of codes tacked up by 
your desk. 

Here's how to do just that, if you have a 
copy ofResEdit. First, make a copy of the 
system Errors DA. (Always work on a 
copy when you're using ResEdit.) 

Launch ResEdit, and double-dick on the 
System Errors DA. In the window that 
opens, double-dick on the TEXT item. 
Now double-dick on TEXT 
"SysErrorList 2.1c ID=-15392 (it may 
have a slightly different name if you have 
a different version of the DA). 

Next, select all the text by either drag­
ging from the beginning to the end or 
clicking just before the first character, 
scrolling to the end of the text, holding 
down the Shift key, and clicking after the 
very last character. Select Copy from the 
Edit menu. Now quit ResEdit, launch 
your favorite word processor, and paste. 
You now have a text version of the error 
codes. 

SYSTEM PICKER 

You Can Keep System 6 And 7 On 
Your Hard Disk 
Yes, you can, although it's a little clumsy. 
If you have a disk that can be partitioned, 
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one solution is to define separate parti­
tions for the two systems and switch parti­
tions to switch systems. 

If your disk can't be partitioned or you 
don't want to reformat it, the solution is a 
little more complex. You need to keep a 
separate System folder for each system and 
select which one you want to use with a 
little utility called System Picker (previ­
ously known as Blesser), available from 
Zmac, CompuServe and local user groups. 

First, install System 7.0 (To do this with­
out erasing System 6, select your current 
System folder and choose Duplicate from 
the File menu before installing.) You now 
can use System Picker to select which 
System folder will be used the next time 
you boot up. Note that you should always 
reboot the Mac immediately after using 
System Picker, otherwise your Mac can 
get confused. 

When you're running under System 6, 
you'll see extra folders on your disk called 
Desktop and Trash. Don't erase these; 
they're created and maintained by System 
7. When you switch back to System 7, 
you'll likely see it update the disk. This 
step is necessary to accommodate whatev­
erchanges you've made to the disk and file 
structure under System 6. 

TAnLETALE 1.2 

Great System Reporting Utility 
TattleTale is a desk accessory, from john 
Mancino, for examining Macintosh 
configuration details, and it's free. Mancino 
asks only that you do something positive 
for the environment in return for using 
the software (it's also Ecoware). 



TattleTale details all aspects of a Macintosh 
configuration, including NuBus cards, 
SCSI chain, memory, processors, ROM 
and operating system versions, Desktop 
Bus devices, fonts, system extensions, open 
files, and active processes. 

TattleTale is also System 7 compatible, 
and also provides a special feature list for 
programmers that lists the "traps" that are 
available and those that are missing from 
the system. 

TEMPO 
Using The Keypad For Macros 
When composing macros, avoid the use of 
the cursor keys. Use the keypad equiva­
lents instead. By doing so your macros 
will work both in Microsoft Word's out­
line mode and also in the regular text 
mode. Remember that Word assigns spe­
cial outlining functions to the cursor keys 
but the keypad equivalents function the 
same in either mode. For example, to con­
struct a type transposition macro, instead 
of Shift-Left cursor arrow, Command-X, 
Left cursor arrow, Command-V, Right 
cursor arrow- use the following: Shift-4, 
Command-X, 4, Command-V, 6. 

TEMP01.2 
Setting Up The Proper Path 
When writing macros using Tempo 1.2 
inside of an application, it can be tricky to 
save a file to a particular folder different 
than the one it was loaded from. Tempo 
starts at the main or root directory of the 
disk when doing a Save As in a macro. 
Although one can use mouse clicks to step 

down through the folders, if you later add 
to or otherwise change the list of folders on 
your disk, this approach can land you in 
the wrong folder when using the macro. 
However, it's possible to set up the proper 
path by using the Open command first, 
before the Save As. The Open command 
allows you to type the characters of the 
folder's name, and the inverse selection bar 
will automatically jump to the matching 
folder in the list. You can press Return 
and repeat this process until you've 
reached the folder that you wish to save 
the file in. At this point you cancel the 
Open and perform your Save As to the 
subfolder that has now been set up. Even 
if you add a lot of new folders, your macro 
will still function correctly. 

USER GROUPS 

Obtaining Utilities Without 
A Modem 

If you want to obtain many of the utilities 
mentioned here or elsewhere but don't 
have a modem to download the stuff from 
on-line services, there are Macintosh user 
groups. 

If you don't have a local user group, you 
can try the BMUG (Berkeley Macintosh 
User Group) software library, one of the 
most complete in the country. It offers a 
catalog of programs (it cost $8 the last 
time I checked) and sells disks for $4 each, 
including postage and handling. You 
might consider joining BMUG just to get 
its newsletter- a semiannual 
300-to-400-page extravaganza. 

BMUG can be reached at 1442A Walnut 
St., #62, Berkeley, CA 94709-1496 
(415) 549-2684. 
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Another user group is the BCS-Mac 
(Boston Computer Society Macintosh) 
Group. BCS-Mac also has a nice fat PD 
catalog and a great monthly magazine. It's 
located at 48 Grove St., Somerville, MA 
02114; (617) 625-7080. 

Of course, you can call Apple at (800) 
5 38-9696 for the name of your local Mac 
user group. 

WORD PROCESSING 

MAC WRITE 
Opening Mac Write Flles Without 
The Application 
Many software developers continue to use 
Mac Write format as their standard for on­
disk program documentation. This can be 
inconvenient if you don't have Mac Write. 
You have to open up Microsoft Word or 
some other word processor and import the 
file, even if all you want to do is take a 
peek at the documentation. 

You could change Word's Creator to 
MACA, using ResEdit. However, if 
you're not comfortable with ResEdit or if 
text files are what you're after, there's a 
nice shareware utility, Read Mac Write, 
that opens Mac Write files and scrolls 
through them on the screen while saving 
the contents as a plain text file. 

Now if you need to take a look at some 
documentation on the fly, you can just 
open the file with aDA such as 
miniWRITER (which is also shareware). 

You can pause the scrolling, but Read 
Mac Write lacks a text buffer and elevator 
boxes for scrolling back over what you've 
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read. Once the text has scrolled by, it's 
gone until you reopen the file and start at 
the beginning. 

Read Mac Write's quick production of text 
files from Mac Write-formatted docu­
ments would also come in handy if you 
had several Mac Write files that you need­
ed to get into plain-text format in a hurry. 
(Read Mac Write is available in the 
Download Library Forum on Zmac.) 

MACWRITE 4.5 
Save As Text When You're 
Exporting Flles 
While there are a few word processors that 
can't recognize and open Mac Write files 
(most notably Microsoft Word), in gener­
al you'll find it easier to export data to 
other programs or via modems by saving 
it as a Text Only file. The Text format is 
easily transmissible over ASCII data lines, 
and works well when you're transferring 
data to other types of computers. 

Numbering Pages Using The Page 
Icon 
The page icon in the Header automatical­
ly begins numbering pages at 1. You can 
change this by selecting Set Page # ... from 
the Format menu. To eliminate the num­
ber on the first page, select Title Page 
from the Format menu. 

Decimal Tabs Override Regular 
Tabs 

When you drag a decimal tab on to a regu­
lar tab, it automatically overrides the tab 
stop and turns it into a decimal tab. The 
tab marker may look like a regular tab, but 
it will behave like a decimal tab. To get a 
good look at which kind of tab is placed on 



the ruler, click on the tab marker or move 
it around to reveal which tab it really is. 

Command-Backspace Restores 
Backspaced Text 
If you want to restore up to 50 characters 
of text that you backspaced over, press 
Command-Backspace. This is especially 
useful if you want to insert a word with­
out taking your hands off the keyboard. 

Hidden Spaces Can Affect 
Printouts 
If your text doesn't print correctly after 
you've set up tabs for columns, check 
problem lines or columns carefully to see 
if any spaces were mistakenly entered 
there. As soon as these inadvertent spaces 
have been erased, your printouts should 
come out looking the way you meant 
them to. 

Lack Of Disk Space Can Cause 
Printing Problems 
You can run into trouble trying to print 
documents if there isn't enough space 
on the disk to save the document to the 
buffer. If your disk is too full to print, 
either delete some files or else transfer 
the document to a less-overburdened 
disk. In a pinch, you can print a few 
pages at a time. 

Identifying Hookup Problems 
If you're getting the message that your 
document can't be printed, try again, 
watching the dialog box while the Mac 
tries to print. If the Mac displays the 
message "Looking for the Image Writer/ 
Laser Writer" for longer than usual and 
then tells you it can't print your docu­
ment, check all the connections to be 
sure the printer is hooked up correctly. 

When Mac Write Says It Can't 
Print A Document 
If you try to print a document from the 
desktop, only to be told that you can't, 
launch Mac Write by double-clicking 
it. Then, close the new file and open the 
one you want to print. 

MACWRITE 4.6 

New Keyboard Sequences 
When going from Mac Write 4.5 to 4.6, 
there are new keyboard sequences. 
The most noticeable is the use of the 
Cursor keys. 

To go to a point in a text passage, just use 
the Arrow keys. 

To go to the beginning of a line, press 
Command-Right Arrow or Command­
LeftArrow. 

To go to the bottom or top of a page, press 
Command-Up or Command-Down 
arrow .. 

To go left or right a word at a time, press 
Option-Right or Option-Left Arrow. 

Finally, to go up or down a paragraph at a 
time, press Option-Up or-Down Arrow. 
You can select a paragraph, letter, work 
or page by combining these key combina­
tions with the Shift key. 

Numeric Keypad Commands 
The asterisk (*) on the numeric keypad 
helps to highlight characters and words. If 
you select a few characters with the mouse 
and discover that you missed a letter or 
two, the asterisk key extends the selection 
by one character for each press. 
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Extend your selection rapidly by holding 
down the asterisk. 

Command-* (using the asterisk from the 
numeric keypad) selects the entire line 
from the position of the cursor to the end 
of the line. 

Option-* (using the asterisk from the 
keypad) selects one word at a time. 

The + key causes the selection to be made 
to the left of the cursor instead of to the 
right. 

The = and I keys highlight all of the line 
above or below, up to the point directly 
above or below the cursor. 

MACWRITE 5.0 

When The Spell-Checker Tells 
You The Clipboard Is Too Large 

If your Mac doesn't have a lot of extra 
RAM, sometimes running Mac Write 
5 .O's spelling checker might result in the 
message, "The clipboard is too large to 
transfer for use by desk accessories or other 
applications." You won't be able to use the 
spelling checker again until you quit 
Mac Write and then reopen the program 
or file you want spell-checked. 

Picking Up Where You Left Off 
You can zip off to the insertion point you 
last saved at by pressing Enter on the 
numeric keypad when you launch the file. 

MACWRITE II 

Creating Flash Cards 
Here is a simple way to use the Mac to 
make flash cards. All you need is a pro­
gram that prints two columns on a page 
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(or you can do it the hard way and use 
tabs). These instructions are for using 
Claris' Mac Write II, but sophisticated 
word processors such as Word, 
WordPerfect, or Nisus- work just as well. 

1. Create a format with two columns. 
Make sure that if the page were folded 
down the middle, the columns would ~ 
situated on either side of the crease. 

2. Type in the words or phrases in your 
target language -let's say Spanish - in 
the left-hand column. 

3. Do a column break. Directly across 
from each Spanish word or expression, 
type the equivalent in English. Make sure 
that the equivalents are directly opposite 
each other, on the same imaginary hori­
zontalline. 

4. Increase the space between the selec­
tions, either by double-spacing (pressing 
Return twice) or by increasing the line 
spacing. This step isn't essential, but the 
results look better. 

5. Print out the list. You'll have a column 
of foreign words and phrases on the left 
and their equivalents in English on the 
right. 

6. If your printer has a sheet feeder, turn 
the paper over and run it through the 
printer again, head first, printing the 
other side. If you have a continuous form 
printer, make sure the paper is rolled to 
exactly the same point before printing 
each side. 

7. Cut the paper vertically up the middle. 
This yields two strips, each with English 
expressions on one side and their equiva­
lents in the other language on the oppo­
site side. Put one strip away to use if you 
make mistakes in the next step or if you ' 



later lose some of the printed phrases and 
want to make a new set. 

8. Trim off all the excess white paper. 

9. Cut the printed words and phrases 
apart, and mix them up. 

10. Whenever you want to test yourself, 
review, or learn new expressions, just pull 
a slip of paper out and look at one side. 
Mter you've tried the translation, turn the 
paper over to see if you were correct. 

Nifty Smart Quote Feature 
The new Mac Write II has a nifty smart­
quote feature that automatically converts 
the typewriter-style single- and double­
quote marks (like"this") to the more-pro­
fessional-looking curly quotes. 

What do you do if you customarily use 
special foreign quote marks (such as 
guillemets in French, Italian, and 
German)? You can change Mac Write II 
to be smart in any language by changing 
the SMQT resource with ResEdit. Open 
the resource and substitute the 
guillemets (both single and double) for 
the curly quotes. The keystrokes for < < 
and > > are Option-backslash and Shift­
Option-backslash, respectively. The 
keystrokes for < and > are Shift-Option-3 
and Shift-Option-4, respectively. Close 
ResEdit and save the changes you've made. 
Now the program will smartly insert the 
new types of quote marks as you type. 

Simulating Side-By-Side Graphics 
Mac Write II handles graphics well, but 
because it treats a pasted graphic as if it 
were a single typed character, it does not 
support text on the same line as the graphic. 

One way around this problem involves 
Canvas 2.0 or 2.1. Canvas allows the 

creation of three kinds of objects: draw 
objects (MacDraw-like), bitmapped 
painting objects, and text objects. 

You can easily create a graphic in Canvas 
with several lines of text and then import 
it into Mac Write II, using either the 
Clipboard or the Scrapbook. The text in 
the Canvas graphic retains its text-styling 
attributes and, for printing purposes, is 
processed as text by Mac Write II (and 
Adobe Type Manager), including fraction­
al character widths. 

This recognition by both Mac Write II and 
ATM of the text attributes of text in a 
Canvas document even extends to popping 
up an alert box if the appropriate font is 
unavailable (text will print as a bit map if 
the required font is not present). 

The catch is that you can edit the text 
object only in Canvas. Thanks to the 
spelling checker built into the latest ver­
sion of Canvas, it is possible for you to 
check the spelling before the object is past­
ed into your Mac Write document. 

This same technique may also work with 
other combinations of word-processing 
and graphics applications. 

The Trick To Editing Footnotes 
If you place footnotes at the end of a 
Mac Write II document, you will discover 
that the footnote page cannot be fully 
edited. That means that you cannot easily 
add a title, such as "REFERENCES," to 
the top of a page. Claris' technical support 
says that the official solution is to save the 
document as a text file, reopen it, and edit 
the final footnote page as needed. 

A better solution is to create footnotes in 
the usual way- in this case, auto-num-
bered and placed on the last page. Before ' 
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you print, change your footnote prefer­
ences to disable the Auto Numbering 
option. Now place the insertion bar some­
where before the first footnote marker and 
insert a dummy footnote. 

When you are prompted for the footnote 
marker, use a space, which will be invisi­
ble in the body of the text. For the actual 
footnote, type the desired title. It will be 
unnumbered on the footnote page and 
will appear before footnote 1. You can edit 
this title/footnote to change its size, style, 
and ruler configuration so it matches 
other titles in the document. 

If you want to add other footnotes to the 
paper after you have created the tide/foot­
note, do not enable auto-numbering. 
Instead, when the prompt for the footnote 
appears, press Return, and the appropri­
ately numbered footnote marker will 
appear- without disturbing the 
tide/footnote. 

TEACH TEXT 
Placing Pictures In Teach Text 
Documents 
To place pictures in Teach Text docu­
ments, type Option-space where you want 
the picture to appear. The pictures must 
be stored as resources of type PICT in the 
document, copied there by ResEdit. The 
first Option-space is drawn as picture 
1000, the second as 1001, etc. Leave 
enough blank lines after the Option-space 
so the picture does not cover the following 
text. To make the document read-only, 
change the file type to "ttro." Teach Text 
will display additional lines of credits 
while holding down Command-option 
and selecting About Teach Text. 
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NISUS 3.05 
Nonbreaking Spaces 
Sometimes you don't want a sequence of 
characters that includes spaces to break 
between lines at the spaces (for example, 
in a mathematical equation). You can 
avoid this in Nisus 3.05 by using an 
Option-space (called a nonbreaking space 
in other programs). To create such a space, 
hold the Option key down while you press 
the space bar. 

If you want to globally change the spaces 
within a selection to Option-spaces, you 
can do so by creating the following one­
line macro: 

1. Choose New from the Macro submenu, 
on the Tools menu. 

2. Type the words "Find/Replace", fol­
lowed by a space. Type a pair of straight 
(dumb) quotation marks with a space 
between them. Type a second pair of 
quotes, this time with an Option-space 
between them. Type a final set of quotes 
containing an "s" (this tells the macro to 
replace the spaces in the current selection 
only). 

Your macro should look like this: 
Find/Replace 1111111111s" 

3. Save the new macro, and assign a key to 

it. Select the text that you want to change, 
and invoke the macro with this key. 

Doing Windows 
Here's a tip that's very useful if you have 
several windows open simultaneously. 

Press the Command key, and click on the 
title bar of any window (including the 
Catalog and Macro windows). The 



Windows submenu (which you ordinarily 
access on the Tools menu) will pop up and 
show you which windows are open. You 
can then access any window by double­
clicking on its name on the Windows 
submenu. 

Zooming The Unzoomable 
Sometimes you might position a window 
on the screen so that its zoom box in the 
right comer of the menu bar (for resizing) is 
off the screen. However, Nisus lets you use 
the zoom box- even if it's off-screen­
simply by double-clicking on the window's 
title bar. This is true for all of your 
windows, including the Macro, Glossary 
and Catalog windows. 

Making Smart Quotes Stupid 
If you use smart quotation marks a lot, 
you should probably set up your Editing 
Preferences with Smart Quotes checked. 
Then whenever you type an ordinary 
quote (double or single), the correct curly 
quote will be substituted automatically. 

Sometimes, however, you want to insert 
straight quotes (when using the symbols 
for feet or inches, for example). Rather 
than going to the Editing Preferences 
menu and changing the settings each 
time, all you have to do is hold the 
Command key down while you type the 
quotes. Holding down the Command-key 
modifier reverses the Smart Quotes set­
ting for that entry. 

TEXT FILES 
Mac, DOS And Unix Text Files 
Mac text files ("text with line breaks," or 
some such in most word processors) 
terminate each line with a carriage-return 

character, while DOS text files use a 
carriage return and a line feed. Unix, of 
course, is different: it uses just the line­
feed character. Programs that let you 
search for and replace non-printing charac­
ters can be used to convert text files from 
one of these formats to another. Two such 
shareware programs are Add/Strip and 
McSink, both available on Zmac or from 
your local user group. 

WORD 
Mail Merge With The Table 
Feature 
One of the worst aspects of Microsoft 
Word's mail-merge feature is all the 
stupid punctuation rules you have to fol­
low. Trying to make sure you have quotes 
and commas in all the right places often 
isn't worth the effort, and it can make 
inputting addresses sheer hell. If you use 
Word's Table feature to create the data 
documents for the merge, however, you 
can put the entire address- including 
commas and Return- into one cell. Not 
only do you avoid having to enclose fields 
containing punctuation with quotation 
marks but you also don't need to use as 
many fields, because all address informa­
tion (company name, street, city, state 
and ZIP code) is contained in one cell 
under one field name. Unfortunately, you 
can't use the Table format if you want to 
sort your data by its parts, such as by ZIP 
code or city. 

Fast Save Uses Disk Space 
Microsoft Word has a Fast Save feature, 
which lets you save files relatively quickly 
in exchange for greater disk-space con-
sumption. When the Fast Save option in ~ 
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the Save As dialog box is checked, 
Microsoft Word doesn't actually delete 
text or gmphics that you remove from a 
document; it just skips over them when 
you're displaying, editing, or printing the 
document. So, files don't get smaller when 
you delete things from them, and there is 
more overhead when you add new infor­
mation. When you choose Save As and un­
check the Fast Save check box, Microsoft 
Word actually erases all the deleted infor­
mation, so the file size should decrease. 

Spell-Checking Without Putting 
The Cursor At Document Top 
It's possible to run your spelling checker 
on a Word document without having to 
move all the way back to the beginning. 
First, select the entire document by mov­
ing the cursor to the left margin, where it 
changes into an arrow, and then click the 
mouse while pressing the Command key. 
When you run your spelling checker, the 
entire document will be checked in a sin­
gle pass, without the annoying "Continue 
Check from beginning" message. 

Re-spaclng Between Letters 
Word creates its own "normal" spacing 
between letters, based on the type and size 
of the font you're using. The problem is, 
sometimes the spacing created isn't exactly 
what you want. 

You can fix spacing between letters by 
selecting the text you want to change, 
choosing Character on the Format menu, 
and then selecting Expanded when the list 
of options appears. The program will sug­
gest an expansion amount in the By box. 
Override this suggested spacing by typing 
in any value from .25 to 14 points. As you 
experiment with different results, you'll 
find the re-spacing that works best for you. 
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Biding Outline Headings 
People who compose a lot of outlines will 
be vexed to find that most headings must 
be left out of the finished product. You 
can delete the outline headings manually, 
but in a long document this can be 
extremely time-consuming and can hin­
der your efforts to revise the file later. 

A solution is to use Define Styles to create 
a style sheet on which all outline styles are 
based. Its style would be the same as 
Normal Text. Using Define Styles again, 
you can define each of the subsequent out­
line styles as being based on this "normal" 
style by entering that name in the "based 
on" box. Now, any changes you make to 
the definition of the base style will auto­
matically be made to all outline styles. 

When you've finished composing and 
want to hide the outline, choose Define 
Styles and add Hidden Text to the style 
definition. All outline heads will vanish, 
unless you select Show Hidden Text. 
When you print documents created with 
this method, be sure Print Hidden Text 
isn't selected in the Print Dialog Box. 

"Auto-Date" Headers And Footers 
Can Be Copied Or Pasted 
Anywhere In A Document 
When you paste "auto date" headers and 
footers anywhere you want in your 
document, it continues to change 
automatically whenever you start a new 
document. This is especially useful if 
you work from templates. 

The "auto-date" can be distinguished from 
text by using the Show Paragmph com­
mand (press Command-Y), which displays 
a dotted outline around all "auto-dates." 



This also works for time and page number­
ing. As an extra shortcut, try pasting 
"auto-date" into your glossary and then 
add it to your Work menu. 

KeySttok~ForUneFonooattmg 

In Word, the Return key is used to end a 
paragraph, while Shift-Return is used to 
end a line without creating a new para­
graph. Shift-Return works fine as long as it 
isn't used in a justified paragraph. In the 
latter case, the line created with Shift­
Return is justified- something most peo­
ple will want to avoid. And you can avoid 
it by pressing Shift-Option-Return. 

This undocumented method of concluding 
a line is very useful for lines within a 
justified paragraph that, for example, are 
to contain only a mathematical equation 
located at a center tab. It's also the only way 
to create the appearance of multiple 
justified paragraphs within a single box. 
Simply apply the boxed format to the para­
graph and conclude each pseudo paragraph 
within the box with a Shift- Option­
Return. The concluding line of each " 
paragraph" will not be fully justified. 

Incidentally, the Shift-Option-Return 
symbol that appears when Show is active 
looks just like the Return symbol. 

Acc~sing The Image Writer's 
Bullt-In Fonts 
Word provides an easy way to access the 
Image Writer's built-in fonts. In the 
lower-left corner of the Word window is 
a rectangular box that usually contains a 
shadowed page number. Click in this box 
and the word Code appears. This invites 
you to type a decimal (not hex) character 
code. Press Return to place that character 
in the text. 

The decimal code for the escape character is 
27 (this appears as a small box in your 
Word document). To access the variety of 
special fonts and font sizes built into the 
Image Writer, simply add the escape codes 
at the beginning of your document and, if 
desired, at other points in your document. 
To do this, click in the Page box, type 27 in 
the place of Code, and press Return. Then 
in the main window, right after the small 
box that should now be showing, type the 
letter that will tell the Image Writer what 
to do. Here's a partial list: 

Esc n (Extended character set = 9 cpi) 

Esc N (Pica = 10 cpi) 

Esc E (Elite= 12 cpi) 

Esc p (Pica proportional) 

Esc P (Elite proportional) 

Esc e (Semicondensed = 13.4 cpi) 

Esc q (Condensed = 15 cpi) 

Esc Q (Ultracondensed = 17 cpi) 

Esc A ( 6 lines per inch) 

Esc B (8 lines per inch) 

When you're ready to print, make sure 
that you have Typewriter selected in the 
Chooser. Do not choose Image Writer. 

Condensing The Space Between 
Itallcized Characters 
Sometimes Word puts too much space 
between italicized words (especially if 
each word is capitalized, as in subheads or 
titles). Simply condensing italicized type 
usually results in squished type. But if 
you turn on Show from the Edit menu, 
you can select the space markers between 
the words and condense only them by 
using the Condense feature found in the 
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Character dialog box. You can condense 
by anything from 0 to 1. 7 5 points. After 
you've highlighted the first space mark 
and condensed it, go on to the next space 
mark, highlight it, and press Command­
A ("Again") so you don't have to reenter 
the values in the dialog box. 

Dialog Box Command Keys 
Word allows users to substitute command 
key combinations for mousing in all dia­
log boxes. Any dialog box can be canceled 
by using Command-period. 

In The Save As ... dialog box: 

Command-S saves the file; 
Command-C cancels; 

In the Open ... dialog box: 

Command-O opens the highlighted 
file; 
Command-C cancels; 

In the OK or Cancel dialog box: 

Command-O presses the OK button; 
Command-C cancels the box. 

In the Find ... dialog box: 

Command-F finds the next. 

In the Change ... dialog box: 

Command-C selects Change Selection 
or Change All. 

Creating Double And Triple Unes 
In Word 
Set Below and Double borders on the 
Paragraph selection under the Format 
menu to create a double line underneath a 
paragraph. For a really interesting effect, 
go to the paragraph directly below the 
double-underlined one and set the borders 
for Double and Above. The results will be 
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three horizontal lines. 

Changing Your Personalization 
Of The Master Disk 
Word lets you "personalize" your 
master disk by entering your name 
and/or organization into a dialog box. 
Unfortunately, once you do, all future 
backup copies will display this informa­
tion in an Info box as soon as you open 
the application. Even though Word's 
documentation states that your disk will 
be "permanently marked," you can 
change the personalized information 
display pretty easily using a file editor 
like FEdit or ResEdit. 

First, display Word's data fork with 
FEdit. Pull down the Options menu and 
select SET EOF or SET END OF FILE. 
Then select ZERO, which eliminates 
Word's data fork. 

The next time you run Word, it will 
prompt you to enter the "personal" infor­
mation again, as if you had a brand-new 
master copy. (This also works with the 
personalization screen ofExcel.) 

Making Your Own Dictionary 

To make your own dictionary for Word, 
all you need to do is open a new Word 
document and start typing your dictio­
nary (one word per line). Then do a Sort 
(not necessary, but a good idea to get 
things in some kind of order), and save 
the document as Text Only. Then, using 
Disk Top, ResEdit or a similar utility, 
change the file Type from TEXT to DICT. 

To have more than one dictionary open, 
select Spelling from the Utilities menu 
(or press Command-L), and get the Start 
Check dialog box; then choose Open : 
from the File menu (or press Command-



0). You can then open the new dictionary 
plus any other DICT file you desire. 

You can add new words to your new 
DICT by using the Add feature; or if you 
want to do a batch add, you can reverse 
the process- that is, change the file Type 
to TEXT, add/edit, and then change 
back to DICT. 

Finding 1he Next Occurrence Of 
A Format 

To find the next occurrence of a font or 
character format, put the insertion point 
within an example of whatever format 
you're searching for and type Command­
Option-Q. Word will then search for the 
next appearance of text with the same for­
matting as that around the insertion point 
and select it. 

To make using style sheets faster, you can 
add unique letters or numbers to your 
style-sheet names that let you call them 
up by these characters rather than the 
sheet's full name. 

Open the Define Styles dialog box, select a 
style sheet, type a comma after the sheet's 
name, then enter the character you want 
to use. The next time you want to apply 
this style, just type the abbreviation. 

Placing A Box Around Text 
Here are two ways to place a box around 
text while in Word. 

If the text isn't justified, select all but the 
last paragraph to be boxed and then use 
the Change command to replace all the 
paragraph markers ( Ap) with line returns 
(An). This tricks Word into thinking it's 
looking at one large paragraph, so you can 
now apply whatever formatting you like 
from the Paragraph Dialog box. You can 
do the same thing with justified text, but 

to prevent partial lines from spreading 
across the page, replace the normal spaces 
with non-breaking fixed spaces (Option­
spacebar or Command-spacebar). 

For paragraphs that have different mar­
gins or indents, you can use Side by Side 
formatting to create your boxes. Insert a 
graphics box in its own paragraph above 
the paragraphs to be boxed, making 
sure that its left margin lies to the left 
of the text you want to enclose. Size the 
box to the appropriate width and 
length, and then add whatever outline 
formats you wish. Select the box and the 
paragraphs and apply the Side by Side 
Paragraph format. You can check the 
results in Page Preview and resize the 
box as necessary. 

Memo Magic 

You can create a memo template, add it 
to the Work menu and have it ready to 
go every time you need to create a cus­
tomized memo. 

Word has a built-in mechanism for gen­
erating dialog boxes and collecting data 
from users. It's called the ASK command, 
and it's part ofWord's Print Merge fea­
ture. The command goes like this: 

<<ASK fieldname=? Message to be 
shown in dialog box>>. 

To do this, create a memo template the 
same way you'd create a mail-merge 
document, with field names ( < <RECIP­
IENT>>, <<REGARDING>>, and 
the like) representing the stuff that'll 
change from memo to memo. Then at 
the beginning of the document, just 
write an ASK statement for each field: 

<<ASK RECIPIENT=? So who's this 
going to, Doc?>> 
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To generate a memo, open the template, 
select Print Merge, and click on the 
New Document button in the Print 
Merge dialog box. Word then throws 
dialog boxes onto the screen, asking for 
the info for each field and merging it 
into the new memo document. Move 
the memo template into the Work 
menu, and you have a customized 
memo at your fingertips. 

If you really want to automate the custom 
memo, have a macro call Word. Just 
record a macro that selects the template 
from the Work menu and performs the 
merge commands. 

Placing A Background Screen 
Behind A Paragraph 
There are times when you may want to 
accent Word paragraphs with a back­
ground screen. The following PostScript 
command, placed before a paragraph, will 
do the job: 

para. 0 0 moveto 0 1 000 rlineto 1 000 0 
rlineto 0 -1 000 rlineto closepath gsave 
.97 setgray fill grestore 

This instruction must be in PostScript 
style, which is one ofWord's automatic 
styles and can be applied by entering 
PostScript in the Define Styles dialog box. 
The value 1000 will handle any paragraph 
up to 13 inches square, but if you want a 
smaller area, which will also print faster, 
you can pick a more realistic value by 
multiplying the number of inches by 72 
and using that result. You can adjust the 
intensity of the gray scale by changing the 
.97 next to setgray. The closer this value is 
to 1, the lighter the screen. Word consid­
ers the space above and below your para­
graph to be part of it, so some white space 
may get filled unless you use the Paragraph 
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command and set this space to zero. 

Printing Legal-Sized Documents 
On The Laserwriter 
You might find that trying to print legal­
sized Word documents on a Laser Writer 
results in the top two inches of text being 
cut off. The solution to the problem is to 
select a larger printing area. 

Just hold down the Shift key when you 
choose Page Setup. After selecting Legal 
Size, click the Option button. Choose 
Larger Print Area from the Option menu. 
Your documents should print without 
any problems. 

WORD3.0 
PostScript Code To Place 
A Border Around A Page 
Here's a PostScript sequence that places a 
border around an entire page: 

page. 
/wp$new [ newpath 36 36 moveto 
wp$x 72 sub 0 rlineto 0 wp$y 72 sub 
rlineto wp$x 72 sub neg 0 rlineto 
closepath ] def 4.0 setlinewidth 
wp$new stroke 

This sequence places a box with a 4-point­
wide border indented 36 points from 
every edge. The number 72 is simply 2 x 
36. Change 36 to 72 and 72 to 144 to 
achieve a 1-inch border and modify the 
number before the word setlinewidth to 
suit your needs. 

Marking A Document Draft 
If you want to mark a draft Word docu­
ment to print out on a Laser Writer as 
such, insert, in PostScript style, the text ; 
below in a header before the normal head­
er information. You can also insert this 



code just before the first paragraph on 
each page of a document, but putting this 
into the header saves you a lot of pasting 
and formatting. And in case you need 
reminding: to format this text in the 
PostScript style, select it, go to the Define 
Styles menu, and type PostScript. 

page. 
/TM {wp$y wp$top sub} def 
/LM [wp$1eft] def 
/RM {wp$x wp$right sub} def 
/printline TM 1 00 sub def 
/putcenter 
{dup 
RM LMsub 
exch stringwidth pop sub 
2divLMadd 
3 -1 roll moveto} def 
/AddToPath 
{ putcenter 
true charpath 
} def newpath 
mmes-Bold findfont 140 scalefont 
setfont 
printline (D) 
AddToPath 
printline 140 sub (R) 
AddToPath 
printline 280 sub (A) 
AddToPath 
printline 420 sub (F) 
AddToPath 
printline 560 sub (T) 
AddToPath 
gsave 
0.9 setgray fill 
grestore 

When you print your document, this 
code will place the letters "DRAFf" 
centered down the page in a light gray. 

Numeric Keypad Equivalents 
Here are some shortcuts for working with 
numeric keypads: 

I repeats the last thing you did. 

* scrolls down one line when pressed and 
released, or scrolls continuously when 
held down. 

+ scrolls up one line when pressed and 
released, or scrolls up continuously when 
held down. 

-extends the selection to the next occur­
rence of any item you enter, such as char­
acters, paragraphs, number signs, bullets, 
etc. 

= finds the next Search Item, even if 
you've cancelled the Find dialog box. 

0 returns the cursor to its last three loca­
tions, one location for each press of the 
button. 

5 returns to the regular screen from Page 
Preview. 

WORD3.0X 
Shortcuts When You "Save As ••• " 

There are a number of keyboard shortcuts 
you can take if you'd rather work through 
the keyboard than the mouse: 

Command-S saves the file. 
Command-E ejects the disk. 
Command-C cancels the dialog box. 

In the Delete dialog box, the same com­
mands work, except that Command-S 
activates the Delete command. 

Using MacDraw To Convert 
Typed-In Capitals To Lowercase 
Letters 

Word can't convert text that was typed in 
capitals into lowercase letters. Pressing 
Command-Shift-K toggles between text ~ 
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"as typed" and all uppercase, but it doesn't 
convert text initially typed as capitals into 
lowercase letters. Also, the capitalizing 
effect can't be used in a document saved as 
"Text Only." There's a work-around to 
this problem if you have a copy of 
MacDraw: 

Text copied from Word can be pasted into 
MacDraw. Then, select the pasted text 
while in MacDraw, and choose Lowercase 
from the Style menu. Then, copy the text 
and paste it back into your Word docu­
ment. The text will now be permanently 
saved as uppercase letters ... even if you 
save the document as Text Only. 

Using Uppercase Commands 
When You're Using Capitals In A 
Document 
If a large amount of your document is 
going to be typed in capital letters, use 
the All Caps character format (Command­
Shift-K) instead of the Caps Lock key. 
This lets you check your text for spelling 
errors without deselecting the default 
Ignore Words in All Caps setting, and 
also lets you change the text back to nor­
mal lowercase format (including proper 
nouns, as long as you remember to Shift 
when you type) by removing the All Caps 
selection. 

Creating Structured Footnotes 
The footnote command may be very use­
ful, but if you try to create scientific struc­
tures such as " ... can be found in several 
review articles 1-12" can be a trying expe­
rience. You can work around this limita­
tion by using Word's hidden text feature. 

While typing a manuscript, use the foot­
note command to enter all of the foot­
notes. Separate the first and second foot-
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note numbers with a hyphen or an em 
dash, and then separate the rest of the 
footnotes with commas. This creates a list 
of reference marks that display as " ... can 
be found in several review articles 1, 2, 3, 
4, 5, 6, 7, 8, 9,10, 11, 12." 

Next, select the second through the next­
to-the-last numbers, including the last 1 

comma (in this example, 2-11). Format 
the selection as Hidden text, using the 
Character command in the Format menu 
or by typing Command-Shift-x. The 
modified sentence displays and prints as· 
" ... can be found in several review articles 
1-12" when the Show Hidden option in 
the Edit Preferences dialog box is not 
selected. 

Creating A Solid Underline 
When using Word to create a form, you 
can't rely on using a series of typed under­
line characters to create a solid line. Some 
fonts show the line on-screen as being 
solid, but when you print them out the 
results will be far less even. To make a 
solid line that stays solid when you print 
it out, set Underline as your style and then 
type in blank characters with the space . 
bar. If you press the Command key whil~ 
typing, you'll create "hard" spaces, which 
the program will keep on the same line. 

How To Keep Outline Entries 
Intact. 

When an outline is renumbered, so are 
entries that start with numbers. A work­
around is to choose Styles from the 
Format menu to set the font for your 
various outline levels to some font that 
doesn't use the square symbol (the one you 
get when you press Option-H). Palencia is 
one such font. 



Every time you type a number which 
starts an entry in the outline mode, pre­
cede the number with the Option-H 
square. When you renumber and leave the 
outlining window, the square characters 
will disappear. 

This allows your outline to print, and you 
won't lose any of the data or text you 
entered. 

Copying Parts Of A Style Sheet 
It's possible to copy one or just a few styles 
from one Word document's style sheet to 
another, without bringing in the entire 
style sheet. First, open the document that 
contains the style(s) you want to copy. 
Select a paragraph that's formatted in that 
style (to copy several different styles, copy 
a series of paragraphs). 

Now, open the document to which you're 
going to copy the styles, and paste the para­
graphs into the style sheet. The new styles 
are now a part of the old style sheet. Now 
you can delete the text you pasted in, and 
the styles will remain in the document. 

Spell-Checking Around ligatures 
If you use a lot of fi and B ligatures in 
long documents, you'll save time run­
ning the spelling checker by replacing 
the character pairs "fi" and "fl" with the 
ligatures AFTER the spell-checking is 
completed. 

The spelling checker can't recognize 
ligatures as alphabetic characters, and 
you can't add words that contain them 
to your dictionary. So, if you put the 
ligatures in before running the spelling 
checker, the program regards any 
remainder of a ligature word to be mis­
spelled - unless the remainder happens 
to match a word in the Main dictionary. 

After the spelling checker has finished run­
ning, go to the start of the document 
(Command-Keypad 9), open the Change 
dialog box (Command-H), set the 
replacement parameters, select Match 
Upper/Lowercase, and click Change All. 

Avoiding Disk-Swapping Hassles 
A lot of people use several different docu­
ment disks during a single work session. 
If you do, and you work on a floppy disk­
based system, you can avoid a lot of disk­
swapping by double-clicking on the 
Word application, instead of a document, 
when you start working. 

Correcting Pagination Problems 
With Serial Printer Drivers 
When you use the serial printer driver 
with either a 12- or 15-pitch printer, you 
must first set the line spacing for all 
paragraphs, or the pagination will be 
incorrect. When you create a new 
document, first go to the Paragraph dia­
log box under the Format menu and set 
the line spacing to 12 points instead of 
the default spacing, "auto." 

If you are having problems printing 
an existing document, select the entire 
text and then go to the Paragraph dia­
log box and do the procedure described 
above. 

Twelve is the proper setting to emulate 
a single-spaced typewriter which 
produces 6lines per inch. To emulate 
other spacing, set a value of72 divided 
by the number of lines per inch. 

Pasting Some Graphics Can 
Cause Problems 
When pasting a graphic from an object­
oriented program (such as MacDraw), 
you might experience some problems if ~ 
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the graphic's rightmost element is aver­
tical line. To get the line to appear, place a 
non-printing character, like a space, just 
to the right of the line. The character 
won't show up when you print the docu­
ment, but Word will no longer think that 
the line is the rightmost object on the 
screen, so it will allow the entire drawing 
to be pasted in. 

Speeding Up The Graphic 
Redrawing Routine 
Word can take what seems like forever to 
redraw a complex graphic, especially one 
that has had smoothing activated for its 
curves. You can avoid this by creating a 
special Graphics style for each graphic, 
and including Hidden as one of its charac­
teristics. Make sure that your Preferences 
setting has Show Hidden Text set to Off. 
Now, you'll be able to quickly scroll 
through and edit text in the document, 
without having to wait forever for graph­
ics to redraw. 

Just remember to redefine your Graphics 
style by cancelling the Hidden character­
istic before you print or repaginate. 

Printing Long Documents With 
Page Numbers 
The Word manual describes a rather 
involved procedure for people who need to 
print long documents (meaning docu­
ments composed of several Word files) 
that have page numbers. One particularly 
annoying hoop you have to jump through 
is having to repaginate each part of your 
document, finding out what its last page 
number is, and then having to set up the 
next file so that it starts with the next 
page number. 
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There is a work-around to this situation. 
Choose Page Setup for each file, and type 
the file name of the next file, as the manual 
says. Then, WITH THE EXCEPTION 
OF THE FIRST FILE of the set of files 
composing the document, blank out the 
Start Page Numbers At box. That is, lea~e 
a 1 in the Start Page Numbers At box for 
the first file, and erase the 1 in that box for 
all the other files. Now, reopen the first file 
of the document and tell the Mac to print. 

The entire document will print out with 
the right pagination, without your hav­
ing had to repaginate each file. 

This only works if you begin printing with 
the first file of the series. If you print a file 
that appears in the middle or end of the set 
of document files, you'll have to follow the 
instructions in the Word manual. 

Cleaning Up Returns In Print­
Merge Documents 
When creating a list of names or address­
es, for example, for print-merging in 
Word, making sure you have appropriate­
ly "Commanded" and "Shift-Returned" 
each and every set of data can be unnerv­
ing. (Remember a Return is only entered! 
at the end of each record, while a Shift- , 
Return may be used for arranging the dam 
more logically.) To eliminate most of the 
problem, you can use the Document 
Renumber command to number each set 
of data which isolates the entries with just 
a Return instead of the desired Shift­
Return. Where you find the erroneous 
Return, put the cursor in front of the entry 
and press the Delete key, then press Shift­
Return. Using the Document Renumber 
command also lets you know just exactly 
how many names or addresses you have. 



Changing The Length Of Word's 
Menu Tides 
You can't change Word's menu titles to 
something less verbose with a utility 
such as ResEdit, because Microsoft 
doesn't use menu resources. So, use a file 
editor such as FEdit and perform an 
ASCII Search for the capitalized word 
"Document ... This reveals the program 
area where the names of menu titles are 
stored. Each title is preceded by the 
length of the tide. For example, change 
the 8 in front of"Document .. to 3, then 
issue the command WRITE SECTOR. 
That's it. Using this technique, you can 
completely rename or shorten Word's 
menu titles. If you rename tides, make 
sure your new titles are no longer than 
Word's old ones. 

When You Get The "Missing 
Comma In Data Record" Error 
Message 
Word's Print Merge capability requires 
that you separate field names with com­
mas or tabs. Unfortunately, when you 
accidentally omit one, the program sim­
ply puts up an error message, without 
telling you where your comma might be 
missing. Instead of going through each 
and every record you're working with, you 
can use this shortcut: 

Count the number of commas in 
the header record, and then use the 
Change command to systematically iso­
late the record that's missing a comma. 
You do this by entering a comma into 
both the Find What box and the Change 
To box. Then select sections of records 
and start searching. 

Word counts the number of changes that 
it makes, and puts that number into the 

lower left corner. If the number of changes 
is not evenly divisible by the number of 
commas in the header record, you know 
that the defective record is somewhere in 
the records you just selected. If the num­
ber is evenly divisible, you can move on 
and select another section. 

Continue this process until you narrow 
down the data records sufficiently to iso­
late the one or more records with missing 
commas. 

Finding The Missing Comma in 
A Data Record 
The easiest way to find a missing comma 
in a data record, while doing a Print 
Merge, is to select the New Document 
button in the Print Merge window. This 
creates a document on the screen. When 
you come across the "Missing Comma in 
Data Record .. dialog box, quit the 
Merge and scroll the document to the 
last record. The next record in your data 
file is the one with the problem. Once 
you have a successful Merge to the 
screen document, select Print and you 
are assured of printing the entire batch 
successfully. 

One Way To Count Words 
Here's one way to count words in Word 
3.0and 3.01. 

Make a copy of your document and use 
that, as this procedure will change the 
document. Select Change from the Search 
menu. Enter w (the white spaces) in the 
Find What box and n (end-of-line marks) 
in the Change To box, then choose 
Change All. When this operation is com­
plete, you'll find the number of changes 
(which is very nearly the number of 
words) in the lower left corner. 
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If, by mistake, you do this on your origi­
nal document, all the words will be 
arranged in a column. Save the situation 
by closing the document and clicking 
No when the dialog box asks if you want 
to save the changes. 

How To See The Size Of A Flle 
Without Returning To The Finder 
Here's a good way to see how big (in K) 
your Word 3.0x files are. This method 
works without having to return to the 
Finder. 

Start by saving the document. Then 
close its window and choose Delete from 
the File menu (if you don't see Delete, 
that means you're in Short menus and 
must change to Full or Normal menus). 
Select the document you wish to see the 
size of from the list. The size will be 
shown under the buttons. This size is 
rounded down to the nearest kilobyte. 
(That's different from the Finder, which 
displays the size to the nearest K rounded 
up; and Get Info, which shows the exact 
size in bytes. Here's an example: The file 
is actually 9728 bytes long. Get Info will 
show that number or 9.5K; the View 
option of the Finder will show 1 OK; and 
the Delete dialog will show 9K.) 
Remember to hit the Cancel button after 
you check the size. 

Accessing Help Fast 
You don't have to dig out your manual 
every time you need help, if you have 
Apple's Extended Keyboard. The key, 
labeled "Help," is right under the F13 
key. When you press it, you'll see a ques­
tion mark appear. This is your cursor. 
Move it to whatever you want explained, 
including menu choices, and then just 
click the mouse for the help you need. 
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If you don't have the Extended Keyboard, 
press the Command key and and the ? 
key to get the question cursor. 

WORD3.01 
Word Features Not Appearing lnl 
The Menus 
Word 3.01 has several features that are 
only accessible through the use of special 
key combinations. These features normally 
never appear in menus. Yet, working with 
the program would often be simpler if 
they did. 

Let's take the example of Insert 
PageBreak. The only way (normally) to 
access this feature is to type Shift-Enter. 
Here's how to make this feature a menu 
choice. Start with a blank document. Be 
sure you are in Full Menus mode. Type 
Shift-Enter to produce a forced page 
break. Select the dotted line that results 
by clicking in the Selection Bar (the col­
umn at the left of the screen where the 
cursor points northeast instead of north­
west). Then choose Glossary from the 
Edit menu. Type in a descriptive name, 
such as "PageBreak," and click on the 
Define button. Next, press Option­
Command-+ (plus sign) and click on the 
name Pagebreak in the glossary list. A 
Work menu will be created (or added to, 
if you already have one), in which the 
new glossary entry will be found. Now 
whenever you want to insert a page 
break, just go to the Work menu and 
select one. 

This method will work with the other 
key combinations Word forces you to 
memorize. These include: Section Mark 
(Command Enter), End-of-Line Mark 



(Shift-Return), Optional Hyphe 
(Command-hyphen), Non-breaking 
Hyphen (Command--). 

WORD3.02 
Repaginating Without Crashing 
Using Word 3.02 And The 
Laserwriter n sc 
Opening a document in Word 3.02 and 
then doing any procedure which repagi­
nates the text causes a Bomb message and 
a crash. 

To correct this, select the Laser Writer II 
SC driver using the Chooser every time 
you open Word. Do this even if the 
Laser Writer II SC driver is the only one in 
the System folder, and it's already been 
chosen while you were in the Finder or 
another application. Once you've chosen 
the Laser Writer II SC while in Word 3.02, 
you'll be able to switch applications and 
print with no further problems. 

Swapping Adjacent Paragraphs 
Want to swap the positions of two adja­
cent paragraphs quickly, without using 
multiple executions of Cut, Copy, and 
Paste? 

Highlight the paragraphs and check the 
alphanumeric position of the first word 
in each paragraph. Then use the Sort 
command (Word will sort in ascending 
order) or Shift-Sort (descending order) 
according to the alphanumerics. With a 
little forethought, you can figure out 
how to move two paragraphs around a 
third paragraph that separates them. 

You can also install markers at the heads 
of as many paragraphs as you wish to 
rearrange. Use Sort, and remove the 

markers when you're finished. The varia­
tions of Sort are endless once you get the 
hang of this useful and underused tool. 

Bonus Disk 
Word 3.02 and above come with a Bonus 
Disk, with aDA called Word-Finder (it 
may not work with System 7). The the­
saurus only works with Word or the 
Finder- it only functions if the informa­
tion in the About ... box of the active 
application says "About Microsoft 
Word ... ", "AboutMSWord ... ", "About 
Word ... ", "About Finder ... ", or "About 
DAs .. .': 

Using ResEdit, you can customize 
WordFinder to work with any application 
that has a MENU resource. First, open 
ResEdit and then open the desired appli­
cation. Open the application's MENU 
resource and open MENU ID= 1. Change 
the first menu item to "About Word ... , 
(with three periods!) and save your 
changes. WordFinder can now provide 
you its riches in the modified program. 

Using The ASCH Code Search­
And-Replace Capability 
Microsoft Word 3.02 and above have an 
ASCII code search-and-replace capability 
that can come in handy when using 
Word to edit and reformat text files cre­
ated on an IBM PC or PC clone. To find a 
particular ASCII code within a Word 
document, type a caret (Shift-6) followed 
by the decimal value of the ASCII code 
in the Find What dialog box. Here's how 
to use this feature to fix a typical PC text 
file imported into the Mac environment 
(always work on a backup copy of the file 
you wish to convert): 

1. Select Change from the Search Menu 
(Command-H). ~ 
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2. Replace the double carriage-Return I 
line-feed (CRILF) pairs at the end of each 
PC text paragraph with a special Mac 
character as follows: click the I-beam to 
the left of the first character in the file. In 
the Find What box, type A13A1 ()A 

13A1 ()A (13 is the decimal value of the 
ASCII carriage-return code; 10 is the 
decimal value of an ASCII line feed). 

3. In the Change To box, type Option-S 
for a bullet ( •) or another special Mac 
character not used in the file. Click Start 
Search or Change All to make the 
changes. 

4. Now, replace the CRILF codes at the 
end of each line within paragraphs with a 
space: with your insertion point at the top 
of the document enter A 13 A 10 in the 
Find What box; in the Change To box, 
type one space; and then click Start Search 
or Change All. 

5. Finally, go back and replace the special 
Mac characters (used to mark the end of 
PC text file paragraphs) with a Return. 
First click the !-beam at the top of the file. 
In the Find What box, type a bullet (or 
whatever special character you used). In 
the Change To box, type Ap (a caret fol­
lowed by a lowercase p represents a Word 
Return character). Click Start Search or 
Change All as before. 

You can also use this ASCII code search 
feature to fix PC word-processing docu­
ments within Word. For example, some 
PC documents contain normal text with 
only occasional ASCII control codes (such 
as decimal value 12 for form feeds or 9 for 
tabs). Use FEdit Plus or another Mac file­
editing utility program to examine the 
codes in the PC document, and then use 
this technique to search for and delete 
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these codes within Word. For a complete 
list of the decimal values for all ASCII 
codes, see the Appendix in the Microsoft 
Word manual. 

By the way, the reverse of this process 
works as well. You can replace return 1 

characters in a Word text file with ASCij 
CRILF codes. This allows you to create 
readable text files for your PC friends and 
customers without leaving your Mac. 

WORD4.0 
Slow Save In Word 
Other applications, such as Correct 
Grammar and PageMaker, seem to hate 
documents saved with Word's Fast Save 
feature. If you want to eliminate the Fast 
Save feature in Microsoft Word, add the 
Fast Save Enabled option to the File menu 
using Word's Commands feature and then 
un-check it. 

To accomplish this, choose Commands 
from the Edit menu. Scroll until you see 
Fast Save Enabled, and place this item in 
the File menu. Then select the Fast Save 
Enabled item under the menu you place1 
it in so that it does not have a checkmar~ 
next to it. 

Fitting Long Entries In Mall 
Merge Fields 
As you're creating the data file, you might 
well find that some of your entries are too 
long or that they just don't fit the pattern 
you've established in the header informa­
tion. You can get around this problem by 
breaking the field entry into two or more 
lines with a soft Return (Shift-Return). 

If you enter a soft Return, the mail-merge 
will bring that onto the next line withou~ 
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disrupting the field order. Be sure to save 
the data file as a normal Word document­
soft Returns are stripped out of ASCII 
documents. To see the difference in a 
Word data file, just be sure that Show 
Paragraphs is on. 

Spacing Paragraphs In Styles 
One useful aspect ofWord's style-sheet 
feature is its ability to assign a space 
before and/or after a paragraph to a style. 
A space before and after in a style defin­
ition lets you maintain consistent spacing 
between elements such as body text and 
section titles throughout a document. 

If you assign Space Before to a style, how­
ever, and a paragraph with that style 
begins at the top of a page, Word adds 
the extra space at the top of the page, 
leaving a gap. As a result, the top margin 
for that page appears to be shifted down, 
making it inconsistent with the other 
pages. Unfortunately, the only way to 
avoid this unwanted result requires 
manual labor: 

1. Place the cursor in the paragraph with 
the unwanted space. 

2. With the Paragraph command, change 
Space Before to 0 points. 

Word removes the extra space at the top of 
the page. 

Note: Because page breaks can change 
while you're editing a document, it's wise 
to wait to make this correction until 
you're ready to print a final draft. 

Boxing In Text 
Just about any currently available word 
processor offers a variety of ways to for­
mat words to make them stand out from 
the main body of the document. But 

what do you do when underlining or 
boldface or even something as exotic as a 
shadow doesn't fit the bill? Try a box! 
Here's how: 

1. Select and format the text to be boxed. 
(Note: After it's been boxed, the text itself 
can't be reformatted.) 

2. Use Command-Option-D to copy the 
selection to the Clipboard as a graphic. 

3. While the text is still highlighted, use 
Command-V to replace it with the graph­
ic image of the copied selection. 

4. Click on the graphic to select it, and box 
it in by choosing the Outline style from 
the Format menu (Command-Shift-D). 

You can also add shadow or boldface for­
mat to the outline style for extra empha­
sis. The secret here is that the style com­
mands don't work just with text- which 
is what most people assume- they also 
work with graphics. 

If the boxed text is on a line with other 
text, it will sit higher, because the bot­
tom of the box sits even with the baseline 
of the text on that line. To correct this, 
select the graphic, choose the Character 
command from the Format menu 
(Command-D), select subscript, and off­
set the text as needed (the larger the font 
size, the greater the offset required). 

Using PostScript Code To Shade 
A Cell 
You can use PostScript code to shade a cell 
in a Word 4.0 table by typing: 
cell. . 75 setgray wp$box fill and 
pressing Enter. Then select the text, and 
format it with the PostScript style by 
pressing the Shift key and selecting 
Define All Styles from the Format menu. ~ 
You can replace the number . 7 5 with 
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whatever number you choose. Make sure 
that you have deselected Print Hidden 
Text in the Print dialog box. 

Adding Words To A Dictionary 
Here's a relatively easy way to add large 
groups of words to Word's dictionary. 
Create a file containing the words you 
want to enter. Then select Spelling from 
the Utilities menu in Full Menus. Select 
the dictionary to which you want to add 
the words. When the first word is 
queried, create a macro (with your macro 
program of choice) that clicks on the + 
button and then on the Continue button. 
Assign a keystroke for the macro, and 
press it as necessary as you continue to 
check spelling in the document. 

You'll find that this also makes your regu­
lar spell-checking go faster, because you 
don't need to reach for the mouse when 
you add words to the dictionary. 

Viewing Landscape Tables 
Here's a tip for creating full-page land­
scape-oriented (horizontal, not vertical) 
tables in Microsoft Word when using a 
small-screen Mac. This tip avoids the 
constant (and painfully slow!) screen 
redrawing that occurs when the cursor 
moves past the edge of the currently 
visible portion of the table. 

1. Create your table. After you've created 
the column headings and table layout, use 
the Insert Row command to specify the 
number of rows. 

2. Resize the window you're working 
in so that it fills the entire screen hori­
zontally but only half of the screen 
vertically. Place the window at the top 
of the screen. 
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3. Now open a second window for the 
table; don't split the window you're work­
ing in- open a new one. Resize the new 
window so that it fits just underneath the 
original one. 

4. Use the horizontal scroll bar to shift the, 
view in the new window so that you can see 
the right edge of the table. 

Now you can see your whole table- the 
top window shows the left edge of the 
table and several of the columns toward 
the middle; the bottom window shows 
the right edge of the table and some of the 
same middle columns. 

Enter the table information. When you've 
finished with the last fully visible column 
in the top window, use the mouse to move 
to the column following it in the bottom 
window. When you get to the right edge 
of the table, use the mouse to move back 
up to the next row in the top window. 

This is a much quicker and more accurat~ 
method of creating a table -you never 
have to wait for the screen to redraw while 
you're typing, and you never lose your 
place because you can't see the row head­
ers at the left edge of the table. 

Sorting A Mail Merge 

Do you want to sort a mail merge data file 
by zip code when the first field is LAST­
NAME and ZIPCODE is somewhere in 
the middle of the record? You can try 
using Option-drag to select just the ZIP­
CODE column. You need to set your tabs 
so that all the zip codes are left-aligned in 
a column. Hold down the Option key as 
you drag the mouse to highlight the 
desired column of text. 

Once you've selected a column of text, 
using the Sort command sorts the records 



based on the first word of each line in the 
selected column rather than on the first 
word of each paragraph in the data docu­
ment. And remember not to select the 
field name at the top of the document. 

Using Outlining To Navigate 
Word 4.0's outline feature is frequently 
underused, probably because most people 
don't make outlines. But this feature can 
be helpful for more than outlining. 

Here is a way to jump quickly to a 
specified place in a long document: 

1. Select Outlining mode (Command-D) 
from the Document menu. 

2. Click on the line of paragraph you 
want to go to (collapsing or expanding as 
needed). In effect, you're creating a kind 
of bookmark by entering an insertion 
point. 

3. Choose Outlining again to go back to 
normal editing mode. Now your cursor is 
at the right spot, but it's probably off­
screen. 

4. Press the right- or left-arrow key to scroll 
the document to the cursor's location. 

Printing Screens In Word 
Here's a tip for printing screened areas in 
Microsoft Word with a Laser Writer IISC 
or other non-PostScript printer for use as 
table headers, highlighted table rows, and 
soon. 

Use Word's Insert Table command to 
set up the text or table in which you 
wish the shaded area to appear. Once 
you have the text formatted as you 
desire, add a column at the left of the 
existing table. If this column has any 
borders, remove them. Use the ruler to 
determine the approximate width of 

the screen area you want (you can figure 
out the row height with the Cells com­
mand). 

Use SuperPaint (shipped with 
Microsoft Word) to create a box of the 
size and screen density you desire. Then 
choose one of the 36 predefined gray­
scale patterns included with 
SuperPaint. Paste the box into the 
appropriate cell in the column at the 
left of your table, and set the left mar­
gin of the screen paragraph to corre­
spond with the desired screen position. 
Make sure the right margin of the para­
graph is far enough to the right that 
the entire screen box fits within the 
paragraph, or Word will add space 
under the paragraph that will expand 
the vertical space of the table row. 

You won't be able to see the effect in 
Page View, but when you use Print 
Preview, you will see the screen over 
the text. 

When you print, your text will overlay 
the screen. You may need to adjust the 
screen placement or size slightly to 
achieve the desired effect. 

Managing Data With The Table 
Feature 
An easy and straightforward solution to 
manage data in Word is to keep data in 
Word 4.0 tables. 

From scratch, simply type your merge 
field names on a single line, separating 
them with tabs. Select the line by point­
ing in the left area of the window and 
clicking once. Now, from the Document 
menu, select Insert Table, and accept the 
defaults presented to you. Your data are 
now in an easy-to-manage grid, one that ~ 
changes height as you enter data. 
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To enter data, click on the last cell in the 
row and press Return- a new row is start­
ed, and you can start entering your merge 
data. · 

If you don't like the column widths, you 
can change them: click on the Ruler icon 
in the ruler, and T markers appear; shift 
these markers around until the table suits 
you. You can also change the page setup to 
landscape instead of portrait, because only 
the characters in your table- not their for­
mat- will be merged. 

If you're merging from a database such as 
one produced in FileMaker, the process is 
even easier: Select the entire document 
you've exported from your database 
(Command-dick in the selection bar or 
press Command-Option-M), and choose 
Insert Table from the Document menu. 
FileMaker can output data in the exact 
format Word needs to produce a merge 
document, and the Table feature organizes 
the information so that you can see what 
you have without having to wade around 
in all those defaulted tabs. 

Using The NEC Daisywheel 
Printer 
If you use Word 4.0 and a NEC daisy­
wheel printer, you may find that the 12th 
line of text on a page often prints over the 
11th line. This didn't occur with versions 
1.5 or 3.1. 

You can count down lllines and then 
insert a blank line to overcome the prob­
lem, but there is a better solution. The 
NEC printer uses a pitch of 12, so if you 
choose the Paragraph command from the 
Format menu (Command-M) and replace 
Auto in the Line Spacing box with-12, 
the overlapping stops. 
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Time-saving Indexing 
To use Word's indexing feature, you must 
mark each word that you want to index 
with i. in front of the word and ; after it. 
This is extremely time-consuming, espe­
cially if you want to index a word every 
time it appears in a document. Here's an 
easy way to add hidden i. and ; characters 
around all occurrences of a given word in 
an open document: 

1. Index the first instance of the word as 
you normally would. Choose Save As from 
the File menu. 

2. In the Save As dialog box, click on File 
Format and choose Interchange Format 
(RTF). Click on OK. 

3. Give the RTF document a name, and 
save it. You'll see a new version of the file 
with all kinds of strange control codes 
embedded in it. 

4. Find the first instance of the word 
that you indexed normally. It will be sur­
rounded by codes that might look some­
thing like this: {\v {\Jce\pard\plain\5240 
Indexwork}}. 

5. Select the word and all of this index i 

code- which always starts with {\v and : 
ends with } } - and copy the selection to 
the Clipboard. Next place your insertion 
point after this word and all the code 
that surrounds it. 

6. Choose Change (Command-H) from 
the Utilities menu. Type the word you 
want to index into the Find What: box, 
and then paste the contents of the 
Clipboard into the Change To: box. 

7. Click on Start Search (choose No when 
Word asks you if you want to continue the 
search from the beginning of the docu­
ment). This will add the correct index 



codes at the beginning and end of each 
occurrence of the word you want to index. 
Repeat this process for all words you want 
to index. 

When you've finished, save and close the 
RTF document. When you reopen the 
document, Word will ask, "Interpret RTF 
text?": click on Yes. The document will 
then appear in normal format with all the 
relevant entries properly indexed. You can 
verify that all the words have been cor­
rectly labeled by choosing Preferences 
from the Edit menu and toggling the 
Show Hidden Text button on. You can 
then create an index for the document as 
normal, using the Index command, on 
the Utilities menu. 

The Word Screen Saver 
Ordinary screen savers may dim your 
screen or offer fireworks and clock dis­
plays, but in Word 4.0, there's an animat­
ed display that is quite beautiful in color. 
Select Commands from the Edit menu 
and choose Screen Test from the list of 
commands in the dialog box. Click on the 
Do button. If you click once while the 
images are dancing across the screen, a 
dialog box will let you customize the dis­
play or cancel it. 

Smoothing The Transition From 
Word 3.0 To Word 4.0 
1. Word 3 and Word 4 can coexist on the 
same hard disk, each with its individual 
preferences file in the System folder, but 
we recommend against keeping the old 
version on-line. Documents have the 
same creator and type IDs in Word 4 
and Word 3, so keeping track of docu­
ment versions can get very confusing. 

(If your Word 4 is sensitive to errors in 
its preferences files), however, it might 
be a good idea to erase the "Word 
Settings (4)" file in the System folder and 
redefine your preferences (if the applica­
tion is bombing). 

2. It's easy to move your personal style 
definitions from Word 3 to Word 4. 
Simply go into Word 4 and select Define 
Styles. Then use the Open menu item to 
open a Word 3 file, which makes all its 
styles available. Any styles you want to 
keep in Word 4 can be saved with the 
Set Default button. 

3. Word 4 retains the ability to deal with 
any ASCII characters, invisible or other­
wise, by specifying their numeric equiva­
lents. In the older version, you could find 
the value for a selected character by click­
ing on the page number at the lower left 
corner of the screen. In the new version, 
Command-Option-Q is the only way to 
show the numeric equivalent. 

4. Word documents that are "fast-saved" 
cause problems for Working Software's 
Spellswell spelling checker and may be 
troublesome for other applications that 
try to convert them. There is a clever 
work-around, however, that allows you to 
change Word's default format from Fast 
Save to normal. Use Word 4's Commands 
menu to add Fast Save Enabled to a menu 
such as the Edit menu. Once it is on a 
menu, you can select it to un-check it, 
and it will remain off until you 
specifically turn it on again. 

5. Finally, for a little fun, select About 
Microsoft Word ... , then click on the 
Word icon while holding down the 
Command key. 
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Formatting Fields From A 
Database Using The Mail Merge 
Function 
Most database programs can export to 
PageMaker (and other desktop publish­
ing programs), but formatting text with 
anything but paragraph-based styles is 
difficult. (For example, you might want 
one field to come out in bold, one in ital­
ic, and one in a different font than the 
rest). The answer is to use Word's mail­
merge function. Format the main docu­
ment as desired, using the field names 
from your database; for example, you 
could boldface the name field and itali­
cize the phone field, as shown here: 
<<DATA Data document>> 
<<Name>> tab <<Address>> tab 
<<Phone no>> 

Export your database to a tab-delimited 
ASCII file, and set this exported file up in 
Word as a data document. Then you can 
enter the field names in the data docu­
ment. Make sure that no commas appear 
within the fields (you can search for com­
mas to be certain). 

Go to the main document, choose Print 
Merge from the File menu, produce a new 
document, and use the Change command 
to get rid of the page breaks between 
entries. You can now import the format­
ted Word document into PageMaker or 
any other page-layout application. 

Creating Tables With Varying 
Column Widths 
The Insert Table command in Word 4.0 
only lets you create tables with columns of 
equal width. Ordinarily, you have to 
struggle with the column markers across 
the ruler to vary the column widths, but 
there is a shortcut that makes it easy: 
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1. Say you're creating a three-column 
table with one narrow column on the left 
for labels and two wide columns to the 
right for entries. As you create the table, 
enter 5 in the Number of Columns box. 

2. Select all the cells in the second and 
third columns by holding down the 
Option key while dragging the mouse 
over these columns. 

3. Choose Table from the Edit menu and 
select the option for merging the two 
columns. Repeat this procedure with 
columns 4 and 5. 

You now have a three-column table. To 
get a narrower first column and wider 
entry columns, just increase the number 
of columns in the table by a factor of 2. 

Creating An On-line Hints Menu 
Word users have been inundated with 
documentation, help files, and third-party 
books discussing all the program's intri­
cate features. Trying to keep track of all 
this information in its present state is 
mind-boggling but worth the effort. 

To have this information literally at your 
fingertips, create a file named Hints in I 
which you store a personalized set of com• 
mands, shortcuts, and tricks that you · 
want to keep at your fingertips. Give this 
Hints file menu-bar status by adding it to 
the Work menu. Press Command­
Option-+ (plus symbol). When the cursor 
turns into the plus symbol, click on your 
Hints document, either in the Open dia­
log box or in its title bar (if it is the active 
document). 

Word will create a Work menu on the 
right-hand side of your menu bar or add 
your Hints document to an existing Work 
menu. 



Launching Mac Write Documents 
With Word 
Whenever you double-dick on a plain­
text Mac Write document (such as the 
documentation files you download fre­
quently from bulletin boards), it won't 
open unless you have Mac Write on your 
disk. As a lot more people use Word 4.0 
than Mac Write, here's a way to make 
Word 4.0 automatically open those 
Mac Write documents in its own format 
when you double-dick on them. 

First, make a backup copy ofMacWrite (if 
you have it installed) on a floppy and then 
delete it from you hard drive. 

Next, make a duplicate copy of Word 4.0 
on the hard drive and rename itMacWord. 

By using ResEdit, you can change the 
Creator of Mac Word from MSWD to 
MACA (highlight Mac Word and choose 
Get Info from the File menu). Make the 
changes in the Creator box. 

Now, when you double-click on a 
Mac Write document, Mac Word will 
launch and the document will be convert­
ed automatically. 

Quickly Adding Fonts To Word's 
Font Menu 
If you need to add font names to Word 
4.0's Font menu, pressing Command­
Option-+ each time can get tedious in a 
hurry. Here's a fast, undocumented way 
to add all the currently installed fonts to 
your menu. 

Choose Commands from Word's Edit 
menu, and choose List All Fonts from the 
list of commands. Then click on the Do 
button. 

The menu bar will flash as Word adds suit­
case fonts one at a time to the Font menu. 

A Patch For Fractional Font 
Widths On Image Writers 
If you do not own Adobe Type Manager, 
and you are using Microsoft Word, there 
is a patch -a set of modifications to 
Word- that allows for fractional font 
widths on Image Writers. It's called 
WORD4MOD.SIT. It should be avail­
able from the usual shareware outlets 
such as user-group libraries, BBSs, and so 
on. On CompuServe its's called WORD­
MO.BIN in the Macintosh Productivity 
Forum's word-processing library. 

Installing the patch requires familiarity 
with ResEdit (available from the same 
outlets). Obligatory ResEdit warning: 
Never use ResEdit on an original or 
master of anything. Always work on a 
copy. And don't forget to lock your 
master disks. That way, if you happen 
to make a mistake and damage some­
thing, you can always make a fresh copy 
from the master disk. 

Recovering Word Temp Flles 
Before you save a Word document, Word 
sets up a temporary file and places it in the 
System Folder. If your system has crashed 
and you want to try recovering a Word 
Temp file, you can try opening it by hold­
ing down the Shift key and choosing 
Open Any File from Word's File menu. 
That should enable you to open the Temp 
file (try the one with the highest number). 
If you want to, you can add the Open Any 
File command to your menu permanently 
by using Word's command option, which 
you'll find on the Edit menu. 
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Kerning With The Displace 
Command 

Microsoft doesn't mention kerning any­
where in the Word manuals, but you can 
do rudimentary kerning with two char­
acters: 

1. Choose Show from the Edit menu. 

2. Place the cursor between the two char­
acters you want to kern. 

3. Press Option-Command-backslash 
and then type the letter D (the formula 
code for Displace). 

4. Press Option-Command-backslash 
again, and then type the letters BA (the 
formula code for Backward). 

5. Enter the number of points to kern (in 
whole points). 

6. Follow this with both open and close 
parentheses to end the formula. The code 
you see on-screen should look like this: 
\d\ba3 ()(using 3 points as an example). 

7. Choose Show again or print your text, 
to see the difference in spacing. If you 
save this formula as a Glossary item, you'll 
have to enter it only once. 

Inserting The Date Into 
Documents 

Word lets you insert the date into docu­
ments through its Commands dialog 
box, but you're stuck with its date for­
mats, which include the day of the week 
(except for the short format- for exam­
ple, 3/31189). If you want a date such as 
March 31, 1989, you'll have to suppress 
the weekday in the System file with 
ResEdit 1.2. (Try this on a copy of your 
System file before you change your 
working System file.) 
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1. Open the System file and scroll down to 

it11. 

2. Open itll. Select it 11 US" ID=O and 
open it. 

3. Next, click on the Suppress Day box 
(see Figure 2). 

4. Close ResEdit and save the changes. 
Open a Word document. To get the date~ 
make sure you're using Full Menus and 
select Glossary from the Edit menu. 
You'll see the following date entries: date 
-now- abbreviated, date- now -long, 
and date- now- short. 

Select either the long or the abbreviated 
format and click on Insert. The date will 
appear either as March 31, 1989, or as 
Mar. 31, 1989, respectively. 

Using Insert Graphic To Speed 
Printing Time 
Inserting a graphic in a word-processing 
document can significantly increase print­
ing time. Here's a trick for trimming your 
printing time on working drafts and 
proofs. 

Measure the illustration's height (many 
object-oriented draw programs have a Sho\'f 
Size option). Insert the graphic into a Word 
document. With the graphic selected, 
choose Paragraph from the Format menu. 
Type a minus sign in the Line Spacing box 
and then enter the graphic's measurement. 
The minus sign adjusts the paragraph's 
height to match the size of the graphic. 

Select the graphic again, choose Character 
from the Format menu, and format the 
graphic as hidden text. When you print 
draft documents, be sure Print Hidden 
Text in the Print dialog box is not select­
ed. The illustrations will be replaced by 



an appropriate amount of white space, and 
you'll know where your page breaks are. 
When you're ready for the final version, 
recheck Print Hidden Text, and the 
graphics will print properly. 

Inserting PostScript Code In 
A Word Document 
Placing bits of PostScript code (or even 
lengthy routines) into a Word document 
is simple. But Word requires that you first 
clearly define what part of the page will be 
affected by the PostScript code. Is it going 
to affect the entire page (for example, a 
box enclosing the page) or just a para­
graph or inserted graphic? 

You define the boundaries by inserting a 
group command immediately before the 
page element it will affect. In Word 
3.02, you could use three such com­
mands: .page., .para., or .pic. (referring 
to the entire page, the next paragraph, or 
the next graphic insertion). Version 4.0 
has added .cell. and .row. to facilitate 
PostScript manipulation of tabular 
material. 

1. Group Commands- Group commands 
create a drawing rectangle that specifies 
the overall size of a PostScript graphic. 
The actual dimensions of the graphic 
never have to be entered, because the com­
mand gathers this information from Word 
itself. The drawing rectangle created by 
.page., for example, is determined by the 
page size you've specified with the Page 
Setup command. If your page is 5 x 7 inch­
es, the drawing rectangle mirrors those 
measurements exactly. Most other group 
commands, such as .para. and .pic., let you 
focus on increasingly smaller or more 
precise areas of the page- a paragraph, or a 
graphic frame within a paragraph. 

After the group command is entered, you 
can enter a PostScript code you've written 
or copied from another source. Here's a 
simple example that places a 5x7 -inch 
box on a page. At the top of the page, type 
the following: 

page. 
newpath 
.25 setlinewidth 
126 144 moveto 
360 0 rlineto 
0 504 rlineto 
-360 0 rlineto 
close path 
stroke 

Anyone with PostScript savvy will notice 
some peculiarities here. The primary one 
is that the PostScript inclusion hasn't 
been bracketed by a save /restore or 
gsave/ grestore pair, which prevents cer­
tain PostScript operators (Rotate, for 
example) from changing the graphics 
environment of the entire page. Why this 
apparent breach of PostScript etiquette? 
Because the group commands automati­
cally bracket each grouping of PostScript 
code with a save/restore couplet. 

You might also notice that the origin 
point (0 0) in Word's version of the 
PostScript coordinate system corresponds 
exactly to that found in PostScript itself. 
This means that the origin point (0 0) is 
found at the lower left comer of the cur­
rent drawing rectangle, whether it is a 
page, paragraph, or graphic frame. 

2. Creating Global Commands-When 
PostScript requires specific measures or 
positions that can't be referred to through 
the built-in variables, the dimensions are 
expressed in points. If you feel more com­
fortable working in inches, simply place 
the following code after a group com-
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mand such as .para. or .page. (and, of 
course, format it in Word's PostScript 
Style): 

/inch (72 mul) def 

Then you can use code such as 1 inch 1 
inch moveto instead of72 72 moveto. The 
routine you've inserted automatically 
multiplies the inch units by 72, convert­
ing them into PostScript's point system. 

Ordinarily, such a routine applies only to 
the drawing rectangle indicated by the 
group command. So if you had a .page. 
and several .para. PostScript groups on the 
same page, you would have to insert /inch 
172 mull def in each group. When Word 
scans the page for PostScript, it does each 
group in turn and discards the variables or 
routines of that group as soon as it has 
been processed. Even routines or variables 
placed after the .page. command can't be 
used by other groups on the same page. 

3. Executing The Postscript Code-If you 
print the document now, you won't magi­
cally have a PostScript-generated box on 
the page. The code prints as ordinary text. 
To have it executed, you must do several 
things. 

First, select the PostScript code (includ­
ing any group command). Then hold 
down the Shift key and pull down the 
Format menu. You'll see that Styles has 
been replaced by the All Styles command. 
All Styles has several predefined styles, 
including one called PostScript. Select it 
and click on OK. The PostScript code has 
now been changed into a form that will be 
interpreted rather than printed. To see the 
code after this point, make sure that Show 
Hidden Text is selected in the Preferences 
dialog box (Edit menu). You can't see the 
results of your tinkering by using the 
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Print Preview command; you must print 
the document on a Laser Writer. 

When you print, make sure that Print 
Hidden Text isn't selected in the Print 
dialog box and check the Chooser to 
make certain that Background Printing 
is turned off. If Background Printing is , 
left on, the PostScript effects will be . 
shifted down and to the right from where 
you want them on the first page of the 
document. Subsequent pages will print 
correctly. 

4. Modifying Word's PostScript Code 
Style-The on-screen appearance ofWord's 
native PostScript style leaves something 
to be desired. 

Fortunately, you can easily modify most of 
the attributes. While holding down the • 
Shift key, select Define All Styles from the 
Format menu. Select PostScript. The 
description box defines the style as 
"Normal+ Font: 10 point, Bold Hidden.'' 
The main culprit here is Bold, which 
makes the type hard to read. So just pull 
down the Format menu while the dialog 
box is showing and turn off Bold. You can 
safely change anything in the Postscript 
style other than the Hidden attribute. 

ZapfDingbat Check Mark With 
Drop Shadow 
Here's how to put a ZapfDingbat check 
mark into a box with a drop shadow: 

1. Press Command-Y to see the symbols 
for paragraphs, spaces, and tabs. 

2. Press Command-Option-Backslash, 
and then type 0(o,4). 

3. Select the text (including the back­
slash), and choose ZapfDingbats from the 
Font menu. Press Command-Y again to 
hide the paragraph and space symbols, 



You now see a box containing a check 
mark. You can experiment with the various 
boxes and check marks in ZapfDingbats 
until you have a combination you like. 

Printing Grey Text 

Microsoft Word 4 lets you assign one of 
eight basic colors to text. Most users don't 
have access to color output devices, and if 
they do they probably don't want to print 
those overripe colors anyway. 

But there's a clever application of this fea­
ture that almost everyone can use. If you 
color text and then print to a laser printer 
with Version 6.0 or later of the 
Laser Writer driver, the text is halftoned. 
The order of grey-scales, increasing in 
darkness, is Yellow, Cyan, Green, 
Magenta, Red, Blue. 

Using PostScript To Place Screen 
And Crop Marks 
1. Screen Marks-If you want to place, say, 
a gray screen behind a single paragraph, 
you do not need to know the precise loca­
tion and size of the paragraph. 

First, remember that the group command 
.para. creates a drawing rectangle that cor­
responds to the size and position of the 
paragraph it precedes. And Word has 
another card up its sleeve- built-in 
PostScript variables. There are 22 vari­
ables, which will aid you as you develop 
code. For a list of the variables and their 
descriptions, see pages 285 and 286 of the 
User's Guide. 

To make a screened paragraph, we need 
the variable called wp$box. Here's what 
you need to type in front of the paragraph 
and then format in Word's PostScript 
style by holding down the Shift key and 
selecting All Styles: 

.para . 

. 9 setgray wp$box fill 

By the way, you don't have to use carriage 
returns, although they make the code 
more legible. You could simply type: 

para .. 9 setg ray wp$box fill 

In any case, the variable wp$box is equiv­
alent to defining a drawing rectangle the 
same size as the paragraph. Without it, 
you'd have to determine the coordinates of 
the paragraph (with a ruler on a printout) 
and type something like 

12 6144 moveto 
360 0 rlineto 
0 504 rlineto 
-360 0 rlineto 
close path 
fi11 

These are hypothetical coordinates, but 
you can see the advantages of having the 
variables. You save a lot of typing, and you 
don't need to figure out specific positions 
or dimensions. 

2. Crop Marks-An even clearer example 
is crop marks, one of six routines includ­
ed in the PostScript Glossary that 
accompanies Word 4.0. Mter the actual 
crop marks are defined, the routine 
places them at the corners of the page. 
Ordinarily, you would have to know or 
calculate exact positions for the marks, a 
painstakingly bothersome task. But with 
judicious use of some ofWord's vari­
ables, you can avoid the hassle: 

wp$1eft markl sub whitel sub wp$y 
wp$top sub moveto markl 0 rlineto 
stroke 

The variables wp$left, wp$y and wp$top 
refer to the left margin, the drawing rect-
angle's height ~nd the top margin.respec ~ 
tively. You don t need to get the dimen-
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sions from the Page Setup dialog box. 
Word fills in the appropriate numbers 
when the file is interpreted and sent to the 
printer. And if you change the page size, 
you don't have to go back to the code and 
insert new dimensions. 

Customizing Word To Open The 
Ruler Automatically 
You can make your documents open with 
the ruler automatically displayed by using 
Commands from the Edit menu. Here is 
howtodoit: 

1. Open any Word 4.0 document. Make 
sure Full Menus is selected. 

2. Choose Commands from the Edit 
menu. 

3. Make sure the dialog box says 
"Configuration: Word Settings (4)" in 
the lower left corner. This tells you the 
name of the file you are customizing. 

4. Scroll down the command list until 
Open Documents With Ruler shows up. 
(Shortcut: Press the 0 key to jump to the 
beginning of the 0 listings.) Click on the 
command name to select it. 

5. Click on the Add button. 

6. Click on Cancel. 

The Open Documents With Ruler com­
mand will now be listed on the Format 
menu. It will not be checked, though, so 
you will have to activate it. Highlight 
the new menu command to select it. 
Every document you open from now on 
will automatically show the ruler. 

It's worth looking through the entire list 
of commands in the Commands dialog 
box, since many useful items are tucked 
away in there, and some of them are not 
documented in the Word 4 manual. 
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Accessing The Macron Character 
In most Adobe laser fonts, you can access 
a plain macron character by pressing 
Shift-Option-comma (although the 
macron may not show on-screen if you do 
not have the appropriate screen font). 

Microsoft Word's formula language 
allows you to over-strike one character 
with another, placing a macron over 
long vowels. 

To put a macron over the desired vowel, 
type the Formula character, Command­
Option-\ (it may not be visible if the 
paragraph markers are hidden). If you get 
a beep instead of the Formula character, 
select Full Menus from the Edit menu. 

Next type an 0, for Overstrike, and then 
type ( and the character you want to have 
the macron. Finally type a comma, the 
macron and ). 

A Macro For Changing Italics To 
Underline Using AutoMac ill 
There is an alternative to using Word's 
search-and-replace operations for type 
styles. 

Here is an AutoMac III macro for chang­
ing italics to underline. (AutoMac III 
comes bundled with Word 4.0. If you 
have not installed it, place the file 
AutoMac III in your System Folder and 
restart your machine. The AutoMac III 
icon appears to the left of the Apple 
menu.) 

First, use Command-9 (9 on the numeric 
keypad) to get to the very beginning of 
the document. Now type a word in the 
type style you wish to change from- for 
example, type italic in italic- and select 
that word. Then type or perform the fol­
lowing steps: 



1. Click on the AutoMac III icon and 
assign a keystroke to run the macro, such 
as Command-Option-U for underline. 
Click on record. 

2. Type Command-Option-R, which 
finds the next occurring instance of the 
selected type style. 

3. Click on the AutoMac III icon, and add 
a time delay of five seconds. 

4. Type Command-Shift-1. This toggles 
the italic style, in this case to off. 

5. TypeCommand-Shift-U. This toggles 
the underline style, in this case to on. 

6. Type Command-9 (numeric-keypad 9), 
which returns you to the beginning of the 
document. 

7. Type Command-Shift-6 (numeric-key­
pad 6), which selects the word italic again. 

8. Click on the AutoMac II icon. Click on 
Misc. Click on J (Jump to a Macro). Jump 
the macro back to itself by typing its 
name (Command-Option-U, which caus­
es the macro to repeat until all italicized 
words are converted to underline. 

9. Click on OK. Click on Stop. 

To run the macro, make sure you have put 
a word at the very beginning of the docu­
ment in the style you want to change from 
and select that word. Then type Command­
Option-U (or whatever keystroke you have 
assigned to the macro). 

Your macro will repeat until all italics are 
converted to underlines. When a dialog 
box asks, "Continue checking from begin­
ning of document?" type Option-period 
to stop the macro, then click on Cancel. 
Otherwise your macro will change your 
underlines back to italics and back to 
underlines in an endless loop. 

This macro can be adapted to inter­
change any fonts or character formats. 
For example, to change random occur­
rences of Venice to Zapf Chancery, put a 
word in the Venice font at the very 
beginning of your document. Then, 
instead of using the two toggle com­
mands described, record into your macro 
the selection ofZapf Chancery from the 
Font menu. 

A Macro For Transposed 
Characters 
You can design a macro for Microsoft 
Word that transposes two letters acciden­
tally typed in the wrong order, a common 
typing error. There may be a drawback 
to this method if the macro uses the stan­
dard Cut and Paste commands, because 
it empties the Clipboard. Here's a macro 
that does the job without using the 
Clipboard. 

First be sure that Num Lock (toggled by 
the Clear key) is off- the status box in the 
lower left corner of the active window 
should not read Num. Lock. Now begin 
recording your macro. (The macro assumes 
that you've placed the insertion point just 
after the second mistyped letter.) Press 
Shift-keypad-4, which highlights the sec­
ond letter. Next press Command-Option­
X (the status box will now read Move To), 
and then press the keypad 4 twice, which 
moves a flashing gray vertical line to the 
spot just before the first letter. Now press 
Return, and then move the insertion point 
back to its original spot by pressing the 
keypad 6 once. Stop recording and assign a 
keystroke. 

Globally Replacing Formats 
There are two indirect ways to globally 
find and replace fonts or formats in Word, ~ 
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for example if you want to be able to 
change underlined text in a file to itali­
cized text. 

The first is to convert the document into 
RTF (Rich Text Format). To do this, 
choose Save As from the File menu, click 
on the File Format button, and choose 
Interchange format (RTF). When you 
save the document, it appears on- screen 
complete with the formatting code. 
Because the code for underlined text is \ul 
and the code for italicized text is \i, you 
can globally change the formatting by 
using the Change command (Command­
H). In the Find What box, type \ul; in the 
Change To box, type \i; and then close the 
document and save your changes. When 
you reopen the document and Word asks 
if you want to interpret RTF text, click 
on OK. All underlined text is now itali­
cized in the new (untitled) document. 

The other way to do this is to use the 
obscure Find Format command, 
described in the Word manual. It lets you 
search for underlined text, but you have to 
change it to italic manually. 

Here's how it works: To find each occur­
rence of underlined text, first select an 
underlined character. Invoke Find 
Formats by pressing Command-Option­
R, and the program finds and selects the 
next occurrence of underlined text. 
Change it to italic by choosing Italic from 
the Format menu (or type Command­
Shift-1). To find the next occurrence of 
underlined text, choose Find Again from 
the Utilities menu (or type Command­
Option-A). 

This procedure isn't global; however, it 
does what you want fairly easily. If global­
format changing is important to you, you 

218 

should know that other word processors 
do it faster and more easily. Mac Write II, 
for example, does it with a few simple 
selections in its Find/ Change dialog box, 
and Nisus and Full Write Professional 
work similarly. 

Ask yourself how much pain Word's lack 
of a Change By Style feature causes you; if 
it's really affecting your quality of life, 
think about changing word-processing 
programs. 

Speeding Table Scroll 
When you're working with a table-laden 
document in Word, it can take forever to 
scroll through the table sections. If you 
frequently use tables in your work, here's a 
trick that can eliminate scroll crawl: 

1. Select the entire table, and choose 
Copy as Picture from Commands in the 
Edit menu (and while you're at it, place 
this command on your Edit menu). Click 
on Do. 

2. With the table still selected, perform a 
Paste (Command-V). The text table will 
be replaced by a graphic version of the 
same table. Now that the table has been 
changed to a graphic, you can scroll it 
much faster. 

3. Go back to the Commands menu and· 
choose Use Picture Placeholders (you can 
add this to the Edit menu as well). Click 
on Do. 

Caution: If you ever expect to revise the 
table, you should first save a copy of the 
text version in a separate file. Once you 
have replaced a table with its graphic 
image, you can no longer edit it, with one 
exception: you can cut rows from the bot­
tom up and columns from right to left if 
Show Paragraph (Command-Y) and Use. 



Picture Placeholders are off. Just grab one 
of the handles on the graphic and drag to 
crop it. 

Add The Fast Save Enabled 
Command To The Flle Menu 
The Fast Save command increases the 
speed of the Save command, thereby mak­
ing it less painful to save your files fre­
quently. When you use the Fast Save 
Enabled command, Word saves files in a 
special file format that's fine for saving 
work in progress. Fast Save isn't suitable 
for final versions, though. If files saved in 
this format are damaged, it's much harder, 
if not impossible, to recover them. 

Placing Fast Save Enabled on the File 
menu makes it easy for you to select or 
deselect the command before you save. 
Word's default option is to add this com­
mand to the Edit menu, but it makes 
more sense to add it here. 

To add the Fast Save command, choose 
Commands under the Edit menu and look 
for the Fast Save Enabled option in the 
scrolling field on the left. Highlight it, 
and choose the File menu and click the 
Add button. (You may have to remove the 
command from another menu before 
adding it to the File menu.) 

Add The Make Backup Flles 
Command To The Flle Menu 
Normally, each time you save your work, 
the new version of your file overwrites the 
previous version. When you select the 
Make Backup Files command, however, 
Word makes a copy of the previous ver­
sion of your file and names it Backup of 
Filename before executing the save. As a 
result, you always have the last two saved 
versions of your file on-disk. This means 
that you can go back to the previous ver-

sion of your file, and you also have a back­
up in case something happens to the cur­
rent version of your file. 

To add the Make Backup Files command, 
choose Commands under the Edit menu 
and look for the Make Backup Files 
option in the scrolling field on the left. 
Highlight it, and choose the File menu 
and click the Add button. 

Add The Load Flle Into Memory 
Command To The Utilities Menu 
This command, which is normally in 
the Preferences dialog box, causes 
Word to keep the current document in 
RAM rather than keep only the cur­
rently displayed portion of the file in 
RAM and read the rest from disk as you 
scroll the file. If you're going to be 
scrolling up and down within your file 
frequently or executing commands that 
require Word to access the whole docu­
ment (such as Spelling, Hyphenate, 
Repaginate Now or Print), keeping the 
file in RAM can speed up Word's perfor­
mance. 

If you always work on files for long peri­
ods, you may be better off checking the 
Always Load File into Memory option in 
the Preferences dialog box rather than 
adding this command to your menu. 
However, if you sometimes open and 
close files without performing extensive 
editing, using this option as a command 
is more efficient. 

Exporting Tables 
Microsoft Word is a great tool for making 
tables to export into page-layout and 
drawing programs. To capture the table's 
border and cell relationships, you must 
use Word's Copy as Picture command ~ 
(Command-Option-D), but this com-
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mand doesn't work properly when you 
want to include text that is not part of the 
table with the table (as a title or caption, 
for instance). Here's a work-around: 

First, move the table away from the head­
er or caption to another part of the docu­
ment. Select the table, choose Copy as 
Picture, and paste the picture where the 
table was before you moved it. Select the 
picture you just pasted, along with the 
accompanying title or caption, and 
choose Copy as Picture again. The whole 
thing can now be pasted into the DTP or 
drawing program, and you still have a 
copy that's suitable for editing in your 
Word document. 

At first glance, it may seem easier just to 
make the caption or header part of the 
table by putting the text into a table cell, 
but because this involves deleting 
columns, repositioning cell boundaries, 
removing cell borders and applying 
styles, it's generally quicker and easier to 
use the two-step Copy as Picture solution. 

Add The Load Program Into 
Memory Command To The 
Utilities Menu 
Like the Load File into Memory com­
mand, this command can also be set in the 
Preferences dialog box, but executing it as 
a preference means you have to wait for 
Word to be read into memory each time 
you launch it. 

If you ever use Word only to browse 
through a file or two, or to perform minor 
editing, the time needed to load it into 
memory doesn't justify the speed increase, 
so you wouldn't want this as a default 
preference. Keeping the command in the 
Utilities menu, though, lets you load 
Word into memory only when it pays off 
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in performance. A good rule of thumb is 
to load Word into memory if you intend 
to use it for more than 15 minutes. 

Add The Move To Commands To 
The Utilities Menu 
Word provides an exhaustive array of cur­
sor-movement commands that most users 
never discover. If you use the arrow keys to 
scroll across your files, learning to use 
these commands can give you a whole 
new perspective on word processing. 

Once you are familiar with the commands, 
learn the keyboard command equivalents 
for real efficiency. You can also use these 
commands to select text; just add the Shift 
key to any of the keyboard command 
equivalents, and text is selected as you 
move the cursor. 

To add any of the Move To command, 
choose Commands under the Edit menu 
and look in the scrolling field on the left. 

Add The Select Whole Document 
Command To The Edit Menu 
People often want to select an entire 
Word document, but it's hard to remem­
ber the keyboard command equivalent 
(Command-Option-M) or inconvenient : 
to use the mouse-click method 
(Command-dick with the arrow tool at 
the far left edge of the window). With 
the Select Whole Document command 
in the Edit menu, selecting an entire 
document is no longer a brain-teaser. 
Interface purists will also want to assign 
it the Option-A keyboard equivalent. 

UnderllmdngEquatlons 
Underlining equations with subscripts 
or superscripts can be hard in Word 4.q. 
The underline style (Command-Shift-lJ) 
places separate underlines under the sur-
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scripted or superscripted numbers. 
Here's how to get a solid underline under 
equations, whether the format is dis­
placed or in-line: 

1. Choose the Show Paragraph command 
from the Edit menu (or type Command-Y). 

2. Press Command-Option-/. This is the 
preparatory command for doing mathe­
matical typesetting. 

3. Enter the letter-typesetting code- in 
this case, X (for the Box command). 

4. Press Command-Option-/ again, 
followed by BO for the bottom border 
of the box. 

5. Type in the arguments, and enclose 
them in parentheses. Apply superscript 
and subscript formatting where necessary. 

6. To view the formula, select Hide 
Paragraphs. Word's typesetting code 
draws a solid line under the equation 
and won't interfere with the rest of the 
paragraph's formatting. 

WRITE NOW 
Setting Up Informal Style Sheets 
You can set up informal style sheets, using 
the dummy formats that you frequently 
use, in a document template that is kept 
open whenever you're working in 
WriteNow. 

When you need a style, just switch win­
dows, click on the paragraph containing 
the format you need, and copy the ruler 
(Command-1). Then switch back to the 
document window and paste the ruler in 
(Command-2). Although this method 
only copies ruler settings (not font or style 

changes, for instance), it can still be a real 
time-saver. It also helps ensure that your 
documents all have a uniform style. 

Later, if you want to change a particular 
format, you can use WriteNow's identical 
ruler feature. Just select the text from the 
first occurrence of the format to the end of 
the document and then hold down the 
Shift key while making the change in its 
ruler. 

WRITENOW 2.0 
Opening RTF Formatted Flles 
You might have problems when trying to 
open files with WriteNow 2.0 that were 
originally saved in the RTF (Rich Text 
Format) format by Word 4.0. Specifically, 
WriteNow displays the error message 
"Bad RTF number" and then refuses to 
translate the file. 

WriteNow 2.0 has "filters" that are sup­
posed to translate a RTF file to the 
WriteNow format. All RTF files start with 
the symbols {/rtf followed by a number. 

For earlier versions ofWord (Word 3.01, 
for example) the number was 0, so you see 
{/rtfO. However, Word 4.0 RTF files 
begin with {rtfl. Apparently, the 
WriteNow 2.0 translator checks this 
number, and if it is not what it expects, it 
refuses to translate the file. 

The fix is easy: Open the RTF file in Word 
(you must make sure that you click on the 
Do Not Interpret button), and change the 
1 to a 0; follow this procedure with a Save 
command. WriteNow 2.0 can then trans­
late the file without difficulty. 
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WRITENOW 2.2 

Generating Endnotes 
WriteNow 2.2 does not automatically 
generate endnotes, but you can use the 
footnote feature and some editing to gen­
eratethem. 

Create the document as you normally 
would, inserting footnotes into the text as 
needed (they'll appear at the bottom of 
the page). When the document is 
finished, create endnotes as follows: 

1. Choose Show Markers (Command-Y) 
from the View menu. 

2. Choose Footnote View (Command-K) 
from the View menu. 

3. Choose Select All (Command-A) from 
the Edit menu, and then choose Copy 
(Command-C). 

4. Choose Page View (Command-D) from 
the View menu. Go to the end of the doc­
ument, and click to place the insertion 
point. 

5. Choose the Insert Page Break com­
mand (Command-Shift-B) from the 
Format menu, Type the word Endnotes 
(or whatever you want), and press Return. 
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6. Use the Paste command (Command-V) 
to place the footnotes at the end of the 
document. The footnotes are unnum­
bered, but there's a footnote marker at the 
beginning of each note. 

7. Now go to the beginning of the docu­
ment, and click to place the insertion 
point. 

8. Choose Footnote View, or press 
Command-K. 

9. Choose Page View (Command-D). The 
insertion point will now be after the first 
footnote marker. 

10. Press the Delete key to delete the 
marker. 

11. Type Command-H (Superscript style) 
and then the endnote number. 

Repeat steps 8 through 11 until you've 
finished numbering all the notes in the 
text. 

12. Number all the actual endnotes at the 
end of the document. 

You can create a macro to do much of this 
for you. Just have the macro stop after step 
11. Then simply run the macro and type 
the note numbers. I 
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